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About the Author

Marcelo Thalenberg is an entrepreneur in the technology indus-
try. During the last decade, two of his startups included what
today is the Avnet branch in Brazil (a components distributor) and
B. I. Tecnologia, a computer telephony integrator that introduced
new hardware and software developments into Latin America.
Today, Marcelo is a consultant focusing on behavior and technol-

ogy.

Just as cars were a new technology in the beginning of the 20th
century without the benefit of traffic rules or drivers licenses,
Marcelo believes that e-mail and instant messaging traffic are dri-
ving people crazy — yet almost nobody learns how to deal with
them. With very little training, you find out how to shrink the
number of messages you deal with and to eliminate many before
anyone even writes them. When you analyze the messages you
receive and classify them by behavior, you notice why people are
sending you messages and why most of the messages arriving in
your Inbox are unwanted. In this book, Marcelo applies his work
with behavior styles to Outlook to help his readers take control of
their office environments and their e-mail Inboxes.

Marcelo writes articles about technology and behavior as applied
to different segments of business, such as sales, marketing, and
working women. In 2002, he wrote a book about time management
with Outlook in Portuguese, called Socorro roubaram meu tempo
(Help, Who Has Stolen My Time), published by Editora Erica.
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Introduction

A t the risk of seeming like Charles Dickens’s Ebenezer Scrooge, | must say
that software can be expensive when you don’t know how to get results
with it. Likewise, it can be a real bargain regardless of cost if it solves an impor-
tant problem. In the past, | wasn’t getting the most of Microsoft Outlook
because the software instructions and the available literature taught me how
to use the product rather than how to solve my problems with it.

When | analyzed my business procedures and other people’s behavior, I had
one question: “How can I use Outlook to solve my business and productivity
problems?” To ensure that weekly reports were always delivered on time, I
asked each salesperson to open a recurrent task with a reminder set for the
day before the reports were due. The reports started to arrive on time. After
creating a workshop checklist, the procedures — using Outlook Contacts —
became fast and easy. The receptionist started creating invitations during
downtime. This book is the result of my practical experience while building
hundreds of applications and training and developing procedures. You paid
for Outlook; you can now increase your productivity by using Outlook more
efficiently.

About This Book

In this book, [ show you how to organize yourself, your team, and your busi-
ness by creating procedures for goals control, communication through e-mail,
sales control, marketing activities, tasks, and information sharing. You dis-
cover how to use Outlook to help you change attitudes and achieve balance
in your life.

How can software solve attitude problems, you ask? Well, using the Reminder
feature can help employees remember to deliver a task on time. Sharing a
task folder with your boss paves the way to negotiating the tasks you should
do first. Using e-mail rules to filter out and expose behaviors helps to elimi-
nate unnecessary messages before they're even written. All these actions can
reduce your anxiety and improve your attitude toward your goals.
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Foolish Assumptions

During the course of this book, I assume that you know how to turn your
computer on, get around in Windows, create a simple a letter with Word, and
use Outlook Express to send and receive e-mail. I also assume that you want
to increase your personal productivity by using Outlook features you may
not have used or seen, in order to improve your daily work or life. If you need
an Outlook book only, | suggest reading Outlook 2003 For Dummies (Wiley
Publishing, Inc.) by Bill Dyszel.

How This Book Is Organized

This book is organized into six parts. The chapters within each part cover
specific topics in detail. You can read each chapter without having to read
the chapters before it, which is helpful if you have better things to do with
your time. You can even just read sections within a chapter without reading
the entire chapter. [ may occasionally refer you to somewhere else in the
book for more detail or background information on a particular subject.

Each part covers a major area of managing your business by using Outlook.
The following sections summarize what you find in each part:

Part I: Managing Any Business

Managing a business includes simple things that make it successful, not includ-
ing the sales and financial aspects. Businesses of all kinds share common
issues revolving around employee relations, planning, and training. But before
you organize your business, you have to organize yourself. Remembering to
accomplish your tasks by their deadlines, arriving at meetings on time, super-
vising your team, and defining and achieving your goals are all areas in which
Outlook can help you get organized.

Part II: Managing Contact Information

Some people think that all you need to know about a customer is a name,
phone number, and e-mail address. The Outlook Contacts list allows you to
fill in the most complete contact record ever imagined. These records can
become your customer profiles. You can easily customize Outlook forms and
contacts according to your business needs.

In addition, the Business Contact Manager (BCM) is a free add-in that comes
with the Office Small Business and Professional edition. BCM includes Account
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and Business Contact forms designed to control your sales and marketing
activities. You can use BCM without any customization. Version 2.0 allows
you to share the same customer base among your team members and custom
create reports and lists.

Part I1I: Handling Communication
and Collaboration

Are you tired of receiving so many joke messages? The Zen of Inbox
Management shows you how to change your Inbox parking lot into a tollgate.
The e-nanny helps you organize your Inbox fast, and the e-office cleaner helps
you automate a daily deep-cleaning routine. Avoiding fraud and junk mail is not
only a matter of building a firewall, but also involves becoming wise.

Collaborative work becomes smooth when everybody uses the Calendar’s
invitation feature and task requests. Sharing the Calendar and Tasks list helps
the team work with fewer interruptions. You can also easily shorten meeting
setup time, without additional e-mail and phone calls, when your team uses
the Calendar and you check the Next Available Time in the team’s schedule.
Other tips in this part can change your concept of meeting planning and trav-
eling and working externally.

Part 1U: Controlling Business Processes

In this part, you find out how to create a telemarketing campaign, including
how to configure the Contacts list for automatic dialing. You also discover
how to refine your customer list by using filters and create direct-mail cam-
paigns with a handy direct-mail checklist. In addition, you use Outlook’s map-
ping and Journal features.

Part U: The Part of Tens

Here, you find tips for increasing your free time and managing your sales and
marketing activities. You also find ways to streamline and safeguard your data.

Part Ul: Appendixes

Because this book explains how to configure Outlook specifically for business
purposes, it includes instructions for using the Calendar, Tasks list, Contacts
list, and the Journal. Appendix E even shows you how to move from Outlook
Express to Outlook 2003.



Managing Your Business with Outlook 2003 For Dummies

Conventions Used in This Book

This book is intended for Windows and Office users. Whenever [ want you to
choose a sequence of commands from the pull-down menus at the top of a
program, | use the phrasing, “Choose File=>Save.”

Icons Used in This Book

A\

Throughout the margins of this book, you see little pictures that highlight
text you’ll want to pay special attention to:

This icon flags helpful information to make things easier for you.

This icon draws your attention to common problems and common mistakes
that may require technical support.

This icon highlights important details you won’t want to forget.

This icon marks advanced information that you may want to skip or ask a
techie guru to help you with.

Where to Go from Here

If you're an experienced Outlook user, you can just jump straight into the
application you need. If you're a newcomer to Outlook, you can start reading
the basics in the Appendixes. If you work in sales or marketing, try Chapter 4
before going to Chapters 14, 15, and 16. Enjoy the book in whatever order you
need it and increase your productivity!
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In this part . . .

mat’s the first thing you think of when you hear the
word business? For many people, the first thing
that comes to mind is money, gained from the practice of
buying and selling goods and services. But what about a
nonprofit organization, a church, or even your family? Are
these businesses that deserve attention and goals? Of
course, they are.

Running any business — whether you're a fortune teller, a
work-at-home consultant, a financial or insurance advisor,
a personal trainer, or even a corporation — is about one
main objective: serving the customer’s needs by people
motivated to do so. In this part, [ show you how to use
Outlook so that you don'’t feel like you're drowning in mil-
lions of tasks. I also show you how to choose the key
issues on which to focus and how to download your brain
and organize your issues so that you can hit your goals
one by one.




Chapter 1

Changing Your Outlook
on Managing Business

In This Chapter
Moving ahead with Outlook
Looking out for all parts of your business
Thinking about business goals and objectives
Managing sales and fulfillment activities
Making Outlook your Control Panel

Planning your goals and activities

M anaging any business is about doing your job better, not harder. It’s
about mastering your business, not being a slave to it. That’s where
Outlook comes in. You can write down and achieve your goals with Outlook.
You can create simple and effective solutions to your daily problems.

Businesses of all kinds share common issues revolving around employee rela-
tions, planning, and training. Using Outlook as a dashboard or control panel,
you can improve the way you confront and manage these issues. With Outlook,
you can shrink unnecessary demands and even downsize your anxiety and
preoccupation to a realistic level, thus balancing your business and your life.
In this chapter, I cover what you need to know to organize and keep track of
your goals.

Going Above and Beyond with Outlook

Outlook can increase your productivity by helping you control your objec-
tives, actions, tasks, time commitments, and team workflow. Other Enterprise
Resource Planning (ERP) systems — computer software that help you manage
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your business — typically only include accounting, invoicing, financial man-
agement, and inventory control and don’t delve into organizing personal
activities, team relationships, or communications skills. ERP systems range
from inexpensive and effective tools like Peachtree to multimillion-dollar cor-
porate systems, such as SAP or Oracle. Some of the things that Outlook can
do for you include the following:

v The Calendar’s collaborative tools can increase your company’s produc-
tivity by providing tools for working in teams. Teams can share commit-
ments, schedule activities in unison, and track participation. Read more
in Chapter 10.

» You can assign tasks to increase commitments and reduce quarrels by
allowing people to accept and respond to automated task requests via
e-mail (See Chapter 10.)

v The Tasks list helps you organize all your pending actions and select list
them by priority or due date. Read more in Chapter 2.

v The Recurrence tool can remind you again and again of anything you
need as often as you need it. For example, you can set reminders for
weekly reports, monthly payments, or daily tasks. Read more in Chap-
ter 2.

v The Contacts list lets you record any information about your relation-
ships and even create a customer profile. Read more in Chapter 4.

v The Outlook automation works to save you time when you make your
phone calls, send faxes, or organize and clean your messages. Read
more in Chapter 3.

» You can use e-mail rules to surf over the e-mail tides, eliminating
unwanted e-mails and automatically filing e-mails in the right folder
for you. Read more in Chapter 8.

v Mail merge between Contacts list and Word can turn any campaign from
impersonal to very personal form letters to electronic messages. Read
more in Chapter 16.

v Dialup properties, used with the Contacts list, allow you to customize
your own telemarketing center and increase the productivity of your
campaigns. Read more in Chapter 16.

v The Business Communication Manager (BCM), a free add-in for Office
Small Business and Professional versions, allows you to control your
customers’ and prospects’ activities from the first point of contact to
the close of a deal. Read more in Chapters 7 and 8.

v Customizing forms to suit your business can improve your company’s
workflow. Chapter 5 explains how to customize and create forms.
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P The most powerful Outlook tool is the on-screen reminder. The alarm pro-
duces on-screen messages, which reminds you to take action. Whether it’s
reaching your quarterly business forecast or simply reminding you, year after
year, to order your spouse an anniversary gift, this feature makes life much
more manageable.

Looking Out for All Parts
of Your Business

The purpose of business is to create and keep customers. Without customers,
there is no business. But without profit to recover your investment and pay
expenses, no business can survive. Marketing, sales, and financial control are
all key issues, but you also need to innovate — not only in the product or ser-
vice but also in the general procedures of your business. Outlook is an addi-
tional tool for your current sales and accounting systems that can help you
achieve your goals and objectives with innovative solutions.

Customers

No business exists without customers, and you create customers through
relationships. Therefore, relationships are perhaps the most important part
of any business. Unfortunately, companies all too often think about their
products or services, but forget how to develop customer relationships or
understand and solve their customers’ problems.

You can develop your customer relationships one by one if your business
allows you to do so. But people in businesses that have thousands of cus-
tomers who don’t require daily attention often forget that they can still develop
relationships with their customers. They can take actions and communicate
with customers in groups. Outlook categories allow you to group your cus-
tomers for various needs. (Read more about categories in Chapter 4.)

Businesses that work with customers in large groups, such as credit-card
companies, newspapers, and the phone company, know customer addresses
and names. You may have the intelligence to sell mass products, but the cus-
tomers are still just names in your databases. While you have an understand-
ing about what it takes to work with groups of people, rather than single
individuals, you still don’t know your customers’ wishes or desires to fulfill
one by one. You can use Outlook Categories to classify your customer base
and work by company type, territory, or vertical markets (see Chapter 4).



10

Part I: Managing Any Business

aA\\J

Likewise, businesses that work with individual customers must develop a
personal and continuous relationship. In order to understand their wishes
and desires, you must know these people well and understand their prefer-
ences, tastes, and moods. You may forget or neglect information written in a
notepad or stored in your head. Outlook contacts can help you collect, record,
and organize any information about your customers. Recording customer
wishes can be a good way to improve your product or service and increase
your customer satisfaction. Customer care and attention is the successful
key to any personal business relationship (see Chapter 4).

Do you want to send a compliment to your customers when their baseball or
basketball team wins a game? Just select your contact by team and send them
an e-mail. Classify them by importance, like Platinum, Gold, and Silver, and
set up the reminder to touch base twice a week or once a month. Read more
in Chapter 14.

Marketing and sales

Marketing is the strategies, tactics, and activities involved in getting your mes-
sage to intended target markets. The focus is usually on selling or facilitating
the introduction of a product or service. Can you send, in a few clicks, a Happy
New Year card to your customer base? With your customer base updated with
Outlook Contacts, not only can you send a card, but you can also group cus-
tomers by categories and take different actions for each group. You can even
design a telemarketing program that includes automatic dialup from your PC.
Chapter 16 explains the use of checklists for marketing programs, events, and
communications.

When it comes to the sales side of things, “Hey, where is my order?” is an oft-
dreaded follow-up question for many salespeople. If the customer has to ask
this question, it can create an unpleasant feeling in the customer or even cause
him to send his order to a competitor. The successful salesman focuses not
on the customer but on what the customer is looking at and makes that the
common starting point for building a relationship. Not only can Outlook help
you get to know your customers and their goals better, but it can also help you
take the proper actions on time. For more on what to do when, see Chapter 14.

Innovation

Innovation is not only about new products or services. It’s also about improv-
ing the way you work — better, easier, faster. It’s even about shrinking your
costs. Using Outlook, you can increase your productivity with less stress by
using the applications explained throughout this book.
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If your entire team uses Outlook’s collaborative tools and reminders, your
company can be more productive, and you can build a stronger and closer
team. Collaborative tools and reminders can improve the way you work in
several key areas:

v Personnel and productivity: Using Outlook Tasks and Calendars can
increase your staff’s productivity. Sending Tasks or Invitations can help
decrease internal quarrels and solidify commitments. For more on facili-
tating teamwork, see Chapter 10.

v Financial and material resources: You may think that an ERP would
take care of the whole business, and if you're concerned with only the
financial numbers, you're probably correct. But Outlook can help elimi-
nate those painful phone calls asking for forgotten payments. It can also
help you avoid sending your own collection notices to your customers.
The Reminders alarm prompts you to take the right action, on time, and
avoid disorganization and unwanted phone calls. For more on minding
these important details, see Chapter 17.

v Profit: The result of improving relationships with your customers and
teams with Outlook will be increased productivity by a stressfree team
of professionals.

Business goals and objectives

Management by objective works — if you know the objectives. What is your
business objective in five years? Write the objective and steps to achieve
your goal, even if you're not sure about them. Write them in an Outlook Tasks
because you may forget about a piece of paper in your drawer. Turn on the
task alarm to pop up in your face as scheduled, check the steps completed,
and then start the next ones. Did you change your goals? Rewrite them. No
matter what kind of objective you want to achieve, the Outlook Tasks feature
is ready to accept any goal, like doubling your company income in five years,
closing the best order of the week, planning for a baby, receiving your master’s
degree or Ph.D,, increasing your customer base, moving to a new house,
moving your office, changing your profession, receiving a deserved promo-
tion, launching a new product, losing weight, winning the Olympic games,
taking your next vacation . . . whatever you want!

Writing your objectives for next month, next year, or for the next five years

is the path to accomplishing them. Outlook Tasks reminds you of key steps
along the way and gives you the chance to adjust according to your priorities
(see Chapter 2).

11
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Customer contact and education

Outlook Contacts is more than a telephone black book; it’s an information
center to track your relationships and activities. You can attach related docu-
ments to the Contact record for easy access, record recent phone call high-
lights, create anniversary reminders, store personal information about clients,
and even build an active telemarketing application. It also has 18 one-click
actions, including dialing the phone for you, to save you time. For more infor-
mation on working with contacts, see Chapter 4.

Sales and fulfillment activities

Analyzing lost orders can, for many companies, reveal where follow-up has
been neglected. When calls come into the inside sales department or when
outside salespeople come back to the office, they often don’t record a cus-
tomer’s pending issues. Later, when the order comes in, the issues may be
overlooked. Salespeople aren’t paid merely to send quotations to customers
but also to follow up on their needs and to understand what’s required to get
a customer to commit and the deal closed. But salespeople often get bogged
down under the flow of everyday activities and lose their focus on the cus-
tomer, which reduces the number of incoming orders. Opening a Task for
each pending quotation and setting pop-up Reminders for next actions can
help keep salespeople on track. You can use Reminders for an internal request
or just to touch base with customers. For more on tracking sales activities,
see Chapter 14.

Procurement

Procurement for office supplies is easy. You can order through the Internet or
catalogs or simply go to a store or a supplier’s warehouse. But besides these
simple orders, how do you control a step-by-step order from an international
supplier? How do you control a project being developed by a new supplier?
Outlook Tasks can help remind you to place a new order, even if you're work-
ing in a corporation with tracking software. Tasks can help you track special
projects or actions. Associating the appropriate contacts for each action, you
can easily call or send an e-mail while you're working with the task on-screen.

Financial and organizational control

Mailing a check is a task often put off or delayed by something else, causing
the unpleasant “Hi, did you send the check?” phone call. You can remember
to make monthly payments by using recurring reminders.
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Making Outlook Your Control Panel

The huge amount of information you receive, process, and store in your
brains nowadays increases stress levels and slows you down like a computer
with the hard drive full. Everyone was taught since kindergarten to retain
information because information is unchangeable. That’s no longer compati-
ble with today’s paradigm: that knowledge evolves . . . and quickly. You need
to discover how to critique, select, and filter information before it even occu-
pies your brain. To be productive, you need to filter and select valued infor-
mation to help you achieve your goals. Without some training, most people
find it difficult to keep up with the information avalanche and end up trapped
beneath it. Understand the problem and start using Outlook to organize the
incoming information flow according to your priorities, thus increasing your
quality of life.

Making Outlook your control panel means managing your time and tasks by
writing or downloading your information and organizing it by priorities, thus
achieving your goals (see Chapter 2 for details).

Downloading your memory

Don'’t tie a string around your finger or place a sticky note on your PC screen
anymore. Instead, tell Outlook to remind you. Are you leaving the Office?
Print the reminders list or synchronize it with your cell phone or PDA.

Many people wake up daily and inhale their breakfast because they don’t
have time to sit down and eat it, and they’re always late. An ambulance driver
doesn’t drive 24 hours a day, 7 days a week. He has to rest. So why are people
running around as if they were working in an emergency room? Anxiety, stress,
and lack of priorities are the roots of this kind of behavior. Downloading your
memory into an agenda or daily planner doesn’t remind you of your commit-
ments unless you open and read it. Outlook allows you to turn off your
ambulance-driver behavior so that you can achieve your commitments and
priorities. You can set up pop-up alarms and reminders_for events, deadlines,
meetings, or anything at all.

Time commitments and to-do commitments aren’t the same thing. You can
adjust to-do commitments according the due date and your priorities, but
time commitments aren’t so easy to change.

v Time commitments: The 5 p.m. tea at Shelley’s house begins at 5 p.m.
sharp, so don’t be late. Any planned arrangement at a specific time is a
commitment. You can use the Calendar to schedule your arrival and
leaving time. For more on scheduling, see Chapter 12.
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v To-do commitments: It's Monday, and you need to send a sales proposal
Friday. You have more than four days to choose when to write the pro-
posal. You can write when and where you want according to your priori-
ties. Simply write each new job on the Tasks list and adjust the Reminder
to pop up according to your will.

Planning your goals and activities

Archimedes taught us his physics principle over 2,000 years ago: No two
objects can occupy the same space at the same time. By analogy: No two com-
mitments can be done at the same time by the same person. So how do you pri-
oritize your commitments and accomplish them all? If you have your list ready,
you have many ways to choose which comes first:

v Choose fun first: If you like it, you tend to do it first. Often, the unpleas-
ant tasks are the ones that you tend to put off and you start them only
when you receive complaints.

v Process by incoming dates: Prioritize by doing the first task in, first task
out, also known as FIFO (first in, first out). However, if a priority change
occurs, this system doesn’t work.

v~ Prioritize by due dates: Adjust a task list according to the delivery date.

+ Handle by importance: Look at your most important goals first. Which
is the most important job? Start doing it.

v Choose important versus urgent tasks: Downloading all your tasks and
time commitments and setting the Reminder alarm with no planning can
cause conflicts. You may end up having to “Be at the board meeting” and
“Deliver a proposal for your Gold customer” at the same time. To avoid
this type of conflict, you need to understand how to distinguish impor-
tant from urgent tasks. Important is what brings results. Urgent is the
pressure for something to get done.

For more on managing your Tasks, see Chapter 2.



Chapter 2
Organizing Yourself with Outlook

In This Chapter

Scheduling your day with the Calendar
Prioritizing your to-do list

Organizing Tasks and e-mail

E/ery single day, information and action items come flooding into your
office by the hundreds. They occupy your mind and even cause you to
lose track of your priorities and waste time on things that aren’t important.
How do you release your mind and organize yourself to focus on what’s
important to your work and personal life? How do you arrange your time so
that you can enjoy working, maximize free time, attend sporting events, see
rock concerts or the symphony, or sneak out of town on a short getaway?

Organizing information, time commitments, and actions helps you to pace
your life and get it under your own will. More than just organizing time and
actions, Outlook helps you organize yourself.

Planning Your Day with Outlook’s
Today Options

Your life may look like a race, but how about changing it from a wacky race to
a championship Formula One race? Winning this race becomes easier when
you adopt Outlook as your dashboard. In order to see your main dashboard:
1. Click the Mail command in the Navigation Pane.
Your Inbox list appears.
2. Click Personal Folders in the All Mail Folders list.

Outlook Today opens, as shown in Figure 2-1.
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Friday, April 29, 2005

Calendar Tasks Messages
Today ‘ear 2010 Goal Cne: Double Inbas o
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Monday (421/2005)
. Gold customer request #123
‘Weskly sales mesting [ {Mane)
b + HBlock time For proposal
I writing
Figure 2-1:
Outlook
Today helps
you plan
your
activities.
I

Whenever you open Outlook, three columns display the various activities
you have lined up for the day:

v~ Calendar: Your open time commitments.

v Tasks: Your Tasks list, showing whether your Tasks are done (shown
with strikethrough) or open. Tasks shown in red are overdue. Each
Task’s priority symbol is also shown.

1 Messages: Your current messages and e-mail activity. You can choose
which mail folders appear in this column.

This handy summary keeps you aware of your time and obligations so that
you can choose how to attack your Tasks one by one.

Customizing Outlook Today

If you're not an extremely focused person, you may lose track of your momen-
tum and workflow after lunch, a long phone call, or a customer visit. Opening
Outlook Today can help synchronize your mind with the demanding actions of
the day. You can make Outlook Today the opening screen whenever you start
the program by choosing Customize Outlook Today. In the Customize Outlook
Today screen, shown in Figure 2-2, select When Starting, Go Directly To
Outlook Today.
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Customize Outlock Today
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(%) Descending (%) Descending
Today
Optl ons Styles Show Cutlock Today in this style: | Standard ¥
according to
your own
criteria.
|

The remaining options in the Customize Outlook Today screen allow you to
format the appearance of the Today screen for your best productivity:

1 Messages: The Choose Folders button allows you to select and display
any desired folder in the Messages column of the Today screen. Try
adding the folders for each of your main customers.

v Calendar: You can choose how many days you want to see in the
Calendar column of the Today screen. If you're busy, select 2; if not,
select 5 days.

v~ Tasks: You can sort the list in different ways, using different sort fields.

v~ Styles: | prefer the Standard style with three columns, but you can
choose one or two columns and different backgrounds like Summer
(yellow background) or Winter (white background).

When you finish setting your options, click Save Changes to save and close
your customization.

Working with Dates in Your Calendar

When you get used to the basic Calendar, recording your appointments
becomes part of your daily routine. Using the View button, you can see your
appointments according to your priorities list or view them by day, week, or
month. Figure 2-3 shows the One Day Calendar view.
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1. Choose View=>Arrange By~ Current View.

The Current View dialog box opens to show the following options:

¢ Day/Week/Month With or Without AutoPreview: Changes your
Calendar view to look like an agenda (see Figure 2-4).

If you become a heavy Calendar user, you may prefer to group your informa-
tion in certain categories, such as active appointments, events, recurring
appointments, annual events, and so on. To do so:

Happy birthday!

The Calendar reminds you on the exact day of a
birthday or anniversary. All anniversaries and
birthdays recorded in your Contacts appear at
the top of the Calendar on the appropriate day.

create a Task (order birthday gift) and set up the
reminder ten days before the big event. (For
more on scheduling Tasks, see the section
“Scheduling a Task,” later in this chapter.)

To receive a reminder before the date (so that
you can order a gift, for example), you need to
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¢ Active Appointments: Lists all your open appointments, including
NG/ the holidays inserted in your calendar (see Figure 2-5).
§g~ Figure 2-5 shows a lot of Holidays listed. Because no appointment or

event occurs between the holidays, they’re listed together. (You can
load the national holidays from many countries; see Chapter 13.)

¢ Events: Lists only all-day events (see Figure 2-6).

e Annual Events: Lists only the yearly recurring events.

Are you an early bird or a nighthawk?

Joe Owl arrived at work with one shoe brown
and the other black. All his mates laughed. From
that day on, Joe started to plan each day the
night before, selecting his clothes and placing
them on a chair. He also started leaving the
office with a printed copy of Outlook Today, to
plan the next day before sleeping.

Each person has a different energy curve during
the day; select your best energy time to work on
Tasks that require more attention. If you're an
early bird, set up the important Tasks reminders
early in the morning. If you feel energized in
the afternoon, then set up the reminder for the
evening.

19
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¢ Recurring Appointments: Lists the appointments by recurrence
pattern, such as weekly or yearly.

¢ By Category: Lists your open appointments by category, such as
Sales Meeting, Important, or Type Of Customer, according to your
use of categories. (For more on categories, see Chapter 4.)

¢ Define Views: Opens the Custom View Organizer so that you can
create your own Calendar view.

2. Select Day/Week/Month.
3. Select the Month button in the toolbar.

The Month view appears, as shown in Figure 2-7.

Mon Tue Wwed Thu Frl Satfsun ||
March 27 8 29 30 31 April 1
Weekhy sales | Meeting cust | Accounting r (| Outloak Trai Jojo Camel's

r

3 4 5 & & g
‘Weekdy sales | Kids school e

9

10 11 1z 13 14 15
‘Weekly sale: Meeting Mr 5 | Fitness
Lunich with g 6
Medicine Eaks Easter Day {
17 18 19 20 21 2z
Tan Day (Ui
Weekly sale: =
24 25 26 27 28 23
‘Weekly sales Administr akiv || Sakes task ol

Organizing Your Priovities
with Vour Tasks List

Organizing your priorities is about listing your dreams, your daily tasks, and
obligations and making a choice about what should be done and when to
achieve your goals. Prioritizing helps you create a self-fulfillment prophecy
step by step.
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Vikes, what should 1 do first?

You don’t like working like a slave Sunday to Sunday, until a breakdown
comes. Working with preoccupation means occupying your time before it’s
needed. Planning your work can shrink your preoccupation and turn slavery
work into hard but unstressed work. Outlook is the tool to help you plan your
day, record your appointments on the Calendar, and compile all your jobs on
the Tasks list.

Instead of the feeling like “Yikes, what should I do first?” ask yourself two
questions:

v How much working time do [ have committed today?

v How do I choose the Tasks to be done in the remaining time?

Remember that committed time means that you’ve already planned and
promised that time (promised to yourself or a client).

For example, say that you plan to work from 8 to 6 p.m. today, which gives you
ten hours in the office. But you have to account for your daily downtime —
lunch, coffee breaks, restroom, a little chat. Give this two hours of your day.
You also have two appointments scheduled, which occupy three hours. That
means that your time available is 5 hours (10 — 2 — 3) to work on your Tasks
list, not deducting any unplanned interruptions.

Using your Calendar and this calculation, you now know your daily time avail-
able. Now you just need to focus on the most productive Tasks.

Knowing what's urgent versus
what’s important

Separating urgent from important tasks is something many people don’t do
well. People tend to focus on urgent activities, mistaking them as important.
Important is what brings results; urgent is the pressure for something to

be done. You can classify your activities by determining both their level of
importance and their level of urgency.

The Tasks list in Outlook lets you classify your Tasks by Priority, like High,
Normal, and Low. To select or change the level of priority in the Tasks list,
click the Priority button in the Task line you want to change and choose your
priority, such as Low.
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But what if you have five important Tasks going on at the same time? Which
one should you do first? Sort your Tasks list by the Priority field to choose
the important actions you want to take first. To sort a Task list by priority
field, simply click the Priority field title in the title bar.

Scheduling a Task

You can open a new Task and not schedule it by simply typing the informa-
tion without a Start Date or Due Date or by using the Reminder to start doing
it and saving it in your Tasks list. However, scheduling means having a list of
all your Tasks with Start Date, Due Date, and Priority Selection in order to
select what you should do first, second, and so on, and finishing them one
by one.

To schedule a Task:

1. With the Task open, type the Start Date in the date box.
2. Type the due date in the Due Date date box.
3. Select High in the Priority list box.

4. Select the date you’d like a reminder in the Reminder time date box
(see Figure 2-8).

5. Click Save And Close.

Your Task is now scheduled and published on your Tasks list.

[ *|@ Subject Skatus Due Date % Complete Categories
] Three vears loan term ends Mok Star... Mone 0%
] Credit berms request For Best Company Mot Star... None 0%
¥ & Gold customer request #123 Mok Star... Mone 0%
=) Acal Fromm Ariazor InFroge... Mon 5/30/2005 25% Fropossl
A Event planning Mot Star... Mon 9/26/2005 0%
] Develop kiwi desest cppartunity InFrogr... Thu 12{1/2005 0%

~ Develop New training pr bation Mok Star... Fri 1j6f2006 0%

=adtime For Product ABC in 2 special pack... Waiting ... Fri 2/10/2008 0% zoals/Objecti. ..
Marmal pream Produsct Team Aligrenent InFrogr... Thu6{25{2006 25% Strategies

! High e insurance Mot Star... Sun 7/23(2006 0%
2] @ Import procedures cordimstion Mok Star... Fri 8/18/2006 0%
=] Three years loan term ends Mok Star... Fri 8/18/2008 0%
F=i) Project 56 Mot Star... Mon 8/25/2006 0%
=N Print and place on 2 plastic cover Propasal... Mok Star... Thu 9/28/2006 0%
2] 1 @ Proposal request InFrogr... Thu 10/12/2006 25% Proposal
=) Best Company follow up Requested Proposal Mot Star... Mon 10/23/2006 0%
2]t Deliver the proposal to Gold Customer InProgr... Thu ij11/2007 S0 Proposa
=] Passionfruit Drink. ‘Waiting ... Fri 6/1f2007 25% Proposal
=) custamer requsst #121 InProgr... Tue 7f3(2007 0% Key Customer
2]t Wear 2010 Goal One: Double the Company... InProgr... Fri 12{31/2010 0%
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Estimating your completion time

Pressure is not the best way to build your Tasks list. Due date, Status, and
percentage of work done are available fields on the Tasks list to help you
choose a working completion order. Why should you estimate your Tasks’
completion time? Because estimating each Task’s execution time can give
you an idea of how many Tasks you’ll be able to accomplish in a set period
of time.

What do you do when you have several important and urgent Tasks to com-
plete at the same time? How do you choose among them? How do you know
which one is the highest priority? Here are some ways in which you can make
distinctions:

v~ By the customer’s screams: You work in the best company, where mis-
takes are addressed without any problem. When a customer wants more
than is possible to give him on prices, delivery time, or credit, the ability
to negotiate and say no is the art of changing the scream into “Okay, |
understand you company’s decision. Thank you. Here is your order.”

v~ By pressure from above: [s your boss the #1 customer? Well, yeah, sure!
The #1 customer deserves the best relationship, right? A good practice
is to show your boss your Tasks list and negotiate the priorities with
him. (See Chapter 10 to find out more about sharing your Tasks.)

v By due date: Setting the due date according your schedule or accepting
the due date upon request is a target or a commitment that could
change. Set the due date to avoid constant changes and change the
expiration dates only for low priority issues.

1 By percentage of work already done: Say that you have two important
Tasks to complete, and one is 85 percent done while the other is 30 per-
cent done. Choose the one that is closer to being finished first and then
go for the second.

v~ By status: The only status that you really need to be concerned with is
the status of Tasks that are “waiting on someone else.” These Tasks may
require that you pressure someone else to release his or her part. All
other Tasks are under your own control to complete and prioritize. On
the other hand, maybe your coworker has different priorities, and your
task is not important or urgent to him. What then? Perhaps you can help
him with his priorities or organization. One way to start is to get him a
copy of this book.

v~ By time estimate: To increase your productivity, figure out how much
time you have available to work and then choose the Tasks that fit into
that time slot.
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To record each Task’s completion time:

1. Open any new Task.
2. Click the Details tab.

The Details screen, shown in Figure 2-9, appears, and new fields are
available.

3. Type your estimated time in the Actual Work field.
4. Choose Filez>Close.
When you’re finished with the project, type the actual time it took in the

Total Work field so that you have it for future reference or charge your cus-
tomer for your time.

Task | Detals

Subject: Sales Report

Due date: ‘Wed 8/232006 | Stetus: Nt Started

Stark date: ‘Wed 8/16/2006 ~| priorky: High  |w| % Complete: 0% &

[¥]reminder: | Man 82172008 [w] [Bo0am  [s] [dgz] Owner: myb

]

Viewing all your fields in the same list

Deciding what is important and urgent can be a terrific help when all vari-
ables are seen at the same time, such as Priority, Due Date, Percentage Of
Work Done, and Estimated Time to complete the job. If you have two Tasks
with the same priorities and due dates, you can choose to finish the one that
needs only half an hour to finish and leave the one that requires six hours for
later, allowing you to get an important Task done sooner.
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To view all the Tasks’ evaluation fields on the same list together, customize
the Tasks list in the following way:

1.
2.

Click Tasks in the Navigation Pane.
Choose Customize Current View in the Detailed list.

The Customize View: Detailed List dialog box opens.

3. Click the Fields button to open the Show Fields dialog box.
4. Select All Tasks fields in the Select Available Fields From list box.
5. Drag and drop the Actual Work and Total Work fields to the Show

These Fields box.

All required priority fields are visible in the same list box so that you can
choose your Task by priority, due date, or percentage accomplished.

. Select each field and move through them in the following order: Icon,

Subject, Priority, Due Date, Actual Work, Total Work, and then any
other field.

This order helps you select which Task to accomplish first by using the
priority and due date fields or which Task could be accomplished first by
reading the actual work and total work fields. Having more information
available makes it easier to select the first Task to be done.

. Click OK.

The Tasks list contains information to help you select the Task by level
of importance.

Saving the view

You can save the Tasks Customized Detailed view by copying it and giving it a
new name.

1.

2.
3.

Chooser>Viewr>Arrange By Current Viewr>Define Views.
The Custom View Organizer dialog box appears.
Click the Copy button to open the Copy View dialog box.

Type Important x Urgent in the Name Of New View text box and
click OK.

The Important x Urgent view is shown in the Navigation Pane.
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Adding the Actual Work and Total Work columns helps you estimate the time
needed versus your available time and gives you more information besides
just the priority and due date. The time spent planning pays off with more
productivity or available free time.

Don’t freeze up because you’re looking at a long Tasks list. Instead, slice it
and look at it one piece at a time. Adjust the size of your Tasks list column for
Next Seven Days Only. Did you accomplish everything? Go to the next slice
(page). Select a view such as Simple List or Next Seven Days. Beside the ten
default views, Figure 2-10 shows some of the views.

To return any view to its default state, choose Customize Current View=
Reset Current View.

Task Details
Date completed: | Mone ~
Tokal wark: 0 hours Mileage:
Ackual work: 0 hours Giling infarmation:

Companigs:

Tracking meetings and Tasks

There are several ways to see your Calendar and Task lists together.

1. Click the Calendar button in the Navigation Pane.
2. Choose Viewr>Taskpad.

(Taskpad is Outlook’s term for the Tasks list.) The Calendar and Tasks
appear together, as shown in Figure 2-11.

To view all your active appointments, click View=>Arrange By=>Current
Views>Active Appointments.
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Figure 2-11:
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Designating and supervising Tasks

Designating a Task is not getting rid of something unpleasant or giving an
order to someone and saying goodbye. Delivering a job by e-mail and phone
calls doesn’t always generate a commitment from both sides. One of the par-
ties may forget about it or have different priorities. Designating a Task means
delivering to someone a job and then confirming their acceptance and com-
mitment to doing it. The responsibility for the action and its supervision still
remains with the person who requested it.

Requesting and supervising tasks with Outlook generates commitments,
saves time, and eliminates phone calls and interruptions.

Requesting a Task is easy. First, create a new Task. Then follow these steps:

1. Click the Assign Task button to designate the person to your Task.
A new form opens.
2. Fill in the assignee e-mail address in the To box.

3. Select the following boxes: Keep An Updated Copy Of This Task On
My Task List and Send Me A Status Report When The Task Is
Complete.
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|
Figure 2-12:
Create
commit-
ments by
sending a
Task
request
through
Outlook.
|

4. Click Send.

The Delegation request is sent (see Figure 2-12).

Upon receiving it, the assigned person has to read it and select the Accept or
Decline button. Accepting the Task inserts it into his Tasks list and sends
back an answer to the requester creating a commitment until the conclusion
of the Task. Declining it opens a window to send a comment back to the
requester. (Read more on delegating in Chapter 10.)

If the recipient accepts the Task until the job is done, both people have the
Task on their Tasks list — one to do it and the other to supervise. Upon com-
pletion of the Task, Outlook automatically sends an update to the supervi-
sor’s Tasks list.

| Project86 - Task S[EZ|
: File Edit View Insert Format Tools Actions Help

ii-4Send | Accounts - | [ 0 | 4h 8 | O Recurrence... i Cancel Assignment | X | i} | @ o

Task | Detals

maxwell@sheephenes, com

Subject: Project 86
Due date: | Mon 8/26/2006 ~ | Status; Mok Starked w
Stark date: | Tue 8/8/2006 v | Priorky: Noemal v % Complete: 0% (%

[¥] keep an updsked copy of this task o my task list
[¥]5end me 2 status report when this bask is complste

Please provide test reports about project 55
Fhase 1

pvats ]

Messaging

Certainly you know how to send and receive electronic messages. How did
you learn to send and receive e-mails? Tipping is the general answer. You got
a tip and started using e-mail without thinking about how to organize and
archive your messages. Now, you need to be rescued just about every time
your Inbox becomes unmanageable.
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To be more organized with your e-mails, it helps to know the tools available
for automating basic e-mail procedures. A lot of garbage is sent without the
sender thinking, “Why am I sending this message?” Outlook can help you
detect and eliminate undesired behaviors, creating folders and using rules to
select and separate the messages for you.

Organizing your mailbox

Outlook has some tools for your mailbox organization, such as the Organize
pane, the Rules wizard, the Mailbox cleanup, the Junk E-mail filter, the
Message options box, and the message views (see Chapters 8 and 9). Before
using any tool, you need to clean your Inbox. By selecting the column From,
you can view each group of messages by sender, and you can delete the entire
group of messages in one click or delete only the unnecessary messages.

To clean up your Inbox, follow these steps:

1. Choose Tools and one of the following commands to organize your
mailbox:

¢ Organize Pane, when selected, appears on top of your mailbox,
helping you select a message and use a command to organize. You
can move messages to folders or change their color so that you
can easily view them.

¢ Rules Wizard selects and takes an automated action in a message
based on some conditions. For example, you can move a sent mes-
sage to your best customer to his folder rather than to the generic
Sent Items folder. You can also select and screen incoming mes-
sages for a specific word, such as weekly report, and automatically
file that message in a Reports folder. You can create hundreds of
rules with the wizard (see Chapter 8).

¢ Mailbox Cleanup allows you to view your Mailbox and deleted
items by size and search for messages older than a certain date.
You can also set up AutoArchive to move your older messages to
the Archive file, automating the mailbox cleanup

2. Choose Actions~>Junk E-Mail=>Junk E-Mail Options.

The Junk E-Mail box has four filter levels of protection, from no auto-
matic filtering to permanently deleting suspected junk mail. It also has
tabs to access safe senders, and a Blocked Senders list lets you insert
names on each list and even synchronize the safe senders with your
Contacts list.

3. Select among No Filter, Low, High, or Safe Senders Only as your Filter
Option.
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Figure 2-13:
You can
configure a
message to
be sent as
Confidential.
|

4.

Click OK.

The Junk E-mail filter is working for you. (Read more about it in
Chapter 9.)

Sending messages option

The e-mail Options button available in the message form allows you to config-
ure how you send messages so that you can take into consideration issues
such as security, sensitivity, and scheduling. (See Chapter 11 for more details.)

To classify the type of e-mail you're sending and to send it at a set time,
follow these steps:

1.

With a blank message open, click Options to display the Options
dialog box.

. In the Sensitivity list box, select Confidential.

The list box also displays the options Normal, Personal, and Private, so
that you can classify the type of message you’re sending.

Confidential means that the recipient will see the phrase “Please treat
this as Confidential” at the top of the sent message (see Figure 2-13). Any
selection except Normal inserts the related message at the top of the
sent message.

When you want to schedule a message to be delivered on a certain day,
you can still write the message ahead of time.

3. Select Do Not Deliver Before, select the date in the date box, and
click OK.
Message Options %]
Massage settings Sacurity
r. %) Importance: | Mormal - r'\.ﬁ Change security setbings for this message.,

Woting and Tracking optidpeyconal
_|Private
B Dluse voting|coefidastia -

Delivery opkians

[IHave replies sent ta: Select Mames.. .
[#] Save senk message to:  Sent Ttems |E]
[#] Do not deliver before:  5/30/2006 ¥ | |S:00FM [
[[]Expires after:
Attachment Format: Def ault b
Encoding: Auko-Select ™

Sensitivity: | Personal w Securiky Sektings...

HNormal

[[]Request a delivery raceint For this message
[]Request a read receipt for this message
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Chapter 3
Automating with Outlook

In This Chapter

Shrinking time spent on calls and faxes

Archiving, backing up, and synchronizing your Outlook files

Fle Flintstones cartoons humorously remind us of how mankind has been
developing automation for centuries. But Fred, even with his dinosaur
automation, always worked harder rather than smarter. Because you're not a
cartoon character, you can use Outlook automation power to relieve you of
boring tasks and increase your spare time. You can stop doing things just
because you're used to doing them. Automation is at your fingertips.

Don’t Waste Time Dialing

MBER
\g&
&

How much time do you waste making a single phone call? First, you find the
phone number to call. Then you pick up the phone and wait until you hear
the dial tone. Next, you press the numbers and then wait until someone
answers — if the line isn’t busy. The process can take from one to three min-
utes. Instead, use Outlook to make the call for you (but remember you still
need to do the talking).

Outlook call automation includes dial-tone monitoring and call status dis-
played in the status bar. When connected, you can pick up the phone and
start talking.

Your phone must be connected to the computer’s modem output jack.

In the following steps, you have Outlook make a phone call for you and
inform you when you need to pick up the phone and start talking. You don’t
even have to open your Outlook contact to have the Outlook operator make
the call for you.
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1. Click the Contacts button in the Navigation pane.
The Contacts list appears.
2. Right-click the contact name you want to call and choose Call Contact.

The New Call dialog box, shown in Figure 3-1, displays the name of the
contact in the Contact list box and the phone number in the Number

list box.
|
Figure 3-1: Gewcan %]
Usethe | mumbertodial
New Call Contack: Smart, Mazwel 2 @
dialer as Nurber: (86)961-861 v [Dialng Eroperties....
yo ur [¥]Create new Journal Entry when starting new call
operator to ||| calistatus: anhaok
make calls prrmr— [
for you.
|

3. Choose the desired number (Home or Business) in the Number
list box.

To write your phone call notes, including a time stamp, and file them in

\

p Outlook, select the Create New Journal Entry When Starting New Call
option. The Journal entry form, shown in Figure 3-2, appears, where you
can make your notes about the call and record the time spent. When
you're finished, just click Save And Close.

14 Phone Call - [Smart, Maxwell] - Journal Entry == ]
Eile Edit View |Insert Format Tools Actions Help

i . Save and Close | 4 | 0B X |+ - v -]d ] @R

Subject: Fhone Call -- [Smart, Mawel]

Entry bype: | Phone cal ~| Company: | Shoephore ine.

I Stark Eime: Maon S{2(2005 W 951 AM v r.ﬁ-.‘

(=

Figure 3.2: Duration: 0 minukes | [[Pause Timer | o
The Phone
Call Journal,
when
saved, is
linked to
your contact
with a time
stamp.
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4. Click the Start Call button.

The Call Status line shows the call progress from on hook until con-
nected or busy.

5. Pick up the phone and speak when the status shows connected or
when you hear a person answer the phone on the other end.

You can use your PC speakers and a mike as a hands-free phone.
To retrieve phone call information in a Call journal, follow these steps:

1. With the Contact open, click the Activities tab.

All linked Outlook items, such as Tasks, e-mails appointments, journal
entries, and linked files related to this contact, are listed (see Figure 3-3).
Look for the items with a telephone icon in the list to see the phone
calls.

2. Double-click the desired call to open the notes.

If you have a long list, you can select only the journal items to ease your
search.

3. Select Journal in the Show list box.

Only the Journal items appear.

General Detais Aickivities Certificates All Fields
Show: | |
[ Subject In Folder
(=1 Choose you topping: Clicking o the tabs Irbox
| Deliver the proposal to Gold Customer Tasks
G Mary Saink Louis closing package 321 Journal
(G» Mary Saint Louis negotiating package 321 Journal
5] Opporturities excel File Journal
¥ Fhone Call -- [Louis, Mary Saint] closng package 320 Journal
5] product list Journal
I _j Froject alignmerk Calendar
. 3 proposal 322 Drafts
Figure 3-3:
The
Activities
page lists all
linked
actions
including
the phone
calls
journal.
I
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Saving Time with the Embedded Fax

The old way of sending faxes is to print the documents and a cover page,
retrieve them from the printer, go to the fax machine, insert the documents,
and then send them. The time wasted during this process can range between
three and ten minutes. Outlook simplifies this process because you can now
send the fax directly from your PC.

Setting up the Microsoft Fax console

To send a fax straight from your PC, you must have the Microsoft Fax console
installed. To see whether it’s installed, go to the Windows Control panel and
the Printer and Faxes folder, and look for the Fax icon. If you see the Fax icon,
then you're all set up to send faxes.

If the Fax icon doesn’t appear, then follow these steps:
1. Click the Windows Start Button and choose Control Panel=>
Printers And Fax.
The Printers And Fax devices list appears.
2. Select the Add A Fax command in the Printers Tasks.

3. Follow the Fax Wizard until the end of the setup.

Sending a fax

With your Fax console device installed, you don’t have to print any paper and
walk to the fax machine, losing time and energy in the process. If you're work-
ing with a notebook computer, the Fax console helps you send a fax from
your hotel room or any other place. Just connect the phone line and send.

To send a fax:

1. Open the document you want to fax.
2. Choose Filew>Print.
The Print dialog box opens.
3. From the Name drop-down list, select FAX.

If the fax driver isn’t shown, see the preceding section “Setting up the
Microsoft Fax console.”
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|
Figure 3-4:
You can
open the
Microsoft
Fax console
folders to
view the
faxes sent
and
received.
|

4. Click OK.
The Send Fax Wizard appears.
5. Click the Address Book button.
The Outlook Address Book appears.
6. Double-click the recipient’s fax number.
The Fax number is transferred to the Fax Wizard.
7. Click Next.
8. Choose and complete a cover page and then click Next.

9. Choose whether you want to send the fax now or at a different time
and then click OK.

The fax will be sent, saving your time with no paper jam. The Fax moni-
tor box opens, showing the call status.

You can read the complete report of your faxes sent and received in the MS
Fax console (see Figure 3-4). Go to your Windows Control Panel, click the
Printers And Faxes folder, and double-click the Fax folder to display the Fax
console. Now select the Sent items to see a list of sent faxes.

S

Dialing 0, 00 21 1 123 123-4567
The time elapsed is 0:09

Sending fax to Frank
¥ Keep this dislog visible at 2l times

Hide | Dizconnect Less << |

Time | Event |
140914 Dialing 0. 59843523
4140330 The lire is busy
1410044 Dialing 0. 50843523
1411:09 Sending page 1 of 1
141206 The call completed
e 141209 The fax was sent successfully
141210 Dialing 0,00 21 1 123 123-4567

Clear list

Integrating Communications

Unified messaging — integrating fax, voice mail, and e-mail in one mailbox —
became a telecommunication fashion about ten years ago. The Unified
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Messages system allows more productivity by centralizing the messages in
one place. Ten years ago, only corporations could afford unified messaging.
Today, reliable and affordable service providers supply unified messaging
systems for a few bucks a month, affordable even to one person.

To understand the fax server and voice mail routing, you have to know what
Direct Inward Dial (DID) is. If your company has a simple business phone
system, then it probably has only one phone number and several extensions.
The receptionist receives calls and transfers them to your extensions.

In larger systems, you can order a number of lines and a block of sequential
phone numbers. For example, if your company phone number is 555-0000, a
sequential block of 20 numbers would go from 555-0000 to 555-0019. Your
company then assigns telephone numbers to each individual for voice and
fax. When someone sends a fax to one of the DID numbers, it arrives in one of
the DID lines with a special signal indicating which DID number was dialed.
The fax server receives the call and looks up the DID number in a table to get
the e-mail address(es) to which the fax is to be delivered and then attaches
and sends the fax in an e-mail message.

A fax service provider uses an infrastructure with thousands of DID numbers
connected to servers. It stores and forwards faxes to its customers’ e-mail
addresses, eliminating the need for fax machines and phone lines. You can
pick up your fax in your e-mail Inbox — anywhere, anytime by using your
webmail access. To choose a provider:

1. Type Fax service in your Outlook Help window.
2. Click Search.

Service Providers advertisement with Outlook matching products
appears listed in the Microsoft Marketplace site, a site containing many
third-party tools related to Microsoft products.

3. Choose a provider in your area code.

Don'’t forget to look for an acceptable price range, international services,
and other features.

A voice mail, like the fax received through a fax server, is an electronic file,
but instead of written information, it has audio information in it. The voice
mail database is related to one phone number and a time stamp. Proprietary
voice mail systems can attach and send the voice mail file to your Inbox in
the same way a fax is sent to your Inbox. You can buy a voice mail system
with the routing properties installed in your company or lease voice mail-
boxes with DID numbers from a service provider. Or use a Unified message
system that integrates your phone numbers with voice mail, fax, e-mail, call
routing, and arrival messages information.
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Managing Vour Data

Sometimes you read in the news or watch on TV about strange people who
don’t throw anything away and live in a mountain of garbage. Imagine what
your house would look like if you never took out the garbage or organized
your clothes or washed your dishes. Disgusting, isn’t it?

Do you know many people who don’t clean their computer files until they
become unmanageable? Messages keep arriving in the Inbox, and they keep
sending messages, which get filed in the Sent box. Completed Tasks and past
meetings with no information to file keep enlarging the size of their Outlook
archives and occupy more space on their hard drive. Because most people
don’t see the garbage inside the computer, they don’t care. But by investing a
little time reading this chapter, you can use Outlook automation to take care
of your computer garbage and clean things up when you want them cleaned.

You can trim down your Outlook data and store the old data for archival
purposes. The Outlook data file stores all Outlook folders, such as Inbox,
Contacts, Tasks, Calendar, Notes, and Journal. While you’re using Outlook,
this data file gets larger and larger, holding more information in your folders,
which can slow down your Outlook searches and other operations. You can
create a second file whose purpose is to hold any file you deem fit. Archiving
items older than six months is the default setting, but you can select your
own time period and also which of the current folders you want to archive.
For example, you may prefer to delete the Calendar items older than six
months. You can set the Archiving period for all folders, or each folder can
have its own instructions. The new data file is called Archive.pst. You can
open this archive file as needed. Another option is to back up all the Outlook
files to another computer on the network or to a server for safekeeping.

Here are a few housecleaning tasks that you can automate:

v Archiving: The Archive Option creates a second Outlook data file, one
file containing your current data and a second one containing your old
data archive. (Read the details in Chapter 9.)

v Synchronizing means that you have two copies of your data file, one in
your mail provider known as an online folder and another inside your
computer known as an offline folder (*.ost). At the moment of synchro-
nization, the two folders become copies of each other. A deleted message
on your computer is deleted in your online folder. A message received in
the online folder is copied in the offline folder. The benefit of synchro-
nization, besides making a backup, is the available access from any other
computer through Outlook Web Access, including Calendar, Tasks list,
Contacts, and, of course, mailbox. Check with your mail provider to see
whether this service is available.
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v If you're not connected to an Exchange server, the free backup add-in is
a great tool for backing up your Outlook data file. Upon exiting the pro-
gram, Outlook updates your backup onto another computer in your net-
work or prepares to record it onto a CD-ROM.

Downloading the Outlook add-in tool

Unless you were looking for a solution in the Microsoft office site, you
wouldn’t know about the Backup tool, which is useful when your company
doesn’t have any type of mail backup. Here’s how to locate and download
the tool:

1. Go to www.microsoft .com/downloads.

2. In the Search For A Download text box, type Personal Folders Backup
and click Go.

The title Outlook 2003 Add-In: Personal Folders Backup appears.
3. Click the title.
A new page appears, showing the download button.
4. Click Download to launch the Download Wizard.
This wizard is valid for Outlook 2000 to 2003 versions.
5. Click the Run button to install the pfbackup.exe software.
6. Follow the Download Wizard.
The backup software is downloaded and installed.

Lost data is more expensive to recover than a stolen notebook, so make your
backups on a regular basis.

Creating a backup file

After the Backup tool is installed (see preceding section), you've got a no-
cost data safety system for making backups. Now it’s easy to keep a copy of
your current Outlook files stored on another computer, server, or CD-ROM.

To create a backup file:

1. In Outlook, choose Filez>Backup.

The Outlook Personal Folders Backup window appears, as shown in
Figure 3-5.
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Outlook Personal Folders Backup (%]

Save backup copies of these persanal Folders files:
2 = Personal Folders

Last backup:  {None) Options... |

Save Backup | Open Backup. .. Cancel |

2. Click Options.
The Backup Options dialog box, shown in Figure 3-6, appears.

Backup Options %]

Reminder
¥ Remind me to backup every |7 = days

Backup files
Backup these personal Folders files:

[ Fersonal Foiders
[ anchive Folders

File lacation
Baclup the Fle selected above to this location:
|C:1.Dochent~; and Settingsimarcelolarchive backup.pst

53 Cancel

3. Select the Remind Me To Backup Every X Days to any period you
want, such as daily or weekly.

Automating overnight backups is an option often used by corporations.
If you travel with a Notebook, then [ suggest making a backup file before

every plane, bus, or car trip.

If you travel a lot, use an e-mail provider with Exchange server, allowing

you to synchronize your data between the server and your computer.
This is better than remembering to make your own backup files.

4. In the Backup These Personal Folders Files area, select the files you
want to back up.

5. Click Browse to select a location to store your backup files.

You can choose another computer on the network to store the file or
create a file to record later onto a CD-ROM.

Chapter 3: Automating with Qutlook
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6. Click OK to return to Outlook Personal Folders Backup window.
7. Click the Save Backup to close the Backup tool.

The Outlook backup file is updated only at the moment you close your
Outlook program according to the preset instructions. A copying file
message is displayed while the backup is being updated.

Opening a backup file
After saving a file on a CD-ROM you need to know how to use the file in
another computer. To open a backup file in any computer, follow these steps:
1. In Outlook, choose File>Open=>Outlook Data File.
The Open Outlook Data File list box appears.

2. Select the driver and the backup file, such as d:\ Outlook backup.pst,
and click OK.

The Backup file opens in Outlook.

Minding Your Own Business
(Life Balance)

“We might do work we love, give up the futile task of proving ourselves to
anyone, keep money within perspective, and do whatever is necessary to
enable us to walk away from our work and activities if our soul requires it.”

— (The Re-enchantment of Everyday Life by Thomas Moore)

What do you want from your life today or in the next five years? Often you
hear about the choices people make in life. Some people want to watch their
kids grow and wouldn’t accept a job promotion if it meant their kids weren’t
the priority. Later in life, when their children are grown, they choose their
career with great success. On the other hand, a successful corporate presi-
dent may be on his fifth marriage, but he has worked for the company for 25
years without interruption. To whom is he married, the company or his wife?

Outlook can help you set up your own pace of life, because your life story is
built according to your choices. You can list your choices for family, finance,
education, social, spiritual, leisure, sports, health, and even retirement and
then select the reminders according to each of these priorities.
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For example, a child’s frustration because of a parent’s delay or no-show at
their special activities is so common it’s become a regular theme for TV
series. If you're involved in your daily activities and phone calls with new
action items rolling in every minute or two, a 15-minute warning before the
event probably doesn’t give you enough time. Here are a few ways Outlook
can help you solve that problem and others:

1 Retirement plan: Set up the reminder for every six months and recur-
rence once a year to evaluate your next step.

v Medicine reminder: Set up the reminder and recurrence daily at the
right time so that you don’t forget to take your medicines.

v~ Kids’ competitions and exhibitions reminder: Set up your child’s
appointment reminder two hours before the event so that you start cool-
ing down your activities and focus on being present at your child’s
event. The day-after results: You're more productive with no guilt and a
happy family.

To find out how to create a reminder, see Chapter 2.

The fulfillment of your life’s dreams or achieving a life balance is a matter of
writing your wishes while keeping in mind all your roles in life and making
decisions on your priorities from time to time. Using Outlook reminders help
you achieve this fulfillment.
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In this part . . .

Wm are your contacts? Your friends, your suppliers,
or your customers? How do you keep track of each
contact and his specific characteristics? When you have
hundreds or thousands of contacts, you can easily forget
someone. In this part, you find out how to use Outlook’s
Contacts list to save all this information about each indi-
vidual so that you can improve your relationships. You
discover how to customize the Contacts list so that you
can be more productive and appear more dedicated to
your customers.

Instead of using the default contact entry form, you find
out how to customize and create your own contact form
with only the information you need on one page. In addi-
tion, I introduce you to Business Contact Manager (BCM),
which is a free add-in that comes with the Office Small
Business and Professional editions. The BCM software
enables you to control your sales opportunities one by
one. BCM offers a series of reports that you can use to
improve your business efforts.




Chapter 4

Creating an Awesome Customers
and Suppliers Database

In This Chapter

Making your contacts more than a black book

Adding a new Contact

Developing profiles

Creating a company profile for sales
Type-casting your customers

A re you tired of searching through sticky notes, business cards, sales
records, accounting systems, and the like for your customer informa-
tion? Instead of moaning about the time, organize your information into one
system. This chapter tells you everything you need to know to get organized
in Outlook Contacts.

Exploring Outlook Contacts

In 1998, when [ was running a technology company, every penny we received
was allocated to product development. We badly needed to update our cus-
tomers and prospects database, but we didn’t have any money to spend on
the project. We explored Outlook Contacts, which was already in our system
software, and discovered that it satisfied our needs. Here are some ways you
may be able to use Outlook Contacts in your business:

1 Import existing contact information into Outlook. Every time a company
starts planning a new system, employee grumbling is heard throughout
the organization. Employees moan, “I don’t have time to stop my work
and grab the information for you.” Outlook has a tool that enables you to
easily load contact information in bulk.
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v Set Outlook Reminders to prompt you to follow up with customers. A
key issue of business-to-business sales is losing sales orders because of
lack of follow-up. Writing follow-up actions on a day planner can be help-
ful, but it’s easy for employees to lose track of some aspects of their pro-
jects. Outlook Reminders are an effective alternative to the day planner
because a message automatically pops up on the screen at the predeter-
mined time, reminding the user to follow up with a customer. This tool
helps employees keep track of their projects.

v Customize Contact fields for your needs. Some software applications
don’t offer users the ability to create custom fields; you’re stuck with
only the default fields. Outlook, however, has a tool to generate fields as
needed and the ability to generate your own customer profile.

v Design customized marketing campaigns. Using the Categories fields,
you can classify your customers by your own criteria and design a mar-
keting campaign by product, by segment, or by type of customers.

1 Add personal information to your Contact profiles. Business or per-
sonal relationships are built on mutual knowledge and understanding,
not just on names and addresses. Outlook Contacts enables you to
record personal information in each profile. For example, you may want
to note that Joe Smith is fanatical about the Giants and loves to talk
about pitchers or that Mary Ford likes to eat at French restaurants and
show off her French accent when reading the menu.

Importing Contacts from Existing Files

Many people think that the only way to add a Contact record to Outlook is to
type the information. If you have just a small number of contacts, this method
is feasible. However, if you have hundreds of business cards, this task is a tall
order. A better option is to scan the business cards with a card scanner and
Optical Character Recognition (OCR) software (which scans the image and
transforms it into text), creating an electronic file ready for import.

Outlook can import files from ACT!, Lotus Organizer, Schedule Plus, database

files, Excel, Access, text files, and other types of resources. The following sec-
tions give you the lowdown on importing files into Outlook.

Importing compatible files

A compatible import file, including the internal field names within it, is fully
understandable by Outlook, making importing easy:

1. Choose File=> Import And Export.
The Import And Export Wizard appears, as shown in Figure 4-1.
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lmport and Export Wizard
Choose an ackion ko perform:
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I Impart & VCARD file { vf)
. Impeork an iCalendar or vCalendar File {vcs)
Flgure 4-1: Impert from another program or file
Impeark Inkernet Mail Account Setbings
The Import Impart Intermet Mail and Addresses
And Export Description
1 data F h files, includi
Wizard AT, Lotus Orgartzr, Persond Faldar (T,
helps |mp0rt Schedule+, database Files, bext Files, and others.
files into the
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2. Choose the Import From Another Program Or File option and then
click Next.
The Import A File Wizard appears.
3. Select your importing software and then click Next.
4. Click the Browse button and find the file that you want to import;
select the Do Not Import Duplicate Items option to avoid importing two
records with the same contact and then click Next (see Figure 4-2).
lmport a File
File bo impart:
— spdons
. () Replace duplicates with £ems imported
Flglll'e 4-2: (%) Allow duplicates to be created
Selecting () D ik import duplicate ftems
the file to
import with
the Import
And Export
Wizard. -
|

5. Select the Contacts folder in the Select Destination Folder list and
then click Next.

6. Click the Import “Your Filename” Into Folder check box and then
click Finish.

The Import A File Wizard appears, showing a progress bar to monitor
the import process until the process is finished.

7. Click the Contact button on the Navigation Pane and read the Contacts
list, checking to see whether the imported names appear in the list.
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Importing noncompatible files

A noncompatible file is one in which the field names are different from the
Contacts list and must be matched (or mapped) one by one in order for the
imported list to be merged correctly.

It’s unusual to find an Enterprise Resource Planning (ERP) system or a sales
system ready to export a file to Outlook Contacts or any nonintegrated soft-
ware because different software products have different requirements for
importing. Most ERP software offers file export tools for exporting to stan-
dard formats, like comma delimited or Excel formats.

Before importing Excel files, you need to know the columns names used for
the data and the content in order to map them to the appropriate Outlook
fields. In the example Excel file, the field Customer Name is the same as Full
Name in Outlook.

Follow these steps to import a noncompatible file:

1. Choose File=>Import And Export.
The Import And Export Wizard appears (refer to Figure 4-1).

2. Select Import From Another Program Or File and then click Next.
The Import A File Wizard appears.

3. Choose Tab Separated Values (DOS) from the list and then click Next.

The Import A File Wizard shows the text box to type, or you can browse
for the file to import.

4. Browse to the file that you want to import, select the Do Not Import
Duplicate Items check box, and then click Next.

The Select Destination Folder list appears.

5. Choose Contacts under the Select Destination Folder list and then
click Next.

6. Select the file in The Following Action Will Be Performed window.
7. Click the Map Custom Fields button in the Import A File Wizard.

The Map Custom Fields dialog box appears. In the left column, the Excel
file is shown, and the field names are listed in the Value column in the
From Frame. The Outlook file is shown on the right side with its fields
shown in the Field column. A third column, Mapped From, is available
under the To frame (see Figure 4-3).

Pay attention, because field names can be misleading. For example, a
field called Name might mean First Name or Family Name, depending on
how the database was designed. In the next step, you have the opportu-
nity to map the content of each field.
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Inthe past, importing Excel files to older Outlook
versions without the proper Excel file configu-
ration started an endless process of importing
empty fields until the computer went down.
Fortunately, Outlook 2003 warns of the transla-
tion error (see figure).

There are two ways of solving the problem
quickly, one for people who are not so familiar
with Excel and a second for Excel users.

v~ Solving the no named ranges problem
quickly: Open the Excel import.xls file and
save it as filename.txt. Then start the import
again for the new text file. (See the section

Troubleshooting Excel import problems

“Importing noncompatible files,” earlier in
this chapter.)

v~ Fixing the Excel file to solve the problem: To
prepare the Excelfile, select the entire data-
base inside Excel (including the headings
and all the data) and then choose
Insert=>Name to give the area (range) a
name. Using this procedure solves the
import problem with Outlook. Start the import
again with the new Excel file. (See the sec-
tion “Importing noncompatible files,” earlier
in this chapter.)

Translation Error

%]

contents of a file system.

@ An error has occurred in the Microsoft Excel translator while getting the

The Microsoft Excel file *CAERP mad.xls® has no named ranges. Use
Microsoft Excel to name the range of data you want to import.

Map Custom Fields

[rag the values from the source file on the left, and drop them on the appropriate destination fisld
an the right, Drag the ikem from the right: bo the left ta remove ik From the Field mapoing,

%]

From: To:
Comma Separated Values (Windows) Microscft Office Outlook
cap 4 test.csy Corkacts
Wale i Fleid Mapoed from -]
Title El Narne
Hame i Title
widdlehame = First Nare
Fanily name HMiddle Narme
| N
Suffix i Last Name
Figure 4-3: Company  Suffion
Departmant v Company »
The Map < 5 <] >
Custom
Fields dialog < Previous Next> | [ Clearmap [ Defaul map |
box.
|

8. Drag and drop the desired fields from the Value list to the Mapped

From list.
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|
Figure 4-4:
When
importing
from incom-
patible files,
map the
incoming
fields to
Outlook’s
Contacts
fields.

In the example, the field Name was mapped to the First Name field in
Outlook. The field Name is seen now in the Mapped From column.
Figure 4-3 shows the result.

9. Repeat Step 8 for all the desired fields in the Value list (see Figure 4-4).
10. After you finish mapping all the values, click OK.
You return to the Import A File dialog box
11. Click Finish.
The Import Progress window appears.

After the import is complete, click the Contact button on the Outlook
Navigation Pane to see the imported contacts.

Map Custom Fields %]

[rag the values from the source file on the left, and drop them on the appropriate destination fisld
an the right, Drag the ikem from the right: bo the left ta remove ik From the Field mapoing,
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Going Beyond Your Little Black Book

Ten years ago, not everybody had an e-mail address, a Web site, and an
instant messaging address, requiring three new fields in the old black book.
These days, the number of people you talk to and the information you have
to record have grown at an exponential rate. Having all this contact informa-
tion available at your fingertips helps you remember things like your cus-
tomers’ favorite teams, their kids’ names, their birthdays and anniversaries,
or their music preferences. With Outlook, you can maintain all this informa-
tion and keep your business operating on a personal level. When you add a
contact to Outlook, it’s much like recording personal information in a little
black book.
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To create a new contact:

1. Click the Contacts button on the Navigation Pane, as shown in
Figure 4-5.

The Contacts list appears.

M

My Contacts

Current View [

O Address Cards

O Detailed ddress C.
O Phore List

O By Category

O By Cormpany

2 By Location

& By Follow-up Flag

I Open Shared Contacts

Figure 4-5: Custormize CUrrent iy,
The Contact EW—
Navigation
Pane shows | i calendar
a window
with the &=| contacts
Contacts | & Tasks
views.
o My 7lae

2. Click New.
The Untitled Contact opens, as shown in Figure 4-6.

The General tab of the Untitled Contact looks like a black book. You can
fill in your contact’s name, address, and phone number.

3. Complete the form by clicking the appropriate buttons and typing the
detailed information.

The Full name and Addresses buttons open a dialog box that lets you
type detailed data, such as Mr. or Ms., city, and zip code. If you don’t see
a button, just type the information in the available text box.

P Click the down arrows to choose other options. For example, you can
change the address from Business to Home or the Business Fax number
to the Home Fax number. In all, you have 19 options, as shown in
Figure 4-7.



54

Part Il: Managing Contact Information

|
Figure 4-6:
The Contact
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with the
General tab
as default.
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4. If you want to add a photo of your contact, click the picture frame and

follow the wizard to attach the contact photo.

Outlook 2003, for the first time, gives you the capability to add a picture.
Now, by inserting your contact’s photo along with the data, you can
quickly associate the person’s face with the facts.

5. Click the Contacts button to link related contacts.

The Contacts list appears.

6. Double-click on the contact to link.

The contact is linked and listed.

For example, say that cousin Harry and his friend Tim play tennis together
weekly. When you call Tim, who is your customer, Outlook Contacts can
remind you of his relationship. Talking casually about the last tennis game
may improve your relationship. You can easily incorporate strategy-
focused networking when you remember connections. You can also link
relatives like wife, kids, and mother-in-law on the contact page.

. Click the Categories button to classify each contact into categories.

The Categories list appears with its default list, such as Goals, Strategies,
Phone calls, and so on (see Figure 4-8). You can choose one of them or
create your own category. Continue with Step 8 to create a New Category.
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Assistant
Business
Business 2
Business Fax
Callback
Car
Company
Home
Home 2
Home Fax
ISDN
Mohile
Other
Other Fax
Pager
Primary
Radio
Telex
TTY/TDD

8. Click the Master Category List button.
The Master Category Wizard appears.
9. Type the desired name in the New Category text box.
10. Click Add and then OK.

The category is added to the Master Category List and is available
for use.

Cousin Harry, besides being a family member, is a friend and travel
agent. You can classify him by using three categories: Family, Friend, and
Supplier, allowing you to take different actions for Harry based on the
different groups he’s in, such as sending a birthday invitation to friends
or mailing your company communication to all suppliers.

For more on categories, see the section “Categorizing Your Customers,”
later in this chapter.

11. Select the Private button if you do not want to share this contact when
Outlook sharing properties are active.

12. Click the Save And Close button.

The new contact is added to your Contacts list.
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|
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Minding the Details

\\J

You can include so many details about your contacts, including information
about their children, hobbies, spouses, and anniversary and birthdates. A
contact has more fields ready and available than you could ever imagine. The
following steps explore some of the fields available on the different Contacts
list tabs

1. Double-click the contact in your Contacts list.

The desired contact appears.
2. Click the Details tab.

The Details page opens (see Figure 4-9). The following fields are avail-
able: Department, Office, Profession, Manager’s name, Assistant’s Name,
Nickname, Spouse’s Name, Title, Suffix, Anniversary, and Birthday.

3. Type the information you want to include into the available fields.

You can also use Outlook to remind you of important dates, such as
anniversaries and birthdays. See Chapter 2.

4. Click the All Fields tab to reveal more personal information fields.
5. Select All Contact fields in the Select From list.

All the native contact fields appear, as shown in Figure 4-10.
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6. Select Address Fields, Names Fields, or User-Defined Fields to see a
particular group of fields at the same time in the Select From list.

The Select From list has nearly 20 different options, including the All
Tasks Fields option to show everything.

7. Select Personal Fields in the Select From list.

The Personal Fields list appears (see Figure 4-11) with new options, such
as children, hobbies, and language.

8. Type the information in the desired fields.
9. Click the Save And Close button.

Seleck from: S
Name Value
ANNivErsary January 02, 2001
Birthday January 01, 1571
Children Jane Mefirst 1T, Jonas Last 11
Gender Female
Habbiss ‘Workout, Mirrors collection
Language French,
Profession Entrepsunes
Referred By Direct
I
Spouse Jonas Last
Figure 4-11: Weh Page btk fissane mefirst .com
The
Personal
fields record
information
about
children,
hobbies,
and
language.
I

Understanding views

The Contacts list view is much more than a simple way of displaying the
available fields in a preset format. Each view is also a different report that
you can sort, filter, and list according to your needs. The Phone list view, for
example, is for good for telemarketing activities, and the Address Cards view
is useful for those used to working with business cards or Rolodex files.
What’s more, you can add or delete fields, sort by one or more fields simulta-
neously in ascending or descending order, and even use filters to select sub-
groups, such as only people from a particular city. Create your own views to
work on what is important to you.
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To customize your Contacts view, select the Phone list in the Navigation Pane
and then click Customize Current view. The Customize View Phone List
appears.

You have the following options on this list:

v The Fields button is the path to the Show Fields box, where you can cus-
tomize the fields listed or add and remove fields from the current view.
(See the section “Creating custom fields,” later in this chapter, for more
information.)

v The Sort button is the path to the Sort box, where you can sort by two
or more fields at the same time, such as city and state.

v The Filter button is the path to the Filter box, where you can define cri-
teria for each field, filtering your desired contacts down to a specific list.
See Chapter 16 for information about selecting your customer base by
using the filters.

Customized views are lists developed according your needs . Develop lists
for sending monthly birthday cards, developing telemarketing activities,
sending advertisements to a selected group of customers, or tracking sales
by customer. These are just some of the customizations you can develop by
yourself. The starting point is understanding how to create custom fields.

Creating custom fields

You may need custom fields to record information about contacts based on
your type of business. A legal office, a doctor, or distribution company may
need to organize important information about the customer, creating special
fields for each one.

Each Contact has only so many fields, and you may need to create a new field
for a specific purpose. You can create any field you need with several choices
of type and format. To create fields, you can start from any Contacts list view.
1. Select the Phone list in the Navigation Pane.
2. Click the Customize Current view in the Navigation Pane.
The Customize View Phone List appears.
3. Click the Fields button.
The Show Fields dialog box appears.
4. Double-click the New Field button.
The New Field dialog box appears.
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5. Select Yes or No in the Type area for the following field types (see
Figure 4-12): Text, Number, Percent, Currency, Yes/No, Date/Time,
Duration, Keyword Combination, Formula and Integer, and each field
with their own format options available.

Show Fields
Available Fields: Show Ehesa Fislds in this order:
Assistant's Phon - File &;
Attachma:t 8 o adde, Foclo\:Up Flag * E
B A foinn i
— | | 5u5recs Hore Poge| New Field g | [cne ]
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H . Callbactk. Mame:
Flgure 4-12: C:t::;res
The New Euﬂpa:v Type:  |Teat %]
ontacts re>¢
T H Courry [Region Farmak: (7
Field dialog Depatrent Humber
box shows | iug starie Qurency .
the options | [Fulltame Date[Time
i Duration
Ki i
in the Sellct availsble Fields from: Conbinstin
T e Iist CL anval 1Eids rrom: FOFMUIE
yp . Fraquently-used fizids || |Integer
|
6. Select Icon in the Format list box.
7. Type the field title in the Name text box.
8. Click OK.
The new field is listed in the last line of the Show These Fields In These
Order List (see Figure 4-13). You can select a title for the field, such as
Decision Maker, to record information about a person who makes the
buying decision for the company.
— Show Fields
Figure 4 13. Available Fields: Show Ehesa Fislds in this order:
=19, Assistant's Phon . File &
Choose Attachma:t 8 o adde, Foclo\:Up Flag * E
Busness Address — —
- ; Cancel
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inform EaLlaack. MName:
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whether the | GZuiee | T o &
First M
person has | g sar Toorae
the power to | Fultane can >
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|
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Displaying the fields in your order

The fields sequence can be shuffled and displayed in any order, but you have
advantages of choosing certain sequences. For example, if you ask to check
your customer record, the operator has to read and confirm the person’s
name, the company, name, job title, address, phone, and e-mail in the
sequence and retype them whenever they change. The fields sequence is
important and can be different, depending on the application. The Show
Fields box allows you to customize the fields’ sequence.

1. Select the Phone list in the Navigation Pane.

2. Click the Customize Current view in the Navigation Pane.
The Customize View Phone List is displayed.

3. Click the Fields button.

4. Drag and drop the desired field into position in the list.

For example, the Decision Maker field is at the end of the list, but you
can move it so that it appears after the Full Name field (see Figure 4-14).
This notation helps remind you who the person is before you call.

Understanding views, how to create fields, and the way to display the fields
in a practical manner helps you and your team work in a more focused way,
without losing time looking for information.

s | Show Fields %]
- Maximum number of lines in mulki-ine mode: 2 | »
Figure 4-14:
Th e Select available fields From:
L. User-defined Fields in Folder w
D ecision Avvallable felds: Sheows these Fields in this order:
Maker field | Erslsees 2 e et
First order Flag Status
was moved lzece | Fulleme __
below the | Goltocay —
-_Naw Figld...
Full name | tescal BusiassPhere
1 ke Business Fax
field to Observations Hame Phores
i Primary SIC Pabile Phone
pI’OVId e Quarker Goal Journal
it Quiz date Categories
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information Move Up
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Developing a Customer or Company
Profile Checklist

Who is your customer? A person or a company? You can record personal
information in the Contact record, as well as the company information in the
same record. If you have two people in the same company as customers,
you’ll have the same company profile for both and a different customer pro-
file for each person.

Say that Microsoft is your customer, so you have to build a Microsoft com-
pany profile. Who is ordering or using your product at Microsoft? You have to
create the customer profile for each person to remind you who they are and
how to improve your relationship with these people as time goes by.

The customer profile is the information about a person, an individual such as
your customer or your contact, at a company that is your customer.

Company profile is the information about the company, such as the number of
employees, location, size, products, and other information valuable for your
work.

When you go to the family doctor, chances are that the doctor has a folder
that contains all types of information about you: your medical history, test
results, and past prescriptions, to name just a few. In a sense, this informa-
tion serves as the doctor’s customer profile.

The doctor and you have the same objective: to develop a precise prescrip-
tion. His records help him develop a personal and friendly relationship and
keep his customers coming back.

A customer profile retains personal data according to each type of business.
Your own profile in a jewelry store is different from your profile in the family
doctor’s folder or if you're a contact within a company. A company profile
retains information about the company and the people working in this com-
pany. Depending on your business, you may need to build a customer or a
company profile. You can use a Contact form and customize it to become a
customer or company profile.

Looking for company information

A profile is a set of information about a person (a customer profile) or about a
company (a company profile). When you’re running a business, you need the
profile to know about your customer (the person) and his company, his
ordering potential, the credit financial risk, preferences, and the way he
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works. Before building any profile checklist, you need to understand the
required information for your own business. You can use Outlook Research to
find typical company profile information on the Web:
1. Choose Help=>Microsoft Office Outlook Help.
The Help pane opens.

2. Click the triangle in the Help title bar to collapse it so that you see
four commands and choose Research.

3. Collapse the dialog box that appears.
A commands list is displayed.
4. Select a company profile.
5. Type a company name in the Search box.
6. Click the Start Searching button.
A new window appears with your results displayed (see Figure 4-15).
7. Choose Click To Read Full Profile.

Internet Explorer opens, displaying the Company profile free information
(see Figure 4-16). If you need additional information, you pay a fee.

: Research v X

Search For:

wiley

Thomson Gale Company Profiles | s

.

= WILEY PUBLISHING
SERYICES INC.

Address 10475 Crosspoint B
Phone 317 572-3000
Fax (317)572-4000
Web http: /v wiley . com

Firm Type Private Subsidiary
|

Revenue $275.00 M

Figure 4-15: Employees 350

A standard Revenue Per Employee 7¢

company Fiscal Year End 4/30/2003

. Year Founded 1807

profllg found Primary SIC 2731 Book Publ
by using the Click to read full profile

research =1 WILEY, REIN AND
pane. FIELDING L.L.P.

Address 1776 K 5t NW, Wal
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|
Figure 4-16:
Afree
company
profile
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pane.
|

The profile found shows the company information in a format required by
most companies today. Besides the address and phone numbers, the informa-
tion provided shows the company’s annual gross sales, number of employees,
type of business, and so on. You can create the same fields in your contact to
add the same information for each customer.

- Competitive Intelligence
Company: Wiley Publishing Services Inc.
Firm Type: Private Subsidiary, Headquarters Location
Address: 10475 Crosspoint B,
City / State / Zip: Indianapolis, IN46256
Country: United States
Main Phone: (317)572-3000
Fax: (317)572-4000
URL: httpsiwww.wiley.com
Employees (Call Report) : 3500
Rewvenue (Estimate) : $2,750.00 M SALES
Additional Financials:
Fiscal Year End: 31-DEC-04
Year Founded: 1807
Primary SIC: 2731 _Book Publishing &amp; Printing
Primary NAICS: 511130_Book Publishers
Updated: 18-JUL-05
p-overview® 0000000
Divisions & Subsidiaries *
Industry Comparison *

Developing your own profile

Profiles developed according to your own business needs help you have in
hand all the information needed to negotiate and improve your customer
relationships. You can sketch out your customer or company profile by writ-
ing the information you need to record and the name of each new field to
create. Use the checklist to start your own company profile. Do you need a
new field? Just create it. (See the section “Creating custom fields,” earlier in
this chapter, to find out how to do so.)

Companies like Thomson Gale or Dun & Bradstreet specialize in collecting
company information for credit and other purposes. Accessing these data-
bases can save you a lot of time, providing you with information all at once.
Basic information may be free, like the example, or you may have to order
and pay for detailed information. These databases don’t solve all your needs.
They don’t, for example, give you the right contact within the company or
offer specific details for prospecting.

What else do you need besides a standard credit profile? Use the following
checklist and write down any other fields you think you may want in your
customer profile:

v Company information: Company size, total sales, territory coverage

v Product or service information: Product lines, production forecast
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v+ Financial information: Stock information, profit last fiscal year, credit
released

v Goal sales: Potential, strategy to make a goal, actions to perform
v Competitor information: Name, strength, weakness

1 Contact information: Decision maker, active or reactive, preferences

Creating a profile for sales

Using a checklist (see preceding section), you can design your Contacts list
as a company profile for sales and even sort your profiles by any field crite-
ria, like the quarterly goal field, to focus on each account. You can create a
company profile with the following fields in the Contacts List view: Icon,
Attachment, Flag Status, Full Name, Decision Maker, Company, Quarter Goal,
Goal Today, Business Phone, Journal, Categories, and any other field you
think you may need.

This company profile gives you three new fields. The first is your current
sales, the second is how much you need to accomplish your forecast, and the
third is the name of the decision maker to close your order. With the Phone
List view selected for the Contacts list:
1. Choose Customize Current View in the Navigation Pane.
The Customize View Phone List dialog box appears.
2. Click the Fields button to display the Show Fields dialog box.

3. Select Frequently Used Fields from the Select Available Fields From
list box.

The fields are listed in the Available Fields list.

4. Double-click each field needed from the Available Fields list to move
it into the Show These Fields In This Order box.

5. Click the New Field button to create the fields.

If you're not sure how to create fields, see the earlier section, “Creating
custom fields.”

The fields are created and inserted in the Show These Fields In This
Order Box.

6. To create your company profile list, select each field, move it up or
down inside the Show These Fields In This Order box, and set your
desired sequence.

If you're not sure how to line up your sequence, see the section
“Displaying the fields in your order.”

The Company profile is ready to be saved (see Figure 4-17).
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7. Click OK.

Your Contact Phone List view appears (Figure 4-18). It contains two
important fields:

¢ Journal: Helps you find any record, such as a proposal or phone-
call notes, related to the customer. (See Appendix C for more infor-
mation.)

¢ Categories:. Helps you classify the customers for several purposes
(see the next section).
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Categorizing Vour Customers

At times, you’ll want to take actions or perform analyses on groups or
batches of customers. You should typecast your customers or suppliers in
order to perform different kinds of group actions. For example, you may want
to perform actions on a specific market segment, send specific information to
a market segment, measure sales results from a particular group, or other
batch processes. The Categories field is your tool to type-cast customers and
create groups.

Open a contact and click on the Categories button in the lower right corner
of the screen to see the default Categories list. Then simply select the follow-
ing categories one by one in the Categories dialog box: Strategies, Suppliers,
and VIP. Then click OK. The Category window for this contact appears as
with all categories (see Figure 4-19).

|
Figure 4-19:
Three
categories
selected in
only one
contact.
|

{ | Strategies, Suppliers, VIP

P No matter what you're focusing on, categories can organize your records so
that you’re ready for a specific action. For example, you can create a mailer
for people with specific job titles, like financial manager, surgeon, or cardiolo-
gist. You can use categories to send a mailer introducing a new product to a
particular group, such as a new medicine for dermatologists or a new compo-
nent for design engineers.

You can even create your own categories. For example, say that you need to
group customers according to each salesperson. You can simply create a cat-
egory for each salesperson and then insert the category in each customer’s
contact. To create a custom category:
1. With your contact open, click the Categories button.
The Categories dialog box appears.
2. Click the Master Category List button.
The Master Category List box appears (see Figure 4-20).

3. Type the name of the category in the New Category text box and
click Add.

4. Click OK.
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When they hate you.. . . Creating categories

This may sound odd, but you may want to create
a category for customers who hate you. That's
because it's important to record customer prob-
lems, such as the company’s failure to correct
an emergency support issue or a bad relation-
ship between a former salesperson and the
client. Classifying the customer and knowing
the reason for the problem may help you
recover that customer later.

You can also use a number of other categories
in your Contacts list for sales purposes, such as
prospectif you're at the beginning of a relation-
ship, potential after you've developed the rela-
tionship but haven't closed a deal, active for a
current customer, or inactive for a customer not
ordering after one year.

The easiest way to increase sales is to work
effectively with your own, current customer
base. Companies working for some years will
have all kinds of customers categorized in their
customer base.

For example, hidden customers: have great
potential but haven't been exploited. Writing a
profile with their credit information, Web site
information, and search engine information by
company name or products may reveal more
hidden customers in your list.

Forgotten customers have been great customers
in the past but remain nonactive because of a
change in your product base or a broken rela-
tionship. Using categories to type cast your cus-
tomers makes it easier to discover and recover
them. If you have a few Hates us contacts in your
list, you can use reminders to call them monthly.
Listing ten forgotten customers, you can call one
or two each day of the week and then weekly
until you turn them into active customers again.

The company profile helps you to have a better
understanding of your customer and the way
business goes.
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Building Customer Profiles
with Forms

In This Chapter

Creating a form
Discovering the toolbox
Creating a customer profile form

Using the new form rather than Contacts

Outlook forms are great tools to align the company information, increase
your productivity, and even start a small sales force automation system.
Before the computer age, if you wanted a form, you needed to sketch it on
graph paper, have a designer develop a model, and then order the form from
a print shop.

With Outlook, when you open a new e-mail to write, you're opening an e-mail
form where you fill in your communication and send it in a format recognized
by any e-mail user. E-mails, Appointments, Tasks, Meeting Requests, and
Contacts are all available forms. In this chapter, you find out how you can
customize Outlook’s available forms so that you can include more key infor-
mation about your customers.

Exploring the Contact Form and Toolbox

Outlook forms all use the same concept: They have a grid-lined background
with preformatted fields that you can easily adjust to your own use. You can
start designing a form by using a Contact form.
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To open a Contact form:

1. Choose Toolsw>Forms=>Design A Form.
The Design Form dialog box appears.
2. Double-click the Contact form.
The Contact form, shown in Figure 5-1, opens. This form is the starting

point for developing any Outlook form.

The toolbox, which appears on the left side of the Contact form (see Fig-
ure 5-1), contains 15 buttons. Table 5-1 shows each button and describes
how you use it.

Table 5-1 The Toolbox Buttons
Button  Name Description
Select Objects Allows you to select an area with several objects
h‘ and take actions like delete, align, change the size,

or move the objects.

ﬁ Label Inserts an explanatory label over the background.
TextBox Generates empty fields that you can fill in with your
Elh| text.
- ComboBox Inserts a box that displays a set of custom-designed
=[5 options in a drop-down list.
ListBox Inserts a box that displays available choices in a list
=1 format. If the list exceeds the box size, the user can

scroll through the list to view additional choices.

CheckBox Creates yes/no or on/off options when inserted next
to an item. You can use in groups to allow users to
select more than one of the items in a list.

<]

OptionButton Creates lists from which you can choose only one
o) item when inserted next to a group of items.
= ToggleButton Inserts an activation button, such as an on/off
— button.
- Frame Ereates a titled frame for separating groups of
| | items.

CommandButton  Creates a button that you can used for actions, such
as Send or OK.

L
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Figure 5-1:

The Contact |

form is the
starting

point for

developing

any Outlook

form.
|

Button  Name Description
TabStrip Presents a series of options at the top of a
LS dialog box.
MultiPage Opens another page of the same form.

i

- ScrolBar Inserts a scroll bar that you can use with a plain
= text box.
" SpinButton Creates a number selection chooser that rolls up
- and down at regular steps or incremental values.
Image Generates a wizard to insert an image, company
logo, or figure on the form.

Figure 5-2 shows what happens when you select each button and drag and
drop it onto the form grid. After dropping a control onto the grid, you can
select it and resize it, or move it into position on the form. Right-clicking on
any item opens a menu of design commands, including a command for item
alignment, design properties, and other advanced features.
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|
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Building a Customer Sales Profile Form

\\3

You probably have a Contacts list with names and phone numbers, but it may
not show all the information you want to include. Fortunately, you can add
customized information in the Field Chooser box on the Contact form. You
simply select any available field and drag and drop it into place on the form.

[ typically include the following fields, but you can include the fields that best
meet your needs:

Name Decision Maker Company

Firm type Full Address Main phone

URL Employees Sales

Fiscal year end Year founded Primary SIC (business classification)
Quarter Goal Goal today Backlog order last until

If the field name you want to use doesn’t exist, you can just create it.
(See Chapter 4 for more information on creating new fields.)

To create a customer sales profile form, you need to follow these general
steps, which are outlined in detail in the following sections:

1. Clean up your form design.

2. Create and rename any necessary frames.
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Figure 5-3: |
This |
cleaned-up |
Contact |
form shows |
only native |
fields. |

3. Insert your fields in each frame.

4. Publish the new form.
Keep in mind that these steps show you how to generate a basic customer
profile form. You can add more pages to the form or add more fields accord-
ing your needs. You can even add extra pages for detailed financial informa-

tion or other needs. The report created in these steps will help the sales
force keep their goals

Cleaning up the standard Contact form

The Contact form is a very complete and generic form for both personal and
company information. When you design a form for a specific purpose, you
don’t need to keep unused fields. Instead, delete them to have more space
available for your own fields.

To clean up your Contact form design:

1. Choose Tools=>Forms=>Design A Form.
The Design Form box appears.
2. Select and click the Contact form.
The Contact form opens.
3. Select and delete any field that you don’t want.

When I clean up my Contact form, it looks something like Figure 5-3.

General (F.2) L] (P.4) (P.5) (P.6) Detais Activities Certificates All Fields (Properties) (Actions)

| Contacts.. | Cateqories... || Private [~

/3
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|
Figure 5-4:
You can
adjust the
lower left
frame size.
|

Working with frames

You may find that you can group the fields you want to include into cate-
gories. For example, I typically split my fields into three categories: Personal
Information, Company Information, and Sales Goals. To split fields into cate-
gories, you need to create frames:
1. Click the Toolbox button.
The toolbox opens.

2. Select the Frame button and then drag and drop it two times onto the
form — one on the bottom left and one on the bottom right of the form.

If you want more frames, drag and drop the Frame button as many times
as the number of frames you want to create.

3. Adjust the sizes of the frames you added in Step 2 so that they fit com-
fortably on the bottom of the form grid, as shown in Figure 5-4.

4. Right-click on the frame and choose Properties.
The Properties dialog box appears, as shown in Figure 5-5.
5. Type the name of your first frame into the Name box.

For example, my frame’s name is Company Information.
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|
Figure 5-5:
The Frame
Properties
dialog box
lets you
change the
frame’s
borders and
name.
|
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6. Type a caption into the Caption box.

For example, my frame’s name is Company Information, and the caption
is the published frame title.

7. Click the Font button to select and change the Captions fonts.

8. Select the frame’s color mode with the Background and Foreground
selections.

9. Click Apply and then Close.

10. For each frame you need to name, repeat Steps 4 through 7.

Inserting fields in each frame

After you create your frames (see preceding section), you're ready to insert
your fields (see Chapter 4 for more on creating new fields). To do so, simply
drag and drop your fields into the appropriate frames.

After dragging and dropping all fields, your screen may look something like
Figure 5-6, with all fields misaligned. Dragging and dropping the fields was
easy, but aligning them one by one manually would be torture.
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|
Figure 5-6:
The
Company
profile for
Sales
misaligned.
|

|
Figure 5-7:
My
Company
profile form
with items
ready to be
aligned.
|
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Fortunately, Outlook has an alignment tool to release you from this tedious
work. Just follow the next few steps:

1. Select the entire column of Text boxes of the frame that needs
aligned, as shown in Figure 5-7, and right-click.

The command list appears.

contacts.... || Cateqonies... | | Private [~
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2. Choose Align=>Align Left.
The Column aligns.
3. Repeat Steps 1 and 2 for all misaligned items on the form.

The aligned form appears in Figure 5-8.
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Figure 5-8: |
My |
Company |
profile form |
designed |
and ready. |
|

Publishing the profile form

When your form is ready, you can file it as a new form or publish and place it
in a public folder available to all company members. You can even use it as
your default contact form (see next section).

To save the form:

1. Click the Publish button (the leftmost button on the Form design bar).
The Publish Form dialog box appears.
2. Type a name for the form into the Form Name text box.

3. Type a name to appear on the form itself into the Display Name
text box.

4. Click the Publish button.

The form is saved in the library.
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Setting Up Vour New Form
as the Default

|
Figure 5-9:
You can
establish
your custom
designed
form as the
default
contact
form.
|

After you've created a custom form for entering all kinds of important cus-
tomer information, you may want to use it as the default form when you open
your Contacts database in Outlook. That way, you have all your important
information in view while you talk to the customer.

Here’s how you set up your new form as the default:

1. Select Contacts on the Navigation pane.
The Contact folder appears on top of the Navigation pane.
2. Right-click the Contacts folder and choose Properties.
The Contact Properties dialog box appears, as shown in Figure 5-9.

3. Select the name of the form you want to use in the When Posting To
This Folder, Use list.

4. Click the Apply and OK buttons.

The new company profile is now your default Contact entry form.
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Would you spell your name for me?

Names like Choo Lao Kon, Zgniev Brzinsky,
Kamal Ahmed Gamal, Antoine Siqueira, and
Belarmino Benallana expose us to the global
caldron and make us repeat the same question
several times: “Would you spell your name
for me?”

Type the correct spelling into Contacts, and
you'll have no more spelling questions again.
Using the Actions menu, you can write letters or
e-mails, merge contact information, even have
the computer dial the phone for you, and auto-
matically apply many other timesaving applica-
tions to your contacts. Give them a try.
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Chapter 6

Kicking It Up a Notch with the
Business Contact Manager

In This Chapter
Understanding BCM
Looking at the BCM’s benefits for your type of business

Understanding and overcoming BCM limitations

f you do a lot of traveling and rent cars from time to time, you know that

you need to be flexible and adjust to each car. At the very least, the seat
position and mirrors need to fit your personal preferences. Today, many
people hate driving manual-transmission cars because they’re used to driving
automatics. If you run a small business with limited resources, you must be
flexible and adapt yourself to the resources available, such as Outlook, but
you can put more of an automatic transmission into your sales with Business
Contact Manager (BCM), which helps focus on the sales while the organiza-
tion runs smoothly.

In this chapter, you find out how to enter your business information into BCM
and use it to control your sales history and activity by customer.

Introducing BCM

Chapters 4 and 5 explain how to customize your Contacts to track your cus-
tomer and suppliers information. If you don’t want to create your own con-
tact pages, you can try using Business Contact Manager, a ready-made tool
designed to control sales and other activities for small businesses. Ready-
made pages with business fields help you control your prospecting and sales
activities, focusing on speeding up your business without having to create
custom forms. BCM is a great tool for managing all your sales activities, from
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new prospects to your best customers, from the first e-mail sent, to closing
deal after deal for years. To do this BCM adds an extra database beside the
Outlook.pst file and four different forms to record your information. The
Product And Service Items List allows you to add your products and service
to any Opportunity. The Opportunity form is designed to link any business
opportunity to a customer in Business Contact or to a company in an
e Account form.
§s~ BCM free upgrade is only available for Office Small Business edition 2003 and
Office Professional edition 2003.

Installing BCM 2.0

To install BCM Version 2.0, open Outlook and 3. Find and select Outlook Update With BCM
connectto the Internet. Now follow these steps: 2.0 in the list and follow the Download And

1. Click Help=>Check For Updates. Installation Wizard until the end.

If the update procedure can't find the BCM
update, use the Microsoft site search and
search for Downloads, type BCV2UPD.exe, and
2. Click Check For Updates. click the Go button. The next page shows the
downloads (see figure).

You're automatically linked to the Microsoft
Office Downloads Home Page.

The check verifies your current Office ver-
sion. At the end of the check, the Office After the installation procedure, open Outlook.
Update page lists the available downloads A new wizard should begin automatically,
to update your Office. asking whether you'd like to use BCM with your
current Outlook profile. Click Yes, and the BCM
Database installation starts and is ready for use.

W United States (c Microzoft.com Home | Site Map

Ol sermar )
L.i10ffice Online

IR cowloxt: ] oo vaups
Horme: Searched downloads for: "BCM v2upd” Help
Assistante
N Results 1-2 of 2, sorted by best makch Page: [1]
Templates
Clip Art and Media ",‘_.1 Business Contact Manager for Outlook 2003 update: Windows Small Business Server 2003

Dowrloads for Office 2003 = Outlook 2003 (and Business Cantact Manager) > Updates
Downloads

Office Marketplace ""j Dutlook 2003 with i Contact ger Add-in: Contacts for Pocket PC

Wark Essentials Downloads for Office 2003 > Outlook 2003 (and Busness Contack Manages) > Add-ins

Micrasoft Office System

Deployment Center Results 1-2 of 2, sarted by best match Page: [1]
Can't find it?
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You can use BCM as an entry-level solution for customizing your sales and
marketing activities. Instead of customizing Outlook Contacts for use in sales,
try using the Business Contact or Account forms in BCM. Instead of using
Tasks to control your business opportunities, share the BCM Opportunity
form with your team.

With BCM, no longer will you leave notes in your shirt pocket and ruin them
in the laundry. You can quickly record important remarks from phone calls.
And you no longer have to open your billing system and build a report to
check a customer sales report — a process that takes more time than you
feel is worthwhile. Thankfully, BCM solves these problems by integrating all
your customer information in one place and even synchronizing with your
Pocket PC.

Keep in mind that BCM is designed to work best when integrated with MS
Accounting 2006.

Today, many businesspeople visit customers and write notes while on the go.
Now you can have BCM on your Pocket PC and synchronize it with your
office PC. (The BCM for Pocket PC doesn’t work on Smartphones, Palm Pilots,
and BlackBerries.) To download Business Contact for the Pocket PC, visit the
MS Office site, select Downloads from the Search drop-down list, type
Business Contact For Pocket PC, and then click Go to start the search. The
next page displays the download information. The download contains two
parts: a sync provider for Microsoft Active Sync and a program residing on
the Microsoft Windows Mobile Pocket PC device.

Getting Information into BCM

After installing BCM, open Outlook and find the new Business Tools button
on the toolbar. This button and its drop-down commands are how you access
all BCM lists, forms, and reports. When you click the Business Tools button, a
drop-down menu with the following commands appears:

v Accounts is where you add companies as customers by simply entering
the account information into the Account form. The form content looks
like a Contact form, designed with fields for classifying customers, such
as Rating (from Excellent to Poor), Status (Current or Overdue), and
Business type (Public or Private company). You can also include market-
ing information fields, such as Source Of Lead to record information
about where the lead was generated. But the most important fields are
the Account History items that list and link all customer actions — from
phone calls to proposals — giving full customer activity information on
a single page. (For more on adding information, see the section
“Entering Account information,” later in this chapter.)
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v~ Business Contact is where you record information about individuals —

whether the customer is an individual entity or an employee of your cor-
porate customer. You can also use this option to link in an Account form
a person’s information to the company he or she works for. You find all
contact fields plus financial information and customer preferences (for
recording the preferred way in which your customer wants to receive
information — from instant messages to face-to-face contact) in this
option.

BCM adds two new folders under the Contacts group so that you can
split your contacts in the following way: The Outlook Contacts List for
Personal relationships, Business Contact to record your customer infor-
mation, and Accounts to record your corporate or other large cus-
tomers. Moving your current contacts from Outlook to BCM is as easy as
selecting the contact and then dragging and dropping it into the desired
BCM list.

v Opportunities is where you enter any sales opportunity, from a request

for information to a quotation. Any customer activity should generate a
new business opportunity. The Opportunity form is designed to track
each potential sale from a probability of 0 to 100 percent, from a
prospective customer to a closed sale, tracking each step in the sales
process until the sale is made. The Opportunity folder is under the
Tasks folders list. An opportunity cannot be saved unless it’s linked to
an Account or Business Account.

v Product And Service Items List is where you enter information about

the products or services your company offers. They’re organized as a
price list or sales proposals that include details about the service,
number of hours, the materials list, and, at the bottom, the Total Value.
The BCM Product And Service Items form is used mainly to quantify the
item and value in a quick and easy format. To use the form, you'll likely
have to adapt your products or services descriptions to fit the existing
fields. To find out how to do so, see the section “Overcoming BCM
Limitations,” later in this chapter.

Finding disappearing BCM commands

Sometimes BCM commands vanish from your Microsoft Office Outlook dialog box appears,
Outlook like a ghost. That's because when click the Disabled Items button. The Disabled
Outlook has a software conflict, it disables the Items list box opens. Select the BCM file and
add-in software such as BCM. To check whatis  click Enable. The BCM commands are now on
happening with BCM, choose Help=>About again.

Microsoft Office Outlook. When the About
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Entering Account information

Chapters 4 and 5 show you how to create a company profile with multiple
company information by using Outlook. Now the BCM Accounts form offers a
predesigned form with some company information fields that may just suit
your business as is. Here’s how to enter information in the ready-made fields:

1. Click Business Tools and choose Accounts.
The Accounts list opens.
2. Click the New button to begin a new account.

A blank Account page opens (see Figure 6-1).

The Account page is designed to hold company information. For per-
sonal information, use the Business Contact form. (See the section
“Entering the Business Contact information,” later in this chapter.)

3. Complete the contact information.

The Account and Business Contact form can have duplicate information,
such as the same phone numbers, Web site, and e-mail address for the
Account name and the Primary Business contact. Don’t type everything
twice. When adding a contact, you have the information on the Business
Contact form.

8- Untitled - Account ==
i Eile Edit View Insert Format Tools Actions Help
i ol Save and Close | | | ¥ 2 50~ | - E-mail Auto-link EJ - ’—'| | B I U= = :=
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Address E-mail and inkernet addresses
Business... E] E-rmail E]
‘eb page address:
This is the maling
address Accourk Financial Infarmation
State: j
Phorne Numbers Stakus: Lt
Business = | rating: =l
Business Fax E] | |
Business Cortacts
Add... Fils s | Business Phone | Mabile hone | E-mal |
Account History Thems
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This form does contain some fields that the Outlook Contacts form
doesn’t offer, including the Account name field, which holds the name
of the company and the Primary Contact field, which links a Business
Contact (a person) to the account.

. When you get to the Account Financial Information, classify your cus-

tomer financial information.

You can seamlessly integrate the customer financial information from
your accounting system from MS Accounting or by importing the data
from other products. Having customer information in front of you helps
you negotiate according to the customer status. The following three
fields help you classify your customer financial information:

e State: Select either Active or Inactive. An Inactive customer is an
older customer that hasn’t ordered for a long time.

¢ Status: Select either Current or Overdue to mark each customer’s
financial status.

¢ Rating: Select Excellent, Good, Average, Fair, or Poor to rate the
account’s performance.

In addition, the Categories button opens the Categories list. (See Chap-
ter 4 for more on categories.)

. After you add your customer information, click the New button in the

Account History Items.

Your information appears in the Account History list, which includes all
items related to the Account. After you click the New button, the follow-
ing commands are available to link with the Account:

¢ Business Note is where you can enter any information about the
account, like a tip or a comment that may be useful in the future.
You also get a time stamping when you save the information.

e Opportunity creates a new opportunity linked with this customer.
For more on the Opportunity page, see the upcoming section
“Tracking Business Opportunities.”

¢ Task opens a new task linked to this customer.
¢ Appointment opens a calendar appointment linked to this account.

¢ Phone Log allows you to enter information while you're on a call
and includes time stamping and a field to type the information
about the phone calls.

¢ File links any file with the account and includes the date that it
was linked. You can link a proposal or any project-related file.

6. Click the Details tab.

The second page of the Account form opens.

7. Enter your account details, as shown in Figure 6-2.
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You can include the following information about your account:

¢ In The Business Type and Location area, you can select your cus-
tomer so that you take actions based on customer type or geo-
graphic location. In Type of Business, select from the following
options: Public Company, Partnership, Private Corporation, Non
Profit Corporation, Sole Proprietorship, and Other. In Territory,
you can choose from eight geographic classifications.

In the Source area, you can record how the customer found your
company and who opened the Account. In the Source Of Lead
box, you can help measure results from every marketing action by
selecting the way that the customer found out about your busi-
ness: Advertisement, Direct-Mail, Employee Referral, External
Referral, Trade Shows, Public Relations, Partner, and Seminar. In
the Initiated By box, type the name of the person who started the
new relationship so that you can follow up with whoever is taking
care of the customer.

The Record Details area helps you keep track of the customer by
recording general information, such as who has been in touch with
him. The fields gives a time stamping for the record creation and
the last user modifying the record by login name if you’re sharing
the BCM database and asking everyone to use his own login.

8. Type any notes or comments you have and then close the window.
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Entering the Business Contact information

The Business Contact form looks like a mix of the Account form plus personal
detail seen on the Outlook Contacts, such as birthday or an assistant’s name.
The form has two objectives: to manage the Business Contact as a customer
with credit and marketing fields and to link personal contact information to
the company information.

For example, say that Daisy has a beauty parlor, and Mary St. Louis is one of
her best customers. Every time Mary calls her shop, Daisy opens her Business
Contact rather than her appointment book. Here’s how you can do the same:

1. Click the Business Tools button and choose Business Contact.
The Business Contact list opens.

2. Select the customer’s name.
The Business Contact page appears, as shown in Figure 6-3.

3. Type your information into the form.

The Business Contact Form has the same fields as a contact, plus the
Contact Financial Information and the Business Contact History areas:

¢ The Contact Financial Information area on the Business Contact
has the same financial information fields as the Account page and
is useful when you're selling to a person, not to a company, such as
when you run a beauty parlor or any personal service business.

e The Business Contact History area has fields that allow you to
attach all information related to an account, along with information
about each individual. These fields help you organize information
based on each person within a large account. When you're selling
to a person, you can easily see what you charged him or her in the
past. In addition, you can also see whether your customer calls for
estimates a lot and then always orders only the cheaper item,
which helps you develop strategies to understand and increase
your relationship with each customer.

After installing BCM, keep the Contacts List for your personal contacts,
suppliers, and others. Move all your customers to the Business Contact
and Accounts. You can move business-related contacts from the Outlook
Contacts List folder to the Business Contact or Accounts folder by
selecting, dragging, and dropping the contact into the Business Contact
or Accounts folder.

4. Click the Details tab.

The only new information is the Contact Preferences area, which shows
how communication should be made with this customer. The Method Of
Contact box is a great tool for recording how your customer prefers to
receive information (see Figure 6-4).

5. Complete the Details form and then close the form.



|
Figure 6-3:
The
Business
Contact
form helps
to manage
the
Business
Contact
information.
|

|
Figure 6-4:
In the
Business
Account
Details tab,
you can
record the
little details
that make a
difference.
|

Chapter 6: Kicking It Up a Notch with the Business Contact Manager

5 Untitled - Busi

Contact

il Save and Close | | | ¥ & & 7| L Email Autolink 2 ¢

i Eile Edit View Insert Format Tools Actions Help

Systenn

-LALB £ U]

Il

General | Dekais |

Linked to Account

Business Fax Bl

| Filz as:

Mokile B|

| Cabegories. .. |

&

KN KR{ K

Cantack
Full Naie. .. [ ] Account name:
Job title: [ | E-mail ard Intermet Addresses
Company: | | E-mail
Address ‘Wb page address: [
Business... (=] Cortact Financial Infarmation
Stake:
[~ This is the maling
address Stakys:
Fhone Murmbers Rating:
Business | | Filng Information

I|EN

Business Contact Hishory Thems

§ S+ | E-mai i E
|i = Save and Close | Il | ¥ o & -] -LE-mail Autolink E

New,.. [y ttem Type Subject lirked To | Created By CreatediDue |
There are roibems to show in this view,
5| Untitled - Busi Contact =
i Eile Edit View Insert Format Tools Actions Help
Systen -|| AlB 7 U=

General [Dctuls ]

Conkact Preferences

I Dorat send emal
I Dorat cal

I~ Dorat send fax
I Do not send kstter

[Huuc

[rene

[rone

|Ncne

Source
Source of lead: [ ZI Method of contact; [
Inkiated by: | |

Job Iriformation
Depattment: I |
Profession:
e | | Record Detalls
Manager's name: [ | Modified:
Assistant's name: | | Modified by:

Personal Information Created:
Diate of birth: lM:\na | Crantad by

ad by:
Anniversary date: = |
HNokes

Comments:

89



90 Part Il: Managing Contact Information

Tracking Business Opportunities
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A business opportunity is the chance to sell your product or service to an
Account or Business Contact from the very first prospecting contact all the
way to “closed and won” or “closed and lost.” Recording the contact informa-
tion and linking each opportunity detail helps you track, evaluate, and negoti-
ate the opportunity until it becomes a closed order. The Opportunity History
Items allows you to link phone logs, tasks, business notes, and files related to
this opportunity so that you have all your information in sight. To enter the
Opportunity information into BCM, follow these steps:

1. With the customer Account or Business Contact open, click the New
button on the Business History Items.

If you're not sure how to open the Account or Business Contact forms,
see the sections earlier in this chapter. A menu appears.

2. Choose Opportunity.
The Opportunity page opens, as shown in Figure 6-5.
3. Complete the page.
Here are few pointers to keep in mind as you complete the form:

¢ The Opportunity data links the Opportunity to a Business Contact
or Account in the History Items list. The Opportunity Title holds
the name or title of each opportunity so that you can remember
the content when reading history or summary reports. The Link
To field links the Opportunity to an Account or Business Contact.
When you open from the History Items, the Opportunity is already
linked to its source.

¢ The Status area has three fields to track and evaluate the way the
opportunity is flowing to a closed order. Sales Stage records the
sale’s current stage, such as Prospecting, Qualification, Needs
Analysis, Proposal/Price Quote, Negotiation/Review, Closed Won,
or Closed Lost. Recording the appropriate stage helps you build
your reports and take actions according each stage. Close Date
helps you forecast when the customer expects to close the order
and keep it in your priorities, based on the closing date. If you type
the format as mm/dd/yy, it is auto-adjusted to the format weekday
mm/dd/yyyy. The Probability field is typed in as a percentage
reflecting how likely you are to win the order.

Reading the Opportunities list, notice that the Expected Revenue
field is the Opportunity value multiplied by the Probability per-
centage. If you open a $1,000 opportunity with a probability of 10
percent, the expected revenue is $100. The same opportunity with
the probability of 50 percent yields an expected revenue of $500.
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¢ Background information has four fields, and two of them —
Source Of Lead and Initiated By — already exist on the Account
and Business Contact. These fields are duplicated because an
Opportunity can start by a new marketing activity and can be initi-
ated by another person. Competitors helps you evaluate the game
and know who is competing for a particular sale. Type (of order)
classifies the order by using Standard, Delivery, Bulk Order, or
Special order.

e Opportunity History Items shows various items linked to the
opportunity. The New button allows five types of items to link:
Business Note, Phone Log, Appointment, File, and Task. Remember
that history items are also available through the Account and
Business Contact forms.

WNG/
&V?‘ Although the Opportunity folder is filed under the Outlook Tasks
folder, no reminder is available. To use any reminder, you have to
open and link an Opportunity to a Task.

Product And Service Items displays a list of items inserted on the
proposal. Click the Add button to enter new products or services.
See the next section, “Listing Your Products and Services,” for
more detail.

4. Click Save And Close.
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Opportunities recorded in this format helps you track each opportunity
among by Account or Business Contact to improve your control of the sales
process. When you complete a sales cycle, you can create quotes, sales
orders, or invoices from your Opportunity records if Business Contact
Manager for Outlook is connected to Microsoft Small Business Accounting.

Listing Your Products and Services

|
Figure 6-6:
The Product
And Service
Items Listis
ready to
insert new
Items.
|

When opening a new BCM sales opportunity, you have to specify the product
or service requested. Every business has a list of the services and items it
sells, including a single lipstick in a drugstore or a brand-new car in a car
dealership. A consultant, a legal office, or a psychiatrist charge services by
the hour and estimate the number of hours per service.

The BCM Products And Service Items List has only four fields to list your
product or service and insert in any BCM Opportunity. You need to add a
product or service in order to specify what is in your sales proposal. To
insert the item:

1. Click Business Tools and choose Product And Service Items List.

The Product And Service Items List dialog box appears, as shown in
Figure 6-6. It contains an empty list with columns for the ltem Name,
Description, and Unit Price to describe the product or service, as well as
the buttons Add, Edit, Delete, and Import. Clicking these buttons lets
you modify your list.

Product and Service ltems List %]
Make changes ko individual product and service items, refresh ibems from an external list, or impork & list of additional
items,

Tvpe name or seleck fram lisk:
Item Mame Description Linit Price
Add,.
[ b [ et Close
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2. To add an item, click Add.

The Add Or Edit Item dialog box, shown in Figure 6-7, appears. It con-
tains four fields:

¢ Item Name: Type the product name or service item.
¢ Description: Enter the item’s description or the type of service.
¢ Unit Price: Include the price of a single unit of this item.

¢ Default Quantity: Indicate the number of items that you typically
sell at one time.

Add or Edit Item %]

Add or Edit Ttem

To add an itemn enter the relevant information, and then click OK, To edk an
kem, change the existing information and clck Ok

Ttem name: ]
Description:
Unit price:

Defaulk quantity: 1

Only these four fields are available to include your product or service
item in BCM list. If you think that your product or service doesn'’t fit into
these fields, read the next section, “Overcoming BCM Limitations,” to
find your solution.

3. Complete the fields with your information and then click OK.

Your new item is added to the list.

Importing an existing list

If you already have an existing list, then you can simply import it directly into
BCM with a wizard if the field names are exactly the same; otherwise, you
have to make the imported fields compatible with the Product And Service
Items List. You can do so by mapping the two sets of fields to each other.
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To import the items, your list must have the same columns and titles and be
saved as a file with comma separated values (.CSV). In Excel, instead of
saving the file in the usual way (as .XLS), choose Save As and then select CSV
Comma Delimited from the Save As Type list. Start the import procedure by
browsing the file on the wizard when it’s ready.

To import your current list:

1. Click Business Tools and choose Product And Service Items List.
The Product And Service Items List dialog box appears.
2. Click the Import button to import or change the current list.

The Import Products And Service Iltems Wizard appears, as shown in
Figure 6-8.

Import Product and Service ltems Wizard %]

To inport 2 list of kems, the information must be in & comma
separated values file . csy) with these Fields in the Following
order:

Product Name, Description, and Unit Price

Select the file that contains the product and service items that you
wark to import:

!

Options
(3) Add the items in this File o the existing list

() Replace existing list with £ems in this File

3. Click the Browse button to locate the file to import.
The Files list appears.

4. Double-click the file to import.
The file is ready to import.

5. Select one of the two options available: Add The Items In This File To
The Existing List or Replace Existing List With Items In This File.

6. Click Import.

Your imported list is ready.
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Importing a fruits price list to BCM

How do fruit wholesalers send quotes and fruits
specifications to a supermarket?

Florida oranges come in at least 11 types,
with the retail package size varying from %
bushel with 5 pounds and approximately 8 to 10
oranges to 1 full bushel with 40pounds and 64 to
72 oranges sold in containers. The fruit distrib-
utor has in his inventory list specifications using
more fields, such as part number, item name,
retail package, packages per box, box per con-
tainer, net weight, gross weight, average fruit
size, and valid until date. The distributor has to
adapt all the information in only four available
fields if he wants to use the Business Contact
Manager as it is.

Item name: Navel orange

Description: Container with 5,000 packs of
1/8 bushels 5 Ibs.

Unit Price: $5,000

The quantity unit chosen was one container.

Usually, this example doesn’t work properly on
a day-by-day basis, even when it's a restaurant
or convenience store selling small packs. You
need more information to serve your customer
well. In this example, you can use the Product
And Service Items List to control your gross
number opportunity and link the proposal in the
same Opportunity page to overcome this limita-
tion, which allows you to have the gross num-
bers in sight; the details are just a click away in
the Opportunities History List.

Linking your proposal
Say that Assai Healthy Juices requests a quote for Acai fruits sold in contain-
ers. The fruit suppliers send a detailed proposal document and give the fol-

lowing product quote:

Product Quote for Assai Healthy Juices

Item name Acai
Description Container
Quantity 1

Price $123.00

Unfortunately, you can’t use the Product And Service Items List to hold and
identify the size of the fruit, the net weight, the container’s net weight,
whether the fruit is fresh or frozen, or the average fruit quantity per con-
tainer. However, you can link to the proposal:
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With the Opportunity page open:

1. Click New under Opportunity History Items and choose File.
The Link File dialog box appears.
2. Double-click the importing file.
«3‘&“\85’? The Fruit Supplier Opportunity to Assai is ready (see Figure 6-9).
&

You can use the Opportunity page for any kind of business.
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Overcoming BCM Limitations

Business Contact Manager is a great tool if you understand how to use it for
your benefit and overcome its two major limitations:

» Older versions of BCM work as stand-alone units not allowing sharing
among several users. Upgrading your BCM to Version 2.0 allows data-
base sharing among several users. If you're using an older version, get
online, choose Help in the Outlook toolbar, choose Check For Updates,
and then follow the instructions to upgrade your system. To use BCM'’s
sharing features, your Outlook program must be installed on a computer
running Windows XP Professional; BCM doesn’t share under Windows
XP Home Edition.
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v The Product And Service Items List has a fixed format with only three
available fields to import data from your sales and accounting system.
You have to adjust the fields from your business system to fit into the
three importing fields: Item Name, Description, and Unit Price, which
limits the way of quoting services and products. Quoting the same prod-
uct as one unit, one box, or one container means you have to open one
line item per packaging. You can’t import your current inventory quanti-
ties because BCM doesn’t import quantity fields. To have the same item
on the different packaging on the same line, you have to define the
meaning of your unit quantity, whether it’s 1 shampoo bottle or a box
containing 12 shampoo bottles. Adapting each Item Name, Description,
and Unit Price for a service, a project, or product is the challenge of
using BCM in any business.

Say, for example, that Daisy works in a computer and software maintenance
company and receives a request for a quote to install and share the new BCM
2.0 in five workstations. She writes a detailed proposal, including minimum
requirements like a Windows XP Professional in the workstation that will
share the database, and estimates the number of hours for her service. She
creates a new item to record this proposal:

Service Quote for Installation Software

Item Name Software installation

Description BCM 2.0 shared in 5 workstations
Quantity 1 service

Price $120.00

Daisy uses the Item name field to specify the service and the Description field to
list what was required. She also links the proposal as a file in the Opportunity
History Items. Adapting her service to the Product And Service Items List, you
can apply Daisy’s idea in any type of business.

In addition, say that Mark works in a legal office, and a new customer
requests a quote for handling the company’s legal affairs. He writes a pro-
posal explaining what his office services cover and sends it as $250.00 per
hour, estimating ten hours per month of service. He estimates the proposal at
120 hours a year and sets it up in the following way:

Service Quote for Mark’s Legal Services

Item Name Legal support
Description Business legal support contract 10h/month
Quantity 120

Total $30,000
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Sharing your database

The Sharing Wizard gives you an optionto print  the installation, don’t waste your time trying to
the step-by-step database sharing procedures.  solve them and risk making your computer inse-
First, you have to give permission for your data-  cure. Instead, call the company that gives you
base to be shared. Second, you have to set up  technical support and ask it to complete the
the other user’s PC to be connected to your setup for you.

database. If you find security problems during

Likewise, a cosmetology clinic can create a Product And Service Items List
for Botox skin-care applications and laser skin-care services in the same way
as a legal office or a computer service. A store or small industry can adjust
its product list to fit BCM’s available fields by using the preceding examples.




Chapter 7

Working with BCM Reports

In This Chapter

Choosing from BCM’s standard reports

Filtering reports

Working with reports in Microsoft Excel

Business Contact Manager (BCM) Version 2.0 is a free add-in to Outlook
in the Office Professional and Small Business edition. Using the BCM’s
reports, you can have snapshots of the entire team'’s activities, which makes
BCM an important management tool. This chapter shows you how to get
value out of BCM reports.

Getting Familiar with Your
Report Options

Reports are not useless lists forgotten in the bottom of a drawer, but informa-
tion that is presented and organized in a way to help you take actions or
make decisions for your company. BCM offers more than 20 ready-made
report formats, and the BCM Reports menu contains reports divided into four
groups: Accounts, Business Contacts, Opportunities, and Others (with 20
more options). The rest of this section describes many of the reports avail-

WING/ able in each of these groups.

BCM works with two kinds of customers and offers reports related to each

group:

v Business To Business (B2B), when your customer is a business
organization

v Business To Consumer (B2C), when your customer is a person
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Working only with people as customers (B2C,) you do not use the Account
entry form and related reports, but the Business Contacts entry form and
related reports. Clicking the Business Tools button and then the Reports and
Business Account commands is your path for the exclusive B2C reports. A
door-to-door cosmetic representative or a real estate dealer specialized in
houses are Business to Consumer examples.

If you work with business organizations, you use the Account entry form to
enter the company information and the Accounts reports to see that informa-
tion in various ways afterward. You also use the Business Contact entry form
to hold information about each employee at the company and then link these
individuals’ records to the company record in the Accounts. Clicking the
Business Tools button and then choosing the Reports and Accounts com-
mands is your path for the B2B exclusive reports. An industrial parts sales-
person is an example of a user of the Accounts reports. An Office product
reseller store deals with both types of business, supplying business organiza-
tions as well as individuals.

No matter which report you create, the result looks roughly the same: The PC
processes and opens your report in a list format.

Accounts reports

The Accounts reports are used when you deal with B2B customers or busi-
ness organizations as customers. You can use the reports as a simple list or
to detect and solve certain problems, such as collecting on overdue
accounts. Read the following explanations to select the report you need for
your business. Clicking the Business Tools button and then choosing the
Reports And Accounts command is the path to these reports:

v~ By Status: Status has only two options, Current and Overdue. This
report is most useful for seeing and working with your overdue
accounts.

v~ By Rating: The rating report shows five levels: Excellent, Good, Average,
Fair, and Poor, and you can create parameters to classify your customer
in any of these categories. You can have a list showing you all your cus-
tomers by classification, thus helping you to explore new strategies and
turn good customers into excellent ones. Or you may notice that you
have too many poor customers and need to prospect better quality
leads. You can use these reports to analyze and work with customers to
increase their ratings. Likewise, if you have too many low-rated cus-
tomers, focus on prospecting new customers with higher potential. To
see your Account By Rating report, click Business Tools and choose
Reports Accounts By Rating. When the report appears, click View and
choose Show Groups (see Figure 7-1).
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v By Category: Because you can create any category (see Chapter 4), you

can identify vertical markets. For example, a fresh fruit distributor sup-
plies customers in different markets, such as restaurants, pie compa-
nies, and ice cream factories. Create each category and list them to
understand in which vertical market you have a better market share.
You can also analyze your profitability within each market and see
which one bring more results. Conclusions like “The ice cream market
has a better market share but a lower profitability than the desserts
market” can help you create new solutions, such as promoting your
products in the desserts market by using special recipes or other offer-
ings. Remember that besides the Report option, you can list your
accounts by using the view by Category on the Navigation Pane.

1 Neglected: I call this report forgotten customers. Did your company give

up on certain customers or simply forget about them? Is there any new
barrier, such as a personnel change or a new competitor in the field?
Analyzing the number of neglected accounts can show you problems not
previously detected and ways to find solutions. Read the neglected cus-
tomers’ histories and call the ones that warrant additional contact.
Often a phone call to a neglected customer restarts the relationship.
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v History: When I worked in sales, before any phone call or meeting, I
used to read a copy of the customer profile and analyze last actions and
unanswered requests. An Account or Business Contact History Report
presents the customer’s historical records, which you can use in meet-
ings or read prior to starting new negotiations. Read the customer his-
tory before a phone call and print the report to have it in your hands for
a meeting.

v Quick Accounts List: This report only lists your accounts with the pri-
mary contact.

v Accounts List with Business Contacts: This report adds every linked
Business Contact to the Account where he works. Suppose that you
work with a company with people working at home or in different
branches. You have the Account entry form for the company and open a
Business Contact entry form for each employee you deal with in the
Account. This report shows all these relationships.

Business Contacts reports

Use the Business Contacts reports when your customers are people and not
business organizations. To access these reports, click the Business Tools
button and then choose the Reports And Business Accounts command to
select the needed report:

1+ Business Contacts phone list: This report is a simple address list.

v By Status: The Current and Overdue status reports are for managing
your financials.

v By Rating: The rating reports are for showing accounts listed by their
rating: Excellent, Good, Average, Fair, and Poor. See the By Rating
reports in the previous section for more information.

v~ By Category: Because you can create any category (see Chapter 4), you
can identify vertical markets like real estate dealers for people looking
for a house under a certain budget.

v Neglected: I call this report forgotten customers. Did you give up on cer-
tain customers or simply forget about them? Try to call again after a
period with no business at all.

v+~ History: The Business Contact History report presents the customer’s
historical records, which you can use in meetings or read prior to start-
ing new negotiations. To access this report, click Business Tools and
choose Reports=>Business Contacts>Business Contact History. In the
Business Contact History Report dialog box (see Figure 7-2), double-
click the desired full name in the Full Name list. The Business Contact
History appears, as shown in Figure 7-3.
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Business Contact

History Report

Select the Business Contack that wou want a report on.

Type a name ot select from the list:

Full Mame | File As b]
Joe Stick, Stick, Joe
Jojo Carnel Camel, Jojo
Mark Eteer Eteer, Mark
Mark Goodday Goodday, Mark
Mary Saint Lauis Lowis, Mary Saink
Figure 7-2: Mazxwell Smart Smark, Maxwel
Sel h Mrs. Jane Mefirst I Mefirst, Jane
electthe My Best Custamer Cuskomer, My Best
Full Name to MMy Mew Customer Customer, My Mew
LN N VT e Llikhram s Ble -k M
see the <l B
Business -
Clear selection
Contact
History. o] o
|
|§ﬂ Busi Contact History EE@
File View Tools Action Help
BEE ¢4 T= oow - Sert Byt TL page 1 . 4 » M ModFy Repart Help
MainReport
]
Business Contact History
Contact details
Maxwell Smart Updated: 8/17/2005
Name: Smart, Maxwall Birthday: 5211849 =
Company: Shoaphone inc. Anniversary:
Job Title: Shoe Sniffer Manager's Name:
Department: Assistant's Name:
Profession:
Business Phone: (B6)861-861 E-mall: smart@emphosho.com
Business Phone 2: E-mail Display As: Mavewall Smart
(smart@emphosho.com)
‘Gompany Phone: Web site: hitp/fwww.emphosho.com
I Mobile Phone: (686816816 Business Address: 86, B6 street
. Sleaping Snake, HUM keruve
Figure 7-3: Else
Read the Business Fax: (86)8628621
Business Source of Lead: Advertisement Modified: BATI2005 2:55:01PM
Initiated By: Modified By: DAISY\daisy
Contact State: Active Created: 5/19/2005 6:30:22PM
H Status: Overdue Created By: DAISY\daisy
History Rating: Good
before
calling the Comments: 5]
customer. ||<] i =
I | Current Page Mo:l Total Page Mo: 1 Zoom Factor: 100%
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|
Figure 7-4:
The Source
Of Leads
report
shows how
customers
are coming
to your
business.
|

Other reports

The Other reports offer two options, including the Business Tasks list that fil-
ters the Tasks list related to BCM and the Source of Leads, an excellent tool
to measure who or what campaign is bringing the customer to your business.
Clicking the Business Tools button and choosing the Reports And Others is
the path to request the following reports:

v Source Of Leads: Measuring what is driving the customer to your com-
pany is great feedback to help you measure the return on investment of
your marketing actions. This report lists customers by each marketing
action and includes a rating. You may find that a particular effort generated
90 percent results, but all were poor customers. The sales results may not
be according to your expectation. For example, say that you invested
$5,000 to participate in a trade show, and, as a result, over a six-month
period, you have five new customers who have ordered $30,000 in prod-
ucts. This investment paid out. Or perhaps you end up with 100 prospects
and no deals at all. Evaluate new marketing campaigns and measure the
results of your previous investments with the Source of Leads report.

To request a source of leads report, click Business Tools and choose
Reports=>Others>Source Of Leads. The Report appears. Then choose
View=>Show Groups. The report displayed in Figure 7-4 helps in moving
fast from one group of leads to another, helping analyze your marketing

efforts.
|51 Source of Leads oEE
File View Tools Action Help
B & % %= oow ~| SortBy: [Name v| TL Page [t v (] Modfy Repart Help
[ Mo Lead Source |
[ Advertisement v 7 o
[ Cirect Mai The Pupunha Restaurant Account
Qurmmrers Il pgvertisomont
[ Public Relations
O seminar Agai from Amazon Opporiunity
[ Trade Show Anaconda’s Exquisite food Account GE7-321-1234
D Other Granny's Flavour INC Account
Passionfruil inc Account
Passionfruit Inc Contact 407-123-1234
Smart, Maxwell Contact (B6)861-861
Spinach, Popeye Contact
Stick, Joe Contact
Stick's Barbecue House Account 123-654-8765
Tears, Chap Contact {002) 9876-5432
Direct Mail
Apple and Grapes Opporiunity
Camel, Jojo Contact
Chili Caliente Hot foods Account
Computer Fruits Inc Account 234 3-123-4567
Kiwi 4 us Account 546 4-123-3456
Palm, Paul Contact 123-321-1234
Passion, Joe Dela Contact b4
ki 3|53 2
Current Page Mo: 1 Total Page Mo: 1+ Zoom Factor: 100%
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v~ Business Tasks: Listing the Tasks linked to the Accounts or Business
Contacts gives you a sort of pending items list for each customer. It’s like
filtering your Tasks to see only those related to your accounts. It’s a great
action report that focuses on the customers’ pending issues. Reading your
Business Tasks list report daily helps you remember important follow-up
actions and select sales priorities before they become overdue.

Opportunities reports

The Opportunities reports are the most important for tracking all business
going on at your company. Listing your Opportunities in different ways can
bring you better business perspectives and priorities. For example, the
Opportunity Funnel report lists opportunities by sales stage from prospect-
ing to proposal/price quote. The Opportunity Forecast shows them by most
recent due date, giving you the chance to prioritize actions to get the order
now. The Opportunity By Product And Service report lists opportunities by
each product so that you can determine your most requested products. The
Past Due Opportunities report lists opportunities by past-due dates, remind-
ing you to reevaluate and understand these accounts. The Opportunity
History report lists the history of a chosen opportunity that can be good to
hand carry to a meeting. Clicking the Business Tools button and choosing the
Reports And Opportunities command is the path to request these reports:

v Opportunity Funnel: This report lists your Opportunities by each of the
following sales stages: Prospecting, Qualification, Need Analysis,
Proposal/Price Quote, Negotiation Review, Closed Won, and Closed Lost.
Tracking all your opportunities by status helps you focus your energy
on the appropriate next steps, to turn each opportunity into a Closed
Won one by one.

v Opportunity Forecast: Listing all your opportunities by due date by
using the Next 7 days, Next 30 days, Next 90 days, and Over 90 days
gives you a view of the sequence of opportunities coming due. Listing by
due date lets you focus on opportunities that are more important and
ready to close.

v Opportunity by Product and Service: Looking at each item of your cur-
rent inventory together with your Opportunity by product report helps
your company forecast new orders. Figure 7-5 shows an example of a
distributor report.

~ Past Due Opportunities: You can use this report to analyze the past-due
opportunities to evaluate the problem or to determine whether you lost
a sale to a competitor or because you simply gave up the opportunity.
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Opportunities by Product and Service
Title Account'Contact Type Sales Stage Close Date Probability Cuantity Subtotal
Agai
A from Anvzon #esa Heatry hices SukOmer  Qusifcaion Saz007 50% 1.500 $184:500.00
Total pumiber: 1 Total revernue: £184,500.00
Apple
Appln and Geapas Tor Pupsrha ok Starcdand ProposalPrice 52005 % 5 38485
Quick
Appla Seanen Chif Caliwtm it forck. Staclard ProgowiPrice 5702008 50% 2328 $302.38
I Quta
Appios Premsticnfat Tre. Bulk Orcer ProgosalPrice. S262005 0% 5 a4.85
- Qucte:
Flglll'e 7'5: Total mumber: El Total roveniss: 539208
Forecast
B
new orders anana _
X Banana At ety dcss Standine Przpecting m4e008 % 100 F245.00
with the Total rumber: 1 Total revenus: 524500
Opportunity
Grapes
By PrOdUCt Appla and Grapas. The Fupenta Restaurant. Standand ;mmsﬂfﬁue 502008 o et 0888
. ke
And Service Gragas Sorach Heatyfoss  Standad  Prospecing 02005 5% 2 308,88
Report. il S i i - o [
I [ent Page Mool Total Page Mo: 1+ Zoom Factor: Fage Width

As an example, you can request the Opportunity By Funnel report by simply
clicking Business Tools and choosing Reports=>Opportunities=>Opportunity
Funnel. The Opportunity Funnel reports opens, as shown in Figure 7-6.

Opportunity Funnel
Titla Account/Contact Initiated By Type Close Date FProbability Total
Prospecting
Barng Assai Haalthy Juicas Srantar BIA00S 3% F245.00
Grages Spinach Healthy Tocds Stantand SHNE0E 25% 0888
Passioning Drink Chil Callents Hot foods Stantar 2007 50% £294800
Total rumiber: 1 Total reven: £36,490 88
I
. Agal from Amazon Assai Haslthy Juicas Jahey Bk Order SE00T 5% 518450000
Flgl,lre 7-6: Total pumber: 1 Total rvanue: $184,500.00
The
. ProposallPrice Quote
Opportunlty Appla and Grapas. The Pupunha Restaurant Standard SIS ] $I53.73
Funnel Appie Seson Chil Callents Hot foods Sandard SHM0S 50% 330238
R Apples Passlanirul In: Buik Order SA005 ) 4485
Hew Passhon frult pie Granny s Favou ING Bk Order S0E0S 50 $350.45
Report lists ny
Crange Sck's Barbecue House Delivery S2008 % $a27 68
and Total mmber: 5 Total revenue: $1,488.00
calculates
values at
each stage. | m E
I [ent Page Mool Total Page Mo: 1 Zoom Factor: Fage Width
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Squeezing the Report to Get
Action Information

You can refine any report listed by using the available filters to have the pre-
cise information you need. Refining the Account By Status report, you can list
the overdue customers to call and fix the payment delay problem.

To understand the whole process, open an Accounts By Status report in the
following way:

1. Click Business Tools and choose Reports=>Accounts=>Accounts By
Status (see Figure 7-7).

The report opens, listing the Current Accounts and the Overdue
Accounts. If you want to work with only overdue accounts — for exam-
ple, you're in the accounting or collections department — you may want
to show only the overdue accounts. To filter the current report to list
only the Overdue accounts, use the Modify Report option.

2. Click the Modify Report button and then the Filter tab in the Modify
Report dialog box.

The Filter options appear, as shown in Figure 7-8.

=3

File View Tools Action Help
H& 2 % [ seetBy: | Accourt Name Pagei 1 [w| 4 4 B M MlodéyRepart

MainReport

s Heitivy Suisces

Prinary Comat: s Mk
Butirmen Proea:

Fae

P i

|
Figure 7-7:
The
Accounts
By Status
lists the
accounts as
current or
overdue.
I | Current Page Mo:l | Total Page Mo: 1+ Zoom Factor: 50%
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|
Figure 7-8:
You can
customize
your reports
within the
Filter tab of
the Modify
Report
dialog box.
|

3. From the Field drop-down list, select the field you want to use to filter
the records.

In this example, I use the Status field.
4. Select the condition to compare from the Comparison drop-down list.

I selected Equals to have the report find occurrences of the word
Overdue inside the Status field that I selected in Step 3.

5. Specify the word or information you want to compare by using the
Compare To text box.

In this example, I type the word Overdue. In Steps 3 through 5, I've asked
Outlook to find all Status fields that equal Overdue. You can combine
other fields with special conditions by using Steps 3 through 5. For
example, you can find all records that contain a rating of excellent or
good in the report By Rating.

6. Click OK.
The new report lists only the accounts you specified, as shown in
Figure 7-9.
Modify Report &
General | Flker | Headsr/Focter
Records
Select Accounts
Filb=ring criteria
Field: Comparison: Compare To:
Status 2 Equas w| |Overdue
v
Cear Al
| Help (s74 i [ Cancel ]

You can save BCM reports as Word documents (*.doc), Excel Workbooks
(*.xls), Web pages (*.htm), and Rich Text documents (*.rtf) to use according
to your needs. For example, using the Excel format allows you to work with
your data to create charts and other analyses. (See the section “Designing
BCM charts with Excel,” later in this chapter, for more information.
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|51 Accounts by Status EJ
File View Tools Action Help
H & * %= [Feowdh  [v| Sortby: |Accoun Name [w] T Pageift  [w] M b o) Modfy Repart Help
MainReport
-~
Accounts by Status
Overdue
| Anaconda’s Exquisitefood |
Primary Contact: Louis, Mary Saint Address: Riverroad Status: Overdue
Business Phone: 987-321-1234 3”':“ Lg'.'_'f' M rga?ea State: Active
Fa: a87-321-5432 e Stales o Rating:  Fair
Web site: hitp:hwwew aefoods_ com
|
Figure 7-9:
The Status
report now
shows
only the
accounts
that you
specify. v
I | Current Page Mo: ] Total Page Mo: 1 Zoom Factor; Page Width

Filtering the Opportunities Reports

Prospecting opportunities can bring surprises like a request for proposal ten
times larger than usual. To analyze the new opportunities, use the Modify
reports option to filter Opportunity by Product and Service.

With the Opportunity By Product And Service report open:

1. Click the Modify Report button and then click the Filter tab.
2. Select Total from the Field list box.
3. Select Greater Than from the Comparison list box.
4. Type the value in the Comparison text box.
In this case, I used $10,000.
5. Click OK.

The filtered report, showing opportunities higher than $10,000, appears
(see Figure 7-10). The report shows two top-priority opportunities that
can boost the company revenues more than expected.
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Figure 7-10:
The
Opportunity
By Product
And Service
report can
be filtered to
show orders
over
$10,000.

Oppor lities by oduct : DErvICce

[Tt

Agai

Al fresn Az #es Healty hices BulkOmer  Qusification 302007 50 1.500 518450000

Total rumiber: 1 Total revenue: $184,500.00

Passionfruit

Passionin@ Drink Chib Calertm Mot Soocks Stardard Prospecing 12007 50% L] $35.34500

Total rariber: 1 Total rrvenue: $35,045.00
rent Page Mo: 1 Total Page Mo: 1 Zoom Factor: Page Width

Using Views Rather than Reports

BCM offers two ways of delivering the same information. First, you have the
ready-made reports, as in the Opportunity report By Funnel . Next, you have
the view options, like the Opportunity view by Sales Stage. These two listing
strategies supply the same information and both can be used for reporting.
Comparing both figures, you notice the same information.

Using the Opportunity By Funnel report

The Opportunity By Funnel report gives you the number of accounts and
total value at each stage: Prospecting, Qualification, Need Analysis, Proposal/
Price Quote, Negotiating/Review, Closed Won, and Closed Lost. The
Opportunities View By Sales Stage also shows the closed orders stage but
doesn’t show the totals. Still, you can view the list, select it, and copy it to an
Excel file faster than using the report.

With the Opportunities list opens, choose By Sales Stage in the Navigation
Pane Current view. The Opportunities appears by sales stage in Figure 7-11.

You may find that using view options can be a great substitute for creating and
modifying any of the Outlook BCM reports. An already existing view option (or
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Figure 7-11:
The Oppor-
tunities list
view

By Sales
Stage looks
like the
Opportunity
funnel
report.
|

an easily modified one) may provide you with exactly the information you
need — and even be more detailed than similar reports. Because the view
options bring the information to the screen rather than to the printer, you can
copy the information from the screen to Word or Excel for printing. Before
using any report, explore the available views in the Current View window. The
Current View options provide listings like By Category, By Rating, and Quick
Accounts. If you need a quick view for a certain decision, changing the view
can be faster and easier than using reports.

[ Opportuniy ... |Linked To Sales Stage Expected Revenue | Probabiity  |Clse D...
=) Sales Stage: Closed Won (4 ibems)
- Guava and P... The Pupunha Restaurank Clased Won §536.57 100% Mon 5., |
-{3 Mew Fruit mizc Kiwi 4 us Clased Won §1,197.21 100% Mon 5/...
-ﬁ Passsionfrut.,. Computer Fruks Inc Clased Won $14,892.15 100°%% Mon 5/...
-fj Grapes Computer Fruits Inc Closed Won §15.84 1009 Sun 7/3...

=l =ales Stage: ProposalfPrice Quate {5 items)

-ﬁ Aople and ... The Pupunha Restaurant ProposaliPrice Quoke 40,00 0% Maon 5/...
-fj drangs Stick's Barbecue House ProposaliPrice Quote $320.76 75% Mon 5.
';’; Apples Joe D la Passion PropasaliPrice Quote $13.46 30 Thu Sf2...
5 Mew Passion.... Granny*s Flavour INC ProposaliPrice Quote $179.73 50% Mon 5/...
5’! Apple Season  Chili Calienke Hat Foods Praposal/Price Quote $151.19 S0f% Mon 5.

=l Sales Stage: Prospecting (3 kems)

-5 Grapes Spinach Healthy foods Prospecting $77.22 25% Mon (...
5’! Passionfruit ... Chili Caliente Hot Foods Praspecting $17,972.50 SO Fri 6f1]...
-_'_'} Banana Assal Healthy Juices Prospecting $80.85 3% Thudf4...

= Sales Stage: Qualfication (1 item

5’! Agaifrom A, Assal Healthy Juices Gualification 92, 250,00 S0 Wed 5.

Refining your views

The BCM reports aren’t so flexible as the BCM views to create new reports. |
use the BCM view to create my own reports, refine the data and collect the
information I need as in the following example.

When your company exists for several years, your database accumulates his-
tory. A view to list only the opportunities created or changed in the last 30
days is available. Adding different fields can supply information for a specific
time period, generating a concluding report:

1. With the Opportunities list open, select a view.

Selecting the Recently Modified view displays the opportunities created
or modified in the last 30 days. You can add the Source Of Leads field to
the same list if you like.

111



1 ’2 Part Il: Managing Contact Information

Figure 7-12:
Selecting
the Source
Of Lead field
to move into
the Recently
Modified
view.
|

2. Select Customize Current View in the Navigation Pane.
The Customize View (Recently Modified) appears.
3. Click the Fields button.
The Show Fields dialog box appears.
4. Select Forms on the Select Available Fields From drop-down list.
The Select Enterprise Form dialog box for this folder opens.
5. Double-click the Business Contact.
The Business Contact now is in the Selected Forms list box.
6. Click Close.

The Show Fields dialog box re-appears with the Business Contacts Entry

Form fields available to select more.

7. Select Business Contact in the Select Available Fields From drop-down

list.

8. Select the needed field from the Available Fields list (see Figure 7-12).

In this example, select the Source Of Lead field.

Show Fields %]

Mazimum number of lines in mulkiine mode: 2 | »

Select available fields Fram:

Business Conkack w

Arvallable felds: Shgw these Fields in this order:
Business State ~ Add - Icon

Business Status — Opporturity Titde

Crested By ParentDisplaylame

Do Mot Call Sales Stage

Da Mat Email Expected Revenus

Da Nat Fax Frobabilty

Da Mot Serd Letker NewFiekd..: | |3 e Date

Initiated By Modified

Modied By

MNewGUID

Parent Enkity EnkrylD
Pi d Method of Co

——

9. Click the Add button.
The Source Of Lead field is added to the view.

10. Organize the order of the fields in the Show These Fields In These
Order list box.
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Figure 7-13:
The
campaign
resultis
listed by
Source Of
Lead in the
last 30 days.
|

Selecting and moving them up or down according to the way you need,
the suggestion is always to keep the Source Of Lead and Modified fields
side by side to measure the current campaign and if you want the city to
work by territory.

11. Click OK and then Close.

The Recently Modified Business Contacts with the Source of Lead field is
available.

12. Click the new field column title to sort by type of lead.

In this case, click the Source Of Lead field. Now you can measure the
direct-mail campaign result from the last 30 days by Source Of Lead, as
shown in Figure 7-13.

Fortunately, you can customize any view in order to refine your reports. You
can use the Business Contacts, Accounts, and Opportunities lists to select
the best view to create your own report. Simply select the list and cut and
paste it into an Excel workbook to create your own reports. (See the next sec-
tion for more information.)

[C] Business Contacts - Microsoft Outlook BE=]|
i Eile Edit View Go Tools Actions Business Tools Help Type & question For help =
JadNew - | G323 X | ¥ B By | o Find | @) Tvee acortact tofind o ) @) |l
E.mail Autolink [# Link to Record | 8 & ¥ 2 | [@ 53] @ )
83 @Back & (A [3 3| 9§ & i o) [Recorttyodfied] o | =1 54 |8
fact Business Contacts !
My Contacts [ || Full Mame Com.... |Source of Lead | Modified Busine... |Mobile ... |E... B File As Ao |
[ O [ By Created By ] ln\ g Joe Newcormer Thu §f114... 1. Newcomer, Jos
O [ By Follow-up Flag €, v Maowel Smart  Sho... Advertisement  Wed 8/10/... (88)86... (68)65... 5... 8. Smart, Maxwel O,
. ) g Chap Tears Hurr... Advertisement  Tue S/%02... (002} ... €... 3. Tears, Chap Curr .
[ By Location ] g Pepeye Spinach Advertisement  Thuaf4/2... Spinach, Popeye 5., Curr..,
O [ Phone List ] 8 Joestick Advertisement  Wed 8/3/2... stick, Joe 5.0 OWELL
O [ Recently added ] g Joe De la Passion Pass... Advertisement  Sun 7f31)... 407-1.. 409-2.. 1. r. Passionfruk Inc  P... Cur..,
® [ Recently Modified Lg Jajo Camel Des... Direct Mai Thu Bj4/2... Camel, Jojo Curr...
e |G v NoshWithmee  Risk .. Direct Ml wed B/3/2... (954) ... f... 3. Wikhmes, Nosh e,
Open Shared Contacts lg Joe Dela Passi... Direck Mai ‘Wed 8/3/2... Passion, Joe Dela P... Curr...
Custormize CLrrent Vie Lg Redie Redford Direck Mai wed B/3f2... Redford, Redie  G... Curr...
[v|l@  Carlos Wassbi Diect Mal Wed 8/3f2... Wasabi, Catlos  C.., Curr,.,
4 Mail Pauil Paim Pup... Direct Mai Thugjiif... 1233, &. Palm, Paul T.. Cor..
- g Joe Shooster  Fire.., Employes Referral Wed 8/3/2... (12)12.. 5... 1. Shooeter, Jog CUrr,.,
:ﬁ Calendar g Mary Saint Louis MSL ... External Referral Wed 8/10/... 321-1.., 2. Louis, Mary Saint &, Curr..,
g Mark Eteer Me=... External Referral ‘Wed 8/3[2... {957} ... ... 1. Eteer, Mark, Curr,
§_=.l Contacts 9, v Mark Goodday Public Relations  Thu 8/114..., 6. Goodday, Mark  Ki.., Curr..,
52] Tas} g ¥ Mrs. Jane Mefi,.. Mes... Seminar Wed 8/3/2... (407} ... joo 1. Mefist, Jane Curt...
\— g Rose Mo Crange Trade Show Wed 8132, Me Orange, Rose C... Ove...
:J Notes € JosMustes Assal Trads Show wed 8/3[2.,. 2345, 234-1.. Jos Musdes A i
| a7
Fiker Applied 19 Items
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Is BCM for you?

Because | worked for years with Outlook, build- .~ What are the most valuable reports in BCM

ing my own reports by importing and exporting that were previously not available? The
data to coordinate sales and marketing activi- Opportunities reports help you list and track
ties, | wanted to evaluate what BCM reports can all potential sales in several ways. You can
do for users. Two major questions came out: track how many requests you have for each

product or list the opportunities according to
forecast dates, thus allowing you to work on
your priorities, like orders that are ready for
closing. The Source of Leads report helps
you measure the Return on Investment (ROI)
for each marketing action you take.

v+ What kind of audience can get the most of
the reports? Small businesses that deal
with relatively few accounts and who need
to manage customers in a few printed
pages get the most out of BCM reports.

Working with BCM Reports in Excel

Collecting BCM report data as an Excel file enables you to extract and work
with the information according to your needs, including transforming the
numbers into charts for a better understanding of your business. Likewise, if
you choose to copy data from views (as described in the previous section),
you can use the Excel instructions in this section to manipulate the data after
copying it into Excel.

Saving reports as Excel files

You can save the BCM reports as an Excel workbook file, which can help you
refine the information and make calculations for your own business. To save
any report as an Excel file:
1. With any BCM report open, click Filez>Save As.
The Save As dialog box appears.
2. Type the name of the file in the Name text box.
3. Select Excel workbook (*.xls) in the Save As text box.

4. Click Save.

Designing BCM charts with Excel

An image can be instantly understood with no questions at all. A table of
numbers needs to be read, understood, and clarified. Using charts, you have



Chapter 7: Working with BCM Reports

|
Figure 7-14:
The
Opportunity
by Product
report can
be exported
to an Excel
workbook.
|

A\

a self-explanatory image for results or trends. You can save BCM data as
reports or views into an Excel file and then turn them into charts.

To create an Excel chart:

1. Open your saved Excel file.
2. Select the data to fit into the chart.

In this example, I adjust two columns, Product and Value (see Figure 7-14).

 File Edit View Insert Format Tools Data Window Help
NG ARSI VRIS DB S| 82-B]EE D - @
=4] Opportunity by product =g
| A 8l ¢ T ol ETF el HT 1T T3] K[L[M[NIOG]
? Apple $392.08
| 5 |Banana $245.00
|10 |Grapes $617.76
| 11 |orange $427.68
|12 |Passion $359.451
3. To draw a column chart, click the Chart Wizard button.
The Chart Wizard begins (see Figure 7-15).
4. Select Column from the Chart Type in the Standards Types tab area
and then click Next.

If you want to create a different type of chart, you can choose it now
from the chart type list.

The next wizard page appears, showing the chart model.
5. Click Next.

The wizard now lets you enter a title for the chart and names for the
axes.

6. Type a title in the Chart Title text box.

For example, you could use Opportunity By Product.
7. Type a name for the Category (x) Axis.

For example, try Product Items.
8. Type a name for the Category (y) Axis.

For example, you can use the axis Value $.

9. Click Next.

The fourth step of the wizard begins. You can save the chart within the
current file or as a new file.
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10. Select As A New Sheet in the Place Chart option.

11. Type a filename in the text box to save the new file.
12. Click Finish.

The chart opens, as shown in Figure 7-16.
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Chapter 7: Working with BCM Reports

BCM integration

BCM integrates with the Microsoft Accounting
2006 database. To integrate, click Business Toals,
click Accounting Tools, click Set Up Connection
To Accounting, and then follow the wizard.

Business Services — like publishing newslet-
ters, creating product announcements, manag-
ing marketing campaigns, developing e-mail
campaigns, and tracking and managing lists —
are all available on the Microsoft Small Business
Web site. To evaluate them, click Business Tools
and then click Business Services to be driven to
the Business Services home page.

E-mail marketing, integrated with the Microsoft
Listbuilder service, is also available. To order,
click Business Tools and then click Email mar-
keting, and you will be driven to their site.

You can import to and export information from
other products by using the Business Data
Import And Export Wizard. To use it, click Filec>
Import/Export and follow the wizard. Importing
from QuickBooks and ACT! is also possible, as
is exporting to CSV or BCM database formats.

By analyzing your BCM reports, you can create marketing programs or busi-
ness communications without any problem. You can use third-party services
or use Outlook automation to broadcast messages from your desktop to spe-
cific groups. Read Chapter 16 for step-by-step instructions on these and other

marketing procedures.

117



1 78 Part Il: Managing Contact Information




Part Il

Handling
Communication
and Collaboration

The Sth Wave By Rich Tennant
Ry

G

i
- ﬁ{ 71 G B
., S
.,/’/// 4 2] >
N b
o —/_‘ [I]
4
e~ =
w RS
o
o -
. N N
= VT NN o

“TY’s just until we install Outlook 2003.”



In this part . . .

Driving a car in rush hour without a driver’s license or
knowledge of the traffic rules would be a mess. So
are many people’s e-mail Inboxes. Understanding why you
send and receive e-mails, including understanding other
people’s behaviors (when sending jokes or marketing
messages), enables you to detect and avoid unwanted
e-mail and then use Outlook’s rules and folders to elimi-
nate them. Your Inbox is a tollgate, not a message parking
lot. You can discover the Zen of mailbox management so
that you can close your message parking lot and then hire
the e-nanny (to organize your mailbox) and the e-office
cleaner (to keep your deleted items box clean).

Coaching and supervising a team can be a lot easier when
you use Outlook’s collaborative tools. You can request
tasks and send invitations (answered by clicking the
Accept button) to create stronger commitments than
when using regular e-mail messages. Don’t waste your
time in long and unplanned meetings anymore. Find out
how to plan a meeting and invite people using Outlook’s
meeting invitation. Traveling and mobility today means
connectivity. You can create a few procedures to evaluate
your remote access abroad and then increase your secu-
rity by carrying and protecting your information in exter-
nal environments.




Chapter 8
Surfing Over the E-mail High Tide

In this Chapter

Responding to e-mails

Cutting down on e-mails
Creating folders and rules

Mastering the Zen of e-mail management

Slddenly, like a nightmare, you are drowning in an endless e-mail tide in a
sea of senseless messages. People at your side are sending good evening
messages by e-mail rather than talking. Personal marketing messages arrive

at an alarming rate. You have 25 separate “requests for answer.” It is enough

to make you lose track of everything. How do you get rid of it all and wake up
from this nightmare?

Understanding Why People Send
Messages (And How to Respond
to Them)

Consider two important skills for any competitive surfer: observation and
practice. The surfing champion spends a month on the beach observing the
ocean, getting a good sense of its tidal cycles. Each day, two high tides occur,
arriving about an hour later than they did the previous day. Observing your
Inbox content over time helps you understand the tides in your sea of e-mail
and even take actions to keep tsunamis from coming into your Inbox bay,
transforming your Inbox into a dreamer’s paradise.

Separating the wheat from the chaff

Written communication has been around since the Stone Age, with cave
drawings from human ancestors trying to tell their stories. One or two
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members of the community had the drawing skills. Today, millions of people
are writing and reading quickly with the assistance of computers. What
makes people read and write e-mail messages? What is important or
unimportant for each individual?

Distinguishing the wanted from the unwanted, the valuable from the rela-
tively valueless, is what our ancestors did in their ancient agricultural prac-
tices or what a surfer does today when choosing which wave to ride. Looking
at your Inbox with thousands of e-mails parked in it is a waste of time and
distracts you from your priorities. You can split the Inbox content among
desired and undesired messages, personalities, feelings, and needs.

The lack of communication rules can generate nonsense messages. In the pro-
fessional environment, we use e-mail to send and receive information, propos-
als, invitations, Tasks lists, and so on. Besides unwanted spamming messages,
we receive unsolicited jokes; spiritual, religious, and personal marketing; and
even answers sliced into 20 different messages. If you understand what is
important to you as well as people’s behaviors and Outlook rules, you're able
to detect and avoid unwanted messages even before they’re written to you.

Unsolicited messages are different than unwanted messages. You can detect
and remove unsolicited messages by using anti-spam filters, but unwanted
messages from your own pool of contacts can be eliminated before anyone
even writes them (see the next section).

You can also adopt several parameters to scan e-mails and classify them
according to their content. You can then automate Outlook by using rules
and automatically organize your wanted messages or eliminate the unwanted
ones.

Dealing with unwanted e-mails

Unwanted e-mails come in two forms: unsolicited junk messages and incon-
venient social behaviors from friends, workmates, and acquaintances. You
can greatly reduce junk mails by turning on Outlook filters (for details, see
Chapter 9), but changing a social behavior requires that you adjust your
environment and use a little psychology.

Identifying behaviors and requesting behavioral changes when appropriate is
a major step in surfing over the e-mail high tide. When you point out a behav-
ior, people think twice about repeating it.
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Following are some behaviors you may encounter:

v Copy maniac: Messages where your name appears on the cc or bcc line
aren’t for your direct action, right? So why do they keep arriving at your
Inbox, interrupting your actions? You can use Outlook rules to route
these e-mails to a new folder called cc, removing them from your sight.
You can then go through the folder at your convenience. A simple analy-
sis of a week’s worth of these stored cc messages (organized by sender
or by title) can reveal excessive unwanted messages coming from the
same source. You can then identify behavior patterns in your colleagues
and eliminate these behaviors before more messages make their way to
your Inbox. (See the sidebar “Working with a cc folder” for more tips.)

P A boss or any person sending a meeting invitation should do so by using
the Calendar invitation features rather than a simple cc e-mail. Meeting
invitations create commitment upon accepting them. (Read Chapter 10
for more details.)

v~ Personal marketer: Mark Eteer needs to send daily messages advising
you of how good he is and how fine a job he’s doing. People moan about
the number of e-mails generated, but don’t know how to solve the prob-
lem. You can use rules to move any Mark Eteer messages out of the
Inbox and into a special folder. Showing Mark his folder with 25 mes-
sages in four days may make him conscious of his behavior and cause
him to think twice before he sends any new marketing messages.

v Procrastinator: Noko Mitment is a procrastinator, always explaining why
his work isn’t ready. Instead of reading ten excuses or schedule adjust-
ments, detect the behavior by using Outlook rules. The rules, used to
separate Noko’s messages from the rest, let you show Noko his own
behavior and help you work as a team to avoid future procrastination.

v Reliever: Cherie Hart is a very sensitive person and sends many advice
messages, tips for a better life and a better world, sunsets, angels, and
so on. Outlook rules help you detect the behavior and perhaps make it
easier to request that she keep it down to one “save the planet” message
a month.

v Joker: A smile to break up the day is welcome but ten jokes a day? Call
Batman to fight your Joker enemy or eliminate his messages by using
Outlook rules.

+* Demander: | want this information now! Why haven’t you answered me?
Did you accomplish my request? When will the job be ready? All these
questions reflect poor timing and prioritizing compatibility between two
people. Understanding a person’s anxiety and the way he or she works
helps shrink the demand to its real size.
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v Soap star: Mary Slicer is an anxious human being, and she sends mes-
sages at every step of the job. You can isolate her behavior by using
Outlook rules, show her the results, and ask her to keep her messages
down to information about key milestones in her project with no step-

by-step messages.

v Hypervisor: Howis Disnow is an anxious manager demanding status
reports and sending messages every minute, interrupting your work. If
you share your Outlook Tasks list with him, he becomes aware of your
working priorities and progress without the need for repeated status

reports, increasing your productivity with no stress. To share your Tasks

list with someone, you should use the sharing folder properties if con-
nected to an Exchange server, or you can publish your Tasks list on a
server. (Read more about your Tasks list in Chapter 10.).

Working with a cc folder

If you create a folder for all the e-mails you're
copied on, you can sort it by sender to help you
identify different behaviors among your cowork-
ers. Analyze each sender’s mail, and you notice
his or her behavior, which makes it possible for
you to show them new skills for improving their
communication by using fewer messages.

Here are a few solutions based on the content
you find in your cc folder:

E-mail problem with an individual: Create a
folder with the name of the person and apply a
rule like, “E-mails arriving from John@Smith.com
move to Smith folder.” Later, show the person the
unnecessary energy spent with his or her mes-
sages. Use this same technique for other behav-
ior patterns.

Company culture promotes an excess of e-mails:
Make a presentation to your team showing it the
meaningless e-mails. By unmasking the issue,
you create the power to eliminate it. Create a
campaign, “Less e-mail means more productiv-
ity,” using cartoons of the common behaviors
identified.

News and other information: Create a News
folder and create a rule to send all newsletters
to the News folder. Read items in this folder
when you have extra time.

Reports: Create a Reports folder with a rule that
sends all arriving reports to the special folder.
You can create a rule that looks for certain
senders or certain words in the subject (like the
word report).

Reflections and jokes: Why do people keep
sending this stuff? Probably because nobody
tracked the problem, measured it, and asked
them to stop. People who send regular jokes and
advice think they're sending a smile or a feeling
from the heart. Sometimes this is true, butin gen-
eral, ten jokes a day is more a cause for crying
than for smiling. Fifteen pieces of advice a day
makes anyone angry. Telling people about it can
solve the problem. Otherwise, you can keep
using the special folder with the person’s name
on it along with the Qutlook rule to reroute their
messages into the folder. If you're still receiving
ten jokes a day, separate them and block them
by using rules.
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You probably also receive other unwanted messages and junk messages. You
can isolate any message constantly sent by using Outlook rules. Avoiding it is
usually a simple matter of revealing the behavior pattern to the person send-
ing you the messages. You can also use Outlook’s junk e-mail filter to elimi-
nate unsolicited messages. (For details, see chapter 9.)

P Using Outlook rules and creating new folders can enable you to detect, ana-
lyze, and eliminate messages before they're written, thus changing unwanted
behaviors. When a behavior is caught and exposed, the sender knows the
behavior isn’t welcome any longer and the environment itself helps eliminate
those e-mails. In the upcoming section “Using Rules to Eliminate E-mails,” you
discover how to create new folders and use Outlook rules to drive messages
straight into them.

Classifying wanted messages

You can classify desired messages according to the action needed:

v No answer required: Newsletters, informative e-mails, newsgroup
e-mails, and so on are messages that don’t demand an answer. You can
have Outlook rules file them for you in a folder called something like
News, Info, Suppliers Info, and so on. Open and read these e-mails at
your convenience.

v Action required now: Answer now before you receive a “Where is my
answer?” message. Send a response even if you don’t have the complete
answer. A response stating “I'll get back to you with an answer within 48
hours” can help eliminate follow-up messages from the sender.

v Actions required later: Although every e-mail message has a follow-up
flag with a pop-up alarm reminding you to complete the action, I prefer
to transform any pending-action e-mails into Tasks by dragging and
dropping them into the Tasks list. The Tasks list is the best checkpoint
for to-do items. To read more about using Tasks and e-mail, see “The
Zen of Inbox Management,” later in this chapter.

Introducing Outlook Rules

Can you imagine what traffic would be like today with no rules and no driver’s
licenses? At the beginning of the 20th century, automobiles were a new tech-
nology for a happy few. There were no traffic jams and few rules. No driver’s
licenses were needed, and few accidents happened. After a few years, cars
became popular and soon obstructed the available roads until modern high-
ways were built.
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The same is happening with electronic messages; your Inbox today looks like
a Disney parking lot avalanche during summer holidays. To manage e-mail
traffic, you have to use the same techniques used for cars: Create rules and
develop your driving and navigating skills.

Thankfully, the Outlook Rules Wizard is a powerful tool for eliminating prob-
lem e-mails. Using rules, you can apply your own criteria to move or block
e-mails and set up alarms that help you surf the e-mail high tide.

Beginning to organize your e-mails

When you first start to organize e-mails, I always suggest keeping on top of
the Inbox by using the Ways To Organize Inbox dialog box. This shortcut lets
you start a rule or open a new folder in one click instead of repeatedly choos-
ing the Tools command and following a menu sequence over and over. The
Ways To Organize Inbox dialog box provides helpful shortcuts for selecting
e-mails and taking actions on them one by one. It also contains a button for
creating new folders.

To open the Ways To Organize Inbox dialog box, simply choose Tools=>
Organize. The Ways To Organize Inbox dialog box appears at the top of
your current mailbox, as shown in Figure 8-1.

| x

Move message selected below to | Inbox W || Move
143 Using Falders

Alternatively, you can use the Rules Wizard to manage groups of messages by
using characteristics like sender, keywords in the Subject line, and so on.
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Using rules to eliminate e-mails

Some e-mails, such as the ones you're copied on, don’t require action and
aren’t urgent. Because you don’t need to read them as they arrive, you can
remove them from your Inbox and send them directly to a folder that you
name. You can then access these e-mails at your convenience.

There are two steps to this procedure: First, you create a folder, and then you
create a rule for filing these messages into the new folder the moment they
arrive.

Creating a folder
To create a folder:

1. Click the New Folder tab at top right of the Ways To Organize Inbox
dialog box.

If you don’t see the Ways To Organize Inbox dialog box, refer to the sec-
tion “Beginning to organize your e-mails,” earlier in this chapter.

The Create New Folder dialog box appears, as shown in Figure 8-2.

Create New Folder

Mame:

[an

Folder contains:

Mail and Post Trems v

Select where ko place the folder:

= ‘E:;ﬁ' Personal Folders s
_j.:f] Calendar

fi=| Contacts

5] Deleted Items
L7 Drafts [4]
L] Inbioz

S8 Journal

L@ Junk E-mail
o | Motes

L4 Cuthoe

U4 Sent Trems

s

[ QK ] [ Cancel

2. In the Name text box, type the name of your folder.

For example, I typed cc for a folder that contains all the e-mail messages
I've been copied on.
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3. Make sure that Inbox is highlighted in the Select Where To Place The
Folder list.

4. Click OK.

Your new folder is ready.

Creating an e-mail rule

After you have a folder ready (see preceding section), you can create a rule
that screens every arriving message and files your message in the appropri-
ate folder.

For example, say that you wanted to automatically archive messages copied
to you. This rule gives Outlook an order: Check arriving e-mails, and when
your address is not on the To list, file the message in a cc folder. (For more
on managing a cc folder, see the sidebar “Working with a cc folder.”)

To create a rule:
1. Click the Rules And Alerts tab on top right of the Ways To Organize

Inbox dialog box.

If you don’t see the Ways To Organize Inbox dialog box, refer to the sec-
tion “Beginning to organize your e-mails,” earlier in this chapter.

The Rules And Alerts dialog box, shown in Figure 8-3, appears.

Rules and Alerts 2[%]
E-mail RUes | panags Merts

5 Mews Rude... Change R - py... | 24 Delete | 2un Rules Mow,.. Options

Rule {applied in the order shown) Actions
Select the "New Rule" button to make a rule,

Rule description (chok an underlined value to edt):

2. Click the New Rule button.

The Rules Wizard appears, as shown in Figure 8-4.
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3. Select Start Creating A Rule From A Template.
4. Select Move Message From Someone To A Folder in Step 1.
5. Click Move To The Specified Folder in Step 2.
The Choose A Folder dialog box opens.
6. Choose the folder you want to move the message to and click OK.
7. Click Next.

The next dialog box, shown in Figure 8-5, allows you to choose a
condition.

Rules Wizard &

(%) Start creating a rule from a template
() Start From a blank rule

Step 1: Select a template
Stay Organized
"} Move messages from somecne to a Foldsr
L} Move messages with specific words in the subject ko a Folder
L5 Move messages senk ko a distribution list to a Falder
X Delete a conversation
¥ Flag messages from someons with a colored flag
Stay Up to Date
S Display mal from someone in the New Ttem Alert Window
il Py a sound when 1 get messages from someore
! Send an alert ko my mobie device when I get messages from someane

Step 2! Edit the rule description (click an underlined value)
Apply this rule after the message arrives
Fram people or dstrbution list
o i o the speciied folder

Example: Move mail from my manager to my High Importance folder

==

8. Select the condition you want and click Next.

For example, if you want to move all e-mails that you’re cc’d on to a
folder, select Where My Name Is Not In The To Box.

9. In the next dialog box, select the action that you want and click the
Next button.

For example, if you want to move the e-mail to a certain folder, select
Move It To The Specified Folder.

When you click the Next button, the Are There Any Exceptions? dialog
box appears.
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10. Click Next if you don’t have any exceptions.

The Finish Rule Setup dialog box appears, as shown in Figure 8-6. Outlook
automatically inserts a name for you in the Step 1: Specify A Name box.

11. Accept the name Outlook suggests or type a new one.

12. Choose Run This Rule Now On Messages Already In “Inbox” if you
already have a lot of cc messages in your Inbox; if you don’t, skip to
Step 13.

Rules Wizard &
Firish rule setup.

Step 1: Specify a name For this rule
whese my name is nok in the To box

Step 21 Sebup rule options
[_]Run this rule now on messages aleady in “Personal Folders"

[] Turmn on this s

Step 3: Review ruke description (dick an underined value bo edit)

Apply this rule after the message arrives
where my name is not in the To box

and on this machine anly
maove i to the oo Folder

(o) Cema )
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This option applies the new rule to all existing messages in your Inbox.

13. Make sure that the Turn On This Rule option is checked and click
Finish.

Figure 8-7 shows a sample rule setup.

Rules and Alerts (B[]
E-mail RUes | panags Merts
% New Rule... Change Rule = S3Copy.. #X Delets | Bun Rules Now... Options
| Rule {applied in the order shown) Actions
where my name is not in the To bos L L
I
Rule description (chok an underlined value to edt):
Figure 8_7: Apply this rule after the message arrives
where my name is nok in the To box
The Rules move it b the oo Folder
And Alerts
list shows
the new
rule.
Ok | [ Carecel | [ Apply
I

Attaching previous messages

An industrial site manager complained to me about how much time he was
wasting reading messages that go back and forth many times. He has to read
from the last to the first message to understand the whole picture and solve
the problem.

To avoid confusing back-and-forth messages, configure your e-mail system to
reply with the prior message attached instead of being at the end of the mes-
sage text. To be more effective, this practice should be taught to the whole
team as a company rule.

To configure Outlook to automatically attach previous messages when you
reply to them is easy. Here’s how:
1. Choose Tools=>Options.
The Options dialog box appears.
2. Click the E-Mail Options button.

3. Select Attach Original Message from the When Replying To A Message
drop-down list, as shown in Figure 8-8.
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4. Click OK.

The dialog box closes.
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The Zen of Inbox Management

The Zen of Inbox management is a set of rules that lets you finish the day
with no e-mails parked in your Inbox. To achieve this goal, follow the path to
Inbox bliss:

v Think of your Inbox as a tollgate and not a parking lot. Every message
that arrives should be read and an action taken to reply, move, or
delete it.

v Remember the John Wayne rule: If the sender is unknown, delete first
and ask no questions. Don’t be distracted by what’s on the Subject line.

v Read the e-mail now, answer it, and then move it to the appropriate
folder or delete it.

v Reply immediately to all messages that require short answers and then
delete the original message and file your reply if desired.

v For requests that you can’t answer immediately, reply by informing the
sender that you’ll get back to them when you have a full answer. Drag
and drop the requested message to become a new Task.

v Don’t keep any message overnight in the Inbox. The Inbox is a tollgate,
and long-term parking is prohibited. Four exit lanes are available for
your message: delete, answer now, move to file, or drag and drop to
become a Task.
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For messages that require more than the current day to answer, drag and
drop them to your Tasks list. Set up the Reminder to schedule your time to
work on each Task. Having all your pending actions in one list helps you
establish priorities. You can see an e-mail dragged and dropped into the
Tasks list in Figure 8-9. (Read more on this topic in Chapter 10.)

Task | Detals
Subject: customes request #121
Due dake: Thu 4/21 /2005 w | Status: Mot Started ~
Stark date: Th #{14/2005 v | priovity; hormal || % Completer 0% =
[“lReminder: | Thu 4/21/2005 v| monaM [ OWner: | Marcelo Thalenberc

Dear Marcelo,
Flease quote the logistic and schedule to ship the Heavy weight generator from Takwan

Diagram and details on the attachment document.
"

o Cotome pvats ]

The Art of Sending Messages

Sending messages means paying attention to the other individual. It means
thinking about his ability to receive and understand your message and writ-
ing in a way that satisfies the reader while communicating your message.
Who is your recipient? How should you write to get and keep your recipient’s
attention?

v Explain the objective of your message in the subject line.

v Summarize the objective of the message at the beginning. If it’s long,
explain it step by step.

v Inform the recipient of any due dates.
v Before copying anyone, ask yourself why this person needs a copy.

v Attach the sender’s message when replying to it. Avoid long, drawn-out
e-mail conversations.

v Use the telephone to clarify doubts instead of starting an inglorious
e-mail battle.

v Revise the message again before pressing the Send button. Keep the fol-
lowing question in mind: Will the reader understand the meaning of this
e-mail?
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v Use Tasks rather than e-mails to request actions from people in your
company. The Tasks requests increase commitment when coworkers
receive and accept the Tasks. Read more on using Tasks in Chapter 10.

v Use the Invite attendees feature in the Calendar to schedule a meeting

instead of writing and sending e-mail invitations. (Read more on this fea-
ture in Chapter 10.)

v Request a read receipt for a message instead of calling the person to
confirm that the message arrived (or worse, sending an e-mail to con-
firm the arrival of the other e-mail). In the e-mail form, click the Options
button, and in the Options dialog box, select Request A Read Receipt For
This Message.

Working in sales or any business associated with emergencies, you must be
online full time and check your e-mail constantly. But for most other profes-
sions, you can probably open your Inbox every couple of hours or once in
the morning and once in the afternoon. Think about working offline and read-
ing the e-mails according to your business cycle with fewer interruptions.



Chapter 9
Managing E-Mail Cleanup

In this Chapter
Eliminating garbage
Taking the anti-plague medicine
Organizing the mailbox fast

Eliminating fraud

Oeaning up your house is not only about removing the dust, scrubbing
the bathrooms, or washing your dishes; it’s also about organizing your
closets and disposing of items not needed anymore. Imagine a cup of yogurt
open for more than a year in your refrigerator. It would smell pretty awful!

A computer without file organization and proper cleanup can be worse than
a refrigerator full of old food; the odor is terrible, and it’s awful to clean and
organize again. Keeping your mailbox clean and organized is easier than
you think when you apply the following concepts and rules outlined in this
chapter.

Eliminating Trash

Before throwing old or unused stuff into the garbage or selling it in a garage
sale, you have to organize and evaluate what you’re dealing with. The same is
true with your computer but with one major advantage: You can use Outlook
tools to help you organize the information and create an automatic disposal
system for you.

Filing valuable information

Many people create folders for each customer or supplier and file all mes-
sages exchanged into the folder for archival purposes, which makes for
some very large folders. If you receive an e-mail and answer it, then filing the
sent message (your reply) means you're filing the original message and the
answer all in one message. You can therefore delete the original message.
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You can use rules to move sent messages into appropriate customer folders
instead of storing them in the Sent Items folder. This technique creates an
automatic archival system without unnecessary e-mails taking up space.
(Read Chapter 8 about using rules to eliminate e-mails by sending them to a
specified folder.)

Stomping out junk e-mail,
the computer plague

Hollywood directors often create terror films with plagues of cockroaches,
bees, and locusts. The junk-mail plague is almost as disruptive. Internet
providers often use strong firewalls to fight this hazard, but Outlook has
some junk-mail options of its own. For example, you can keep a list of
recipients to block and place senders or their domains on the list in just

a few clicks. You can also use Outlook’s adjustable junk-mail filter.

Outlook has three main lists for managing incoming e-mail:
v~ Blocked Senders list: People or domains from whom you don’t want to

receive any message.

1 Safe Senders list: People or domains from whom you want to receive
any kind of message.

v~ Safe Recipients list: People you're sending messages to now and want to
receive their answers.

You can use these three lists to eliminate a good portion of your incoming
e-mails and focus on important messages.

Blocking junk mail

To block a person or domain from getting an e-mail to your Inbox, follow
these steps:
1. Select the sender’s message in your mailbox.
The sender message is highlighted.
2. Choose Actions=>Junk E-Mail=>Add Sender to Blocked Sender List.

You’ve now notified Outlook that this sender is not welcome in your
Inbox, and Outlook will move all his messages to the Junk E-mail box.

Setting up your Safe Senders list

Add all e-mail addresses in your Contacts folder into the Safe Senders list
when setting the filter for Safe Lists Only. To do so:
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. Choose Actions=>Junk E-Mail=>Junk E-Mail Options.

The Junk E-Mail Options box appears.

. Click the Safe Senders tab.

The Safe Senders dialog box appears with a permission list of e-mail
addresses to be received by you. Add selected names to this list. This
list works only when selecting the Safe Lists Only in the Junk mail filter
to route all other e-mails to the junk mailbox.

. Select the Also Trust E-Mail From My Contacts check box.

After you select this option, you don’t see Contact e-mail addresses in
the list. However, the Junk E-mail Filter allows all e-mail addresses in
your Contacts folder to pass through to your Inbox.

. Click Add to add one e-mail or domain in your Safe Sender list.

The Add Address Or Domain dialog box appears.

. Type the e-mail address, such as name@example.com, @example.com

or example.com.

The two latter examples allow e-mail addresses for an entire domain to
contact you, while the first example specifies a single individual.

Click OK to add the name to your list.

Setting your filter options

Part of the security and productivity of your e-mail messages is under your
control. You can use no e-mail filter at all or apply a higher level of security,
such as allowing only those listed in the safe senders list to get messages into
your Inbox.

1.

Choose Actions=>Junk E-Mail=>Junk E-Mail Options.

The Junk e-mail filter options appear. Clicking the tabs Safe Senders, Safe
Recipients, and Blocked Senders display their respective mail lists,
enabling you to add or remove any address or domain.

. Click the Options tab to see the filtering levels.

The junk e-mail filter has five levels that move incoming junk-mail mes-
sages to the junk-mail folder until they’re deleted.

. Change the level of junk e-mail protection according to your needs.

I suggest the low filter option day by day, but sometimes the junk-mail
tide becomes a tsunami. If it does, change your filter to Permanently
Delete Suspected Junk E-Mail until it’s over.
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Helping you out: The e-nanny

When you were a baby, no matter what kind of mess you made, your mom,
granny, or nanny would clean and organize it for you. Outlook 2003 has an
Organize tool that works like an e-nanny, cleaning out your excess e-mails.

To call your e-nanny, simply choose Tools>Mailbox Cleanup. The Mailbox
cleanup, like a nanny, cleans the living room instantly but does not generate
daily or weekly cleaning routines. The Mailbox Cleanup dialog box, shown in
Figure 9-1, provides a convenient set of options that help you organize your
e-mail folders immediately:

v View Mailbox Size button: Click this button to see the size of each
folder.

v~ The Find button: Lets you set values for older than or larger than mes-
sages to look for and delete.

v AutoArchive button: Click this option to transfer older files to your
Archive file. (See the section “Automatically archiving old messages,”
later in this chapter, to find out move about the Archive file.)

v Deleted items options: Choose View Deleted Items Size to explore the
items you have previously deleted or choose Empty to clean them out
forever.

Mailbox Cleanup %]

"% You can use this kool ko manage the size of your mailbox.

N . .

“~  You can Find types of iters to delete or move, empty the deleted
kems folder, ar you can have Outaok transfer ibems to an archive
file.

iew Mailboo: Size. .

B« (OFinditems olderthan  op 2 days Find...

(@Finditems larger than | 250 |2 kilobytes

L Clicking Autasrchive will mave old ikems bo the
g archive file an this camputer, You can find fuindichive,

these kems under Archive Folders in the folder

I sk,
Figure 9-1: @ SEzgrggscem:d items Folder permanenthy Empty
The C|eanup [ view Deleted Items Size...
options
-
are your e
personal
e-nanny.
I

Maintaining with the e-office cleaner

If you work in an office, you know that after working hours, the cleanup team
cleans the office and performs its maintenance on a regular basis. Likewise,
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the e-office cleaner can automatically empty your basket (deleted items
folder) on a set schedule. It can also store your older items in the archive
folder, and it never misses a due date.

Emptying your deleted items trash

To put the e-office cleaner to work and automatically empty your deleted
items trash:

1. Choose Tools~>Options.
The Options dialog box appears.
2. Click the Other tab.
The e-Office Cleaner options appear.
3. Select Empty The Deleted Items Folder Upon Exiting.

Now, every time you exit Outlook, the e-office cleaner empties your
trash folder.

Automatically archiving old messages

You can store your old messages (over x days) in the Archive folder provided
by Outlook, making your current Outlook folder much lighter. The Archive
Folder is a second Outlook folder stored on your computer that you can open
at any time to access old data. You’ll have the Outlook.pst file as your work-
ing file and the Archive.pst file holding your old data.

Setting up the AutoArchive saves time and organizes your older items for
easy retrieval. To set up AutoArchive:

1. Choose Tools=>Options.

The Options dialog box appears.
2. Click the Other tab.
3. Click the AutoArchive button.

The AutoArchive dialog box appears, as shown in Figure 9-2. It can prompt
you at a specified number of days to transfer your older but needed files
from the Outlook folder to your Archive folder, making your daily Outlook
folder smaller and less encumbered. You can archive messages from all
your mailboxes or select only your Inbox, and even delete messages over
a certain age, such as 6 or 12 months.

You can tell AutoArchive to prompt you every so often (every 60 days,
for example) before it performs its function.
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AutoArchive %]

[l Run dutodrchive every 14 2 days
[] Prompt before Autodrchive runs
During Autcdrchive:
|| Delete expired items {e-mai Foldars onity)
[¥] awrchitve or delete old items

I o the folder and choose Froperties, then go to the
. Autodrchive tab,
Flgure 9-2: || Retention policy
- 19 The network admiristrator has nok set retention policies.
The Au_to &
Archive
setup.
P

|

[] show architve Folder in Folder list
Default Falder settings For archiving

Clean out kems older than |6 |2 Morehs |
(%) Mave old items to:

CriDocumerts and Sstbings\daisy| Corfiguragd Erowse...

) Permanently delete old ibams

| Apply these sstbings to all Folders now |

Tao spedfy dfferent archive settings For amy Folder, right-chck

. Enter the desired number into the Run AutoArchive Every XX Days

option.

So if you want AutoArchive to run every 60 days, type 60. Before
autoarchiving on a regular cycle, Outlook can prompt you for your go-
ahead.

. Click to place a check mark next to the second line, Prompt Before

AutoArchive Runs.

You also have the following setup options during autoarchive.

. Select Delete Expired Items (E-Mail Folders Only) according to your

needs.

Selecting Archive Or Delete Old Item displays two more options. The
Show Archive Folder In Folder List option displays the Archive folder
inside Outlook, and the Clean Out Items Older Than XX option sets at
what age items will be removed.

. Click OK.

Avoiding Fraud: Never Send
Personal Data by E-Mail

Phishing attacks use both social engineering and technical subterfuge to
steal consumers’ personal identity and financial account information. Social-
engineering schemes use spoofed e-mails that lead consumers to counterfeit
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Web sites designed to trick them into divulging financial data such as credit-
card numbers, account usernames, passwords, and Social Security numbers.
Hijacking logos and brand names of banks, e-retailers, and credit-card
companies, phishers often trick recipients into responding. To find out

more about the subject, visit the Anti-Phishing Working Group site at
www.antiphishing.org.

To avoid phishing scams:

v Be suspicious of any e-mail with urgent requests for personal financial
information.

v Don’t believe e-mails directed at you from unexpected sources. Phishers
typically include upsetting or exciting (but false) statements in their
e-mails to get people to react immediately.

v Never give personal data over e-mail, no matter who is asking for it.
Phishers typically ask for information such as usernames, passwords,
credit-card numbers, Social Security numbers, and so on.

v Phisher e-mails are typically not personalized, while valid messages from
your bank or e-commerce company generally are.

v Distinguish between personalized and addressed-to-you e-mails. Most
phisher e-mails have your name on them, but they’re not personally
written for you. In other words, they’re form letters.

v Never fill out forms in e-mail messages that ask for personal financial
information.

* You should communicate information such as credit-card numbers or
account information only via a secure Web site or by telephone.

+ Do not believe in any prize you may have won or miraculous offer to
release millions of dollars from a former African state secretary.

Tips authorized by the Anti-Phishing Working Group site atwww . antiphishing.org
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Chapter 10
Facilitating Teamwork

In This Chapter
Working as a sports team
Creating intercompany teams
Collaborating by using Outlook Tools

A ny business operates with teams, even if you work alone at your home
office. There is, at the very least, a kind of unofficial team made up of
your collaborators, suppliers, and customers. This chapter reveals how you
can use Outlook to keep your team working together and in perfect order.

Maintaining Team Commitment

The most important and fundamental team is that of a simple couple. Two
humans surviving together and growing a family — without this basic team
unit, you might not be here today. Growing from two people to a family or a
tribe, humans have always had to work together. Tribe leaders evolved to
help guide the group through dangers and to manage internal problems, such
as competition and jealousy. The most basic team commitment in our culture
is the wedding ceremony, and it starts with a question: Do you take this
person to be your spouse . . . for richer and for poorer, for better and for
worse, through sickness and in health . . . until death do you part?

This question illustrates a perfect example of the team commitment: To harbor
mutual respect and trust while maintaining a good climate anywhere and any
time. One of the ways of creating confidence and respect is by combining and
sharing resources. Sharing your goals, Tasks, and information resources with
your team makes your business stronger and better. Outlook’s sharing proper-
ties can help you share your goals, Tasks, and information with your teams —
whether your team is made up of family, business groups, or friends.
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Business, teamwork, and sports

I've never heard about a team — even a dream
team — winning a season without any training.
Even gifted athletes have to train and practice
together, or their individual strengths won't
amount to much. Team sports, such as football,
soccer, basketball, and baseball, demand a per-
fect understanding and synchronicity among
players. Daily training helps improve the team'’s
performance and helps create a unit that is

analogy for business is so strong that sports
vocabulary is often used in a business context,
such as using striking outfor losing an objective
or coach rather than mentor. Unfortunately, the
common goal shared by a business team is
often lost due to lack of instructions, lack of a
good coach, or lack of supervision. Coaching
and supervision in Outlook’s collaborative tools
help you score more home runs in less time.

greater than the sum of its parts. The sports

Maintaining a working team through good and bad times involves making the
commitment to the team. Keeping commitments requires that you negotiate
and maintain agreements. Daily actions based on mutual agreements, com-
pleted without excuses, is the key to making the team function properly.
Your job description (both within a particular project and in the company

in general) is an agreement.

Using Outlook’s collaborative tools to apply the following concepts, you can
keep your team working cooperatively and efficiently, as well as give your
business a boost of team power:

v Leadership: The role of a leader is to plan, delegate, supervise, coach,
and keep the team moving in the right direction, scoring their goals.
Outlook’s sharing and supervision properties can enhance leadership
capabilities by helping team leaders zoom in on the players’ work (by
reading their Tasks and Calendars). For more on reading Tasks and
Calendars, see the upcoming section “Taking Advantage of Collaborative
Tools.”

v Negotiation: Several steps are involved in achieving an agreement.
Negotiating is the art of having two or more sides arrive at a common
point or understanding. Outlook collaborative tools help you negotiate
requests, such as proposing a new meeting time, saying “No” to a Task
request and sending your reply with a new proposal, or coming up with
another way to solve the request. For more on this topic, read the
upcoming section “Taking Advantage of Outlook Collaborative Tools.”

v Agreement management: Having an agreement is not a guarantee of get-
ting the job done. Supervision and coaching can help you avoid failures.
The Tasks list helps you manage each team member’s pending Tasks.
For more on Tasks, read the upcoming section “The agreement game,”
later in this chapter.
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v Sharing: Companies that share values and information empower their
teams more effectively than those that don’t share information.
Outlook’s sharing properties empower each team member to get infor-
mation without interrupting the other players. For more on sharing, see
the upcoming section “The goal is sharing.”

1 Delegation: You are a doer, not a lazy person, and you wish you were an
Octopus so that you could work on more jobs at the same time. So, how
do you get more brains and arms working for you? Delegating to your
coworkers is the answer. Outlook’s delegation tools let your chosen
team members negotiate agreements on your behalf (accepting and
rejecting invitations), without your having to open your Inbox. Take a
breath and plan what you want to delegate. For more on delegation,
see the upcoming section “Delegating.”

v Commitment: The real commitment is not only a matter of saying yes but
also having a willingness to do it. The Outlook Accept or Decline buttons
increase the commitment among parts. Few people will click an Accept
button without reading and thinking, “Am [ willing to do this?” This
mental question increases the commitment. For more details, read the
upcoming section “The agreement game (Tasks),” later in this chapter.

Using E-Mail Tips to Promote
the Calendar

You can use Tasks and Invitation requests to organize your team’s agree-
ments and keep it working together and in unison. Outlook’s supervision and
delegation features help move the ball downcourt toward the goal.

One such method is to send an e-mail tip. However, you need to ask yourself
the following questions before sending a tip:
v What is the advantage to your team if the members start using this tip?
v Does your team know about the Calendar?
v Does your team know how to use the Calendar?
v Why is your team not using the Calendar?

The advantage of using the Calendar for invitations is saving time. Your team
may not be using the product because they don’t know about its benefits.

For example, some managers told the HR department that their teams hadn’t
been answering Calendar invitations by using the Accept or Decline buttons
in Outlook, thus forcing the team to waste time by using the phone to confirm
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the meeting or invitation. So the HR department broadcast an e-mail tip:
Please answer the receiving appointment invitation by clicking the invitation
buttons to accept or to decline the sent invitation. This communication

was necessary because most people didn’t know how to use the Accept or
Decline buttons. A tip can bring results when people already have some
knowledge of the product. A training session and a campaign to implement
the Calendar will bring better results if the Calendar is not generally in use
within the company.

Instead, the broadcast tip needed a subject line more like “Save time by using
Outlook Calendar for invitations and requests.” The message content should
explain the problem and give readers the advantage and solution.

The problem: Losing Time due to missed meetings and excess confirma-
tion calls and e-mails.

The solution: How to save time by using the Calendar appointments and
invitation.

HR should inform the managers prior to sending the tip broadcast and
should support the whole team’s use of the Calendar.

Training is not only long hours in the classroom or an e-learning course.
Today, training includes broadcasting tips and filing them on a public folder.
You can even create a six-month, quick-learning program to develop team
skills one application at a time, as shown in Table 10-1.

Table 10-1 A Six-Month Quick-Learning Program
Month  Program Benefit Tool Chapter
1 Invitation time Time saving Calendar 12
saving
2 Task supervision Organization and  Tasks 10,11
Time saving
3 Drowning in Shrink Inbox E-mail rules 5,6
e-mails traffic
4 Priorities Self-organization ~ Tasks and 10, 11,12,
Calendar and others
according to
department
5 Effective sales More closing Tasks 14,15
control business
6 Delegating Don't be a doer, Delegate 10, 11,12

be aleader
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Create tests like a fake invitation and check all attendee’s answers or circu-
late a Task request to be declined with a new date proposition. Invest time in
helping the person who didn’t answer the test. Know-how without doing is
not knowing.

\\3
Outlook Programs work when managers and leaders don’t exempt them-
selves from the rules and use the applications along with the rest of the team.

Sharing Your Work with
the SharePoint Server

Today, corporations use third parties for everything — even to produce

their products in different plants. How do you make the project drawings,
sketches, documents, and schedules accessible from anywhere? You can load
all your documents in a public folder and upload them to a Web site or have
them in a more organized manner, by creating a document or meeting work-
space on a SharePoint service. The SharePoint workspace is a predesigned
Web site to integrate team information for small businesses. After creating
your SharePoint workspace, you can invite your team to start working on the
same workspace and start using the Calendar invitation features of Outlook.

The SharePoint server, together with Outlook, helps you work with team
members from different companies. You can share the same information in a
secure and organized way.

You can also send Tasks and Invitations to different companies without any
problem. Since Outlook 2002, you don’t need to be connected to an Exchange
server to send or accept Tasks and Invitations. Consider asking your close
customers and suppliers for their permission to send Invitations and Task
requests — doing so via Outlook is a great timesaver. Simply determine their
Outlook version and their knowledge of its features to get a better feel for
their capabilities. Close customers or suppliers can schedule appointments
by sending an Outlook invitation and receiving the customer or supplier
acceptance (or a new date proposal). You can send a Task to your supplier
requesting any kind of office maintenance with a due date and receiving the
due date confirmation.

For example, say that you need to develop an e-training manual about
Outlook’s marketing features. Your assigned team works via Internet from
different locations. You decide to employ a SharePoint workspace site where
you can load and share documents and schedules without needing any
technical expertise. To create a workspace for this project, enroll in the

MS SharePoint trial on the site www. sharepointtrial.com/welcome.
aspx and follow the instructions for setup. After the setup, log onto your
SharePoint site and follow these steps to create your own workspace:
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. Click Create.
The new page opens; scroll down to the end of the page.
2. Click the Sites And Workspaces hyperlink.

3. Follow the wizard to fill in the title and description of the workspace
and the project description.

4. Continue through the wizard until your workspace is finished.
Figure 10-1 shows a sample decision-meeting workspace.

5. Insert your information into each part of the workspace by clicking
Add New Item.

6. Manage your attendees by clicking Manage Attendees.

To specify each team member, give each attendee permission in the
workspace. Then you can open an agenda item for each member.
Table 10-2 shows you an example.

M Home Support Help Up to Sharepoint Team Site [l
af . e
Ci) E-Learning

Home Madify This Workspace »

Objectives * Agenda o

There are no tems to show in this view of the "Objectives” Subject wWner ime

list. Ta create & new item, click "Add new item” below. There are no iterns to show in this view of the “Agenda” list. To

= Add new itern create a new item, click "Add new item" below,

o Add new item

Attendees hd
L] MNarne Edit  Response Comment Document Library -
F. 10 1 ‘I_'here are no iterns to show in this view of the "attendees” Type Marne & modified By
lgure -1 figE. There are no iters to show in this view of the "Document Library”
A blank ® Manage attendess docurnent library. To create a new item, click "Add new document”
belaw.
SharePoint ® Add new document
decision-
. Tasks -
meetlng Title & Assigned To
WOrkSpaCe There are no itemns to show in this view of the "Tasks" list. To
create a new item, click "Add new itern” below.
I aa [~

Table 10-2  Team Members and Their Project Assignment List

Member Subject Subject

Marcelo Script and coordination
Mary Pedagogic evaluation
John Designer/final edition

Joe Voice recordings
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|
Figure 10-2:
The
workspace
setup is
ready to be
shared
among
users.
|

7. Insert each document into the Document library following the wizard
steps.

Figure 10-2 shows the decision-meeting workspace with the information
entered.

Several other templates for different project types are also available. With the
page ready, you can use Outlook to notify your team members of the work-
space and send updates.

To send a meeting request to employees to participate in a SharePoint work-
space, follow these steps:

1. With the Calendar view open, click the New button and choose
Meeting Request.
The Invitation form opens.
2. Click the Meeting Workspace button to open the Workspace Wizard.
3. Select Change Settings to find your workspace address.
The wizard page changes.

4. Select Other in the Location list box.

The Other Workspace Server box appears.

™ Home Support Help Up to Sharepoint Team Site [
@ E-Learning g
Home Modify This Workspace =
Objectives * Agenda o
Develop Marketing training using Subject wnEr Time
Outlook, ! new Beta Approval | vew Jagques 2 hours 1
@ Add new itermn Final Editing ! Hew John 1 day
Pedagoqic Evaluation ! tew Mary ! day
Attendees T Program Design | Hew John 2 days
farme Edit Response Script ! new Jaques z days
Jaques Thal [ Mone
joe@mtcriativa,com.br Mone a8 Add new kem
john@mteriativa.com br Mone
rary@rteriativa.conm.br Hone Document Library =
Type Mame & modified By
@ Manage attendess B Example Rule !res Jagues Thal

8 Add new document

Tasks T v
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Figure 10-3:
Add the
path to the
workspace
by sending
an invitation
with the
site link
embedded
inthe
invitation.
|

5. Type your workspace site address.

The workspace address looks like a site address, such as http://myb.
sharepointsite.com/.

6. Choose Link To An Existing Workspace.

The workspace address or address list is found and displayed in the
Select Workspace list box.

7. Click OK.

The Wizard page returns to the starting page

8. Click the Link button.

The meeting workspace is linked to the invitation, as shown in Figure

10-3.

9. Complete the invitation and send it to each attendee.

The attendees receive an invitation with the SharePoint site directions

(see Figure 10-4).

] Untitled - Meeting g
i Eile Edit View Insert Format Tools Actions Help
ii=1Send | Accounts~ | 4 | i} 8 | ¥ Recurrence... -7 Cancel Invitation | 1 B | X | % | W 12
E.mail Autolink |2 Link to Record | (& =
Appointment scheduling Meeting Workspace v X
Meeting is linked to workspace
Sublect: @ Goto workspace
= 1F this is a new workspace, goto &
Location: w | Label: |:| Mone Vl now Eo:
- Create an agenda
. e - Share documents
Starttine; | Mon 8[15[2005 [v| 1zaoem [v| Claldsy even: - Track tasks
£ng time: an §/15/2005 [v] [no0pm [v] - Coordinate meeting detais
Remove workspace link
[¥|Reminder: |15 mirutes _Vl Shays time as: . Busy Remove
[ This is an anline meeting using:
Meeting Workspace: Mew E-learning training project
Wisit the workspace to learn more about this meeting or edt its contents,
Permission ko access workspace
#  This workspace is associabed
~ with move than one mesting,
Attendees Fram other meetings
may have access to the
workspace.
prvate [ @ More infematn
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Figure 10-4:
The
invitation
includes a
link to the
meeting
workspace
address.

j New E-learning fraining project - Meeting BE
i Eile Edit View Insert Format Tools Actions Help
i o Agcept | ? Tentative | % Decline | + Propose New Time | 5] Calendar... | -5 | X | & - & - |2} | @ 5

From: John [John@mbcriakiva.com,br] Sent:  Fri 7/29/2005 3:02 FM
Required:  Joe ; Mary ; 1@mbcristiva, com, br

Optional:

Subject:  MNew E-learning training project

Location:  Sharepoint belaw

‘ihen: Friday, June 02, 2006 12:30 PM-1:00 PM.

Meeting \Workspace: Mew E-learning fraining project <http /fwww, micristiva.com.br.sharepointsite netAntitleday?
InstancelD=1>

Wisit the workspace to learn more sbout this meeting or edit its contents.

Taking Advantage of Outlook
Collaborative Tools

Outlook collaborative tools are Agreement, Supervising, Delegate, and Sharing.
Two people working together can have many forms of agreements: looking in
each other eyes, requesting the agreement by phone, or using Outlook agree-
ment tools. Sharing your Calendar and your Tasks list gives support and super-
vision without interrupting any third-party work. Delegating others to act on
your behalf can increase your productivity, so start delegating according to
your needs.

The agreement game (Tasks)

If you're in business, you can probably recall a time when your assigned
Tasks did not get done. Mike believes Joe accepted an assignment and keeps
asking about it. When the due date arrives, it turns out Joe doesn’t deliver

151
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the job. If Joe could say, “I'm sorry, this is not my job. I can’t help you now,
but I can explain how you might get it done,” he would not receive the
repeated pressure from Mike, and Mike wouldn’t be angry about losing time.
Saying no and negotiating another due date or explaining to coworkers how
they can get the job done without you keeps the company game moving fast.
Only when the team understands the workflow and the agreements involved
in that flow will you start winning the game. Outlook’s collaborative tools can
put you a major step ahead. There is no purpose in sending a Task request
and not receiving a committed answer, such as, “Yes, I can deliver that by ...”
or “No, I can’t do that as requested, but [ propose the following. . ..”

Today, working people send most of their requests by e-mail or phone, believ-
ing that the sent e-mail is enough. In this way, your request is lost in the mail-
box mess without any priority and often forgotten. Outlook collaborative
tools enable you to send a request or an invitation that demands a simple
answer like accept, decline, or propose a new way, which means finding an
agreement between the two parties. Everyone on your team must use Tasks
lists and requests.

Player rules

Every game has rules specifying what each player should do. The agreement
game requires that each player follow the rules like any other game. The fol-
lowing game rules help your team to use Tasks effectively.

v+ Rule 1: Each player should understand and use the Tasks list (Figure
10-5). He should assign his Tasks due dates, changing the priorities
levels from time to time because new incoming events can change
the priority of existing Tasks. For example, receiving an order to be
shipped in two hours can change the team’s priorities in a few seconds.

You can view the Tasks list in several views. From the Navigation Pane,
choose Next Seven Days or Overdue Tasks to view and manage only your
short-term priorities. The Tasks Navigation Pane offers ten ready-made
options with self-explanatory names, such as Simple List, Detailed List,
Active Tasks, By Category, Completed Tasks, and Tasks By Time Line.
The Tasks View By Person Responsible or By Assignment are great for
supervisors.

P Sort your Tasks list view by Priority or by Due Date by simply clicking
the column title just below the Tasks title bar. Sorting by one of these
columns changes the view and shows different priorities depending on
the column used.

+~ Rule 2: The Task request, like a ball in motion, is “agreed to” by clicking
the Accept button or rejected by clicking the Decline button (see
Figure 10-6). Not clicking any tab is against the game rules.
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P After accepting and saving a Task request, you can open it in your Tasks

list. Outlook automatically adds it to your Tasks list, sets up the priority
among your open Tasks, and sets up the reminder for the time sched-
uled to work on it.

v Rule 3: The person who requests a Task, such as a coach, must super-
vise the team member’s action until the Task is complete. Clicking the
Assign button to request a Task transforms your Task into an e-mail to
be addressed with two available selection boxes:

e Keep An Updated Copy Of This Task On My Tasks List: Selecting
this option sends the Task and keeps a copy on your Tasks list for
your supervision.

153
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¢ Send Me A Status Report When The Task Is Complete: Selecting
this option generates a final status report that is automatically sent
to you as a Task update e-mail upon the completion of the Task.

Using these two options keeps the requested Task on your list and helps
you supervise it. Read more details about supervision in the section
“Supervising,” later in this chapter.

v Rule 4: Before bothering the person about the Task, go to your Tasks list
and open your request to check any status changes.

Exception: Send simple requests, which can be completed or answered

in a few minutes or in one step, by e-mail. Examples of simple requests
include “Please send me the sales report from March that is in your file.”
You don’t need to create a Task with agreement confirmation for such
items.

The agreement game rules (Calendar)

The rules in the preceding section are valid for Calendar invitations or
appointment scheduling. Click the Invite Attendees button on the Calendar
or the Assign Task button on a Task to send your message with an automatic
response capability. This lets the recipient answer by clicking response
buttons.

Opening the Tracking tab in an invitation sent in your Calendar lets you
supervise all sent invitations and the responses. Read Chapter 12 for
more details on the Calendar.

Supervising

Good supervision is not just assigning a job by e-mail or by phone call and
forgetting about it. Good managers don’t trust only their memories; they list
all pending actions on a notepad and tick the completed actions when done.
If you have hundreds of Tasks each week, using a notepad to control a group
of Tasks is not an option. Assigning Tasks to your team and keeping a copy
on your Tasks list facilitates the work, but supervising all pending tasks of
only one person on your Tasks list is not easy. By changing the current Tasks
list view on the Navigation Pane by Person Responsible, you can have all
Tasks listed by each assigned owner (see Figure 10-7), which eases your
supervision. A second view option, By Assignment, is available showing only
the tasks assigned to other people.

Opening your own Tasks list by owner allows you to check each owner’s list
and due dates so that you can negotiate a change when needed. By using
your Tasks list, you don’t have to interrupt anyone’s work to check on the
status of a job.
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You have a distant vision of your team workers and a closer vision of their
assigned Tasks. If your team encounters a particular problem or priority con-
flict, you can zoom in on your collaborator’s Tasks list and read all his pend-
ing jobs while working together on the priorities. To have the power to open
your collaborator’s Tasks list, you must be connected on the Exchange
server, and the collaborator must give you permission to open his tasks. To
open your collaborator’s Tasks List folder from Outlook:

()

. Choose File=>Open=>Other User’s Folder.
The Open Other User’s Folder dialog box appears, as shown in Figure 10-8.
2. Click the Name button to select the person you want to supervise.
3. Select Tasks from the Folder Type drop-down list.
4. Click OK.

The third-party Tasks list opens in Outlook; you can read and even sug-
gest a priority change when needed.

[ *|@ Subject Reguested By  Owner Due Dake Skatus

= Owner: Joe (5 items)

] Weekly sales report Joe Thu 7/2&f2005 Mok Star...
=) Marithly Accounting report Jae Thu 7/26/ 2005 Mok Star..,
Fl} Back up Business Conkact Manager Database Joe Mon 812005 Mok Star...
] Project 94 part B changes Joe Wed 8f24f2005 InProgr..
ad] Check Hong Kong imparks monthy  shiping Jog Mon 12/5(2005 In Proar...

= Owner: John (2 items)

g Eack up Business Cortact Manager Database John Mon &1 2005 Mok Star ...
2] 1 EDI Dataintegration with Customer C for... Jahn Fri 692006 In Proar...
=) Qwiner: Mary (2 items)
] Sales report Request Mary Fri 9/2f2005 Mok Star...
al Check pending orders with Supplisr B Mary Fri 1/6[2006 In Proar...
Open Other User's Folder
Folder bype: | Tasks ~

Calendar

Contacts

Inbo:
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Delegating

Delegating a job doesn’t mean that you're getting rid of it. Rather, delegating
involves passing on, entrusting, or assigning a job and all its decisions to a
person able to perform it without your supervision. To delegate, you must be
patient and plan ahead. You must train people to perform well by themselves
on your behalf and define very clearly the limits of the Task.

You might, for example, show your administrative assistant how to act on
your behalf in maintaining your meeting agenda, or in sending or receiving
invitations for you. Outlook delegating properties allow the delegated person
to receive your invitation requests in her Inbox and answer on your behalf.
When she answers on your behalf, Outlook sends you a confirmation, inform-
ing you that the delegated person replied. You then have the information
available on your Calendar.

Using the Outlook delegation feature, your receptionist or assistant can
accept or decline invitations on your behalf, thus giving you time to concen-
trate on your priorities. Here’s how you can delegate your invitations:

1. With Outlook open and connected to an Exchange server, choose
Tools=>Options and then click the Delegates tab.
The Options dialog box opens to the Delegates options.

2. Click Add to add users from your list.

In this example, | added Mary. The Exchange server adds Mary to the
delegate list and opens the Delegate Permissions for Mary, as shown in
Figure 10-9.

3. Select the Delegate Receives Copies Of Meeting Related Messages Sent
To Me box.

This way, you don’t have to share your entire Inbox with your coworker.

Delegate Permissions: Mary %]
This delegate has the Following permissians
3 Calendar  |Editor {(can read, create, and modify items) |

Delegate raceives copies of meeting-related messages sant bo me

=

/]| Tesks |fifhor{canead anderesteiens) v
-

_J Irkox Mone w

Q —| Conkacts | Author (can read and create tems) -]

Mokes Mone £
=
'3) Journal Mane w

[[] Automatically gend a message to delegate summarizing these permissions
[ Delegate can se= my private kems




Chapter 10: Facilitating Teamwork

The Delegate permission dialog box lists other folders like Tasks and
Notes with option to share with the Delegated person, creating a short-
cut, instead of opening and sharing the folders one by one.

4. Click OK to start delegating.

The goal is sharing

When you make important information available to your team, you reduce
interruption. Sharing your Calendar or Tasks list gives your team the power
to read them, instead of interrupting you to ask questions. Sharing your fold-
ers is easy, but before sharing them, you have to determine the permission
level of each team member. Sharing and data integrity must work together.
You can have your assistant manage your agenda, sending or receiving invita-
tions on your behalf, or you can allow team members to read your agenda
only. The main permission levels are as follows:

v Editor: The Editor has full power, including rights to modify and delete
the information being shared.

v Author: The Author has less power than an Editor and can’t modify items.
The Author can add and delete items but not change previous items.

v Reviewer: The Reviewer can only read items.
To share your information, you have to choose which folders should be
shared. You can share your Calendar, Tasks, and e-mail or contacts and spec-
ify who is allowed to view the information and at what sharing level. With
Outlook open:

1. Click the Calendar button from the Navigation Pane.

The Calendar folder is visible on the My Calendars window on the
Navigation Pane.

2. Select Share My Calendar.

The Calendar Properties dialog box opens on the Permission tab (see
Figure 10-10).

To allow someone to share your Calendar folders, you must add his
name to the Permission list and choose the Permissions Level.

3. Click Add to open your lists.
The Add List dialog box appears.

4. Open the Show Names box to see all the names available.
You can select individuals one by one or select a group.

5. Click the name you want to select.

Figure 10-11 shows Joe, John, and Mary selected.
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6. Click Add and then click OK.

The chosen persons are added to the Calendar sharing list, as shown in
Figure 10-12.

7. Select the Preset Permissions level on the list box or create a custom
level by selecting each permission item on the Permissions frame.

8. Click Apply and then click Close.

The sharing permission setup is ready.
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Sharing tools service suppliers

Sharing your Outlook folders (such as Calendar, aspx) and also on MSN (www . msn . com) for
Tasks, or Contacts lists) is possible when OQutlook  OQutlook Live service. Scroll down to find MSN
is connected through an Exchange server or a  Services and click E-mail Solutions. You can also
small business server. To have this service forfew  share your Calendar, Tasks, and Contacts and
bucks a month, look for an Exchange server even publishyour business folders on a Web site
provider such as MI8 (www.mi8.com), which or through a SharePoint server. Look for
stores your Outlook folder with all properties. You  SharePoint service providers at the Microsoft
can look for other providers at the Microsoft MarketPlace or at the following site: www.
MarketPlace (http: //office.microsoft. sharepointtrial.com/welcome.aspx.
com/en-us/marketplace/default.
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You can share your Tasks list, Contacts list, and Inbox in the same way as
explained with the Calendar. You can give certain team members the power
to work in your Outlook folders in just few clicks.

To open the shared files:

1. Choose File=>Open~Other User’s Folder.
The Open Other User’s Folder dialog box opens.
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2. Type the username in the space provided.

3. Select the folder name (such as Calendar) from the Folder Type
list box.

4. Click OK.

The shared Calendar opens.



Chapter 11
Applying Teamwork

In This Chapter

Organizing customers and suppliers lists
Confirming sent e-mail

Voting

Organizing the customer support
Controlling projects

Like you, your customers and coworkers want to make life easier and
better. They want to keep the ball moving toward their goals, not away
from it. In this chapter, you find out how to use Outlook’s collaborative tools
to move the ball toward the goal. You also discover how to avoid customer
complaints due to unresolved and unshipped orders, how to avoid phone
calls asking, “Hey, did you receive my e-mail,” and how to take a survey in a
single e-mail. Using Outlook’s collaborative tools, you can determine how to
achieve your objectives in fewer steps.

Creating a Uniform Customers
and Suppliers List

Could you send a Happy New Year’s card to your entire customers and sup-
pliers list today? This question is a good one to ask to determine how up-to-
date your Contacts list is. Even small databases of 200 names involve regular
updates and changes — one person leaves the company, another changes his
phone number, and yet another is promoted. Companies with large customer
lists end up creating task forces at the end of the year just to update the com-
pany database.
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Another issue is where the list is located. Quite often, the list is split up
among the billing system, the purchasing department, and each salesper-
son’s various archives (Rolodex, Pocket PC computers, and even the busi-
ness card forgotten in the top drawer). Without an updated database, you
can’t communicate well with your customers. Here are a few possible solu-
tions to this problem:

v Use your Contacts list as your customer and suppliers database. Update
any information as you receive it, when working by yourself.

v Use your assistant’s Contacts list as the company list. Create a rule that
you send every new update you get, such as a business card, a phone
call with new information, or an e-mail, to the assistant for database
updating.

v Create a public list on the Exchange server and choose a person to be
the list keeper. You can use the BCM Business Contact Manager add-in,
shareable since Version 2.0. You can share the business contacts and
accounts as one list with the rest of your company. (You can read more
about BCM in Chapter 6.)

You should update address changes and add new contact information imme-
diately. The first option is good when you’re working alone. The second
option works when you don’t have an Exchange server available or don’t use
the Business Contact Manager Version 2.0. The best option is the third one,
because the Contacts list is available to the whole team anytime, anywhere
with Outlook Web access. You simply type the new contacts into your
Contacts list, save it, and then send it as a vCard to the Contacts list keeper
as follows:

1. Open the saved contact.
2. Choose Actions~>Forward as vCard.
A new e-mail opens with the vCard attached.
3. Send it to the Contacts list keeper.
The Contacts list keeper receives the e-mail and can simply drag and

drop the vCard from the e-mail into the Contacts list.

Adding a contact in this way automatically records the date the contact was
created (using the field name Created) and maintains a last modification date
(using the field Modified). You can customize your contacts view to include
the Created and Modified fields if you want to keep track of this information.
(Chapter 4 explains the procedure for modifying contact views.)

You're likely to receive contact information from several sources, such as the
internal sales system, each salesperson, or the management team.
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Associating the contact with the person who generated it facilitates tracking.
You can use categories to help you track this information:
1. Create a new category for each sales team member.
(Read Chapter 4 to find out how to create categories.)
2. Insert a new contact on the list.
3. With the contact open, click the Categories button.
The Categories dialog box appears.
4. Select the Sender Name category and save the contact.

The contact is associated with its source.

Following Up on Requests

WING/
§§‘

“Hello, Mary, did you get the e-mail I just sent you?” s this a question you
often ask your active customers or new prospects? The question sounds like
something you tell first-year business students not to do.

Requesting an e-mail read receipt to confirm that the e-mail was received and
read (thus avoiding the phone call) seems like a good idea, but some busi-
nesspeople consider the e-mail confirmation feature offensive. Many people
even turn it off without allowing the receipt to go back to the sender. Most
people don'’t like to be forced into responding. So the question remains; what
is the best way to follow up and close a request?

Flagging

A polite way to request an answer is flagging for a reply or call. Flagging
means adding your reply information to the top of the e-mail, requesting an
action — to call you or send an answer within a certain period of time.

Flagging works in the following way:

1. With your e-mail open, click the Flag button on the toolbar.

The Flag wizard appears (see Figure 11-1).
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2. From the Flag To list box, select one of the following options: Call, Do
Not Forward, Forward, For Your Information, No Response Necessary,
Follow Up, Read, Reply To All, Review And Reply.

3. From the Due By list box, choose the date and time.
4. Click OK.
5. Complete and send the message.

The person receiving the message sees a note on top of it (see Figure
11-2) with your request to reply and the expected return date.

-1 flagging for follow up message - Message (HTML) =)=
¢ File Edit View Insert Format Tools Actions Help
i &Reply | iReply to All | Forward | 4 ARAETER AR AY RSN |

i 2L E-mail Auto-link |2}, Link to Record | @ 3

From: myb [1@mtcriativa.com.br] Sent:  Man 8]1f2005 2:42 PM

To: Johin
Ce:
Subject:  Fagging For Follow up message

The person usually gets the message with your polite request for action. You
also can keep track of the sent message by opening it and adding a follow-up
flag as an open issue reminder to you. To set up the flag:
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1. Select the Sent items mailbox in the Mail Navigation pane.
The Sent Items list appears.
2. Right-click the desired message to open the drop-down list.

3. Choose Follow Up=>Add Reminder to open the Flag for Follow Up
dialog box.

4. Set up the reminder and click OK.

If you have a lot of messages with follow-up actions, you can list them all at
one time. First, select your Outlook mailbox and then choose the For Follow
Up search folder located on the Navigation Pane within the Search folder. All
your follow-up messages appear.

\\3

The e-mail confirmation request

Confirmation requests work with a little help of psychology, perhaps by
inserting the following comment at the top of your e-mails: “I've set up an
automatic e-mail confirmation to this message in case you don’t have time to
reply.” You can set up the reading confirmation request the following way.

1. With your e-mail open, click the Options button.
The Message Options dialog box opens.

2. Check the Request A Read Receipt Of This Message check box in the
Voting And Tracking options area.

3. Click the Close button to save the request.

After you write the message and click Send, the message is sent with the read
confirmation request. When the addressee opens the e-mail, he can accept or
deny the read confirmation message. If he accepts it, you receive an e-mail con-
firming the time the message was read, thus saving you a phone call. Give your
customer time to take a breath and think before you call to close the deal.

Conducting Surveys

Voting is a popular method when you need a group of people to choose from
several options. However, getting your team to make a decision can be diffi-
cult, not to mention time consuming, to plan, execute, and tally all the votes
and hear all the opinions. With Outlook e-mail voting, you can hold an election
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in minutes and avoid wasting time counting each vote. Outlook tallies the
votes for you.

To conduct a survey and add voting options:

Message Options %]
Massage settings Sacurity
- r. %) Importance: | Mormal - r'\.ﬁ Change security setbings for this message.,
I ' !
. Sensitivity: | Mormal w Securiky Sektings...
Flgure 1 1-3 vioking and Tracking options
The Votin g @g [[JUse wating buttons: o
an d [[]Request a delivery raceint For this message
Tracking [V]Request aread recept for this message!
Options Delivery options
] Ha i tba: |
area allows V‘I [[IHave replies sent ko Select Mames.

you to type [¥] Save sept message to:  Sent Items | Browse...

any voting [[] Do not deliver pefore:

[Expires after:
buttons fOI' Attachment Format: Default w
your pO" Encoding: Auto-Select ™
poside e
ative
optons.
P
I

1. With a new e-mail open, click the Options button.
The Message Options dialog box appears, as shown in Figure 11-3.
2. Check the Use Voting Buttons check box.

3. Click the Use Voting Buttons drop-down list and choose the option you
want.

You have three options:
e Approve; Reject
* Yes; No
¢ Yes; No; Maybe

But these three choices aren’t sufficient for choosing from a list of possi-
bilities. The surprise is that you can add voting options to the list and
use them in your e-mails.

4. If you don’t like the options listed in Step 3, create your own by select-
ing and deleting the text from the Use Voting Buttons list box.

5. Type into the Use Voting Buttons text box the options you’d like, sepa-
rating them with semicolons.
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For example, if you wanted your employees to choose among pizza top-
pings, you may type; Veggie; Mushrooms; Onions; Black Olives; Cheddar;
Pepperoni; Italian Sausage; Beef; Ham; Pineapple.

6. Click Close to save the newly created list
7. Type the subject and text of the e-mail as desired and click Send to
distribute it to your team.

Figure 11-4 shows the e-mail if you were tallying up votes for pizza toppings.

After the voting takes place, you don’t have to count the votes one by one
like a political election. When a team member clicks a choice, it automatically
sends an e-mail back to you (the sender). But you don’t have to count each
e-mail. Instead, just open the original e-mail you sent and click the Tracking

V&“\NG! tab to read the results at the top of the page (see Figure 11-5).
S
The sent e-mail’s Tracking tab doesn’t open until you receive the first answer.
|
Fi 1-4: I Click on your topping tab choice fo get it by 7:30pm. Joe - Message (HTML) BB
IgI.IYI’e * |} Eile Edit View [Insert Format Tools Actions Help
I'Oku Can \: . peply | 3 Reply to All | < Forward | 4 3|3 | ¥ [(S]023 X | & -+ - & PRRCA |
clickyour |; | === = = o=
toppin e 2
hoi pping  Veggie | Mushrooms | Onion | Black olives: Cheddar | Pepperoni | ltalian sausage | Beef | Ham | Pineapple | Strawberty -]
choices to i
vote on the
. From:  Marcelo Thakenberg [marcelo@mtcriatia.com,br] Sent: Tue 7/12/2005 1:31 PM
type of pizza . I
Ta: joe@mtcriakiva.com.br; jim@mtcriativa.com,br
you want. e
Subject:  Click on your bapping kab chaice o get it by 7:30pm. Joe
|
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Figure 11-5: | message | Tracking
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Isplays the | [#ary
results for |2 :
Joe Pepperoni: 7[12[2005 2:06 PM
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Organizing Customer Support

A cosmetic company’s e-mail hotline receives the following customer e-mail:
“My dog drank your shampoo. What are you going to do about it?” Customer
service forwards the e-mail to the legal department, copying the woman. The
attorney replies to the customer service department, blaming the woman.
But he presses the Reply To All button, so the customer receives a copy of
his e-mail . . . and the wrong impression. The results? The lawyer loses his
job, and the company pays the customer damages with strong apologies
attached.

Large companies run contact-center software for customer service needs, but
you can create a small customer service center with Outlook Tasks. To make
this center most effective, you must follow some standard procedures. First,
every call should open a new Task, because Tasks are used to track the calls.
Second, it’s forbidden to forward customer e-mails to others within the com-
pany. Instead, you drag and drop the e-mail into a Task and send it by using
the Task request feature (see Chapter 10). A mistake like the one described in
this section will never happen again.

A small company can run a hotline or customer service center by following a
few simple guidelines:
v Every customer contact by phone, e-mail, or fax opens a new Task.

v~ All internal requests from customer service should be requested as a
Task, keeping a copy on the customer service side.

v The Task is closed when the customer receives a solution.

v~ Save all closed Tasks in a special folder and analyze the problems
from certain periods so that you can detect repetitive issues and solve
for them.

You can customize the Task form to add a ticket number, product informa-
tion, customer information, and the problem. It doesn’t matter what type of
business you have; you can create any kind of field according to your busi-
ness needs. You customize a Task in the same way that you customize a
Contact form (see Chapter 5):

1. Choose Tools=>Forms=>Design A Form.

The Form library opens.
2. Select the Task form you want displayed.

3. Because you don’t use the main page, click the page 2 tab (P, 2).
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A full page appears so that you can design a form. You have a full page to
insert any field for your new Task form. Chapter 5 explains the proce-
dure for adding fields to this form. The information to include on your
example customer service form may include

¢ Product information fields: Model, Description, Serial number,
Purchase Date, Store, City, and State.

¢ Customer Information fields: Name, Phone Number, and E-mail.
e Action Report field: Insert a text box to type new information.

4. Create the frames by selecting them from the Control ToolBox and
then formatting them and inserting their titles.

See Chapter 5 for detailed procedures.

5. Create the fields by using the Field Chooser and insert the fields
inside each frame and align them.

See Chapter 5 if you're not sure how to create fields.

6. Create the Text box by dragging the TextBox from the Control
ToolBox to the form page.

Read Chapter 5 for details.

7. Save the form by clicking the Publish button on the top left of the
form.

You now have a Task ticket to help you organize your customer service sup-
port. This ticket helps you control your customer service requests and move
them around the company by using e-mailed Tasks. You can then customize
the Task form according to your customer service department needs.

Controlling Projects

You may be considering moving to your dream office — think of the architec-
ture, the external design, the interior design. But when you calculate how
much it costs to merely start the project, you may realize how much you need
a project-planning tool to help. The first step, planning and budgeting your
office, may look like only one Task, but when you look closer, it involves three
new tasks:

v Evaluate with a real estate dealer the leasing cost at the building you
want.
1 Evaluate the interior design cost of your office with an architect.

v~ Evaluate how to finance your dream office.
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Figure 11-6:
By adding a
table to a
Task, you
can control
the next
steps.
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Merely to start evaluating the project, you have three major tasks and three
different people involved in making decisions. No doubt each of these tasks
involves a series of smaller steps, too.

You can open a Task for each request or manage the office-budgeting project
in only one Task. To use only one Task for the project, you can build a
project-management table.

You have two suppliers for each request, their services, their contact details,
the next action description, and the next action date and results columns. As
you start, you fill in the next action date for each one and create the reminder
for the next due date as it comes.

You can design your table in a Word document or in an Excel workbook. To
paste the table in your new Task, follow these steps:

1. With Word or Excel open, select and copy the table.

2. Go to your new Task and paste the table into it.

Your Task now has a planning table (see Figure 11-6).
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You can attach tables to manage projects with sequential actions or multiple
actions. For example, if you're moving your office, you may have a table that
keeps track of the planning sheet, packing and unpacking lists, and so on. An
event planner may track suppliers, entertainers, catering professionals,
printed materials, and giveaways. (You can read about event planning in
Chapter 16.)

Working with your Team’s Calendars

Figure 11-7:
Viewing
three
Calendars
together
helps
manage a
team’s
available
time.
|

Joe runs a company with Mary and John, and they all share their Calendars,
(Each one can alter entries in the others’ Calendars as an editor.) Joe opens
both Mary’s and John’s Calendars in Outlook, as shown in Figure 11-7, so that
he can see a view of the entire group at one time. He can open any appoint-
ment in any Calendar and change it as the owner because of the permission
settings. (Chapter 10 explains these sharing properties and how to open a
third-party Calendar.)
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Sometimes Joe needs to read only one Calendar, so he selects the desired
Calendar from the Navigation Pane. Below his Calendar is a new window
called Other Calendars, which he can select and deselect to open or close
them.
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To save the same appointment in each person’s shared Calendar:

1. Create and save one appointment in the first shared Calendar.

2. Copy your appointment.

3. Select the next shared Calendar time with your mouse and press paste
your appointment into it.

Take care to select the right period in the Calendar. Copying allows you to
paste the appointment into any time slot. The internal schedule automati-
cally adjusts the appointment to the new time. Be sure to double-check that
you pasted the appointment into the appropriate time slot.

Checking the availability of every member of a sales team takes time and can
be a challenge. Open any appointment in your Calendar and click the
Scheduling tab to display the Free And Busy Time table. Typing each name
into the All Attendees list shows each person’s Free And Busy Time table.
You can group the sales team together, so instead of typing all the members’
names on the scheduling list, you just have to type the group.

You can open a group schedule by name in the following way:

1. With the Calendar open, choose Actions=> View Group Schedules.
The Group Schedule box opens.

2. Click the New button.

3. Type the name of the group, such as Sales Team, into the text box.
The scheduling for that group appears.

4. Click the Add Others button to select each member from your list.

5. Click the Save and Close button after adding the names to the list.

The group is ready.
To open the group and see the schedule:

1. Choose Actions~>View Group Schedules.
The Group Schedule dialog box opens.
2. Select the group whose schedule you want to see.

The group schedule opens.
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Leading Vour Team
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The evaluation form is a good way to provide personnel directions and
coaching, even in a small company. If you don’t have an evaluation form, look
at the MS Office Online site at http://office.microsoft.com for a tem-
plate. When you have five or ten people under your command, you can file
their evaluations as Tasks, opening each one from time to time to check on
their goals and supervise how they’re progressing on them. You can also
create a new folder to hold the employee evaluation forms:

1. With the Task folder open, right-click the Task folder name and
choose New Folder.
The Create New Folder dialog box opens.

2. Type the folder name into the Name text box.

3. Click OK.
Your new folder is ready.

You then need to create a task form for each employee. For the due date,
enter the date of the employee’s evaluation.

To create each employee’s evaluation form as a Task, follow these steps.
1. Open a new Task with each employee’s name and the due date as the
next evaluation date.
2. Open each employee’s old evaluation form.
3. Select the content and copy it.
4. Paste the form into each employee’s Task.

The Task looks something like Figure 11-8. Note the scrolling bar, used
so that you can read the whole document.

The reminder doesn’t work for Tasks stored in subfolders. Reminders work
only for Tasks stored in a main folder.

A good coach doesn’t have to keep in mind all the details about a team. You
can store all these details in the evaluation. You can also send a copy of these
Tasks to each employee after the evaluation.
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Requesting and Planning a Vacation

Planning is the essential ingredient in making a vacation work. To schedule a
summer vacation, take the following actions, which you can perform by using
the Calendar, invitations, and Tasks:
1. Schedule and block the time on the Calendar with the Vacation label.
2. Send a Task request for boss’s approval for the time off.
3. Inform the HR department of the vacation schedule.
4.

Open a new Task with the following subject: Transfer my duties to my
coworker and set up the reminder date one week prior to the vaca-
tion.
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Shrinking the Meeting Time

In This Chapter

Meeting cultures

Planning meetings

Cutting the invitation and confirmation time

Managing resources

Video and Web conferences
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Gathering people together for any objective is an art and a science. Even
just getting a group together for happy hour can be a challenge. The
weekly sales meeting schedule always runs late. The training should start at
9 a.m., but at 10 a.m., people are still showing up. Why do event planners give
early-bird prizes? Finding people and setting up meetings can be difficult.

People don’t always give time commitments the same priority either. This dif-
ference is especially noticeable across cultures. Every culture, country, or
individual has a specific way of perceiving time. Fortunately, Checklist and
Outlook can help implement time-commitment guidelines in your business
when your entire team uses the Calendar and its sharing properties.

If you've never used Outlook Calendar, read Appendix A before reading this
chapter. Understanding the Calendar prior to reading this chapter will
increase your results on shrinking the meeting time.

Planning and getting effective meetings becomes easier when you understand
people, cultures, and Outlook’s collaborative tools. Checking your team’s
common free time saves you time scheduling meetings and sending invita-
tions. The attendees receiving the invitation can answer simply by clicking
the options, which also automates the process of inserting the meeting time
on each Outlook agenda. At the same time, it sends a reply to the sender to
facilitate attendance tracking. Finding meeting resources, such as a projector
or a meeting room, become easy when using Outlook’s resources application.
You can read more about sales meetings in Chapters 14 and 15.
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Identifying Meeting Cultures
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Time for an artist, a painter, or a film director has a different meaning than it
does for a businessperson or university professor who spends years in spe-
cialized research projects, a farmer tending crops, or a Wall Street banker.
Understanding their time perceptions makes your time commitments work
better.

How much value do Americans associate with time? At the end of a meeting
with your customer, the usual parting remark is “Thanks for your time,” show-
ing the great value of the attention received. Hundreds of time-management
trainings are available throughout the country. Thousands of books are in the
library about the subject. While | was working in Japan, my Japanese repre-
sentative scheduled our arrival so that we would show up at our meetings 10
or 15 minutes early; we would then wait to ring the bell precisely on time. I
missed a train in Switzerland due to a one-minute delay. The siesta is a Spanish
creation, and, when working in Latin America, your schedule is (more or less)
on time. The precision isn’t great, but the attention when received is friendly
and warm. Time perception isn’t the same everywhere. Understanding it and
getting the mood helps you have better, more effective meetings anywhere in
the world.

The Outlook Calendar time zone setup is intelligent. For example, when you
open a conference call invitation from California in New York, the time sched-
ule automatically appears in local time. The same happens when you send an
invitation to your Japanese, Chinese, or Greek customers. Their language is dif-
ferent, but Outlook adjusts the time according to the time zone receiving the
invitation. (You can read about working with two time zones in Chapter 13.)

Taking Advantage of Categories

Keep in mind that the company culture reflects meeting style. Today, many
corporations make strong demands on their salespeople to attend Web con-
ferences and Webcasts, often giving them little time to handle the customer’s
demands.

You can track and measure how you spend your time during the week or
during the month by categorizing each appointment and viewing the
Calendar By Categories, thus allowing you to see the time invested in internal
meetings, traveling, phone calls, or customer care.

Here’s an example. Joe is a sales director of a high-tech company. His com-
pany launches one product every week and sometimes two in a week. The
company demands that he spend more time in product training than in sup-
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porting the customer base. Joe uses his Calendar to measure his time spent
on training and his time spent touching base with his customers in the follow-
ing way.

First, he creates two categories to use in his appointments: a Training cate-
gory for time spent in training and a Calls category to trace customer contact.

To create your own categories, follow these steps:

1. Open Outlook Calendar and open any appointment.
The Appointment page appears.

2. Click the Categories button in the lower-right side to open the
Categories dialog box.

3. Click the Master Category List button to open the Master Category List
dialog box.

4. Type your category name into the New Category text box.
For example, if you want to create a Training category, type Training.
5. Click the Add button.
6. Repeat Steps 3 to 5 to create any other categories you’d like.
Your new categories are now available.
7. Close the Appointment.
You return to the Calendar page.
For example, you can use a Calls category to classify every customer appoint-
ment and a Training category to hold every training session. Selecting a cate-

gory for your appointments allows you to evaluate the amount of time spent
in trainings and the amount of time spent with customers.

To view and calculate the time spent in each category, you need to modify
your Calendar view as follows:
1. Select By Category in the Navigation pane.
Outlook displays the Calendar entries by category:.
2. Choose Customize Current View In the Navigation Pane Current View.
The Customize Current View By Category dialog box opens.
3. Click the Fields button.
The Show Fields dialog box appears
4. Double-click Duration in the Available fields list.
The Duration field moves to the Show These Fields In This Order list.

177
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5. Click OK.

The Duration field is now visible, as shown in Figure 12-1. A new column
showing the duration time of each event is now available.

[ Subject Location Duration Start End Categories Recurrence Patberm
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Joe tracked his results for one month and presented the results to the board,
which convinced them to develop a new training system to give him and his
coworkers more time to work with customers. Like Joe, you can use your
Calendar to measure and analyze the time you spend on different issues,
which can help you create different ways to be more productive.

Planning Productive Meetings

Your boss calls you and some of your coworkers for an unplanned meeting.
The purpose is unknown. When everybody comes to the meeting room, the
boss begins asking questions that no one can answer without preparation. To
get the answers, the employees have to go back to their offices, collect the
information, and prepare it for presentation after a coffee break. What went
wrong with this meeting? The boss should have used Outlook to plan the
meeting. Outlook Calendar is a great tool for sending invitations and receiv-
ing confirmations, but how do you effectively plan the meeting?

Preparing for meetings

Mary is a sales manager and has weekly sales meetings from 8 a.m. to noon.
The sales force reports on its weekly sales numbers, new prospects, and
challenges. Unfortunately, some members of the sales staff were taking too
long with their reports — talking about the weather or the traffic problem
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they encountered on the way to each customer. To solve the problem, Mary
proposes a visit report. She proposes the topics and explains to each sales-
person what’s important to discuss in the meeting. She also sends each one a
recurring Task with the following subject: Weekly report reminder to be ready
the day before, not Friday 5:30 p.m. A few weeks after starting the program,
the meeting time shrinks to one hour, as scheduled.

You don’t need to be a manager to manage your own meetings. Just keep the
meeting objective in mind, bring your meeting minutes to guide you through
the meeting, and track the new requested actions.

Developing a meeting checklist

The Calendar Invitation form enables you to provide complete information
about a meeting. (To access the Invitation form, with Outlook open in the
Calendar, choose Newr>New Meeting Request.) Then you simply use the fol-
lowing fields on the standard Invitation form:

* Subject: What'’s the purpose of the meeting? What’s your expectation at
the end of the meeting? Type the purpose into the Invitation subject.

v Guest Invitation: Why do guests need to come? Don’t waste time invit-
ing people only for political purposes.

1 Requirements: Should attendees read something before the meeting or
bring something to the meeting? Will the attendee take part in the pre-
sentation? What part? How much time does each attendee have?
Communicate the request to each attendee on the invitation.

v Date, Time, and Place: Fill in this information on the Invitation form.

v Equipment required: Will you need a meeting room, projector, confer-
encing devices, video, or other items? You can reserve shared resources
by using Outlook Calendar, creating an e-mail address and calendar for
each resource, and delegating an owner for the resources mailbox. Read
more in the section “Reserving Resources,” later in this chapter.

v Guest confirmation: Track the confirmation in your own appointment
by clicking the Tracking tab. The tracking application appears later in
this chapter in the section “Getting the confirmation list.”

Scheduling Meetings

People still pick up the phone to call and ask meeting attendees their time
availability for a particular meeting or send an e-mail and wait days for
people to answer. When everybody is using the Calendar connected through
an Exchange server, you can easily check a person’s availability.
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How much time do you spend contacting people regarding an upcoming
meeting? A 10-person meeting requires 20 phone calls and e-mails confirming
and reconfirming the meeting. Outlook Scheduling helps you propose the
first free time available for all ten people in one fell swoop. You can also nego-
tiate with one or two people to see whether they can change their schedules

to facilitate a common meeting time.

Using the Scheduling tool is an easy and efficient way to find the first avail-
able time slot common to all attendees, without calling or interrupting
anyone. For example, say that you need to know your coworkers’ schedules
for a meeting on Friday. Here’s what you need to do:

1. With the Calendar open, click the Scheduling tab.

2. Add each guest name to the All Attendees list.

The Scheduling tab looks like Figure 12-2. In this example, Mary is busy
at 1 p.m.

3. Click the AutoPick Next button.

The green and red lines move to 2 p.m. through 2:30 p.m. and show the
first mutual free time.
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When exploring the Scheduling page in Figure 12-2, notice two things.
First, the Zoom drop-down list includes an option to see a full week
timetable. Use this view to find common free times during the week,
rather than during a particular day. Second, the Refresh Free/Busy com-
mand, which you can access from the Options button, is useful for
reconnecting your Outlook to the Exchange server and updating the
timetable again.

4. After finding an appropriate time slot, click the Appointment tab.
The Meeting invitation form opens with all guest e-mails ready to send.
5. Fill in the subject and planning information.
The Scheduling tool fills in the time automatically.
6. Click the Send button to send the invitation.
Figure 12-2 shows your schedule with the subject of your meetings. When
you need privacy and don’t want to show this information, uncheck your
Outlook configuration for this option:
1. Choose Tools=>Options=>Calendar Options.
The Calendar Options dialog box opens.
2. Click the Planner Options button.
The Planner Options dialog box appears (see Figure 12-3).

3. Uncheck the Show Calendar Details In The Grid check box in the
Group Schedule because you don’t want to expose your appointments
details to everyone.

Planner Options %]
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Graup Schedule
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._.E using k in 3 Group Schedule,
[Cshow lendar detai

4. Click OK.

Because you already can share your Calendar with authorized people, don’t
use this option when scheduling meetings. Show only your free and busy
times to anyone.
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Checking available time with
the Free/Busy option

Not having access to an Exchange server is no longer an excuse for not shar-
ing your free time and busy time with your coworkers. You can publish your

Calendar on an Internet site. Outlook has a feature to publish your Free/Busy
Calendar every few minutes or every hour on the site you choose.

To take advantage of this feature:

1. Choose Tools=>Options->Calendar Options=>Free/Busy Options.
The Free/Busy Options dialog box appears (see Figure 12-4).
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2. Type the number of months you want to publish in the space pro-
vided.

Free/Busy can publish your next 30 Free/Busy Calendars.
3. Type the number of minutes you want between each new update.

4. Check the Publish at my Location check box and then type the URL
location where you want to publish your Free/Busy information.

The name you specify, such as Internet site, can include FTP, HTTP, or
file URLs.

5. Click OK.
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Setting up your Free/Busy tool requires a little bit more technical expertise
about loading and downloading information to an Internet site. Check with
your Internet provider for the specifics.

The Free/Busy Internet page looks like a copy of your Scheduling tab (refer to
Figure 12-2).

Finalizing the invitation time

Confirming and negotiating meeting times is now easier than ever. Outlook
helps you eliminate stress and save energy trying to find the attendees and
coordinate their schedules. Now, you can just ask your suppliers, customers,
family, and friends to use the Calendar options. Any Outlook user with
Version 2002 or newer can create invitations and confirmations, even without
an Exchange server.

When you receive an invitation and open it, you see four buttons:

v Accept: Clicking the Accept button sends your acceptance and inserts
the meeting into your Outlook Calendar.

1+ Decline: Selecting the Decline button gives you the option to add a com-
ment to your reply.

v~ Tentative: Selecting the Tentative button opens a warning box with the
following information: This Meeting Has Been Tentatively Accepted And
Moved To Your Calendar. You now have three options: send the
response, edit and add a comment, or cancel.

v Propose New Time: The Propose New Time button opens the
Scheduling table when you’re connected to the Exchange server. You
can click the AutoPick Next button to search for the next available time
slot. (If you aren’t connected to the server, you have to guess about
other attendees’ availability.) Click the Send button to send your new
time proposal.

Don’t forget to set up the appropriate reminder 15 minutes before the event.
Accepting an invitation or writing an appointment without turning on the
reminder can spell disaster. Use the Default Reminder option as a safety to
make sure that you never forget.
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To set up the reminder:

1. Choose Tools~>Options.
The Options dialog box opens.

2. Check Default Reminder to set a default reminder time in any
appointment.

3. In the time list box, select the amount of time prior to the event that
you’d like the reminder to appear.

4. Click OK.

Getting the confirmation list

When your guests reply to your invitation by using Outlook, you don’t have
to read each e-mail confirmation to see who is coming. You don’t need a
printed confirmation list. Just open your appointment, and a Tracking tab
appears, as shown Figure 12-5; click it to produce a report that shows the
replies to your invitation. This report serves as your confirmation list.

Appoinkment Scheduling Tracking

The Following responses to this meeting have been recelved:

[ Wame | attendanice Responss
Iﬂ]Jﬂ Mesting Organizer Hone
{A|marcelo@mbcriativa.com.br  |Required Attendee Tenkakive
{A|bruna@mtcriativa. com.be Required Attendse Mone
(=AlMary Required Atbendee Accepbed
=A[3ohn Required Attendee Accepted
=)

akendimento@mkcriativa,com.b Required Atkendes None
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The invitation and confirmation procedures work without the Exchange
server when using Outlook 2003 and 2002. Take care when using older ver-
sions, because users receive an unformatted and unreadable e-mail rather
than an invitation.

Reserving Resources

Reserving a meeting room or a projector or a video used to be difficult. You
had to call the receptionist and check whether the resource was available or
not. Creating an Outlook address for each resource, such as a meeting room
or a projector, you can reserve and see the current reservations online with
fewer interruptions to the resource administrator. Request that your system
administrator create an e-mail address for each resource, like meeting rooms
or projectors. By having their own mailbox address, they also have their cal-
endar and free-busy list, now available for online sharing when using the
Exchange Server.

You simply assign a manager for each resource, such as a receptionist for the
meeting room. To save the resource manager’s time, set up automatic
answers to resource requests. With the mailbox for the meeting room ready,
follow the next procedure to create the automatic reservation confirmation.
1. Choose Tools=>Options=>Calendar Options.
The Meeting Room Calendar Options dialog box appears.
2. Click the Resource Scheduling button.
The Resource Scheduling dialog box, shown in Figure 12-6, appears.

3. Check the Automatically Accept Meeting Request And Process
Cancellations check box.

If you ask for a meeting room reservation and it’s available, it will automati-
cally accept the request and inform you of the reservation or cancellation.
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4. Check the Automatically Decline Conflicting Meeting Requests check box.

If someone else made a reservation prior to yours, your request is
declined. You then have to negotiate with the resource owner and the
other requester.

5. Select the Automatically Decline Recurring Meeting Requests check box.

A recurring meeting request schedules the meeting room reservation for
every week at the same time. Creating a rule to not accept recurring
reservations is a company decision.

6. Click the Set Permissions button to share the Calendar among the
resource requesters in order to read the busy times.

You can set up the permissions the same way you shared your own
Calendar in Chapter 10.

When the setup is ready, everybody will know when the meeting room is in
use or reserved without having to bother the resource manager.

Managing Time through
Agendas and Minutes

Arriving on time requires that your Calendar reminder setup is adjusted
properly, allowing you extra time to shift gears and perhaps fight traffic. (See
the section “Finalizing the invitation time,” earlier in this chapter, for more on
setting up reminders.) Conducting an on-time meeting requires planning,
organizing, efficient note taking, and timekeeping during the meeting. Outlook
can’t help you manage the time, but your note taker can write each action
item and send it as a Task to each appropriate person.
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Figure 12-7:
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You can find, download, and print agendas and minutes according to your
meeting style from the Microsoft Office site. Click the Help button and the
Microsoft Office Online command to open the Web page. Search the tem-
plates for “Agendas And Minutes.” Look for the Agenda Wizard; it helps you
plan and manage all aspects of your meetings (see Figure 12-7) and use the
Meeting tracking form to keep the meeting on time (Figure 12-8).

You can copy and paste agenda forms to your invitations.

Ringing cell phones during the meeting can break the concentration of the
participants. The interruption is multiplied by the number of attendees in the
meeting. Likewise, be sure to turn off your phone when visiting customers.
After the handshake, you can even tell the customer you're doing so to give
them your undivided attention. The result is often reciprocity.

Meeting ABC 8/4/2007

9:37 AM to 11:07 AM
Meeting Room 2

Meeting called by: Type of meeting:
Note taker. Timekeeper:
Attendees:

Please read:

Please bring:

Agenda

Evaluate last actions John 10
Evaluate new Advertising agency John 10
New product launching Mary 20
Step by step action Joe 20
Evaluation Team 30

Additional Information

Special notes:
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Figure 12-8:
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Meeting ABC

8/4/2007
9:37 AM to 11:07 AM
Meeting Room 2

Meeting called by:
Note taker.

Type of meeting:
Timekeeper:

Attendees:
Please read:
Please bring:

Agenda

Step 1

Discussion

John 10

Conclusions:

Action items:

Person responsible:

Deadline:

Step 2

Discussion

John 10

Conclusions:

Action items:

Person responsible:

Deadline:
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Step 3 Mary 20

Discussion

Conclusions:

Action items: Person responsible: Deadline:

Step 4 Joe 20

Discussion

Conclusions:

Action items: Person responsible: Deadline:

Wrap up Team 5

Discussion

Conclusions:

Action items: Person responsible: Deadline:

Additional Information

Special notes:

Conducting Video and Web Conferences

Video conferencing systems used to be very expensive, and few companies
had them. Today, kids use Instant Messaging software, such as Messenger
with a Webcam and microphone, essentially having Web conferences with
their friends. Webcast training isn’t just for techies anymore. You can invite
people to Web-based training without requiring any technical setup by using
Outlook’s invitation process with the Web conference page address on it.
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When the attendees accept the invitation, the reminder opens Internet
Explorer on the meeting page. To set up the invitation for online training or
conferences, follow these steps:

1. With Outlook open to the Calendar, click the New button to open an
appointment.
The appointment opens.

2. Click the Invite Attendees button.
The Invitation page opens.

3. Check the box that reads This Is An Online Meeting Using.

The new field Event Address and a check box, shown in Figure 12-9,
appear.

4. Select Windows Media Services from the list box.
The other options are for Exchange or Netmeeting corporate users.
5. In the Event Address text box, type the address of the site.

6. Check the Automatically Starts Windows Media With Reminder check
box.

7. Fill in the invitation with your attendee’s address, the subject, and the
proper time.

8. Click Send.

When the attendee accepts the online meeting invitation, Internet
Explorer opens the Web training site automatically on time.

Appoinkment Scheduling

To,.

Subject:

Location: || Label: ([ Nore v
Start time: Eri 7/15/2005 | ‘mooem || Clalday evert
End time: Fri 7/15[2005 | HI0PM [
I [“]meminder: |15 minutes - @ Show time as: | [l Busy hd
Figure 12-9:
. [¥] This is an online meeting using:  ‘Windows Media Services w
The Online | ==rarereees
meetin g Event Address: | hitps:if1azb3c.com [CJautomatically start Windows Media with Reminder
setup helps I
everyone
show up
online on
time.
e ]



Chapter 13

Working with Outlook
on the Road

In This Chapter

Remembering the document expiration date
Being a team player anywhere

Using Outlook Web Access

Planning remote access

Working with two time zones

Adding international holidays

oe arrived at the airport for his trip to Brazil and was stuck because he

forgot to get his visa. Mario forgot to bring his medicine with him to
China. He doesn’t know what it’s called in China or if it even exists. Mary
invited a local customer for dinner, and the restaurant didn’t accept credit
cards. She was mortified when she realized she didn’t have enough cash on
hand. Neal had problems accessing his e-mail from a small town. A phone call
at 3 a.m. woke you up because your husband forgot the time difference
between Hong Kong and his house. Jennifer brought her cell phone to Italy,
and the roaming didn’t work. Traveling and working on the road require a bit
of planning if you want to avoid these types of problems.

Traveling requires that you have flexibility and can find solutions for working
in different environments while keeping the same quality and frequency of
contact with your office and family. Outlook can help you work out of the
office seamlessly.

Developing a Travel Checklist

The following list can help you avoid making common mistakes of interna-
tional travelers:
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v Open a reminder on the Tasks list with your passport’s expiration date.
(See the section “Remembering Expiration Dates,” later in this chapter.

v Check the need for a visa or vaccines before the trip.
v Order your medicines for the travel period.
v Check cell phone roaming availability with your cellular service.

v Don’t forget to make your schedule available to your team if you aren’t
sharing yet through Outlook sharing properties. (For more on sharing,
see Chapter 10.)

v Share your agenda with your family. It’s an easy way to be in touch.
Don’t forget to inform them of the time shift between your location and
your home.

v Determine which credit cards the country you're visiting accepts.

v List ATM addresses in the foreign city you’ll be visiting. Check the ATM
locator on your credit card’s Web site. I looked for the city of Manaus in
Brazil (in the Amazon Region) and found five ATMs available for
MasterCard and 14 ATMs for Visa.

v Keep funds handy for the international airport tax. Check with your
travel agent to determine whether such a tax is necessary.

v Check into ordering local maps for your Pocket PC. MSN Maps &
Directions linked with Outlook Contacts does not have worldwide
coverage.

v Check customs rules for business samples, gifts, foods, and electronic
devices.

Creating a technology travel checklist

How about creating a travel checklist for your
Notebook or PDA Connections so that you can
avoid any Outlook communicating problems?
Here's what you need.

Wireless: Does your wireless provider have any
access point in the visiting country? Visit your
provider's home page or customer service to
find out.

Dialup: Bring a dialup cord and print the set-
tings for dialup, including the phone numbers to
dial in from the country you’re visiting.

LAN cord: Bring your notebook LAN adapter
and LAN cord to make a connection. They aren't
available everywhere. Print the settings for
backup purposes. Throughout my many years of
traveling I've seen people desperately looking
for a LAN house because they brought the
gadget but forgot the connection cable.

AC power: Europe AC power is 220VAC; is your
power supply ready, or do you need an adapter?
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Using Cell Phones Abroad

America, Asia, and Europe have different wireless systems, so ask your local
operator to check the roaming availability of your system. Note that some
systems require you to release your phone number to certain countries to
allow the roaming to work. Also, don’t forget to write down the procedure for
accessing your cell phone’s voice mail from an international phone (not the
cell phone itself). Write this information in an e-mail and file it with your
other techtip folder procedures — or put it on a note inside Outlook Notes.

Losing your cell phone means losing your embedded phone list. To avoid this
potential catastrophe, synchronize your phone list with Outlook Contacts to
keep everything current in your Outlook master Contacts list. Even cheaper
phones allow you to synchronize with Outlook. Order a cable to connect your
computer with your cell phone and install the appropriate synchronization
software. Check your phone company site for a synchronization kit.

A\

Technology Works Almost Anywhere

Before traveling with all your gadgets or wearing your Batman utility belt full
of connectors and other gadgets, it’s a good idea to make sure that every-
thing will work abroad. A computer isn’t a Swiss Army knife, after all. You can
use three ways to access your Outlook data from anywhere in the world:

v You can carry your Outlook folder on a memory card or CD-ROM and
open it offline on any computer that has Outlook. See Chapter 3 for
details.

»* When you employ an Exchange server for your business, you can access
your online information by connecting and opening your Outlook Web
Access (OWA) page and working online.

v You can carry Outlook on a device like your Notebook, PDA, or cell
phone, thus allowing you to open the information online or offline. Read
more in Chapter 3.

Opening your file from a memory
card or CD-ROM

Follow these steps to open your file from a memory device or from CD-ROM.
Outlook should be open on the third-party computer. Next, follow these steps
to access your data:
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1. Choose File>Open~>Qutlook Data File.

2. Search for *.pst file on your memory device (maybe E:\ Outlook.pst)
or on the CD-ROM (using d:\ Outlook.pst).

3. Double-click the filename.

Your Outlook file is open and ready to use. Any changes you make to
your file while using the third-party computer are saved with your file.

Be sure to replace the file on your office computer when you return from
your trip so that you use the most current version.

Connecting through OQutlook
Web Access (OWA)

If you travel a lot, you're probably accustomed to using Web mail to access
your messages from any computer while you’re on the road. Outlook Web
Access (OWA) gives you the same online access to your entire personal infor-
mation management (PIM) system in Outlook. Even if you bring a notebook
computer with you on the road, accessing your information online has its
advantages, including protecting your information from theft or system fail-
ures. You can work with your Calendar and your Tasks list online, from any
computer, or search for a customer’s phone number from your Contacts list.

OWA is available if your e-mail provider offers the service on an Exchange
server. OWA offers all the regular Outlook features online, including Calendar
Contacts and Tasks. Today, even small companies with no Exchange server of
their own can order the OWA service from an e-mail provider like MI8 (see
www.mi8.com). You can also check the Microsoft Marketplace for an
Exchange server provider. You can have the service for few bucks a month
with no technical expertise needed. For more information, visit the MS Office
home page at http://office.microsoft.com and select Office
Marketplace from the left column.

OWA looks exactly like your version of Outlook, including all the same
folders . . . you're simply accessing your Web mail and Outlook information
from an online source. You can synchronize your computer’s Outlook folders
with the Exchange server so that you can work offline on your computer with
the same information. The Outlook folders on your computer are called
offline folders. 1f you're already connected to an Exchange server, right-click
your Outlook Inbox and choose Properties. The Inbox Properties dialog box
opens with the General options in view. Select the Synchronization tab to
show the last synchronized date (see Figure 13-1).
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Using an e-mail provider with Exchange server, you can order mailboxes for
your family and share your Outlook information the same way expensive sys-
tems do.

Connecting through OQutlook
Mobile Access (OMA)

By using wireless Pocket PC and Palm OS devices, BlackBerry, Treo
Smartphone, or Windows-based Smartphones, you can get full wireless
access to your Outlook mailbox functions if your Exchange service provider
or your mobile phone company offers the service. Exchange service
providers, such as MI8 (see www.mi 8 . com), provide these kinds of services.

Cell phones with built-in cameras are sometimes not allowed in commercial
buildings. These days, you may also be asked for your notebook serial
number by building security personnel. To save time and hassles, print your
notebook serial number and cell phone on a card to present at the reception
desk and also record an Outlook Note with your computer serial number and
save.

195
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Hand-carrying your Outlook folder

Fifteen years ago, transporting your files from
one place to another meant having to carry a
heavy portable hard drive or a tape drive. Today,
you can have a Traveldrive device on a key
holder with 2GB and a USB connector working
as a portable computer drive. Also, music play-
ers like iPods and other MP3 devices can act as
portable hard drives and store your Outlook files
while you travel. Loading your Outlook file onto
any device is easy. First, check the size of your
Outlook folder to make sure that it fits on the
device's available space.

To determine the Outlook folder's file size,
choose Tools=>Mailbox Cleanup and then click
the View Mailbox Size button. The Folder Size
dialog box opens. If the folder fits on your
portable device, you can upload the information
with the Backup tool.

To use the Backup tool, choose File=>Backup.
From the Outlook Personal Folder Backup dialog

box, click the Option button and then select the
file to back up. Browse the memory drive
address and select Backup The File Selected
Above To This Location. Click OK and then click
the Save Backup button on the next screen.
Read how to download and install the Backup
tool in Chapter 3.

To read your Outlook folder on any computer
running Outlook:

1. Open Outlook.
2. Choose File=>0pen=>0utlook Data File.
The Outlook Data File dialog box opens.

3. Double-click the folder name to open the
file.

While traveling, don't forget to physically sepa-
rate the Traveldrive device or CD-ROM and your
computer as a safety precaution.

To open a note:

1. Click Notes on the Navigation Pane.

A\
If you don’t see the Notes button on the Navigation Pane, click the
Configure button, in the Navigation Pane lower right to add the button.
2. Choose New=>Note to open a new note.
3. Type the notebook data into it.
4. Click Save And Close.
\\3

You can also just double-click in an empty area of the notes screen to open a
new note.

Remembering Expiration Dates

People tend to forget about expiration dates on documents that stay valid for
a long time, such as driver’s licenses, passports, and vaccine dates. When a
document is valid for three, five, or ten years, you obtain it and tend to forget
about it until you need them renewed . . . yesterday!
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Don’t get stuck in the airport anymore because you didn’t check your visa or
get a vaccine — these items are the first things you should renew when
you’re traveling to a foreign country. Some consulates can be slow or may not
even have an office in your city, so check the country’s requirements first and
then schedule your applications well in advance. Passports are generally
valid for a long time, so use the Task reminder one month before your pass-
port’s expiration date to create a reminder:

With Outlook open on the Tasks list.

1. Click the New button to open a new Task.
2. Type Passport Expiration into the Subject line.

You can open a Task to remember expiration dates for any document,
including your passport, driver’s license, or any other document. Simply
type the name of the document into the Subject line.

3. Set the expiration date as the due date.
4. Set the Reminder date to one month before the due date.

Be sure to set the reminder with enough time to renew your document.
5. Click the Save And Close button.

Outlook now reminds you of your expiration date so that you have
plenty of time to renew your passport.

Coordinating Time Zones

Working daily with other locales and countries or from other countries means
working with different time zones. Some people even wear watches that run
two time zones at the same time. Likewise, Outlook allows you to add differ-
ent time zones to your Calendar so that you can avoid waking up your spouse
at 3 a.m. when you’re working in Hong Kong and forget the time shift. Adding
Hong Kong’s time zone to your Calendar is easy.

1. Choose Tools~>Options and click the Calendar Options button.

The Calendar Options dialog box opens.

2. Click the Time Zone button to open the Time Zone dialog box, as
shown in Figure 13-2.

3. Type your label in the Time Zone Label text box.
You can type ARZ if you're in Arizona, for example.
4. Check the Show An Additional Time Zone check box.

5. Select a time zone from the Time Zone drop-down list.

197
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You can select Hong Kong, for example.

6. Type the city or country name in the Label text box.
You can type HGKG for Hong Kong.

7. Click OK.

Time Zone [~ %]
Current Eime zone M
Label:
Time zane: {GMT-07:00) Arizana v
|
- Current bime: | Thu 7/7/2005 2:19 PM
Figure 13-2:
YOU can [#] Show an additional time zone
selecttime | ‘'
zones in Time zone:  LGMT-+08:00) Pequim, Chonguim, Hong Kong, Urumal +
Hong Kong
and Arizona.
|

Your Calendar now looks something like Figure 13-3.

a\\S
If you work coast to coast in the United States, you can add the three time
zones in the same way you added the Hong Kong time zone.
| aal De
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Finding Vou Anywhere Easily
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Your clients and coworkers often need your input, even when you’re working
abroad or outside the office. Outlook can help you keep your office informed
about your external meetings and business trips. Making your agenda avail-
able to your company is easy. When you’re connected through an Exchange
or small business server, you can make your Calendar (or parts of it) avail-
able to your colleagues so that they can find you in just a few clicks. You can
also print a copy of your Calendar, publish it on the Internet, place it on a
public folder, or use a SharePoint server. The SharePoint server is another
Microsoft product that makes collaborative work easier. (You can read more
about SharePoint and other sharing procedures in Chapter 10.)

Besides making your schedule available for others to read, you can give cer-
tain individuals (your assistant, for example) the power to add new appoint-
ments to it. Chapter 10 explains how to share your Calendar.

When you're out of the office visiting a client, you don’t have to waste time
writing your contact’s address down for your office; instead, you can attach
the contact’s information to your Calendar appointment in Outlook. This con-
nects all the relevant information in your appointment book for single-click
access, and makes it available to your team if you choose to share your
Calendar. Follow these steps to attach your contact to your appointment:

1. Open a new appointment in the Calendar.

2. Click the Contacts button in the lower-left corner.

The Select contacts dialog box is displayed.
3. Select the applicable contact.

The contact is linked to your appointment.

Keeping in Contact with Your Family

If you're married or have kids, traveling on business can require more from
you than it may from a single person. You must be available by phone, e-mail,
or instant messaging at any point in the day — not only to keep the relation-
ship running, but also to be available for the many little emergencies that
happen all the time in families. Leaving a copy of your agenda with addresses
and phone numbers can help your family connect with you when necessary.
Outlook can help you deliver your travel agenda to your family in several
ways.

199
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Figure 13-4:
Publish your
Calendar as
a Web page
on your
home
computer.
|

The easiest way, of course, but the most likely to be misplaced, is to simply
leave a printed copy of your agenda at your house. Just open your Outlook
Calendar and print a copy of your agenda. Don’t forget to print the phone
numbers of your hotel or of the other places you’ll be.

The following sections describe some other options.

Publishing your agenda on the
family home computer

If you have a local network at your house, connect your computer to the net-
work, open your Outlook Calendar, and follow these steps:
1. Choose Filez>Save as Web Page.
The Save As Web Page dialog box appears, as shown in Figure 13-4.

You can set the starting and ending publishing date to show only your
trip schedule.

2. Set the trip’s duration by using the Start date and End date dialog

boxes.
Save as Web Page % %]
Durakion
Start date: | Tue 1/2{2007 ~ | End date: | Fri 1/5[2007 v

Options
[ Include appoirkmert details

[Juse background graphic:

2ave as
Calendar title: | Mark

File name: C\Documents and Setbingstdaisy|Deskiopt Mark. htrn

Flosensamdussraganteomar

Adding dates publishes your agenda for the period listed; other dates
aren’t published and appear blank. You can publish any calendar period
you choose — from one day to one year.

3. Check the Include Appointment Details check box.

This option gives others access to details such as meeting locations,
phone numbers, and contact names.
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4. Enter a name in the Calendar Title area.

For example, you can use your name so that others can quickly see that
this schedule belongs to you.

5. Browse through the home network to choose a folder on the destina-
tion computer, such as Shared Documents on a Windows XP family
computer, for publishing your information.

6. Highlight the chosen folder and click Select.
7. Click the Save button to publish the Calendar.

The Calendar is now available on the destination computer with the spe-
cific dates you chose to publish.

To view the schedule, open the shared folder located on the family computer
and click the Calendar file to open it. Scroll down and read the appointment
and event details on the right side of the Calendar. With this information,
your family can quickly find and call you in an emergency. Don’t forget to
include your hotel reservations on the Calendar.

You can also publish your Calendar on a stand-alone home computer. When
you don’t have a home computer network, save the published Calendar on a
floppy disk or CD-ROM. Insert the disk in your home computer, select the
Calendar by its saved name, and click to open and read it.

Publishing your agenda online

When your family is spread out across several different computers in differ-
ent locations, you can publish your calendar online. In the same way people
are publishing their personal blogs, you can publish your agenda on a Web
site available to your family. Check with your Internet provider about how to
upload your agenda. You publish your agenda the same way you do to save it
on the family computer (see preceding section). When your family accesses
the page on the Internet by using Internet Explorer, your published Calendar
opens without Outlook. Publish it in an out-of-the-way folder (with no links to
it) on your site so that nobody will know that it’s there except your family.

Giving access to your Calendar folder

Running your own business by using an Internet provider with an Exchange
server allows you to give Calendar access to your colleagues and family
through sharing properties. Chapter 10 shows you how to share your Calendar
and how to access a third-party Calendar. You can give your family a password
so that they can open your Outlook Web Access (OWA) page and read your
information. The OWA page is a synchronized copy of your own computer
Outlook folder with your Calendar Tasks and mail folder available online.
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Adding Foreign Holidays to Outlook

If you call a foreign country during one of the national holidays, you're likely
to waste your time and money. Without Outlook, you may not be able to
recall Hong Kong’s new year or when the Carnival takes place in Brazil. You
can add the national holidays from any country to your Calendar to avoid
making calls at the wrong times.

1. Choose Tools=>Options to open the Options dialog box.
2. Click the Calendar Options button.
3. Click the Add Holidays button.

The Add Holidays To Calendar dialog box opens.

4. From the list, select which country’s holidays you want to add and
click OK.

The holidays start loading into your Calendar.

\3
) You can also add religious holidays of the Christian, Islamic, and Jewish reli-
gions to your Calendar. Use them for your own religion as well as to observe

your customers’ religious holidays.
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In this part . . .

M illions of small actions — from posting a payment
check on time to closing a lucrative contract —
build any business. You can use Outlook to track the
boring, day-to-day tasks. You can enter that tip you
received during a phone call with your customer into a
Journal form with a time stamp and then retrieve it by
opening the customer’s contact. Visiting your customers
requires planning and organization in order to achieve the
best results.

In addition, marketing programs, besides needing creativ-
ity, need organization. You can start with simple check-
lists that you develop using Outlook. You can even create
filters for selecting a customer base as you wish.




Chapter 14
Tracking Sales Activities

In This Chapter

Taking care of customers after getting the order
Tracking periodic sales goals
Prioritizing customer messages

Synchronizing sales info with your mobile device

Salles activities differ from one business to the next. If you're running a
business where your customers keep buying from you weekly, monthly,
or at least once a year, you have to take care of your customer relationships
in addition to managing the ordering cycle. Getting the order and vanishing
like a ghost doesn’t add value to your sale. Outlook can help you track your
activities for each customer and even remind you to call your customer
weekly.

Keeping a Client

Pressure to increase revenues often translates to finding new accounts at the
expense of maintaining existing accounts. You've likely heard stories about
surprised managers crying, “Oh, my gosh, this company used to be my top
customer. Now they moved to our competitor without even negotiating with
us!” What happened?

Taking care of your customers after you get the order — and keeping the rela-
tionship strong — is an art. Do you know how many times you have called or
visited each customer lately? Most salespeople don’t control the number of
contacts they make with each customer. However, you can classify your cus-
tomers according to their sales potential and define the number of weekly
calls or monthly visits each receives. Outlook can help you touch base with
your customers according to your schedule.
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Categories allow you to manage customers in groups. You can examine the
groups and detect missing or unfinished activities for certain customers.
Then you can schedule a certain number of visits or social meetings with
your customers, such as happy hours or lunches.

You can classify your customers by using four categories:

v Platinum: The best customer

v Gold: An excellent customer

v~ Silver: A good customer

v~ Standard: An average customer
You can also define a call frequency for each category. You can then use the
categories to classify each client according to sales potential and view your

Contacts list by categories (see Chapter 4). Table 14-1 can help you plan
your activities for each customer; it’s for customers placing orders at least

quarterly.
Table 14-1 Customer Contact Plan
Classification Visit Phone Calls Social Meeting
Platinum Weekly Daily Monthly
Gold Twice a month Twice a week Once a quarter
Silver Once a month Once a week Once every six months
Standard Once a quarter Twice a month Once a year

Of course, you may not want to follow such a rigid contact cycle as Table 14-1
suggests. Maybe you have some customers that you just like spending more
time with. Maybe your Platinum customer doesn’t want to receive your call at
9 a.m. every Monday morning. To achieve a balance and not lose track of
your customers’ needs, use Table 14-1 only as a guide.

Scheduling customer contact frequency

Outlook offers many ways to remind you about your client appointments and
calls. One way is to create a recurring Task. However, the objective isn’t to
receive a reminder on the same day at the same time every week, but rather
to remember the next required action after the end of a call or meeting. For
example, after finishing a call with your customer on Friday, set the reminder
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for next week on a different weekday. And instead of using Tasks for simple
reminders, use the Contacts follow-up flag as a simple reminder, thus leaving
important Tasks in your Tasks list and the reminders in the follow-up flags.

To open a Task for each Platinum customer and then create a reminder for
the next action, follow these steps:
1. Open one Task for each Platinum customer.
Read Appendix B for more details.
2. Type Customer’s Name Touch Base Reminder in the Subject field.

3. Write down your last actions with the date, such as the last visit date
and your schedule for the next visit, or the last phone call date and
your schedule for the next phone call.

4. Set up the reminder for the next scheduled event.
5. Save and close each Task.
The Task looks like Figure 14-1.
Creating a recurring Task is helpful for five to ten customers. If you have a group

of 50 active customers, you add 50 Tasks to your list. See the next section to
find out how you can avoid excessive numbers of Tasks by using the flags.

inder - Task BEE

i Eile Edit View Insert Format Tools Actions Help

! ol Save and Close | [l + ' Becumence... 15 Assign Task EJ  Arial =l - AB XU l%l%
E.mail Autolink |2 Link to Record | (& =

-] Platinum Shoephone Inc. Touch base

Task, Detals

Subject: Platinumn Shoephone Inc, Touch base reminder

Due date: Sat 5/6/2006 | Stsus:  Completed v
Shark date: ‘Wed 8102005 ~ | Priorky:  High v| % Complete:  100% &

jReminder: Cowner: b

Last meeting date 01/10/06. Mext meeting schedule for 01418406

Last phone call to Masxwell taday, next phone call next Tuesday.

Last phone call to Henry on the procurement department last Friday, next phone call next Monday.
Pending issues:

1. Renew contract 123

2. Check delwary order 397,

|
Figure 14-1:
Use a
reminder to
touch base
with
Platinum
customers.
|

Mavewell Sark Flatinum Private [ ]
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Flagging a contact

If you're working with a large group of contacts, a better option than setting
up Tasks (see previous section) is to use a follow-up flag. You can use this
flag to set up five options: Follow Up, Call, Arrange Meeting, Send E-Mail, and
Send Letter.

To view all your customer reminders in one list by category, set up your con-
tacts list by using these steps:

1.

With the Contacts list open and displayed by Category, click
Customize Current View on the Navigation Pane.

The Customize View dialog box appears.

. Click the Fields button on the Customize View dialog box.

The Show Fields dialog box appears.

. Select Miscellaneous Fields from the Select Available Fields From list

box.

4. Select the Reminder Time and Reminder Topic fields.

. In the Available Fields list, click the Add button for each field to move

it to the Show These Fields In This Order list.

. Click the New Field button to create the Call Date field with the time

format.

. Adjust the new fields in the Show These Fields In This Order list

according to your needs.

. Click OK.

Your Contacts list now has three new fields: the Call Date field for typing
your last call, the Follow-up field to see the next action, and the
Reminder Time field (see Figure 14-2). This customized list displays your
reminders together.

Instead of opening each contact to update it, you can update the list in the
following way:

1.

Select the contact name from the list and type the date in the Call Date
field.

. Right-click the contact name and choose Follow-Up.

The flag for the follow-up box opens.

. Select an action, such as Call, Arrange Meeting, or Follow Up, from the

Flag To list box.

4. Select the date and time from the Due By list box.
5. Click OK.



|
Figure 14-2:
You can add
new fields
for follow-
up control in
the
customer
list.
|
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The action and the reminder time appear on the selected contact line. Now
you can control, in one page, all your customer actions — from the last con-
tact date to the reminder for the next action. By setting reminders for every
customer, you can easily remember to contact each customer according to
your schedule.

BCM Business Contacts and Accounts provide the same customization as
explained here. You can also use add-in software, such as Reminders, by
e-mail, available at RSOutlook. You can then send the reminders to your
mobile device.

Don’t set all follow-up reminders to the same time, such as Monday morning
at 9 a.m. Schedule the reminders throughout the day and week.

Tracking your customer history

Salespeople aren’t always organized and often spend a lot of time looking for
a proposal or trying to remember the date and subject of the last phone call.
Using BCM (see Chapter 6), you can link all your actions to a particular cus-
tomer and access all the information from the Contact record. The Outlook
Contacts Activities page can show you all actions related to a contact. You
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can link any document, Task, appointment, or meeting phone log to your cus-
tomers and read them in one click. Here’s how:
1. With your customer contact open, choose Actions=>Link= File.
The Choose A File dialog box opens.
2. Select your file, such as Mary’s Proposal 321.
3. Click OK.
The proposal file is linked with Mary’s Contact record.
Besides linking external files and documents to your contacts, you can also
link Outlook appointments, Tasks, phone call journal entries, and e-mails
(both sent and received) and then read them in a single list.
1. With your customer contact open, choose Actions=>Link= File.

The Link Items To Contact box appears, as shown in Figure 14-3.

Link Items to Contact %]

Look in:

L7 Drafts [1] ~
L) Inbox (2)

A8 soumal

g dunk E-mail

Lo | Motes

U Oukbioze

=7 Sent Ikems

2 ]

=

[ ¢ @ Subject Statis Due Date Percen... Categories ||
I ] 1 ‘ear 2010 Goal One: Double the Company...  InProgress Fri12{31j2010 0%
. ) tustomer request #121 InProgress  Tue 7j3/2007 0% Key Customer
Flgure 14-3: =] Passicrifruit Drink. ‘Waking on ... Fri&{1/2007 25%  Proposal
You can link 2] 1 Delver the proposal to Gold Customer InProgress  Thu 1/11j2007  S0%  Froposal
2 Print and place on a plastic cover Praposal ... Mot Starked  Thu 9/26{2006 0%
=
an 0 Utl OOk al Project 86 Mot Started  Mon 8/Z8/2006 0%
itemto a ] 1 @ Dream Product Team Alignmeri InProgress  Thu 6/20/2006  25% Strateges v
contact. Lo [Cconea ] oo
I

2. Select a folder, such as Tasks.
3. Select a Task from the Task Items list.

For example, I chose a Task called Deliver The Proposal To Gold
Customer.

4. Click Apply.

The item is linked to your customer contact.
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Automating links to your contacts
Linking each item to your contact manually is tedious and can potentially add
hundreds of weekly actions to your work, making you lose more than your
patience. You may forget to link items or lose track of e-mails, Tasks, and
appointments related to your customers. Fortunately, Outlook can automati-
cally link the items related to your contact in the following way:
1. Choose Tools=>Options.
The Options dialog box appears.
2. Click Journal Options.
The Journal Options dialog box appears, as shown in Figure 14-4.

3. Select the items to be linked on the Automatically Record These Items
list box, including e-mail message meetings, Tasks, and other actions.

Journal Options %]
Journal
Cll Automaticaly record these ibems Far these contacts:
[ E= i [#] oo Camel ~
| Meeting cancellabion [¥] Mark Eteer
|+ Meeting request Meark Goodday
[+ Meeting response || Mary Saink Louis
I [w] Task request ~ Masowell Smart bl
Flgure 14-4' Alsa record Files From: Double-clicking & journal enkry:
The Journal (4] Wicrasoft Office Access @i e
i [¥] Micrascft Office Excel
0 ptions [¥] Micrascft FowerPoint (%) Opens the kem referred to by
d ia |Og bOX [w] Micrascft word the journal ertry
links items [ Aytosrchive Journal Entries. .. ]
to a contact. :]OK
|

4. Select the contacts to be linked from the For These Contacts list box.

5. In the Double-Clicking A Journal Entry area, select the option called
Opens The Item Referred To By The Journal Entry.

The Journal has a wider application than simply linking Outlook items to
a contact. The Journal can also measure the time you spend working on
a document or present your documents in a timeline chart, showing
each one on the date that it was used. Read Appendix D for more details
about recording office documents in the Journal.

6. Click OK.

All Outlook items related to your contacts are now linked.
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Reading your client history

Searching for customer files in your computer’s folders can be tiresome. You
may store one Word document in one place, an Excel spreadsheet in another,
and the date of your last meeting in the Calendar. You can, however, have all
this information organized for you by opening only one page, which means
no lost time searching for the information.

To read your customer history:

1. With the contact open, click the Activities tab.

The Activities page appears. When the Show list box says All Items, all
your activities related to the open contact are listed, as shown in Figure
14-5.

2. Click any item in the list to open the linked document or Outlook
item.

The information is displayed without your having to look for it.

General Detais Aickivities Certificates All Fields

Show: Al Ttems ]
[ Subject In Folder
| proposal 322 Drafts
j Project alignmert Calendar

o] product list Journal

5 Phone Call - [Louis, Mary Saint] closing package 320 Journal

5] Opporturities excel File Journal

G Mary Saint Louis negotiating package 321 Journal

G» Mary Saink Louis closing package 321 Journal

/| Dedver the proposal to Gold Customer Tasks
4 Choose you topping: Clicking o the tabs I

|
Figure 14-5:
The
Activities
page lists
the
customer
history
items.




Creating Sales Targets

Past sales reports, backlog orders reports, and client histories can all give
you a decent picture of your business today, without the need of a crystal
ball. Open sales proposals and sales opportunities accumulated over a
period of time can help you forecast short-term sales and create sales objec-
tives for each customer — with your insight and analysis, of course. Likewise,
listing the sales targets for a certain period helps you monitor each customer
and achieve your sales goals. Creating a customized contact list with fields
for your quarterly objectives, including your quarterly sales goal and your
goal today, gives you an actual-versus-forecast picture. Figure 14-6 shows a
customized customer list with a sales goal for each customer. (Chapter 4
covers customizing the Contacts list for sales activities.)

Figure 14-6:
You can
customize
the

Contacts list
for sales
actions.
|
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The sales goal is only the final parameter. Organizing your open opportunities
and proposals, listing the missing items, taking actions, and negotiating with
your customers helps you achieve your goals with less stress. You can open a
Task to control every open sales proposal. You can also customize the Tasks
list in the same way that you can customize the Contacts List (see Chapter 4).

To customize your Contacts list by category:

1. With the Tasks list open By Category, select Customize Current View
from the Navigation Pane.

The Customize Fields dialog box appears.
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Figure 14-7:
Selecting
open
proposals
on a Tasks
list helps
you analyze
your
activities.
|

2. Click the Fields Button.
The Show Fields dialog box appears.

3. Click the New Field button to create a new field.
The New Field dialog box appears.

4. Type the name in the Name field.

In the example, the field name is Value.

5. Select and move the fields in the Show These Fields In This Order list

according to your needs.
6. Click OK and close the Show Fields dialog box.
7. Create the Proposal category.

See Chapter 4 for more details on how to create a category.
8. Select every open proposal on the Proposal category.

After this setup, you can close all categories in this view and see only
the proposals (see Figure 14-7) with their due dates and status. Select

the proposals and cut and paste them into an Excel workbook to analyze

them and create forecasts and charts.

[ *|@ Subject LET Ststus | Due Date %, Complete | Categories
4 Categories: (none) (8 items)

& Categories: Key Customer (1 kem)

3 Categories: Platinum (1 item)

=l Categories: Proposal {3 items;

F &cal from Amazon| 456,456 In Prog... Mon 5(30/2005  25% Fropasal
&] t  Deliver the proposal to Gold Customer §123,456 InProg... Thu1j11/2007 S0% Proposal
] Passiorfruit Drink. §765,432 Waitng... Fri 6/1/2007 25% Fropasal
3 Categories: Strateges (1 item)

The Tasks list view, which includes the value fields, enables you to follow up
with each proposal; the reminders turned on for the next step appear to
remind you of the next action.
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If you're a BCM user, you can create a similar report to the one in Figure 14-7
without having to add new fields. Just use BCM’s Opportunities reports, such
as the one shown in Figure 14-8. Unfortunately, there are no reminders avail-
able in BCM, but the numerous fields in BCM records lets you create reports
with all kinds of data in them. Use either BCM or Outlook Tasks, whichever
best fits your needs. For more information about BCM and BCM reports, see
Chapters 6 and 7.

[} Opporturity Title Linked To Sales Stage Expecte... |Pro... Close Date
-_’} Apple and Grapes The Pupuriha ... ProposaliPric,.. $0.00 0% Mon S{30/2005 4:54...
57 Acple Jo= De la Passion PropasalfPric...  $13.46  30% Thu 5/26/20055:50 .,
J} Shampoo Mary Saint Louis PropasalfPric. .. F4.46  S0% Wed 5/17/2005 10:4...
-_!} Grapes Spinach Health.., Prospecting $77.22  25% Tue 8/30/20055:04 ...
-f} Banana Assal Healthy ... Prospecting $80.85  33% Thu S/4/2005 4:31 PM
=9 Apple Season Chili Caliente H... Propasalffric. .. $151,19  S0% Sun 10/30/2005 4:5..,
-_!} [Mew Passion Frui pie Granny ‘s Fla... PropasalfPric, .. $179.73  50% Mon 5/30/2005 5:01...
--'} drangs Stick's Barbecu... PropasalfPric. .. $320.76  75% Mon SF30[2005 5:04.,.,
I |
-{! Passionfruit Drink, Chili Caliente H... Prospecting $17,972...  S0% Thu &[3/2005 1:41 PM
Figure 14-8; |23 #ziram Amazen AssalHealthy ... Qualfication  §52,250.,.  50% wed 5/30/2007 4:56...]
You can use
the BCM
Opportunitie
s listto
control all
your
prospects.
|

Each BCM Opportunity is linked to its Business contact or Account. You can
link any open Task to its contact by clicking the Contacts button at the
bottom-left side of each Task and choosing the desired contact name. Open
your contact and click the Activities tab to see all the Tasks associated with
this contact. Read about the details in Chapter 15.

\\J

Analyzing Quotes to Help Close Orders

A distributor’s sales manager analyzes the number of quotes sent compared
to the number of closed orders. The number is below 10 percent. The presi-
dent of the company demands that any request for quote — even for nonreg-
istered customers — must be sent promptly, so the manager analyzes all the
quotes, one by one. He detects that most of the unclosed orders aren’t from
current customers. He then negotiates with the president to create a new
rule: to send quotes only for registered customers. Now, the receptionist asks
every incoming phone call whether the person is a registered customer. If the
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answer is no, she sends an e-mail form, customized by using Outlook forms,
(see Chapter 5 for customizing a form), to register the customer. The result
was fewer phone calls for useless quotes, and the number of closed orders
versus quotes is four times higher than before. Having fewer prospects
increased the company billings.

Analyzing your client’s current backlog report not only shows your future
billings but also shows the way the client is placing new orders. You can
detect a drop in orders so that you can work to get a new order or under-
stand the customer’s current trend. Search the backlog report for orders that
are about to hit the delivery stage and then follow up with each customer on
the appropriate delivery date. Set up Tasks to remind you to follow up with
each customer.

When your business is only you, you can’t delegate. But when the business is
growing, inform your customers about your growing team. Introduce all new
team members and distribute their phone numbers and e-mails. Tell your
customers how the new staff members can support them on your behalf,
even helping to close orders. The VIPs are your customers, and they must be
supported by the entire team, not only by you.

Classifying Messages

If you deal with hundreds of messages each day, besides the Zen of Inbox
Management (see Chapter 8), you may need to employ other tactics to clas-
sify and organize messages — especially for sales purposes. Using colors to
organize messages, having Outlook search for specific words within mes-
sages, and even forwarding the messages to a mobile device are all helpful
ways to keep organized.

Coloring messages

Coloring your messages can be a helpful tactic to get your mind around the
wad of e-mails you receive every day. You can identify arriving messages
by using colors — your boss’ messages in pink or your best customer in
green — and simplify your Inbox, both visually and psychologically. To set
up the colors for arriving messages, use the Organize Pane.
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|
Figure 14-9:
You can
organize
your
messages
by color.
|

Don’t use all the colors in the rainbow to classify each of your incoming mes-
sages, because your Inbox will end up looking like a carnival parade.
Overusing this feature defeats the purpose of coloring the messages.

To apply color to your messages:

1. With your Inbox open in Outlook, choose Tools~>Organize.
The Organize Pane is displayed on the top of your Inbox.
2. Click Using Colors on the left side of your screen (see Figure 14-9).

The Organize Pane shows the fields to color the messages.

| x

Color messages |from % | mer@bestcompany, com | in | Gresn | | | Apply Color

| Donel
i Using Colors Show messages sert only to me in v

3. In the Color Messages list box, select From.

4. Select the desired e-mail from the Inbox to apply the color to or type
the e-mail address into the text box.

5. Select the color from the list box.
6. Click the Apply Color button.

From now on, the titles of the messages from this customer appear in the
color you choose. Using color this way enables you to see important mes-
sages in the blink of an eye. You can classify your top five customers (per-
haps including your boss) by giving each one a different color.

You can also apply colors to messages containing certain words or phrases.
Colors and filters are a great way to organize and prioritize your actions relat-
ing to arriving messages.
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Follow these steps to apply color to select words:

1. Click the Automatic Formatting command at the top of the Organize
Pane.
The Automating Formatting dialog box appears.

2. Select your rule on the Rules For This View list box, such as Mail
Received From John@123.Com.

3. Click the Condition button.
The Filter dialog box appears (see Figure 14-10).

Filter (%]
| Messages |More Choices | Advarced

Figure 14-10 Search for the word(s): |p.0.; Purchase Order; RFQ; request For quote;  |w
Ad d f| |te |’|n g In:  subject field and message bady ~
and COlOfIng From, .. mybestcustomer@hestcompany, com|

to marcelc@mbcriztiva.com.br
messages []where T am:

by using
words and
e-mail
address.
|

Time: rone »

of | [ Cencel |[ Gearan

4. Type the words to search for, such as p.o., purchase order, rfq, and
request for quote — all separated by semicolons — in the Search For
The Words text box.

5. Using the In drop-down box, decide where in the message the search
should be completed.

6. Enter the e-mail address into the From text box.

7. Click OK.

Messages with the words you entered now appear in the color you
choose, thus calling your attention to these special messages.

Selecting arriving messages by subject

When you use colors and filters (see preceding section), you can select and
color messages that come in from a particular person or that contain specific
words. You can also create a rule to automatically categorize all arriving
quote requests from your customers. Using the e-mail view By Categories,
you can then list all incoming proposals together in one place.
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Figure 14-11:
Type words
to identify in
arriving
messages.
|

With

1.

the Inbox open:

Choose Tools=>Rules And Alerts=>New Rule.
The Rules Wizard opens.

2. Select Start From A Blank Rule.

. In the Step 1 Select When Messages Should Be Checked, select Check

Messages When They Arrive.

. Click Next.

The wizard displays a new page.

. In the Step 1 Select Condition(s) list, select With Specific Words In The

Subject.

. In the Step 2 area, choose Specific Words.

The Search Text dialog box appears.

. In the text box Specify Words Or Phrases To Search For, type the

words to search for, such as Quotation, Proposal, RFQ, and Quote,
separated by commas.

. Click Add.

The text moves to the Search list (see Figure 14-11).

Search Text %]

Specify

Search

“quobs
“propo
“order”
“price”

B0, or

words or phrases to search For in the subject:

hst:

“or
sal" or
"or

10.
11.

12.

13.
14.

. Click OK after you add all the desired words and phrases.

Click Next to see the new wizard page.

In the Step 1 Select Action(s) List, select the Assign It To The Category
Category.

In the Step 2 area, select Category.

The Categories list opens.

Select Proposal and click OK.

Click the Next button twice, skipping the exceptions list.
The rule setup is ready (see Figure 14-12).
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Rules Wizard &

Which condibion(s) do you want to check?
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15. Type the rule’s name in the Specify A Name For This Rule text box.
You can call the rule Proposal, for example.

16. Click Finish.
The Rules And Alerts list opens.

17. Select the rule you named, click Apply, and then click OK.

The rule is ready. All requests are now filtered and listed in one category —
the Proposals category, in this case.

When you apply rules to your Inbox, you can also place a greater focus on

your sales activities and related messages. To list your messages by category,
choose View=>Arrange By Categories.

All arriving messages with the requested words are listed in the Proposals
category. Sales managers can use the same technique to search for words
and move them to specific folders. This way, they can route sales team
reports to the appropriate reports folders.
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Receiving Outlook messages
on your cell phone

Mary is waiting for an important order from her top customer, but she can’t
wait any longer. To be informed of the arriving message, she makes a rule
that when a message comes in from important@veryimportant.com,
Outlook should send a copy to her mobile device’s e-mail address. To send
the e-mail to a cell phone, use the following rule:

1. Choose Tools=>Rules And Alerts=>New Rule.
The Rules Wizard opens.

2. In Step 1, select Send An Alert To My Mobile Device When I Get
Messages From Someone.

3. Follow the wizard instructions.

Check with your cell phone company about your phone’s capability to
receive messages and their maximum sizes. In the worst case, you can proba-
bly receive the message subject, the sender, and arrival time.

You can also receive Outlook’s Reminders as SMS messages at your Mobile
device by using available Add-in software such as Reminders by SMS. The
software is available at www. rsoutlook. com. The add-in reminder software
sends Outlook Reminders from Tasks, appointments, and mail messages to
your mobile device through Short Messages Service (SMS), thus helping you
keep your appointments no matter where you are. Besides the add-in soft-
ware, you can contact your mail service provider or your cell phone com-
pany to determine what other wireless synchronization services are
available.



2 2 2 Part IV: Controlling Business Processes




Chapter 15

Planning, Prospecting, and
Visiting Customers

In This Chapter

Getting information about a new customer
Planning a visit to a prospective customer
Doing your homework after visiting a customer
Sending and following the proposal

Using BCM to track your customer account

A salesperson who doesn’t properly plan looks like a merchant in the
Moroccan tourist market, hustling and negotiating to get the order.
Although nothing is wrong with this type of selling, most likely your prospect
isn’t a tourist searching for a bargain in an open-air market. You have to
develop strategies to create good relationships. Winning the customer’s con-
fidence means creating business for the long term. In this chapter, you dis-
cover the basic procedures for organizing a sales effort — from prospecting
to closing an order — using Outlook or Business Contact Manager (BCM).
(For more on BCM, see Chapter 6.)

This chapter explains the step-by-step procedures for building a customer
profile and tracking all customer activities with Outlook Contacts or Outlook’s
Business Contact Manager (BCM) add-in software. Both options are good, but
different. For example, whereas in Exchange server you can load and share
contacts, BCM has ready-made business forms. Which one you use depends
mostly on what you need in a program.

Loading a New Customer Profile

Joe Newcomer was hired as a new salesperson to be in charge of prospecting
and developing a new customer base. As soon as he starts, he’s assigned an
unknown company to prospect. Instead of going for a blind meeting, Joe does
a little Internet research to collect some customer information. He visits the
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customer’s home page and collects some data. Next, he uses search engines
such as Google and Yahoo! to search by company name and gets even more
information. Third, he searches by the company’s products and services to
gather information about their competition and product placement. He then
loads all this client information into a Contact record that he customizes as a
company profile (see Chapter 4). Figure 15-1 shows this record.

|©] Contacts - Microsoft Outlook == ]
! File Edit View Go Tools Actions Help Type a question for help =
B Mew = (3 X | ¥ 82 & - | EoFind | [} Trpe s contacttofind = | -@H
63|, @ Back ©) 2 [3.[2 ]9 |8 3 @ @) Prone s =E-EY )
= e T
My Contacts |0 @|w|FullMame  ©  Decisi... | Company Quarker Goal |Goal to... | Business Phone Journal | Cate
® Phone List | k here .
O By Category &g ¥ Chap Tears [ HurryHarryine  97,000.00 35 (002) 96765432 [
O ey Company %] Clark Caliente Daily Planet 120,00000  15% (123) 1234-1234 [
o 87 ¥ Jane Mefirst @ Meefist 450,000,00  24% (407) 12341234 [@
~ By Location 3 Joe Shooeker Firewater 10,000.00  100% (12)123-1234 2
|
© ey Follow-up Flag | _ 83 Jojo Camel Desert Sand 453,232.00  35% =
Figure 15-1: o =l Mark Eteer [ Meetdebest 123,321.00  85% (967) 12341234 [
Joe" Open Shared Contacts 8 Maxwell Smart Shosphome e, 54,600.00  37% (8e)eel-gal [
0(.3 S Customize Current Vie {5 - B ||
Contacts list —
view was | | Ml
customized || . calendar
asa || 4| contacts
customer 2] Tasks
sales e
X Ja [ =
profile. &l I (2]
3 Ttems
|

You can type information that doesn’t fit into your Contact record fields into
a Journal note in the following way:

1. With the contact on the screen, choose Actions~>New Journal Entry
For Contacts.

The Journal Entry form appears. The Journal title always contains the
contact name.

2. In the Subject text box, type a name to remember the information
you’re saving.

3. Select Note from the Entry type list box.

The Entry Type list box shows nearly 20 options, including Document,
Phone Call, and Letter.

The Start Time date box shows the current time, but you can change it
as desired.
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4. Type or paste the information at the bottom of the record.
Figure 15-2 shows information in a customer record.
5. Click the Save And Close button.

Adl Site information - Journal Entry == ]
Eile Edit View |Insert Format Tools Actions Help

¢ o Save and Close | i | B0 e8| K| G | @ L

Subject: Ske information

Entry bype: Mate w | Compary: Best Compary

Statbime: | Tue 10/10/2006 vl 1nsaam v o

Duration: O minutes . \a=/

Branches in 3 countries.
Plant in Chatanooga.
Major customers Silver shadow, Liguid Gold.

Figure 15-2: | '™
You can use
a Journal
note to hold
customer
information.
It

[ Contacts... | |ty Best Custeeer Categories....| Brivake []

Mapping Your Client’s Location

You can also use BCM to calculate the distance and driving time from your
office to your customer’s place. To calculate the distance, open your prospec-
tive contact to find the map:

1. With the contact open and in view, click the Traffic Sign button (dis-
play Map of Address) on the toolbar.

If you're online, Internet Explorer opens to the MSN Maps & Directions
site, showing the customer area map. Figure 15-3 shows an example.

2. At the MSN Maps & Directions site, select the To Here command under
Get Directions.

The new page shows the Start Address entry box.
3. Type the starting address.
4. Click the Get Directions button.

The map is displayed with the route directions, including the distance
and the time needed to get there. Figure 15-4 shows the example at this
stage.
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Working on a Customer’s Request

After a customer meeting, you probably have plenty of homework to do back at
the office. You may have to prepare a request for quote and estimate the time to
delivery of a product. You also may need to prepare for a potential sales order.
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Taking preparation to the next level

Joe maps his client's location. Now that Joe has
this information, he opens his calendar at the
appointment setup and turns on the reminder to
warn him 90 minutes before the meeting start
time.

Before leaving the office for the meeting, he

He also prints the customer profile with objec-
tives and some prospecting questions on it. He
can also synchronize the information instead of
printing it, if he's using a PDA or other mobile
device. During the meeting, Joe pays close
attention to his new client— with his cell phone
switched off — asking his questions at appro-

prepares the company folder with a profile and

. , . . riate intervals.
his company’s product or service information. p

Before writing the proposal, you may need to get information about delivery
time from the product department, information about special payment terms,
and discount information for volume orders. Request the support to close a pro-
posal by using the Tasks assignment instead of using e-mail in the following way.

Requesting internal support

In a small company, you can probably just talk with your boss and get the
answers you need. But in a larger organization, you should send a Task to the
product department, asking for the lead time on a special order. You can also
assign a Task to the credit department, requesting the information needed to
release a special order payment terms.

You can assign any internal support by using Tasks instead of e-mails, thus
creating commitments along with the messages. The following example steps
walk you through the details.

1. Type your subject into the Subject line.

For example, you might type, “Lead-time for Product ABC in a special
package. Value $50,000/year.” Typing the value on the Subject line priori-
tizes the answer.

2. Select High from the Priority list box.

3. Change the Status to Waiting On Someone Else.
This option increases the importance of the Task.

4. Select tomorrow’s date as the Due Date.

5. Type your explanation text.

For example, you can type something like “Mark, Please evaluate the file
attached and inform the lead time after receiving the order. Please also
indicate the most economical volume for a monthly delivery. Thanks.”
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. Click the Insert button to attach the file with specification and quantities.
. Click the Assign Task button.
. Type the e-mail address of the person in the To text box (see Figure 15-5).

. Select Keep An Updated Copy Of This Task On My Tasks List in order
to not lose track of your request.

e W 3 &

10. Select Send Me A Status Report When This Is Complete to keep tabs
on the completion of the job.

11. Click Send.

\\J
After requesting the Task, don’t forget to follow up with a phone call.
Task, Detals
To... Mark@rmycompany. com
Subject: Leadtime for Praduct ABC in & special package | Yalue $50,000)yesr
Due date: | Frl 2/10/2006 ™| Ststus:  Waiting on someone else b
Stark date: | Thu 2972006 ~ | Priorky:  High | % Complete: 0% £,
[¥] keep an updated copy of this task on my task list
[¥] Send me a status report when this task is complste
Mark,
Please evaluate the file atteched and inform the Leadtime after receiving the order.
Please alzo inform the best economical volume for a monthly delivery.
Tha.
|
Joe
Figure 15-5: .ﬂj
USE the spedal package
Task requestdac (2. |
request to
create com-
mitments.
Goals{Objectives, Platinum Private [
|

Sending a proposal

After getting all the information and the proposal ready, you need to call the
customer to arrange a meeting to discuss the proposal. During this meeting,
you present and explain the proposal and note the customer’s reactions to it.
Be prepared for negotiations. Some customers request the proposal before
the appointment; in this case, send the proposal attached to an e-mail. Instead
of using an e-mail receipt confirmation (which can offend your customer),
you can insert a follow-up flag in the e-mail.

With the proposal e-mail typed and ready to send:

1. Click the Flag button.
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Figure 15-6:
Insert a
follow-up
reminder in
the e-mail
to your
customer.
|

2. Select Follow Up in the Flag To list box.
3. Select the current date in the Due By date box.
4. Click OK.

The follow-up message appears at the top of the e-mail as a reminder to
your prospect (see Figure 15-6).

Te... mynevicuskomer@bestcompary.com

Wi ce...

Subject: Proposal request

Attach... W Proposal # 1 Best company.doc (24 KB} =3 Atachment Optians. .,

T
Dear ir. Best Customer

Followr attached the proposal per your reguest

Following up on the proposal

Following up on proposals is not a simple and rational task. You have to rec-
ognize when it’s time to negotiate the order. You have to listen to the cus-
tomer’s comments and provide information on how your product or service
can solve their needs. Task reminders are a good way to start your activities,
but your negotiating skills are the key to winning the order.

You can link each proposal to a Task and then set up reminders to follow up
until the order is won:
1. Select the Proposal e-mail from Sent Items box.

To move the e-mail into a Task, you have to move over some commands
to open the new Task.

2. Drag the sent e-mail to the Tasks button in the Navigation Pane.
The My Tasks window appears showing the Tasks folder.

3. Drop the e-mail into the Tasks folders.
A new Task opens with the e-mail inserted into it.

4. Select and link the prospect contact by clicking the Contacts button in
the bottom-left corner of the open Task.

The phone number or e-mail address is then linked to the Task.

5. Select the Proposal category by clicking the Categories button in the
bottom-right corner.

Using the categories helps you list all open proposals by using the Tasks
View By categories.
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|
Figure 15-7:
The
customer’s
history
appears
inthe
Activities
section.
|

6. Set the Due Date to about five days from now.

7. Set the Reminder to tomorrow’s date.

8. Choose Insert=>File to insert the proposal file.

9. Click the Save And Close button.
When you receive the reminder, call the prospect to check on the proposal
status and to view his analysis and comments. You can then reply and over-
come the customer’s objectives. Then set up the reminder for the next call,

as negotiated with the customer. Repeat this basic process until you close
the order and turn your prospect into a customer.

Recording and reading the
entire customer history

You can link to all your customer’s details by using the Journal (see Chapter 14)
and also create phone logs and notes by using the Journal Entry command. You
can then read your customer’s historical data by following these steps:
1. With the Contact record in view on the screen, click the Activities tab.
2. Select All Items from the Show List list box.

The activities-linked files, meetings, appointments, phone call logs,
notes, Tasks, and e-mails appear, as shown in Figure 15-7.

General Detais Aickivities Certificates All Fields

Show: |

[ Subject In Folder
2] Credit terms request for Best Compary Tasks
| Leadime For Produck ABC in a special package | Value §50,000/yvear Tasks
] Mesting ot Best Company Calendar
5] Propasal # 1 Best company Journal
(3 Requested Proposal Drafts
.4, Search engnes information (Google, Yahoo and M3N) Journal
Ly Sike information Journal
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Using BCM to Prospect a New Customer

\\3

If your company doesn’t use the Exchange server and doesn’t have anyone to
customize Outlook, you can use BCM rather than Contacts to manage your
prospects. To open the BCM new Account form:
1. Choose Business Tools=>Accounts.
The Account list appears.
2. Click the New button.
The New Account page appears.
3. Complete the customer information in each appropriate field.
4. Click the Save And Close button.

See Chapter 6 for more details about using BCM to store your customer
information.

Recording customer information

To file the important information collected at the customer site, which
doesn’t fit neatly into the fields of the Account record, you can open a note.
Because the note is listed in the Account History, you need to type a title to
make spotting the note in the history easy.

When your Account form is open:

1. Choose Newr>Business Note in the Account History frame.
A Business Note appears.

2. Type your information from the company site into the comments text
box and type your subject into the Subject text box.

For example, “Information from their site” would be a good subject that
makes finding the information a quick task.

3. Click the Save and Close button.

Open a new note whenever you need to type more information. Your two
saved notes appear in the Account History.

Linking appointments

To set up an appointment from the account form, your best option is to open
the appointment from the Account History Items, linking it to the prospect
account.
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To do so, choose Newr>Appointment in the Account History frame. The
appointment appears so that you can fill it in and save it. The Appointment is
linked to the Account History. Figure 15-8 shows a New Account form. Notice
all the available information about the prospect at this moment. You can even
print the information and carry it with you to your appointment.

Remember to click the customer map button linking with MSN Map &
Directions to calculate the distance and time between the two offices. (See
the section “Mapping Your Client’s Location,” earlier in this chapter.)

General Detais
Acoount Primary Business Contact
Agcourk name: Best Company Brimary contack: Customer, My Best ~|[E)
Address E-mail and inkernet addresses
Business... G188 MW 157 Street E-mail
B Hialesh, FL 33015 E]
ieb page address: bttp: . besteustomer. com
I~ This Is the maling
address Accourk: Financial Infarmation
State: Active j
Phone Kurmbers Stakys: Current Ll
Business [r][azs1zs1za4 | Rating: ]
bsmessfax (] Proposa |
Business Cortacts
Add... Fils s | 30k Titke | Business Phone | Mabils Phone | E-mal |
Customer, My Bast mbc@bestcompany....
Remoye
[ | tem Type Subject Linked To | Created By Created/Due
_:;| Meeking First appointment Prospect Best Com... DAISY\daisy Sat 8f20{20...
I3 Hote infarmation got through search engines Best Com...  DAISY\daisy Sat 8120420,
| Hote inFarmation From their site Best Com... DAISY\daisy Sat 8f20{20...

Working on a customer’s
request by using BCM

A customer visit brought in a $50,000 per year “request for quote.” You need
to create and fill in a new Opportunity and then send Tasks to other depart-
ments so that you can control your proposal. Open your Account and choose
Newr=>Opportunity in the Account History. After the Opportunity appears, fill
in the following fields:

1. Type an updated name to the proposal into the Opportunity Title
text box.

In the example, I use Best Customer special packaging proposal # 1.
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2. Type the new expected Due date into the Close Date field.
3. Type the competitor’s name into the Competitors field.
Knowing your competitor helps you building your negotiation strategy.
4. Tl)l'pe 25% into the Probability field, because you feel a good starting
chance.

Your prospect demands a proposal with several items and descriptions that
don'’t fit into the current Opportunity fields. You can use the Product And
Service Items List to value the entire package in the following way and link
the proposal file with detailed information into the Opportunity History.
1. Choose Add~Create Your Own.
The Add Item dialog box opens.
2. Type the item name in the Item Name field.
3. Type a description in the Description field.
In the example, I use special packaging.
4. Type the total opportunity price in the Unit Price field.
In the example, [ use 50,000 as the whole package price
5. Type 100% in the Adjusted Percentage field.
There is no discount or judgment yet.
6. Type 1 in the Quantity field.
7. Click OK.

Assigning internal support

The Opportunity total value is recorded in the Product And Service Items
List. After updating the information, you need to assign Tasks to other
departments. To assign a Task and link in the Opportunity History Items,
follow these steps:

1. With your Opportunity open, choose New=>Tasks from the
Opportunity History items.
The new Task appears.

2. Fill in the Task assignments and then send and save them.

You can view the Tasks listed in the Opportunity History Items list.

Simply repeat the preceding steps for each new assignment.
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Updating the opportunity

Organizing and linking files from the beginning is a smart way to not lose time
searching for information. After receiving the assigned information and writ-
ing the proposal, you should link the file to the Opportunity.

With your Opportunity form open:

1. Choose Newr>File.
The Link File dialog box opens.
2. Select the proposal by its filename.
3. Click OK.
The Opportunity is up-to-date (see Figure 15-9).
4. Click the Save And Close button.
The updated Opportunity is linked to the Account.

General Detais
Acoount Primary Business Contact
Accourk name: Best Company Primary cortact: Customer, My Best ~|([E)
Address E-mail and inkernet addresses
Busingss... 6188 NW 167 Street E-mzil mne@bescompanyi.com
B Hialesh, FL 33015 E]
ieb page address: bttp: e besteompanyi.com
I~ This Is the maling
address Accourk: Financial Infarmation
State: Active j
Phone Kurmbers Stakys: Current j
Business [r][azs1zs1za4 | Rating: 5l
| i
Business Fax B | Fropasal |
Figure 15-9: Business Cortacts
Th e add... Fils s | 30k Titke | Business Phone | Mabils Phone | E-mal |
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Opportunity Remove
History
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I |
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a” actions 5 E-mal Message Froposal # 1 specid packaging Best Com... DAISYdaisy Sat 8/z20/z0...
and files o) Dooument Propasal # 1 Best company.dac BestCust... DATSYidaisy Sat 8/20/20...
E Meeking First appaintment Prospect Best Com... DAISY\daisy Sat 8f20{20... |
to each ;
) -f} Opporbunity Sum... Best Custamer special packaging proposal # 1 Best Com... DAISYdaisy Sat 8f20/20...
0 p pO rtun |ty. I Hote Information got through search engines Best Com... DAISY\daisy Sat 820420, v]
= PSR ST R TN PRSP R
|

Following up on the proposal

by using BCM

You can e-mail your proposal to the customer and then follow up the next
day to see what she or he thinks about the proposal.
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With your Account open:

1.

Choose Newr>Mail Message in the Account History Items in the lower
left side.

The new e-mail appears.

. Write your message, attach the file, and use the Read Confirmation

request or Follow-Up request as desired.

. Send the message.

The e-mail is sent and linked in the Account History items

You have two options to follow up the proposal on time: using a flag or a
Task (see the next two sections for details).

Flagging as a reminder
Use your Account flags to remind you of Tasks as follows:

1.

2.
3.

With your Account open, click the Follow Up flag in the toolbar.
The Follow up flag dialog box appears.

Select the due date in the Due By box.

Click OK.

Reminding with a Task
You can open a new Task to remind you of a Task.

1.

G = W N

With your Account open, choose New~>Task in the Account History
Items in the lower left side.

The new Task appears.

. Type the proposal title in the Subject line.
. Select the Reminder Selection Box.
. Select the Reminder date and time in their selection boxes.

. Click the Save And Close button.
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Chapter 16

Minding Your Marketing Methods

In This Chapter

Communicating with your customer

Planning and implementing direct-mail campaigns
Executing an e-mail campaign
Planning events and pulling them off

Creating telemarketing strategies

Fle Marketing department of Fake, Inc. had an excellent new product
launch with advertising and direct-mail campaigns for their customers.
Unfortunately, they forgot to communicate and prepare their sales channels to
support the launch. Their resellers weren’t prepared for all the requests and
inquiries they received, and they ended up losing orders. The lesson? Don’t let
pressures force you into releasing a campaign without all the items checked
and approved. Otherwise, you’ll be marketing a negative image of the com-
pany, and the expense of the campaign will not be well compensated. You can
use Outlook tools to accomplish these basic marketing activities. This chapter
shows you how to use the checklist to improve your marketing results.

Know Vour Audience

Who are your customers? Do they know your product or service? Do cus-
tomers know where to buy it?

Anyone who knows the answers to these questions and takes the proper
actions should be a millionaire. Unfortunately, the answer is not the same for
all products and all people. Consumer goods companies specialize in mass
communication over a broad audience.

To improve results, companies are moving their campaigns from TV to
Internet, measuring their expenses and the return on their investments. A
pizza delivery store defines its territory and distributes its menu to most of
the residents within the territory, working to be better than its competitors
and notifying its customers by sending delivery menus with weekly offers.
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What kind of promotions work and for how long? When you develop pro-
grams and record the sales results and questions received, you can improve
your next marketing program. (Read more in Chapter 4.) The following sec-
tions in this chapter talk about the different methods you can use to deliver
your marketing programs.

Direct-Mail Marketing

The direct-mail business started with no phone or computer systems, by the
simple sending and receiving of information through the post office. Aaron
Montgomery Ward sent out his first mail-order catalog in 1872 to rural
America. The first catalog consisted of a single sheet of paper, 8 x 12 inches,
showing the merchandise for sale with a price list and ordering instructions.
Today, even a pizza delivery store uses the same concept, sending their fliers
and waiting for customers to read them and call or order online. Technology
evolved and now any kind of business can apply the brilliant idea of direct-
mail marketing. The process consists of three simple steps: plan the direct-
mail content, identify the audience, and get feedback.

Planning direct mail

Napoleon King is the emperor of his own pet shop company and decides to
send a direct-mail letter to his customers. The most import thing for him is
his signature at the bottom of the letter showing him as the company presi-
dent communicating with his customers.

Newspapers, credit-card companies, and other large corporations have their
own Napoleons sending mailings with their names at the bottom, but when
you get in touch with the company, you end up talking to an impersonal and
automated telephone system. You're lucky if you get to talk to any human
being inside the company, much less a decision maker.

On the other hand, Napoleon’s company is customer oriented. It communi-
cates to the customer exactly how he will be supported, guaranteed! Besides
planning the content of the communication, Napoleon’s company develops a
customer base segmented by pet, which lets them work their customer base
by each pet segment. It also uses the customer’s preferred way of receiving
communications, whether by printed mailings, e-mail, or phone. The com-
pany collects feedback in the store, at its call center, and from its Internet
store, closing the direct-mail cycle at every point.
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Planning the content

A new hotel is inaugurated in the neighborhood of an exhibition center.
Millions of dollars were invested, but the marketing content didn’t include
the key advantage of the hotel — that it is only a few steps from the exhibi-
tion center’s main entrance. Similarly, a new pizza delivery opens in a neigh-
borhood that already has five competitors. Its owners distribute their
delivery menu without comparing it to their competitors’ menus. They
simply forgot to read their competitors’ menus and communicate their
advantages to their prospects.

Don’t make these same mistakes. Before creating a direct-mail program, plan
your content by asking the following questions:

v What value does a direct-mail program have for my customer? Your
customer may want to receive information about your product and ser-
vice, or maybe he ordered once from your company and would view a
newsletter as unwanted junk. Because direct mail is relatively cheap,
companies often don’t pay attention to their lists, cleaning their data-
base, or refining it according to the customer’s needs.

v What would my customers like to hear about my product or services?
Refine and study your customer base. Ask customers what they don’t like
before you ask them what they do like. This question can help you find
the right way to distribute information about your products and services.

v What would I like to communicate and receive as feedback? You may
want to send a newsletter that has no direct feedback expected from the
client. The purpose of this newsletter is to keep your company on the
customer’s mind and update customers about your products. On the
other hand, you may send a direct-mail response card that you expect to
receive back in the mail from a certain percentage of your prospects.
Perhaps you want to send an announcement of a special event or sale
that occurs on a specific date and increase the traffic at your shop.
These are just a few of the possibilities of direct-mail programs.

After you determine the type of communication you want to create, you can
plan a direct-mail campaign for better results. Fill in a Word or Publisher tem-
plate (available at http://office.microsoft.com) and merge it with
your Outlook Contacts to broadcast your print or e-mail communication. The
systematic explanation appears in the section “Printing direct mail,” later in
this chapter.

Selecting the audience

After you design your mailing content (see preceding section), you need to
decide to whom you will send the messages — to 200 people or 30,0007 A
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new hotel may use previous trade show visitor lists as its first mailing list. A
pizza delivery business may order lists in its territory to start its business.
The following questions help you select and update your mailing list:

v Who is my mailing target audience? You can select your customer base
or a specified territory or category for specific purposes. Read the sec-
tion “Merging selected contacts with a letter,” later in this chapter, for
more information.

v Is my customer database up-to-date? Databases get old quickly because
phone numbers and job titles change all the time. When the Journal is
on (see Appendix D), Outlook automatically records the created and
modified dates for each contact, which you can use to find and eliminate
old contacts. BCM Business contacts has four fields on the Details page
that automatically record not only the created and modified dates but
also the origin of the contact, identified by the user login on the system.
Later in this chapter, under “Selecting customers by using filters,” you
see how to filter your list to remove old contacts and check later
whether they are still correct.

Selecting the feedback

Aaron Montgomery Ward in 1872 sent his first catalog and explained the pro-
cedures for placing an order. Receiving the order was his feedback. Feedback
can be necessary to prospect new customers, to develop branding, or to
develop future product improvements.

Sending the information is just the starting flag; to win the race, you must
have the feedback channels ready. When you receive response cards, phone
calls, or Internet responses, all the feedback channels must work properly
and every answer must be collected and analyzed. When the phone is busy
for five minutes, the customer can move to another supplier. Receiving an
e-mail without replying is the same as neglecting the customer. Feedback
must work to improve a company’s relationship with its customers.

The kind of feedback you want to receive may include an answering card, an
e-mail answer, a form filled in at your site, or a phone call. You have to get
your team ready to receive the feedback and work with it, updating the infor-
mation in your Contacts list or BCM Business Contacts list. The Mailing Form
Checklist is the starting point to plan your mailing, as shown in Figure 16-1.

If you take the proper actions and use the checklist, you’ll cut down the pos-
sibility of failure and increase your results. Planning the process helps make
the mailing easy to pull off, with no failures.
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Mailing Form Checklist

Goal:

Information format:
() Printed mailing () Electronic Mailing

() Letter () Newsletter () Magazine
() Invitation () Folder () Folder
() Others

Customer base selected by:
() Marketing Segment () Job descriptions () Territory () Others

Specification:
Answers expected by:
() Answering card () Site form () E-mail () Phone call
Answering Support Schedules
Who will collect the answers an dtake the actions?
Names:
Specify Actions:
Attach telemarketing script to support the program ()
Return of investment Metrics: Calculate the labor cost and program expenses.
Measure the sales increment by customer and by time in 30 days or 6 months return.

Printing direct mail

The great advantage of printing direct mail with Outlook is the capability to
personalize each letter by inserting the name of the person not only in the
address line, but also in the content, making each letter look unique to the
addressee. Setting up the procedure, you can print hundreds of letters with
specific details for each customer.

Besides merging the entire Contacts list, you can send the communication to
certain contacts, selected by specific criteria, such as cat owners for a pet
shop or job descriptions for an industry offer. The following sections explain
merging contacts.

Business Contact Manager users can use the same steps by selecting their
Accounts or Business Contacts list.
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Merging all contacts with a letter

Merging each name from a customer list is easy with Word and Outlook,
together with their mail merge options. For example, say that Golden Pet
Shop is moving to a new building, and the owners want to invite their cus-
tomers to an inauguration party. They have their entire customer base in
Outlook Contacts and used categories to classify customers by their pets,
with categories such as Dogs and Cats. They send a printed letter to all their
customers. To write and merge a letter with Outlook Contacts, they use Word.

When the letter is written and ready, they need to prepare a merge with
Outlook Contacts. You can use this procedure to merge your lists with any
flyer, pamphlet, or envelope or to send the communication as an e-mail mes-
sage. Here’s how you can do so:

1. With the form letter open in Word, choose Tools=>Letters And
Mailing=>Mail Merge.

The Task pane appears on the right side. Step 1 of 6 of the Task pane
begins.

2. Select Letters as the Document type.
3. Choose Next: Starting Document=>Use The Current Document.

4. Choose Next: Select Recipients->Select From Outlook Contacts~>
Contacts Folder.

The Select Contact list folder appears. Other contacts lists are also
available.

5. Select your Contacts list.
The Choose profile dialog box showing Outlook appears.
6. Click OK.

The Mail Merge Recipients dialog box opens, showing your entire list
with the capability to deselect (remove) any contact from the list (see
Figure 16-2).

7. Click OK if you don’t need to edit the list.
8. Choose Next: Write Your Letter.

9. Click in your Word document where you want the addressee’s name
and address to appear.

This location becomes the insertion point of the address block for
merging.

10. Choose Address Block in the Task pane.
The self-explanatory Insert Address Block dialog box appears.
11. Configure the address merging format for your letter and click OK.

The address block is linked to merge with your letter.
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12. Position the insertion point at the greeting line in your Word docu-
ment and click Greeting Line from the Task pane.

The Greeting Line Wizard appears.

13. Using the wizard options, adjust the greeting as you want, such as
Dear Mr. Randall or Dear Mr. and Ms. Randall, and then click OK.

The Greeting line is linked to merge with your list.
14. Choose Next: Preview Your Letter.

At this point, you can use the arrow buttons on the Task pane to change
the recipient name for your view and click the Exclude This Recipient
button to remove any person in the mailing list.

15. Choose Next: Complete The Merge.
16. Click Print.

The Merge To Printer dialog box opens.
17. Select All and click OK.

The invitation letters start to print and the mail merge is complete.

Merging selected contacts with a letter

Selecting 50 or 150 people from a list of 15,000 names is easy when you use
the Contacts list or BCM Business contacts. You can narrow down the list by
choosing specific job descriptions, such as financial manager, or by choosing
customer ratings, such as Platinum customers. You can also send an offer to
only the customers in your southeast region. You merge the selected names
with a letter the same way (see the earlier section “Printing direct mail”).
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You can even use Outlook categories to link customers to a certain item. For
example, a pet shop might link owners to their pets. To send a letter only to a
specific group, such as cat owners, open your Outlook Contacts list or BCM
Business Contacts list and follow these steps:

1. Select By Category from the Navigation Pane view.

The Contacts list shows your different categories (see Figure 16-3).

Mail Merge Recipients
To sork the list, click the appropriate column heading, To narrow down the recipients displaved by a
specific criteria, such as by city, click the arrow next to the column heading, Use the check baxes or
buttons o add or remove recpients from the mal merge.
List of recipients:
* Last_Mame  *| First_Name * Tie  *| Comp.. *| Street_pddress
N Tears Chap Hurry Harr,.. 353 HH st
Spinach Paopeye
[ e Crange Rose
[ Camel Jojo Desart Sand
[ Mefirst Jane Mrs. Meefirst 1, 15t ave
Eteer Mark Meetdebest 1, anvcomp st
< | >
[ Select Al ] [ Clear all ] [ Refresh ]
[ ) (oo ) [oime
L 2

2. Select the desired contacts from the category you’re interested in.
3. Choose Tools=>Mail Merge.
The Mail Merge Recipients dialog box opens (see Figure 16-4).

Mail Merge Helper %]

The meain document and data source are now available. Choose the Sebup
buittan £ lay out your main document.

] PMain documerit

[ creste -
Merge bype: Maling Labels
PMain document: Document3

[
2 Data source
[ Get Data - ] [ Edk -
Data: C:ADOCUME1Y,,.\OMM3, doc
3 :
Merge the daka with the document
z
Options in effect:
Suppress Blank Lines in Addresses
Merge bo Prinker
Cancel




Chapter 16: Minding Your Marketing Methods 245

4. Select Only Selected Contacts from the Contacts list.
5. Select All Contact Fields from the Fields to Merge option.

6. Select New Document if you don’t have a prior document; select
Existing Document in the Document file frame if you have a prior
document to merge.

If your document to merge is ready, click the Browse button to locate
the desired file. After the document filename is located and inserted,
click OK. The documents are merged.

This procedure links the existing letter with the list containing a certain
category. You can save the selected categories as a data file for future
use or reference. If you want to make another letter for the same cus-
tomer list, the database is ready so that you don’t need to open Outlook
and go through the selection procedures again.

7. Select Permanent File and type the filename in the text box or use the
Browse button to find the file.

8. Select Form Letters in the Document type list box and New Document
in the Merge To list box under the Merge options.

9. Click OK.
Word opens, showing the mailing letter.
10. Choose Tools=>Letter And Mailings=>Mail Merge.

The Word Mail Merge Task pane opens at Step 9 of the “Printing direct
mail” section, earlier in this chapter.

11. Follow the Mail Merge Task pane procedures from Step 9 of the
“Printing direct mail” section, earlier in this chapter, until the end.

Your letter is ready to print.

Labeling the mailing

After the letters are ready, you need to print your address labels. To print the
labels for a complete list, open the word processor as you did in the “Printing
direct mail” section, earlier in this chapter.

Remember to have the brand and type of label ready, such as Avery 2336 or
any other brand. Also check the Preview to see whether the inserted address
block appears as desired.

To print your labels:

1. With Word open, choose Tools->Letters and Mailing=>Mail Merge.
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. Select Labels for the Document type.

. Choose Next: Starting Document.

. Select Change The Document Layout.

. Choose Label Options.

. Select the Label brand and number in the Label Options box and

click OK.

. Choose Next: Select Recipients.

8. Select from Outlook Contacts.

9. Choose Contacts Folder.

10.

11.
12.
13.

14.

15.
16.

17.
18.

19.

The Select Contact Folder list opens. When using BCM, you can select
the Account or Business Contacts list.

Select your Contacts list.

The Mail Merge recipients list box opens, showing your entire list. You
can deselect (remove) any person from the list.

Click OK.

Choose Next: Arrange Your Labels.

Choose Address Block in the Task pane.

The Insert Address Block Box Wizard appears.

Configure the address merging format for your letter following the
wizard; check the format in the Preview window and then click OK.

Click Update All Labels.
Choose Next: Preview Your Labels.

At this point, you can use the arrow buttons on the Task pane to change
the recipient name for your view and click the Exclude This Recipient
button to exclude any person from the mailing list.

Choose Next: Complete the Merge.
Click Print.

The Merge To Printer dialog box opens.
Select all and click OK.

The labels begin printing.

You can print selected labels by using these procedures. To create labels
from a selected group of contacts, use the same procedure as described ear-
lier in the section “Merging selected contacts with a letter.” Repeat the same
procedure up to Step 5 and then begin here with Step 1.
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Select Mailing Labels from the Document Type list box and New
Document in the Merge To list box under the Merge options.

The selected contact labels are ready to merge.
Click OK.

Word opens automatically with a windows warning to press the Setup
button on the Mail Merge Helper.

Click OK.
The Mail Merge Helper appears (see Figure 16-5).

Filter (%]
Conkacts | More Choices | Advanced | sgL
Find items that match these criteria:
Stabe contains M CT; MO
Defire more crikeria;
of | [ Cencel ][ Gearan
4. Click Setup.

The Label Options dialog box appears.

. Select your label brand and model and then click Close.

You are back to the Mail Merge Helper dialog box. Word document now
shows the labels border. At the same time, the Cancel button at the mail
helper becomes the Close button.

Don'’t click any other button of the Mail Merge Helper; the preset is
ready. The Create button is already configured for your label, the Get
Data button is already configured to use your Outlook Contacts, and you
don’t need to edit the database.

6. Click the Close button.

7. Choose Tools=>Letters And Mailing=>Mail Merge.

The Mail Merge Task pane opens, and you should see Select Recipients
on the first line.

. Repeat the procedures from the section “Labeling the mailing” Steps

13 through 20 to configure and print the selected labels.

Having your Contacts list organized and updated is the key issue for a good
mailing. Outlook does the rest for you.
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Selecting customers by using filters

The earlier section, “Merging selected contacts with a letter,” shows you how
to select contacts under one condition, such as by category. You can also
easily select contacts using more than one condition by using the contacts
default fields, such as Job Title and State/Province. For example, say that you
want to invite selected people from your mailing by Gender, Job title and
State; to a meeting. You can select up to three fields on the same time from
your Contacts list.

To select contacts by using more than one condition, follow these steps:

1.

With your Contacts list open, select the By Company view from the
Navigation Pane.

. Click Customize Current View from the Navigation Pane.

The Customize View: By Company box appears.

. Click the Filter button.

The Filter dialog box opens.

. Select the Advanced tab.

The Advanced filter option appears. Next you can set the region criteria
to something like States.

. Click the Field button and then choose Address Fields=>State.

The State field is selected to add a criteria.

6. Select Contains from the Condition list box.

7. Type the State acronyms in the Value text box.

10.

You can type more than one value by including a semicolon after each
value. For example, you can type NY; NJ; CT to search for three states at
the same time.

. Click the Add To List button to insert your criteria as part of the crite-

ria list.

. Repeat Steps 5 to 8 to continue adding fields from your Contacts list.

You’re basically creating a filter with multiple criteria, and there’s no
limit to the number of fields you use. Figure 16-6 shows the filter with
three criteria: Gender, State, and Job title. You can also add a filter.

Click OK.

The Contacts list displays the list according to the criteria.



Chapter 16: Minding Your Marketing Methods 24 9

Event Planner Worksheet

Locati
ocation:
Figure 16-6: . .
Usethe | CIt¥: : Place:
Advanced Address: Phone number

filtertap | () Map to guest arrival

toselect | Date:_/ /[
customers Seating arrangements
by multiple Number of expected attendees:___

criteria, | Audio Visual () Projector () Screens () Sound System
such as () Internet connection ( ) others

t?V state, | Coffee break () morning () afternoon

]obt!tle, () Lunch () Dinner () Cocktail

and title.

Room reservation () Qty.___

After your list appears on-screen, you can select it and then copy and paste it
into an Excel workbook to create different kinds of analyses.

If you're a frequent mailer, you may want to add the Mail Merge toolbar. To
use the shortcut, simply choose Tools=Letters And Mailing=>Show Mail
Merge Toolbar. The Mail Merge toolbar now appears as an extra line in your
Word toolbar.

E-Mailing Marketing

You can send a personalized letter as a personalized e-mail. To send your
mass mailings as e-mails, open the selected document in Word and then
follow these steps:
1. Choose Tools-Letters and Mailing~>Mail Merge.
The Task Pane Wizard appears on the right side.
2. Select E-Mail Messages.

3. Follow the wizard until you reach Step 6 and then click Electronic
Mail under the Merge Frame.

The Merge To E-Mail dialog box appears.
4. Select AutoMergeField from the To list box.
5. Type your subject into the Subject line.
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6. Select HTML Among Plain Text Or Attachment from the Mail Format
list box.

7. Select All Records and click OK.

The e-mail broadcast starts moving the letters from Word to your
Outlook Outbox to be sent until the broadcast is complete.

After sending the e-mail, check the Inbox for refused messages due to errors.
Fix and clean your contacts after each broadcast.

Broadcasting e-mails from your own computer is possible on a broadband
connection after hours, or you can use a service provider linking your
Outlook Contacts to their broadcasting services tools. Using BCM, click the
E-mail Marketing or Business Services command on the Business tools drop-
down list to evaluate Microsoft as a service provider for broadcasting and
controlling your e-mail marketing campaigns. Outlook 2003 users can also
look for broadcast and mail services from other e-mail service providers.

Planning Events

Fake, Inc. put on a nice event with an outstanding stand-up comedian and a
nice cocktail party, but what was the purpose of the event? The guests didn’t
get the message. Another company invested $10,000 on a trade show booth
and collected 343 business cards, later forgotten in the sales manager’s desk
drawer. The return on investment is zero in both cases. To avoid these
results, you have to plan your event to ensure a positive outcome.

Business events can be meetings, seminars, workshops, trade show booths,
parties, and shows with small or large audiences. You can manage your
events with Outlook even if you have hundreds of guests. Planning any event
has four phases:

v Developing the event content checklist.

v Convincing the customers to come.

v Sending the right message to your audience during the event.

v Following up with guests the day after, when the message is still hot.

Thinking about the event’s content

Your event’s content can be a PowerPoint presentation by one person or a
complex plan with several speakers. First, you create a table or an Excel doc-
ument listing all the event details. Then you open a Task and paste the table
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or link the Excel file so that you can control the sessions within Outlook.
(Read Chapter 11 for information about pasting a table or inserting an Excel
file into an Outlook Task.)

The infrastructure can be split into two parts: One part includes the location
and resources needed and the other includes the materials for each guest.

Create your Event Planner Worksheet like Figure 16-7 and then copy it and
paste into a new Task to control the event.

Guest Material and Printing Worksheet

() Charge $___receipt () Free of charge

()Badge () Meeting name card 3 fold

() Answerback cards

() Guests check list () Prize tickets () Certification
() Marketing material list attached

() Gifts
() Other:

Designate an administrative person to create name badges and to coordinate
written material, guest checklists, and gifts. Open a new Task and create a
Guest Material and Printing Worksheet, such as the one shown in Figure 16-8.
Send the Task to the designated person with your comments.

Day After Checklist

Event Objectives

Actions

Collect the answer-back cards and fill in each contact.

() Send a letter thanking the customer for coming.

() Make a personal thanks phone call for coming and record their comments.
() Determine who will make the calls if it's not you
() Send the phone call instructions. Attach the instructions
() Must be a person-to-person call? Name:
() How long do you expect for the phone call results?___days.
() When is the next follow-update___ /[

Who is in charge of the follow-up?
Who measures the expenses and return of the investigation?
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You can print badges and triple-fold name cards, merging the selected con-
tacts as you print your labels.

Convincing the customers to come

Walter is a software design engineer and often visits and supports customers.
His company’s workshop timetable is planned one year in advance, so while
he visits customers, he warms them up as potential workshop attendees.
When the company broadcasts its first e-mail invitation, the workshop is full
in two days with no problem at all. Mark has the same job function as Walter,
but he doesn’t tell his customers about the upcoming workshop. For Mark,
every workshop is a fight to fill up with attendees, and the e-mail broadcast
doesn’t bring the desired results. He has to work overtime to call and get
workshop attendees. This scenario demonstrates that two people do the
same work but obtain different results due to their communication.

Motivating the customer to come to an event requires a concerted effort. You
can use marketing tools, such as flyers, invitations, e-mail announcements,
and phone call reminders, to increase your results. Use Outlook or BCM at
this stage to merge the contacts with your printed and electronic communi-
cations. The upcoming section on telemarketing explains how to use the
Contacts list as an active telemarketing call center.

You can also use your own team to warm up the audience, asking them to
remind customers about the event to come.

Mingling during the event

Your event must be designed for a pleasant time while your message is
passed along to the audience. You can measure how the message sticks for
each guest by gathering the comments heard by your team. Training your
team to socialize while mingling with your guests gives you instant feedback
at your event.

Following up the next day

Use feedback cards and follow-up phone calls after the event; an event is part
of a process, and it doesn’t end when the event is over. Events aren’t stand-
alone programs. Each event is an investment to get future results. Reactive or
otherwise difficult prospects who became receptive at the event should get a
“thanks for coming” and a phone call to solidify these new relationships. The
Day After checklist (Figure 16-9) helps you schedule the next steps after the
event.
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Use Contacts or BCM Business contacts to send the “thanks for coming”
letter and then update each attendee’s record in your Contact profile. Use the
Contacts list as a telemarketing tool for the day-after-event calls. (For more
on telemarketing, see the next section.)

Ensuring Telemarketing Success

Outlook can work as a telemarketing workstation, even doing the dialing for
you. Creating the telemarketing view allows multiple phone calls in a sequence
and is an effective way to invite guests to your event or to make the event
follow-up call. Outlook is ready to make the calls for you. Open your Contacts
list, select the contact you want to call, and click the Telephone button on the
\BER toolbar. Select the phone number, and the call procedures starts.
3
< Your computer modem must be connected to a phone line in order to dial for
you. See Chapter 3 for details.

If you need to make one call after another, certain Contacts List views, such
as the Phone List or By Category, are better than others. When you need to
fill in new data, you must create new fields and place those fields in the
Contacts List view in a practical sequence (see the next section).
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Telemarketing forms

The Telemarketing forms use the same design concepts in Chapter 4 but

now applied to phone calls. Say that a company launches a new product with
workshops and demos for beauty parlors and now wants to call the customers
who didn’t order the product to evaluate the results. The company decides
to add the following fields to the Contacts lists to have an effective telemar-
keting operation:

Using Outlook Contacts you can customize the view and add fields for your
sales campaign. The following fields are typical for telemarketing activities.
v~ Call date: Add the call completion date.
v Quiz date: List the customer’s scheduled date to answer the questions.

+ Follow-up flag: Use this field to remind yourself about the next phone
call as scheduled by the customer.

v Like: Indicate whether the customer liked the product.
v Buy: Add the customer’s intention to buy the product or not.
v When: Type the expected date to place the first order.
QIING/ The previous fields are useful for building your telemarketing application, not
S for communicating with your customers. Using straight questions like the

ones in the preceding list can sometimes be offensive to a customer. Instead,
build more delicate questions to gather the information in the form.

Chapter 4 includes details for adding fields and customizing the Contacts
entry form.

Creating a view title

When a view is ready to work, you can rename the view for future use in one
click. To create the Telemarketing view, follow these steps:

1. With Outlook open on your Customized Contacts list for telemarket-
ing, choose Viewr>Arrange By~ Current View>Define Views.
The Custom View Organizer dialog box appears.

2. Click the Copy button.
The Copy View dialog box appears.

3. Type Telemarketing in the Name Of New View text box.

4. Select This Folder, Visible To Everyone and click OK.

The Telemarketing view appears in the Navigation Pane, as shown in
Figure 16-10.
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Adding a script to your
telemarketing operation

Sometimes you need a script so that everyone is using the same text with
carefully planned questions that match your company profile. Such a script
explains the campaign objective and procedures to your operators. You
simply have to send the script written in a Word document to each operator.
To have the script running in front of Outlook, follow these steps.

With the Contacts list for telemarketing open:

1. Click the Navigation Pane in the Menu View.
The Navigation Pane disappears.
2. Choose View=>Reading Pane~>’Bottom.
The Contacts list appears in the top half of the screen.

3. Open your Word processor in a separate window, write your script,
and save the file.
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4. Minimize and adjust the Word window size to fit over the Outlook
reading pane.
Outlook Telemarketing, complete with a script, is ready to work. Don’t
forget to use the Keyboard Alt + Tab commands to move between the
Word document and the Outlook screen.

Telemarketing reports

You can create reports to analyze guest confirmations or to determine how
many calls resulted in sales. Simply customize the Contacts List view by adding
any question fields and measuring the outcome by using reports. Copy and
paste your custom Contacts list into an Excel workbook for creating charts and
statistical analyses. Select your Outlook list from your current view and copy
and paste the list into an Excel worksheet to make your analyses.
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be under? You Kknow, I still haven’t got my £older
structure organized the way I want it.”



In this part . . .

Fe day has only 24 hours. What do you want to do
today, in the next 30 days, or the next year? Planning
ahead helps you make the best of your 24 daily hours. In
this part, I give you ten tips that put time on your side
with Outlook’s help.

[ also give you ten marketing and selling tips, as well as
tips on basic security for your company data.




Chapter 17

Ten Tips for Keeping
Time on Your Side

In This Chapter

Organizing your time commitments

Controlling the system and more

A n old quote says, “If time didn’t exist, everything could happen at the
same time.” People today are working in high-anxiety environments,
where everything must occur at the same time. Take a breath, list, and plan

your actions. A little planning can give you perspective about what is truly
important.

Goals and tasks are imposed in three ways: from within, by your supervisor,
or by the system in which you work. When goals are self-imposed, you're the
master and control your time. With supervisor- or customer-imposed goals,
you have to negotiate a time slot with another person. System-imposed goals
mean you have to obey the system instead of making it work for you. You can
use Outlook to better manage your time and increase your productivity.

Self-Imposed Time Commitments

Listing your time commitments in the Calendar, your tasks in the Tasks list,
and then filing the information in the correct folders can make your workload
seem much more manageable.
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Starting your day

Start your day by opening Outlook and reading your Calendar schedule and
your Tasks list. Take a breath, evaluate what you want to accomplish in the
morning and in the evening, select your priorities, and start doing them one
by one. Do you need to wait for someone to finish a task? After a task request
is sent and negotiated, jump right into the next job. Take a break between
each job. Remember that time commitments are more than writing your
schedule into an agenda or into the Outlook Calendar. When you need to
make a change, you can plan your next steps so that you don’t miss today’s
goals. To read the Outlook Today page:

1. With Outlook open, click the Mail button in the Navigation Pane.
The Inbox list appears.
2. Select Personal Folders under All Mail Folders in the Navigation Pane.

The Outlook Today page appears, showing your time and tasks commit-
ments beside the Mail Folders list.

Focusing on the current activity

When you have someone to remind you of your daily activities, you can give
all your attention to the current activity because you know someone will
remind you of your next appointment or task. When you don’t have someone
to remind you and because you aren’t a robot, you need something to remind
you about your priorities. You can list all your tasks in the Outlook’s Tasks
list. Turn on the reminders so that you can focus your brain on the current
activity without interruptions. Then, write your to-do list, selecting the priori-
ties and attacking them one by one without mercy.

Recording your goals as
tasks with reminders

Dreams can become reality when you start writing them down and planning
to achieve them. Where do you want to spend your next vacation? When do
you plan to retire? Do you plan to raise a family? Write your personal and pro-
fessional goals for this year and for the next five or ten years, creating a task
for each one. Set up the reminder for the next six months. When the reminder
pops up, you simply open the task and read it, update the task according to
what you've accomplished, and then set the reminder for the next date until
you achieve your goal.
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Taking a break

When you work for hours in front of a computer screen, your eyes become
tired, and so do you — especially when you’re passionate about your work
and forget what’s going on around you. Taking short breaks energizes you for
another round. Before starting a long and involved job, open a new appoint-
ment in your Calendar and set the reminder for 50 minutes from now. When
the reminder bell sounds, take a break, stretch, and change your line of sight
from your computer screen to a farther view from your office window (or at
least the end of your room). You can produce more if you give yourself a few
short breaks to reenergize.

Avoiding high anxiety (or “1 don’t work in
the emergency room” syndrome)

The workload and environment at certain places can look like an emergency
room. Discerning what is important from what is urgent helps you list and
complete each job by its importance level. Before you feel like you're working
in an emergency room, use the task priorities and classify their importance
levels. A little planning and prioritizing may even prevent you from needing
bypass surgery.

Boss-Imposed Time Commitments

When two people want different tasks completed at the same time, they have
to negotiate an agreement. Supervising, delegating, and sharing pertinent
information help to make first things first.

Shrinking supervision time

Supervising a team with different, ongoing activities can be difficult, and you
may spend a huge amount of time and energy making phone calls and
requesting updates. Instead, assign a task to each person by choosing
File>Newr>Task Request. Doing so gives each person a specific job. You can
then select your Tasks List view to view the records by assignment, which
lists all pending issues by the assignee.
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Delegating

Delegating to members of your team so that they can act on your behalf
saves you time and increases each person’s responsibility. When you use
Outlook with Exchange server, you can access the delegating tool. It allows
your assistant to send meeting invitations and reply to received invitations
on your behalf. Outlook sends an automatic copy to your Inbox.

Sharing your Tasks list and your Calendar

When you receive many requests from coworkers, you may need to organize
these requests better. You can make everyone list their requests in the Tasks
list and then set the priority and due date for each task, thus creating a prior-
ity sequence. Share the Tasks list with your coworkers and then decide which
tasks to do first. To share your Tasks list:

With your Tasks list open:

1. Select the Tasks folder from the Navigation Pane.
2. Right-click the Tasks folder.

A drop-down list appears.
3. Choose Sharing from the drop-down list.

The Tasks properties open on the Permission tab. To allow coworkers to
share your Tasks folder, you must add their names to the Permission
List and choose the Permission Level.

4. Click the Add button to open your lists.
The Add Users dialog box opens.
5. Open the Show Names From The list box to see all lists available.
You can select individuals one by one or a group list.
6. Click the name you want to select.
7. Click the Add button and click OK.
The chosen persons are added to the Permission List.
8. Select the Permission Level from the list box, such as Reader or Editor.
9. Click the Apply And Close button.

The Sharing permission setup is ready.
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To open a shared folder, open Outlook:

1. Choose File=>Open~>Other User’s Folder.
The Open Other User’s dialog box opens.
2. Type the name of the person whose folder you want to share.
3. Select the folder name, such as Tasks, from the list box.
4. Click OK.
The shared folder appears.

Time Commitments Imposed
by the System

You can avoid a lot of interruptions by simply controlling the way you're
online. Voice mail and e-mail are supposed to help you control the way you
receive information. Repetitive tasks turn into time wasters, usually because
information isn’t easily available. Organizing and filing the information can
help you request service maintenance faster.

Turn off the interruption killer

When you don’t want to be disturbed, you turn on the DND (Do Not Disturb)
option on your telephone device, close your office door, or put a sign on your
door, right? When your Inbox notifies you about the arrival of each incoming
message, you're interrupted by the sound, and the warning appears on-
screen. To solve this problem, you have to switch off the Notify Me When
New Messages Arrive option. Because you control the e-mail and not the
other way around, switch off the notification alarm.

With Outlook open:

1. Choose Tools=>Options.
The Options dialog box appears.

2. Click the E-mail Options button and then click the Advanced E-Mail
Options button.

The Advanced E-Mail dialog box appears.
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3. Uncheck the following commands: Play A Sound, Show An Envelope
Icon In The Notification Area, and Display New Mail Desktop Alert.

4. Click OK.

No buzzer alert will break your attention when incoming e-mail arrives.

Streamline technical support

Every time you need support for an electronic device like a printer, computer,
or cell phone, you call the customer support line for a chat. The first ques-
tions are usually the same: What is your product? What is the model number?
What is the serial number? When did you purchase it? Did you purchase the
warranty? Many times, you have to disconnect, collect the appropriate infor-
mation, and then call back. To solve such a problem, create a contact for
each hardware device or software program you have and store the important
information in the contact’s record. If you have several computers from the
same manufacturer or multiple software licenses, you can create an Excel file
with this data and attach it to your contact.

With the Contacts list open:

1. Click the New button.
The new contact appears.
2. Type Customer Service into the Name field.

3. Type the name of the product in the Job Title text box, such as printer
or computer.

4. Enter the device’s customer service number and the company’s e-mail,
IM, and site address in the appropriate fields.

To include the device’s name, model, serial number, and purchase or
guarantee date, you can create new fields or use the existing fields.

5. Click the All Fields tab.

6. Select Miscellaneous Fields list from the Select From list box.
The Miscellaneous fields appear.

7. Type the following data in the appropriate fields.

Type Product Name in the User Field 1, Model Name in the User Field 2,
Serial Number in the User Field 3, and Purchase Or Guarantee Date in
the User Field 4.

During a maintenance call, you can add additional information.
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8. Type the Account number in the Account field.

9. Type the Account ID in the Customer ID field (see Figure 17-1).
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10. Click the Save And Close button in the toolbar.

With 20 or 30 items, you can create a new Contact folder just for software and
devices. You can name the new contact folder something like Support. Create
a new contact for each new item upon its arrival or installation date.
Spending a few minutes now can save you a lot of time in the future.
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Chapter 18
Ten Sales and Marketing Tips

In This Chapter

Discovering selling tips

Getting the scoop on marketing tips

Getting the order is the final step of any sale. Whether you're beginning
with a prospect, getting to know your product or service, or arriving at
the final sales procedure, you need to follow through with many steps to
transform a prospect into a customer. Using Outlook to remind you about the
next step helps you track and better serve each customer. Managing and
maintaining your sales effort, along with a strong team and a good marketing
program, are the ingredients of a good business. The following ten questions
can help you brainstorm about your business.

v Who are your customers?

v Do they know your product or service?

v How does your product or service solve their problems or needs?

v Who are your competitors?

v Does your company deliver something better that your competitor?
v Do you record your customer information?

v Do you keep track of your customer requests?

v Do you keep track of your lost orders and indicate why you lost them?
v Do you keep track of your sales team actions? How often?

v Do you coach your team members to motivate them and improve their

results?

In this chapter, I give you ten sales and marketing tips. Keep in mind that a
sale involves understanding your customer needs and filling those needs
with your products or services. Paying attention, following up correctly, and
supporting your clients are the keys to maintaining good relationships. In
addition, Outlook is a helpful tool when you know how to use its features for
marketing activities.
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Understand Your Customer’s Uision First

In the beginning of my career, | was a sales manager of consumer products. I
dealt with highly professional procurement managers from national chains to
very small storeowners to exporters from different countries. I found that
each company has its own way of doing business. So does each person. By
understanding the focus and procedures of each business, I was able to grow
my sales territory as never before. Most salespeople, when talking with cus-
tomers, try to explain how good their products are, before they really under-
stand what the customer is looking for. If you understand your customer’s
vision first, you can better explain your service or product in terms of how it
fills their needs. You can present the same product in different ways to match
each customer’s point of view. Working as a sales professional, you can
record the customer’s information in Outlook Contacts so that you remember
the kind of presentation that works best for each customer.

Track Opportunities with Tasks

One of the major problems in sales involves losing track of a potential sales
order. Often, salespeople forget about a quotation because other customers
are demanding their attention, so they end up forgetting or giving away a
potential order. In Outlook, you can record all pending requests — from
prospect information to quotations to closing the orders — in Tasks. Keeping
the reminder on is a key way to following up at the appropriate time. For
more details on reminders and tasks, see Chapters 14 and 15 and Appendix B.

Keep Tabs on Your Customers

The market moves faster than ever before. Our brains can’t keep track of so
many changes and updates to customer information. You can, in a sense,
download your brain by recording all the information about your contacts as
profiles or by using the Account or Business Contacts in the Business
Contact Manager. Before calling a customer, you can open his company home
page each week and record the news into the contact record. You can easily
record the information in the following way:

1. With Outlook open to your contact record, search the customer site
with Internet Explorer.
2. Select and copy the information found in the customer site.

The information may be the quarter results, a new product launching, a
new director, a new trend, or any unknown information.
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3. Move to the open contact in Outlook.

-

. Choose Actions~>New Journal Entry For Contact.
The Journal appears.
. Paste the information into the Journal.
. Select Note from the Entry Type list box.
. Paste an information title for easy retrieval into the Subject field.
. Click the Save And Close button.

You have now saved the information into your customer contact with a
time stamp without having to type any detail.

@ N & O

Draw Up a Letter Of Understanding
Commitment

Sales professionals often have to consider a customer’s counteroffer or busi-
ness proposition, so it’s important to know and remember exactly what the
customer is offering. A letter of understanding becomes especially important;
it confirms the terms of a proposed deal from a phone conversation or meet-
ing. You can keep a letter of understanding template in your files and fill it in
when needed. For familiar customers, you can write up the phone call infor-
mation in a Journal entry and send it as a phone conversation reminder
attached to an e-mail. (Read Appendix D for the details.) You can then insert
a follow-up flag to remind yourself that the customer got the e-mail with the
phone conversation reminder attached.

Measure Your Sales Team’s Performance

Unfortunately, many companies measure team performance only by gross
sales and/or gross profit. But you may wonder why one salesperson’s results
are better than another’s. Some possible reasons include the customer base
potential, the number of customer visits made during the month, the value-
add that the customer perceives, the business knowledge of the salesperson,
and personal motivation. Sometimes a new hire can, in just a few months,
bring in some surprising results from a customer base of leftovers. Self-
motivation is the answer. Measuring your sales team’s activities and meetings
by reading their shared Calendars, Tasks, and customer profiles can provide
you with information to coach them and drive them to their goals. Evaluate
with each salesperson the time invested in a potential customer and the
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results. Coach them with your experience, by evaluating the opportunities
and the identifying action items needed to focus the energy on the main
opportunities. Don’t wait for the weekly meeting.

Increase Marketing Productivity

Outlook comes with your Windows operating system and can help control
your sales and marketing activities for each customer. Using Outlook, you can
broadcast personalized e-mails or letters to thousands of recipients within
just a few minutes. You can customize the Contacts list for telemarketing
activities, including dialup automation. The system works well and gives the
best results only when your company is organized. The database must be
correct, the marketing plan well developed, and the content of each letter or
message carefully written. A handy software product isn’t enough without
capable, motivated, and well-trained people. In the end, a motivated team
brings the best result. Invest in your team’s training. Read more detail in
Chapter 16.

Increase Orders by Working
with Target Markets

When you aren’t working with mass-market products, you have to build a
customer base with companies and personal contacts and compile informa-
tion about each one in your Contacts list or BCM Business Contacts. The
additional data helps you create strategies for different segments. With the
right data, a pizza delivery restaurant, for example, can determine that it sells
more veggie pizzas than anything else and create new veggie flavors for its
customers. A dermatologist can offer skin treatments according to the age of
the customer base. An industrial company can classify its customers accord-
ing to their sales potential. A software company can research and develop
new products for a vertical market in which it has more customers. Having an
organized and accurate database helps you generate better marketing cam-
paigns. Sometimes a simple newsletter to an inactive customer inspires them
to reorder. Keeping your customer base updated and developing campaigns
to communicate your service is easy with Outlook. Follow these steps to
filter your customer base for a particular profile:

1. With your Contacts list open, choose Customize Current View from
the Navigation Pane.

The Customize View dialog box appears.
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. Click the Filter button.

The Filter dialog box appears.

. Click the Advanced tab.

The Advanced Filter dialog box appears.

. Click the Field button.

All fields, including the ones you created for your business, are
available.

. Select a field and a condition and then type or select a value for the

selected field.
Some examples follow:

e Filter for single or widowed customers by using the Spouse field
and selecting Is Empty as the Condition.

e Filter customers by age by using the Birthday field with the
Condition On Or Before. In the Value field, enter a date such as
12/31/1950. You can also select the monthly birthday to send a
birthday e-mail by using the This Month Condition.

e Filter women only by using the Gender field. Select the Condition
Equals and the Value Female.

Using the three filters together, you can select women, single or wid-
owed, born before 1950, as shown in Figure 18-1. You can refine your
search even further by using the State field and selecting all customers
living in the same state.

. Click OK.

The Contacts list displays your database filtered and ready for your
action.

Filter (%]
Contacks | More Choices | Advanced | s
Find items that match these criteria:
Birthday onor before  12{31) 1950
Gender equats Female
Business Address State contans MY
Spause i by
Defire more crikeria;
ok | [ cancel || cearal
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Build a Checklist from the
Customer Perspective

Marketing doesn’t just involve one department in a company. The marketing
programs integrate several departments, including products, channels, and
customer service. You get the best results from the customer’s perspective if
you check all the details before you launch the program. The following
expected actions by customers checklist helps you verify that the sales pro-
gram is properly set up in all related departments.

+ Grabbing additional information at the product Web site. Is the site
ready, and did you measure its usability? Usability refers to how easily
the reader can find and understand the information at your site. For
example, certain colors and font styles aren’t friendly to older people.

v Calling an 800 number. [s the staff trained and ready to handle the cus-
tomers’ questions? By using Outlook as a telemarketing tool, you can
receive phone calls, record the information, and give good support, even
if it’s only you doing all three tasks.

 Sending a message with a question about the product. Who’ll receive
the messages and answer it? Create a special mail address for your
advertising responses. Use Outlook’s rules to route messages or colors
to prioritize them.

»* Ordering the product in a store. Do the stores have enough inventory
to support potential sales? Before you start the campaigns, the sales
channels must have the sales inventory ready.

List the entire program systematically to create your checklist. Upfront plan-
ning is better than having to fix the program while it’s running and losing
money. Even if you're running a two-person business, simplify and use this
checklist with your partner’s help. Create procedures to measure results.
Measure the daily visits to your site, the numbers of messages received, and
the numbers of calls received. Evaluate the program by the reported incom-
ing problems, even if your results are positive.

Maximize Events and Presentations

For the past 15 years, I've been working with marketing presentations and
workshops in the semiconductor and IT industries. The definition of a good
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event can be merely the number of people in the audience, or it can be the
number of VIP customers present, or the number of smiling faces at the end
of the event. When you’re investing your money, you have to tighten up the
whole process, including getting the right audience to the event, feeling the
temperature while the event is running, and performing the day-after actions
to achieve your goals. Salespeople too often forget to follow up the day after.
Answerback or evaluation cards often don’t bring the desired information. By
working with small audiences, such as 40 or 50 people, you can use Outlook
to schedule phone calls during the week after the show. You can use a flag for
each contact or create a category to list all participants from the workshop
and select them for a telemarketing action.

P Be sure to ask your workshop attendees whether the event met their expecta-
tions and what else you can do for them to increase their satisfaction. When
someone important misses the event, follow up with a phone call and send
the information anyway.

Balance Mail and E-Mail Campaigns

By broadcasting a free newsletter for self-enrolled readers and then measur-
ing the cause of returned messages at each broadcast, you’ll notice that
many returns are because the addressee’s mailbox is full. Other readers just
look at the headline and delete the message. Broadcasting to 10,000 readers
doesn’t mean that you have that many people reading your message.

Be sure to choose e-mail broadcast frequency and headlines so that you
make readers eager to get the information. In the past, [ published a weekly
newsletter with timesaving and productivity tips; if | didn’t publish one week,
[ used to receive letters from 3 percent of my readers asking for their tips.
Before broadcasting, think of yourself as your average customer and ask
yourself, “How often would I read the newsletter?” Broadcast your newsletter
with your own answer to the prior question.

Direct-mail campaigns, although more expensive with printing and postage
costs, have a strong value in delivering printed information into the readers’
hands with no need for a computer. You can use Outlook to broadcast or
print your mailers. Measure the return of both options (printed mail and
e-mail) against their cost to evaluate the right balance for your company.
When broadcasting by using Outlook instead of a third-party provider, mea-
sure the returned mail in the following way. (Remember to create an e-mail
address used only for the broadcast, such as
news@yourcompanydomain.com.)
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Before the broadcast:

1. Create a new folder named newsmmdd where mm is the month and
dd is the broadcast date.

For example, news0717 stands for July 17.

2. Create a rule for moving the returning messages from the broadcast
address to a specified folder.

See Chapter 8 to find out how to create a rule.

Open the specified folder and screen the returned messages two days after
the broadcast. Check for wrong mail addresses and delete them from your
database or fix them. Check for returned mail due to mailboxes being full and
evaluate the percentage over the total sent to determine whether it’'s worth
sending a printed letter. Always evaluate the results and the cost of the pro-
cedures. Unrequested e-mail broadcasts are cheap, but your potential cus-
tomer may avoid your company after receiving such unwanted messages.
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Ten Technical Tips for
Safeguarding and Mobility

In This Chapter

Synchronizing messages with Outlook

Keeping your Outlook data safe
Using Outlook data with a cell phone
Improving your use of messaging

Fese days, business road warriors work just about anywhere and any
time. You need to have your computer information available and safe at
any moment, without having to call and interrupt someone for a phone
number, address, or business report. In this chapter, I give you tips that help
you stay online while on the road and offer some advice to help you use and
protect your information on mobile devices.

In addition, safeguarding means protecting your company information from
being stolen or used by unauthorized people. Besides using the technical tips
in this book, having knowledge of the potential hazards helps your team safe-
guard company information.

Receive Reminders via Vour Cell Phone

One of Outlook’s most helpful features is its reminder. Unfortunately, you
receive a reminder only when you're working on your computer with
Outlook. However, you can forward your reminders to your cell phone by
sending a short message SMS. You simply insert an add-in software product
to Outlook that sends every reminder as an e-mail to your cell phone mail
address. Outlook then sends a short message to your cell phone when a
reminder pops up in Outlook (your PC or server still must be on).
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[ use Outlook Reminders by E-mail from the RS Outlook site (see www .
rsoutlook.com), but you can also try Sperry software at www. sperry
software.com. Use Outlook reminders if you're often out of the office. If you
didn’t request the SMS service from your phone company, check out how you
can release the service for your cell phone.

Synchronize Your Reminders Anywhere

Today, even the cheapest cell phones also have calendars, tasks, and reminders,
but using the cell phone keyboard to set up your calendar isn’t a fun and easy
activity. However, you can use Outlook’s add-in software to synchronize your
cell phone with your tasks and calendar. In addition, many phone manufacturers
offer software for uploading your cell phone data from a computer, but if your
cell phone company doesn’t offer such software, you can order the Phone Tools
software from www . avanquest . com. You can synchronize by using a cable or
infrared connection, depending on your device. You can synchronize the next 30
days of activities or just copy the appointments and tasks needed for the day.

Protect Vour Data

\NG/
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Losing your device or having it stolen is a financial setback, leaving you open
to the possibility of having an unknown person read your information. That’s
a serious lack of security. Creating passwords to access your hardware is the
first step. You should password-protect your notebook, Pocket PC, and even
your cell phone.

To protect your Outlook folder, create a password. With Outlook open and
the All Folders list displayed, choose Personal Folders=>Properties in the
Navigation Pane. In the Personal Folders Properties dialog box, click the
Advanced button and then click Change Password. Because you don’t have
an old password, just type the new password, retype it in the Verify Password
text box, and click OK. Now you have a password protecting your data.

The Outlook data file protection helps maintain privacy when other users use
the same computer, but it doesn’t protect against hackers. This password
was designed for privacy among several users, using the same computer
only. This method isn’t as secure as using password-protected Windows user
accounts. Keep a copy of your password in a safe place so that you don’t lose
your data if you forget the password.
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Protect Your Cell Phone Contacts
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Today, cell phones can carry up to 2,000 names, but finding one out of 2,000
names in a cell phone takes more time than you may have. You can synchronize
and shrink your Outlook Contacts list to work with your cell phone by creat-
ing a contact folder named Mobile and copying and pasting the contacts you
want into this folder. Then install an add-in software program (such as
Avanquest) to synchronize your cell phone agenda with Outlook.

If you don’t have a program to synchronize your cell phone agenda, I suggest
using Mobile Phone Tools from Avanquest (www.avanguest.com). You can
copy your contacts to a cell phone, edit your cell phone numbers on the com-
puter instead of using the phone, and synchronize the phone contacts with
the Contacts list. From the Mobile Phone Tools screen, you choose which
contacts you want to move — all of them or just a few.

Before leaving the office, I make it a habit to copy the contacts I need for the
day and any emergency phone numbers, too. I can delete them all later if [ no
longer need them on the phone.

Use Training as a Protection Tool

When the “I Love You” virus stopped thousands of companies, | heard a
coworker who was informed about the virus say, “I had to open the message.
Only my husband sends me / love you messages.” Even with all the firewalls
and software protection tools available today, education is still the only way to
avoid cases like this one. Training increases the awareness of each member of
your team, so that they aren’t fooled by fake and inoffensive-looking messages.

The John Wayne rule is one important way to protect your company: “Delete
First and Ask Questions Later.” When you don’t know the sender, the subject
of the message is of little consequence. If there is a link to click, delete the
message before you click away your computer’s security. When something is
important to the senders, they’ll call you or send you a letter. Don’t trust any
emotional mail about prizes, debts, jokes, love, sex, and other catchy topics. I
recently won a prize from my Internet provider, but instead of clicking the
link in their message, [ opened their Web site and checked the published con-
test instructions, confirming the e-mail.
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Avoid Mail Before Writing It

People tend to take the easy way out, which is rarely the most intelligent way.
Most people find out how to use e-mail through tips or just by sniffing around
on their own. Today, most people manage the messages only by chronologi-
cal arrival, without evaluating the content. A joke or a $1,000,000 order is
treated the same way from an e-mail processing standpoint.

Prioritizing the types of messages sent and received (as this book does in
Chapters 8 and 9) helps people think before writing messages. When you
identify and expose behaviors like unnecessary self-promotion or laziness,
people will start thinking about their messages before sending them. Create
e-mail rules in your company, including a manual, training sessions, and a
campaign with sponsors from the IT and HR departments.

Increase Vour Password Secuvity
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Do you know how many passwords you have? You generally have passwords
for your e-mail address, your voice mailbox, your credit cards, your ATM
card, security system keyboards at your house or office, not to mention all
your logins to Internet sites. Easy-to-crack passwords include names, dates,
or words in lowercase letters. Increase the security of your passwords by
using uppercase and lowercase letters, mixed with numbers, such as
L703KK4aB. Instead of having the passwords on your mind, create an Excel
workbook for your passwords with password protection so you will need to
remember only one password.

To create password protection for your Excel workbook, open your Password
Excel workbook, which has previously been created and saved. Then choose
Tools=>Options to open the Options dialog box. Click the Security tab to open
the security page, type the password in the Password To Open text box, and
click OK. A Confirm Password dialog box opens for you to enter the password
again. Retype the password, click OK, and then save and close the password
file. From now on, the password file demands a password.

You can also search on the Internet for Keepass, a free open-source password
manager, instead of using an Excel file.

Recover a Permanently Deleted Item

Instead of cursing your computer when you delete a message by mistake, you
can recover the message for up to three days if you're working with Outlook
connected through the Exchange server. Here’s how:
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In Outlook, open the deleted items folder:

1. Choose Tools>Recover Deleted Items.
The files available for recovery appear.
2. Select the deleted message you want to recover and click Recover.

The message is transferred to the Outlook mailbox.

Create a Message with Restricted
Reading Permission

I recently received a message from a person with whom I have a good profes-
sional relationship. The message said that I had to sign on to the Microsoft
IRM service by using my .NET Passport in order to receive messages from
him. Because I didn’t know the meaning of the IRM acronym, I felt I was
receiving a kind of Mission Impossible, top-secret message.

Well, IRM is a type of protection that keeps messages from being read, for-
warded, or printed unless the sender allows it. The IRM acronym doesn’t
mean Impossible Reading Message, but rather Information Rights
Management. Sending a message with this service protects your message
from being forwarded or printed and keeps the message’s content restricted
according to the sender’s wishes. The service is available only to Microsoft
Office Professional Edition users. Here’s how to send a restricted message.

Before creating a restricted message, you have to download and install the
Windows Rights Management (RM) Client and sign up for the MSN .NET
Passport to create your password to access the service’s server.

To install the Windows RM client and get a .Net Passport, follow these steps:
1. With a new e-mail open in Outlook, choose Filez>Permission-~>Do Not

Forward.

When trying the IRM the first time, a warning window prompts you to
install the Windows Rights Management client.

2. Click Yes to install the Windows Rights Management client.
Follow the setup instructions until the end of the installation.

3. Going back to your message, choose File>Permission=>Do Not
Forward.

If you already have your .NET passport, Windows prompts to confirm
whether you’ll use your current ID. If you don’t have a .NET passport
installed, the Service Sign Up wizard appears.
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4. Select Yes, I Want To Sign Up For This Free Trial Service From
Microsoft and click Next.

The Windows RM Account Certification Wizard opens with two options.

5. Choose No, I Do Not Have A .NET Passport And I Want To Register To
A .Net Passport Now or Yes, I Do Have A .NET Passport if you already
have one.

6. Click Next and follow the wizard.

The wizard takes you to the Microsoft site to create your credentials or
download your current one.

After you follow the steps from Microsoft’s site, your .NET Passport cre-
dential is ready, and Windows Rights Management is installed in your
computer.

After you complete the setup, follow these steps:

1. With a new e-mail, open choose Filec>Permission=>Do Not Forward.
The Select User dialog box appears.
2. Select the user from the list and click OK.

A headline on top of the message appears.

Although the Windows Rights Management and .NET Passport require some
setup work the first time, they provide valuable protection that you can use
on any new message.

The addressee who is using Outlook 2003 and receiving the IRM message also
needs to set up Windows Rights Management in order to read the message.

To create a restricted-reading message, you need Office Professional 2003.
Reading an Outlook message with a program other than Outlook is possible
by downloading the Windows Restricted Permission viewer.

If you aren’t running Microsoft Office 2003 or an e-mail application that sup-
ports messages with restricted permission, you can view this message by
downloading the Rights Management add-in for Internet Explorer from
http://r.office.microsoft.com/r/rlidRestrictedPermission
Viewer?clid=1033. You can then read the message as an Internet Explorer
page.

You can also restrict documents created in Word, PowerPoint, and Excel in
the same way.
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Protect the Addressee’s Mail Address
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Once, when [ was participating in an e-learning class, the teacher sent her
presentation in a regular e-mail to 100 participants. As an enrolled partici-
pant, [ received her message and more than 60 unnecessary Replied To All
messages, based on the teacher’s message. Participants used Reply To All
instead of using the bulletin board, as instructed.

Broadcasting messages to a dozen people by using the CC: or To: line can be
a lazy and even dangerous thing to do. First, you're giving out others’ e-mail
addresses without consent and thus multiplying their exposure to risks.
Second, this type of message can generate a mass of junk mail when people
start answering by clicking the Reply to All button.

To avoid these problems, use the BCC line for all the recipients’ addresses
and put your own address into the To line, which sends the message to your-
self. Your own address is the only one the recipients see.
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In this part . . .

rlese basic Outlook appendixes explain the step-by-
step procedures for using the Calendar, Tasks,
Contacts, Journal, and E-mail for those who aren’t familiar
with Outlook.




Appendix A
Calendar Basics

In This Appendix

Using the Appointment form

Supervising your team’s appointments

Customizing and viewing the Calendar

Fe word calendar comes from the Latin word calendas, which means the
first date of the Roman month, and the day Romans paid their accounts.
This definition may explain why, to this day, the first of the month is often
when bills are due. Outlook Calendar is useful not only for organizing your
time commitments and automatically reminding you about those commit-
ments, but also for inviting people to a meeting or event.

Creating an Appointment Entry

\NG/
$

An Outlook Appointment is the basic form you use to set up anything in the
Calendar, including personal time commitments, meetings, events, and activi-
ties to which you invite other people. Outlook’s definition of an event is an
activity that lasts all day.

Although one Outlook event lasts all day, it doesn’t block the day during the
event. You still can use it for other purposes.

Exploring the Appointment form allows you not only to understand all the
resources for making appointments, events, or meetings, but also figure out
how to classify each appointment and list according to your priorities and
how to use the reminders to organize your time.

Follow these steps to set up an Appointment.

1. With your Calendar open, click the New button.
The Appointment appears.
2. Set up the Start Time and End Time (see Figure A-1).
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Figure A-1:
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The start time typically indicates the beginning of the appointment, not
the time to start going to the appointment. Calculate the time you need
to get to the appointment and then set up the Reminder in Step 11 to
help you arrive on time. You can even change the Reminder sound to a
horn or heavy rock if you tend to get too involved in your work. Another
option is to add the travel time to the actual appointment and adjust the
start and end times accordingly. This technique is useful if your assis-
tant is likely to book another appointment in the Calendar during the
time you need to be traveling. If you don’t build this time into the
appointment, you or your assistant may forget and schedule something
in that time slot.

You can double-click in the Calendar One Day view to see the appoint-
ment, with its start time, as selected in the Calendar.

3. Type the subject of the appointment in the Subject text box.

4. Type the appointment’s location, such as your office or the customer

site, in the Location text box.

5. Select your label from the Label list box to color-code your

appointments.

The Label list box enables you to pick ten colors in order to color-code
your appointments. The following Calendar views support these color



Appendix A: Calendar Basics 28 7

codes: One Day, Week, Work Week, and Month. When you have three
appointments colored in red, for example, you have three important
appointments on that particular day. You can associate each color with
these definitions: None, Important, Business, Personal, Vacation, Must
Attend, Travel Required, Needs Preparation, Birthday, Anniversary, and
Phone Call. The Label option colors only the appointments.

6. Click the Contacts button to open the Contacts list. You can link any
contact record to this appointment or meeting.

7. Click the Categories button to open the Category list, and then select
and classify the appointment in any category.

8. Check the All Day Event check box to turn the appointment into an
all-day event; the Start Time and End Time drop-down boxes disap-
pear when you use this option.

The Show Time as list box displays four options: Busy, Tentative, Free,
and Out Of Office. This feature is especially helpful when you work with
groups, because it shows your free/busy times on your Scheduling page
when you’re connected through the Exchange server. In addition to
affecting the Free/Busy scheduling, the Show Time as options also show
up in the Calendar, each with a different colored bar next to the appro-
priate time slot. This view provides a quick, visual take on your day’s
appointments.

9. Select the Show Time as list box according the options explained
previously.

The above selection in the Appointment will display the same color bar
in the calendar and Scheduling pages.

10. Set the Reminder to a time just before your appointment.

11. Click the Reminder sound button if you want to play a different sound
when your reminder pops up.

The Reminder Sound selection box appears.
12. Click the Browse button, select a sound, and click OK.
Your pure dynamite sound is ready to catch your attention.
13. Click OK and then the Save And Close button in the Appointment.

The Appointment is saved in your calendar.

Setting Up a Recurring Appointment

You can use the recurring appointment feature to establish meetings or time
commitments that repeat weekly, monthly, or even annually or to set up a
recurring appointment.
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To do so, open your first appointment and follow these steps:

1. Click the Recurrence button.

The Appointment Recurrence dialog box appears (see Figure A-2).
2. Set up the desired recurrence pattern, such as daily or weekly.
3. Click OK.

_Appointment Recurrence %]
Appointrent Hme
Start: | 12:30PM w End: | 1:00 PR | Duration: | 30 minukes £
Recutrence pattern
) Daily Recir every |1 week{s) on:
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LIMorthly | [ Thursday [JFriday  [5aturday
) Yearly

Range of recurrence
Y
Skart: | Thu 9/15/2005 | (2Noend date
(End after: |10 | ocourrences

(CEnd by: Thu 11/17/2005 [

Collaborating on Time Commitments

In addition to the Appointment form, which you can use to control your own
time commitments, the following Calendar tools can help you schedule your
time with other people.

Free/Busy scheduling

Free/Busy scheduling displays each attendee’s time slots as Busy, Tentative,
Free, or Out Of Office. You select one of these options in the Show Time As list
box in every saved appointment. Follow these steps to see the Free/Busy grid:

With the Appointment open in Outlook:

1. Click the Scheduling tab.

The Free/Busy scheduling grid appears. You can compare your schedule
with your colleagues’ free and busy times when you’re online and on the
same Exchange site.
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2. Type the e-mail address in the All Attendees column.

The Free/Busy time slots appear in the attendee’s e-mail address line.
Now you can check the first free time available to all attendees (see
Figure A-3).

3. Click the Autopick Next button.
The bars in the scheduling calendar move to show the first free time
available to all attendees. Outlook adjusts your meeting’s start and end

times based on this particular time frame. After selecting a free time
slot, you can e-mail all the attendees an invitation.
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Meeting invitations

From Outlook’s point of view, a meeting is just the same time commitment for
more than one person. You can use Free/Busy scheduling to check your col-
leagues’ free time or simply invite them to a meeting on a tentative basis.

With your Appointment open:
1. Click the Invite Attendee button to transform the Appointment into an

Invitation.

The To line is added to the Appointment, enabling you to send the invi-
tation as an e-mail.

2. Type the e-mail address into the To line to invite the addressee.

3. Click the Scheduling button to check the attendee’s Free/Busy time.
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4. Click the Send button to send the invitation.

The invitation is sent.

Meeting commitment

The meeting invitation is a timesaving tool that helps eliminate the need to
locate people by phone. The addressee sends an answer by clicking the
Accept, Decline, Tentative, or Propose New Time buttons (see Figure A-4),
creating a commitment by automatically inserting the invitation into his or
her Calendar.

|
Figure A-4:
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Sharing Calendars

You can share your Calendar so that your supervisor or assistant can see it
(as long as everyone is using the Exchange server). First, you must give the
person permission to access your Calendar.

With your Calendar view open:

1. Choose Share My Calendar in the Navigation pane.
The Permissions In Calendar Properties dialog box appears.

2. Click the Add button to open the Add Users dialog box.



Appendix A: Calendar Basics 29 1

3. Select the person who you want to access your Calendar and click OK.
The Permissions page reappears.
4. Select the Permission level for the selected people.

Permission levels include Reader, which means people can only read the
Calendar, and Editor, which means they can read and edit your Calendar.

5. Click OK to enable the sharing.
To open a shared Calendar:

1. Select Open A Shared Calendar in the Navigation Pane.
The Open A Shared Calendar dialog box appears.
2. Type the name of the person whose Calendar you’re sharing.

The Calendar appears in Outlook.

Viewing the Calendar

The most frequently used Calendar view is the Day/Week/Month view, which
displays your Calendar like a daily, weekly, or monthly planner. You have the
option to move from one view to another by clicking the appropriate button
in the toolbar. Other views are useful for seeing only certain events, such as
active appointments, annual events, recurring appointments, and categories.
Use the Calendar View options to see information quickly by just changing
the view.

The Calendar’s amazing features remind you about meetings and appoint-
ments, allow you to check your free and busy times, make creating invita-
tions faster, and all in less time. Use these features, and you just may find you
have more spare time.
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Appendix B
Tasks Basics

In This Appendix

Understanding tasks

Assigning tasks
Viewing the Tasks list

Fe Tasks list is your to-do list, and it helps you meet your obligations on
or before a certain deadline. The time span in which you complete the
job is your choice. Your list can be as simple as Grandma’s household chores,
stuck to the refrigerator door, or as complicated as an international business
executive’s schedule. Outlook’s Tasks list offers more than a paper list. You
can determine the deadline of a job, assign its priority, and estimate the time
you need to do it. These features help you plan and attack each task accord-
ing to your own priorities. This appendix explores the available fields within
the Tasks list to see how you may be able to use them.

Creating a New Task

The Tasks list’s many informational fields let you measure the status of each
job and classify them in ways that are important to you. Familiarizing your-
self with the default form helps you use the fields according to your own
needs, not only for your own sake but also to prioritize tasks for your team.

To create a new task, follow these steps:

1. Click the Task button (or press Ctrl+4) to display the Tasks list.

2. Click the New button (or press Ctrl+Shift +K) to display a new task, as
shown in Figure B-1.
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3. Complete the following fields:

¢ The Subject line is where you type the job title or desired job
action.

¢ The Due date field is where you indicate when you intend to finish
the job.

e The Start date field is where you enter the date on which the job
was written or accepted.

e The Status drop-down list is where you classify how the task is
moving. You can pick from the following options: Not Started,
Deferred, Waiting On Someone Else, In Progress, and Completed.
The Status field is useful for analyzing all your tasks in one list.
Perhaps you need to see how many tasks are waiting on someone
else, for example.

¢ The Priority drop-down list offers three options: Normal, High, and
Low. You can use this field to view your tasks by priority. The
Tasks list view shows an ! sign for tasks with high priorities, a
sign for tasks with low priorities, and no sign for tasks with normal
priorities.
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¢ The Reminder check box selection turns on a pop-up screen
reminder and a sound on the date and time selected in the
Reminder Date and Time box. By clicking the Reminder sound
button, you can select a new sound file to play in the Reminder
sound box.

e The Owner field displays the owner of the task. Does it belong to
you, or did you send it to someone?

¢ The Contacts button allows you to link a contact to a task by click-
ing and selecting the contact from your Contacts list.

¢ The Categories button helps you classify and view the Tasks list by
categories, such as internal or customer’s requests.

¢ The Private check box lets you keep the task private (not shared)
when folders are shared on an Exchange server.

4. If you want to repeat the same task on a certain period of time, click
the Recurrence button.

5. Click the Save And Close button.

The task is saved in your Tasks list.

If you have a long Tasks list, you can select the Views command in the
Navigation pane Current View window to help you decide how to attack your
own priorities. See the next section, “Viewing the Tasks List,” for more infor-
mation about the Tasks List view.

Viewing the Tasks List

You can view the Tasks list in the Task pane in ten ways; each way has differ-
ent advantages, depending on your needs, priorities, and work periods.

To view your Tasks list:

1. With Outlook open on the Tasks list, select one of the views by choos-
ing View in the Navigation Pane Current View.

The Simple List looks like Grandma'’s list stuck to the refrigerator, with
the subject and due date. The Detailed List displays the Subject, Status,
Due Date, Percentage Complete, and Categories fields, as shown in
Figure B-2. The Overdue Tasks option is helpful for managing delayed
tasks and for evaluating what to do about them.
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2. Explore the other views, including Active Tasks, Next Seven Days,
Assignment, By Person Responsible, By Category, Completed Tasks,
and Tasks Timeline.

Moving from one view to another can help you determine which task
you need to finish at each moment. Read more in Chapter 2.

You can move from one Tasks List view to another at any time, to view your
information in the most effective way possible for your work.
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Requesting and Supervising Tasks

Sometimes asking someone to complete a task, or even sending them an
e-mail about it, isn’t enough to ensure that the person will do the job. The
great thing about Outlook’s Tasks list is that assignees have to click the
button to accept responsibility for it, and then clicking the Accept button
copies the task into the assignee’s Tasks list. You then immediately receive a
confirmation, which makes it much harder for an assignee to forget about his
commitments.

Requesting and confirming tasks

Besides sending coworkers task requests, you can also send task requests to
your suppliers or customers (if they use Outlook’s tasks). Since Outlook 2002,
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any Outlook user can accept tasks and invitations with no problems at all.
The following steps show you how to request a task.

1. With your task open, click the Assign Tasks button.
New fields and selections appear in the Task.

2. On the To line, type the address of the recipient of the task. This
person will receive the task as an e-mail.

Two new options are available to link the requester (task creator) to the
assignee (task recipient), enabling you to supervise the task without
phone calls or personal meetings. Steps 3 and 4 show these two options.

3. Select the check box Keep An Updated Copy Of This Task On My
Tasks List to receive an e-mail notice each time the assignee updates
the task.

4. Select the check box Send Me A Status Report When This Task Is
Complete to receive an e-mail update when the task is complete.

5. Click Send to send the task request to the assignee.

In order to receive updates about assigned tasks, you have to assign the task
to only one person at a time. In order to receive an update from more than
one person, you have to open and assign the task to each individual sepa-
rately. For example, in a sales environment, you may want to request a
weekly report from each salesperson individually, rather than one from the
whole group. This technique makes each salesperson responsible for his or
her own status report.

Accepting or declining tasks

Outlook sends task requests as e-mails. The assignee receives and opens the
e-mails. The task has two buttons:

v The Accept button sends the assignee’s response and updates the
requestor’s Tasks list.

v The Decline button declines the task. Assignees typically edit the
response to explain why they can’t accept the task and perhaps propose
a new agreement.

When the assignee clicks one of the buttons, he or she can also type a com-
ment with the response before Outlook sends it.
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Supervising a task

When you request and supervise a task the old-fashioned way, you give the
task to the assigned person and record in your planner a reminder to check
in with the person on a certain date. Then you often call the assignee to see
how the work is going. This approach is time consuming for both people and
requires many unnecessary interruptions. Outlook’s supervising options
update the information for you when you selected the check box Keep an
updated copy of this task on my tasks list before assigning and sending the task
(see the previous section). Every time the assignee opens her task and
updates it, Outlook automatically sends an e-mail to the task requester and
updates the requester’s Tasks list, thus saving you many potential phone
calls. When the assignee completes the task, the requester’s Tasks list is also
updated and appears as complete.

Task supervision only works when the assignee updates the tasks in his own
Tasks list, of course.

Sharing your tasks

You can also share tasks and allow your team to view your Tasks list when
Outlook is connected through an Exchange server. Your supervisor can view
your current list without interrupting you, and your assistant can remind you
to change a task priority when necessary.

Giving permission to someone to share your Tasks list and the procedure to
open a third-party list are the same as for the Calendar. See Appendix A for
more information.



Appendix C
Contact Basics

In This Appendix
Understanding the Contact record

Using the Actions menu

Fe Contact is the most versatile item within Outlook due to its quantity of
ready-made fields available for recording data. The Contact record
includes fields for professional data, such as names and contact information
for coworkers, and for personal information like anniversaries, personal con-
tacts, people’s hobbies, and spouse’s and children’s names. Exploring a con-
tact in this Appendix shows you some of the fields available for recording
this information.

Exploring a Contact

The Contact fields appear in the General page, as well as the Details page of
each record. The All Fields tab shows you 20 groups of fields. To explore
these fields, start with the main page.

1. In Outlook, click the Contacts button in the Navigation Pane (or press
Ctrl+3) to display the Contacts list.

2. Click New (or press Ctrl+Shift+C) to display a new contact (see
Figure C-1).

3. Click the Full Name button.
The Check Full Name dialog box appears with the Title, First, Middle,
Last, and Suffix fields available for all parts of the name. You can also
choose the Show This Again When Name Is Incomplete Or Unclear
option in order to have this dialog box pop up whenever you type a

name into the Full Name field that doesn’t have all the parts. Correct the
name in the appropriate fields.

4. Click OK to return to the Contact window.

5. Type the job title, such as Manager or Salesperson, in the Job Title field.
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6. Type the company name in the Company field.

7. Select the way to file your contact in the File As list box.

You can file by the name, company, or both. The idea is to file the con-
tact by the field that you’re most likely to use when you're searching for
the contact. If you're more likely to remember the company name, file
the contact by company. If you’ll remember the person’s name, file

by that.

The Phone Numbers area has four buttons and four fields: Business,
Business Fax, Home, and Mobile. You can also change the button name
and the phone number by using a list of 19 options.

. Click the arrow button next to the Business button.

A list of 19 phone number titles appears, including telex and radio. You
can even save the contact’s boat radio number in the Radio field or the
telex number of a ship. Select one of the options and numbers to be dis-
played on the contact’s screen.

. Type the phone number in the desired phone number fields.

The Check Phone Number dialog box appears when the number isn’t
properly typed within the following fields: Country/Region, City/Area
Code, Local Number. If this dialog box appears, fix the field and click OK.
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10.

11.

12.

13.

14.

15.

16.

17.
18.
19.

20.

Click the arrow button next to the Business button below the
Addresses frame.

Three address fields are available: Business, Home, and Other. Select the
one you need to fill in, such as Business.

Type the Address in the text box and click OK.

The Check Address dialog box appears when the address is incomplete,
showing the following fields: Street, City, State/Province, ZIP/Postal
Code, and Country/Region.

Check the This Is The Mailing Address box if the current address is
the mailing address.

This option tells the Actions menu to use the selected address for mail-
ing purposes, such as when creating letters or labels.

Click the picture icon to open the Add Contact Picture dialog box.

The Contact Picture dialog box displays the Folders list, where you
select the picture to be inserted. Adding a picture helps you remember a
customer’s face, which can be especially helpful when it has been a long
time since you've seen the person.

Double-click the picture to insert it into the contact frame.
The picture is copied into the contact frame.

Type the e-mail address or select it from the address book by clicking
the Address Book icon on the right side of the E-Mail field.

Three e-mail addresses are available to use.

Click the arrow beside the E-Mail field to select an address or to add
more than one e-mail address.

The Display As field shows by default the name of the person and the
associated e-mail addresses. You can edit them if needed.

Type the person’s Web address in the Web Page Address field.
Type an Instant Message address in the IM Address field.

Click the Contacts button in the lower-left corner to link a relative or
another person by choosing the contact in the Select Contacts dialog
box and clicking OK.

Read more about Contacts in Chapter 4.

Click the Categories button in the lower-right corner, select one of
them to classify your contact, and click OK.

You can find out more about classifying your contact in Chapter 4.

You can use the data you've entered in the Contacts fields for performing
automatic dialing or sending invitations (see Chapters 3 and 16).
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Exploring the Details page

The Details page in the Contact record has additional fields where you can
record professional and family information. Open the Details page to see the
available fields.

With your contact open:

1. Click the Details tab.
The Details page appears (see Figure C-2).
2. Type the professional information into the appropriate fields.

The available professional fields are Department, Office, Profession,
Manager’s Name, and Assistant’s Name. These fields are useful for keep-
ing in contact with the whole team.

3. Type the personal information into the appropriate fields.

The Nickname, Title, and Suffix fields are the same ones the Full Name

field uses in the General tab. You can make note of any titles or special
additions, such as when a person is a Ph.D. or if you're talking with the
Jr. or Sr. The Spouse’s Name field is also useful for remembering social
obligations.

4. Select the contact’s birthday and anniversary in the Birthday and
Anniversary drop-down lists.

When you use the Birthday and Anniversary fields, Outlook inserts a
reminder into the Calendar.

5. Set the Online Net Meeting settings.

These settings are used in corporations for instant messaging, confer-
ences, and remote desktop maintenance.

Exploring the Activities page

The Activities page records every action related to a contact and creates a
history file. You can record the details manually or automatically by using the
Journal and its link commands. You can link all Outlook activities, including
meetings, appointments, sent and received messages, and Office documents.
Read Appendix D and Chapter 14 for detailed information.
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Automating Actions

You can automate several actions by using the contact data, which eliminates
the need to retype or dial a phone. You can use the Actions drop-down menu

list or the four shortcuts available in the toolbar.

v+ Follow Up reminds you to follow up with a contact.

v Display Map of Address shows an Internet map of the contact’s address.

v New Message to Contact opens a new e-mail addressed to your contact.

v AutoDialer calls the contact’s phone number.

Flagging for follow-up

The flag for follow-up dialog box reminds you to take an action related to the
contact, including calling, sending an e-mail, sending a letter, and arranging a

meeting.
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With your contact open:

1. Click the Follow Up button.

The Flag for Follow Up dialog box appears. You can select the date and

time of the reminder and have Outlook remind you about one of the fol-
lowing actions: Follow Up, Arrange Meeting, Send E-Mail, Call, and Send
Letter.

2. Select Follow Up from the Flag list box.
3. Select the Date and Time in the Date box.
4. Click OK to return to the Contact screen.
The Follow Up reminder page pops up as scheduled.

5. Click the Clear button in the Follow Up reminder page after you’'ve
completed the task.

Displaying maps

The Display Map of Address option simply displays an area map of your con-
tact. Outlook uses the MSN Map site to create this map, so be sure that
you’re connected to the Internet when you use this option.

Simply click the Display Map of Address button. Internet Explorer opens and
displays the MSN page with a map to your contact’s address.

Sending e-mails

The shortcut for sending e-mails presents you with a new e-mail form con-
taining the customer’s e-mail address in the To line, which saves you a bit of
time on each new e-mail you send.

Autodialing phone calls

How much time do you waste reading a contact’s phone number, pressing the
buttons on the phone, and waiting for a voice to say hello? A few seconds if
you’re young and fast and minutes when you’re older and slower. Release
yourself from this unworthy job by using the autodialing feature. Read more
in Chapter 3.
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More automation actions

Almost 20 options are available from the Actions menu, including New Contact
From The Same Company, New Distribution List, New Letter To Contact, New
Meeting Request, New Task For Contact, New Journal Entry For Contact, Link,
Call Contact, and Forward As vCard.

Many users aren’t aware of the following commands, so the detailed explana-
tions can help you understand the advantage of using them for your own work.

v New Contact From The Same Company saves time by creating addi-
tional contacts that have the same address. Just fill in the contact’s
name, job title, and phone and e-mail information, and the rest is done.

v New Distribution List opens the Distribution list box, where you can
create a group of contacts. You can name it Sales Team and include all
the sales team members in the group, for example. You can then send
messages and perform other actions on preestablished groups of con-
tacts, instead of sending e-mails to each contact individually.

1 New Letter To Contact opens the Letter Wizard and inserts the contact
information into a Word letter.

v The New Journal Entry and Link commands link information related to
your contact in the Activities tab. Appendix D explains this process.

v Forward As vCard creates an e-mail with an attachment called vCard
that contains the contact information. Receiving an e-mail with a vCard
allows anyone with Outlook to click and open the contact to read it or
drag and drop the vCard into his or her Contacts list so that you can add
the new contact without having to type any data. You can create and for-
ward any vCard from your Contacts list.

Using a vCard as your message signature

You can create a Contact record with your personal contact information and
use it as your mail signature. First, you have to create your own contact
record to send as a vCard, because it’s unlikely you have your own informa-
tion saved as a contact in your own list. After saving the new record, you can
use the following procedure to add it as your e-mail signature:

1. With Outlook open, choose Tools=>Options.
The Options dialog box appears.
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. Click the Mail Format tab.

|
Figure C-3:
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|

The Mail Format page appears.

. Click the Signatures button.

The Create Signature dialog box appears.

. Click the New button.

The Create New Signature dialog box appears.

. Type your name as the signature name in the Enter A Signature Name

text box.

You can have more than one signature; each one has must have a unique
identification name. You can create a professional and a personal
signature.

. Choose Start With A Blank Signature and click Next.

The Edit Signature dialog box appears (see Figure C-3).
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7. Click the New vCard From Contact button.

The Select Contact As vCards export list appears.

8. Select your own vCard.

9. Click OK to return to the Mail Format option box.

10.
11.

12.

Select the signature you want to use for new messages in the list box.

Select the signature you want to use for replies and forwards in the
list box.

Click Apply and then OK.

Every e-mail you create or forward now includes your vCard as a signature.



Printing for your planner

You can print your Contacts for your planner or
black book. Just open the Contacts list to the
Address Card or Detail Address Cards views.

1. Choose File->Page Setup.

Five formats are available: Cards Style,
Small Booklet, Medium Booklet, Memo
Style, and Phone Directory Style.

2. Select Small Booklet.

The Page Setup Small Booklet box appears.
3. Click the Paper tab.

The Paper page appears.

4. Select your desired type of paper, such as
Avery, Filofax, or Daytimer, or any other
from the Paper tab (see figure).

5. Select the page size in the Size list box.

6. Click the Print button and follow the
wizard's steps.

The Contacts listis printed in your planner’s
format.

Page Setup: Small Booklet Style

Style name: | Small Booklet Style
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Paper
Type:
Avery 41-357 s
fvery L7901
fuvary L7I0Z
FiloFax #106
Dray-Timer #20254 Parkable Loose-Les
Cuskom L]
Dimensions:
Wickh:  &50"

Paper source:

Height: [11.00"

Auom&kico v
IMargins
Top: 0.50" Left: 050

Boktom:  0.50" Right:  |0.507

Page
Size:
Day-Tirner Senior Desk -~
Drary-Timer Senior Pockst
Day-Timer Junior Desk
Day-Tirner Junice Pocket
Dy Runner Entreprensur
Day Runner Classic -7
Dirnensions:
width: | 2.75" Height: 4.25"

Orignkation

Aflaflala

(%) Partrait
alladllala

O Landscape

OF ] l Cancel

|| [ print Preview | |

Fric...

Appendix C: Contact Basics 30 7




3 08 Part VI: Appendixes




Appendix D
Journal Basics

In This Appendix
Linking an Item or a Journal
Automating the Journal
Using the Journal information

n the dictionary, journal is defined as “a personal record of occurrences,

experiences, and reflections kept on a regular basis; a diary.” The meaning
of journal in an accounting or bookkeeping context is “a book listing all trans-
actions and indicating the accounts to which they belong with a time stamp.”
In keeping with these ideas, the Outlook Journal is a kind of diary in which
you record your personal work history and retrieve it in an organized way.

In this appendix, you find out how to manually link an Outlook item to a con-
tact and how to display all linked items. You also discover how to explore the
Journal entry form for your professional use.

Introducing the Journal

To understand the Outlook Journal, you need to understand some other
terms as well. An ltem, for example, is any Outlook occurrence, such as an
e-mail, appointment, meeting, task, or contact. Linking an Item is recording
the item in the Activities list found in any contact record. The Journal entry
form is where you record non-Outlook items, such as phone call comments or
files from other programs. The Journal also records (or maintains links to) all
your Office document activities, recording a time stamp when you open and
when you save each file and listing them in Journal view.

The Journal lists all your contact information in an organized way in the
Activities page and displays all your Microsoft Office activities in the Journal
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view. You can record any occurrence manually or use the Journal’s automa-
tion to do the work for you.

The most common Journal activity is inserting a time stamp on Outlook Items
and Microsoft Office files. You can use this feature to list each of your con-
tact’s activities on the Activities page, thus creating a contact history. You
can also list the time you spend working with each Microsoft Office file.

Outlook records Journal entries based on when the action occurs. For exam-
ple, a Word document is linked to the timeline on the date it’s created or
modified. You can set the Journal view to By Type on the timeline to see
entries listed by activities such as e-mail messages, meetings, and phone
calls. These views allow you to quickly locate information, such as a proposal
sent last month or an e-mail sent two weeks ago.

Creating a Contact History

The Activities page for each contact contains the contact history with all
related activities, each appearing with a time stamp. The “activities” shown
in the list are Outlook items, such as e-mails, tasks, appointments, meetings,
and related occurrences for the contact recorded into the Journal entry form.
A Journal form records the information you type, links to other items in
Outlook, and links to documents created in Microsoft Office programs.

Linking items to a contact manually

Do you remember the details of your last phone call with your best cus-
tomer? When was your last meeting before the phone call? When did you
send the last proposal? All this sort of information is spread out in different
folders on your computer. Wouldn't it be easier if you had an index listing all
your activities with each customer when opening the contact record? The
Activities page of each contact serves just this purpose — to index and pro-
vide links to all customer information.

With any contact record open, click the Activities tab. The Activities page
appears. All your linked items, files, and Journal entries are listed on this

page.

The purpose of linking items to a contact is so that you can list them in the
Activities page. To list an activity in the Activities page, you have to create a
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link between the activity and the contact. Linking any Outlook item to a con-
tact’s Activities page is as easy as the following steps:
1. With your contact open, choose Actions=>Link=>Items.
The Link Items To Contact dialog box appears.
2. Double-click an item, such as a task, e-mail, or calendar.

The item is linked to the selected contact.

Retrieving the linked information

Finding the recorded information for each contact is now very simple and
easy. With the Contact open, click the Activities tab. The Activities page
opens with all items displayed in the Show drop-down box (see Figure D-1).
Understanding the concept of linking and retrieving items is the first step
toward using the Journal and Outlook in general.

Link Items to Contact %]

Look in:

18 3aurnal e
@ Junk E-mai
Lo | Motes
U kb
L= Sent Items
] Tasks
# [ fwchive Folders
L % 4 Archive Folders

w

Figure D-1: | 1ems:
Reading the [ 4@ Subject: Status Due Date Percen... Categories ||
A” Items .(_1 oustomer request #121 InFrogress  Tue 7/3/2007 0%, Kery Customer
3 el ek I pheted .
Activities 3] Passionfrui Drink Wakingon ... Frif1j2007  25%  Proposal
|ist re\/ea|s ) ‘eekly time record Emplovee # 234 InProgress  FriS[11/2007 0%
& 1 Deliver the proposal to Gold Customer InProgress Thu 1f11j2007  S0% Propasal
y0 ur ] Best Company Foliow up Requested Proposal Mot Starbed  Mon 102372006 0%
C UStOmerS' & 1 @ Proposal request InProgress  Thu 10/12/2006 25% Proposal P
histories. —— —— | ——
|

Linking Items Automatically

Outlook can automatically link all items related to each contact in the
Activities page, thus eliminating the need to record each item manually. The
next steps show you how to set up Outlook automation to automatically link
items related to a contact:
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1. With Outlook open, choose Tools=>Options=>Journal Options.

The Journal Options dialog box appears (see Figure D-2). You can decide
which items Outlook will automatically record in the Journal, including
meeting requests, e-mail, and tasks.
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2. Select any item to be recorded in the Automatically Record These
Items check boxes.

You can also select each contact to link and automatically list their
items in their own Activities list.

3. Select each desired contact in the For These Contacts check boxes.

The selected contacts now maintain links in their Activities pages, as
specified by your settings.

4. Select the Opens The Item Referred To By The Journal Entry radio
button in the Double-Clicking A Journal Entry frame.

This option lets you open a Word document without having to open the
Journal form that links to it.

5. Click OK.

The Journal now creates a history in the Activities page for each chosen
contact and links all the related items to the page.

Using Journal automation with Microsoft Office files creates a log for each file
indicating when it was opened and when it was saved and closed. These logs
can help you measure the time you spend on certain files, such as when
working on a proposal or an Excel cost sheet.
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Add Microsoft Office documents to your Journal entries only if you have a
real need for this type of automation, because it slows down your system. It
can take Outlook up to a minute to create these Journal links while it saves
the file upon exiting. To avoid this delay, you can create manual entries.

To link Microsoft Office files to a Journal:
1. Choose Tools=>Options->Journal Options to display the Journal

Options dialog box.

2. Select the Office programs you want to create logs for in the Also
Record Files From check boxes.

3. Click OK.

The Journal now logs the use of Microsoft Office programs.

Retrieving Journals

You can retrieve your Journals in two ways: by reading the Journal list in the
Activities page of each contact or by searching using the Journal views. I rec-
ommend using the Activities page in the customer’s history because it’s a
personalized list for each contact. The Journal views provide an excellent
way to retrieve any document by type and are better as generic lists that let
you see all phone calls, for example, no matter who the contact is.

Viewing the Journal list by contact

The Activities list displays the items linked to a contact including the Journal.
You can find any file or item linked to a specific contact by using these steps:
1. With the contact record open, click the Activities tab.

The Activities page is shown with all linked items listed, including the
Journal items. To list only the Journal items, proceed to Step 2.

2. Select Journal from the Show drop-down list.

The Journal list related to this contact now appears.

Using the Journal views

The Journal views list all activities and occurrences by type and time stamp.
The six views let you list and retrieve any record easily.

313



3 ’4 Part VI: Appendixes

aA\\J

To change the Journal view, open Outlook and click the Journal button in the
Navigation Pane. The Journal list is displayed by type in the timeline; this
view shows each type of recorded item and its files. You can double-click any
of these items to open them.

You can arrange the timeline view by day, week, or month by using the tool-
bar buttons. The Day view is an excellent way to search for a file when you
remember more or less when you worked on it. Just visit the appropriate
date and look for the file among the Journal entries at that time.

If the Journal button doesn’t appear in the Navigation Pane, click the arrow
icon (the Configure buttons) in the lower-right corner of the Navigation Pane.
From the drop-down list that appears, choose the Add Or Remove Buttons
command and then choose the Journal button. Outlook adds the Journal
button to the Navigation Pane.
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Shifting from Qutlook Express
to OQutlook 2003

In This Appendix
Moving from Outlook Express to Outlook 2003
Copying Outlook Express data from another PC

0utlook Express is a free basic e-mail program that doesn’t allow you to
manage your appointment and tasks. Outlook Express users often
install the Office 2003 package without using the wizard to move all their
Outlook Express content, thus arriving in Outlook 2003 automatically and
painlessly. This appendix covers the basic steps for upgrading to Outlook
2003 while keeping your data intact.

Moving from Outlook Express
to Outlook 2003

If you've been working with Outlook Express as your mail program for some
time and finally decided to move to Outlook 2003 so that you can benefit
from the Calendar, Tasks, and other features, you may be wondering how you
can transfer your Outlook Express data to Outlook 2003 without losing any
information. The Outlook 2003 Import and Export Wizard enables you to
move all your Outlook Express data, including the mail account, all mail-
boxes, the address book, and rules into Outlook 2003, in a few easy steps.
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Importing Internet Mail account settings

Outlook 2003 Importing wizard detects the Outlook Express data installed on
the same PC. To migrate from Outlook Express to Outlook 2003, you first
need to import your Internet Mail account settings:
1. In Outlook 2003, choose Filec>Import and Export.
The Import and Export Wizard appears.
2. Select Import Internet Mail Account Settings from the list box.
3. Click Next and follow the wizard until the end.
The Internet settings are installed in your Outlook 2003.
Before importing your older mail to Outlook 2003, clean out all undesired

mail from all your mail folders so that you can start a new application with-
out junk mail.

Importing mail folders and other data

If you’ve been running Outlook Express for some time, you probably created
mail folders, an address book, and maybe even some mail rules. Don’t worry.
You can import all your data with the Import And Export Wizard. Follow
these steps to import your mailboxes, address book, and mail rules:

)

. In Outlook 2003, choose Filec>Import And Export.
2. Click Outlook.
The Import And Export Wizard appears.

3. Select Import Internet Mail And Addresses from the list box and
click Next.

The Outlook Import tool moves to the next page (see Figure E-1).
4. Select the Internet mail application you want to import from.
In this case, choose Outlook Express.
5. Check the Import Mail check box to import all your e-mails.

6. Check the Import Address Book check box to import your address
book.

7. Check the Import Rules check box if you want to import your older
Outlook Express rules and click Next.

The Import Addresses page appears. If you're already using the Outlook
contacts folder, you may have some duplicate addresses after you
import from an external source.
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8. Select one of three options: Replace your duplicates with items you
import, allow the duplicates to be created, or don’t import any dupli-
cate items.

9. Click Finish.

At the end of the import procedure, you're running Outlook 2003 with all your
previous Outlook Express data.

Changing your default mail system

Even though you've imported your Internet account settings and your date,
your computer’s Internet Explorer settings still selects Outlook Express to
create a new message. To change the default mail system from Outlook
Express to Outlook 2003, follow these steps:
1. In Internet Explorer, choose Tools=>Internet Options.

The Internet Options dialog box appears.
. Click the Programs tab (see Figure E-2).
. Select Microsoft Outlook from the E-Mail list box.
. Select Microsoft Outlook from the Newsgroups list box.
. Click Apply and then OK.

Your Internet settings are now linked to Outlook 2003.

(22 I U )
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Copying Outlook Express
Data from Another PC

If you're running Outlook Express on a different PC, you have to export the
Internet accounts, mailboxes, address books, and rules data files to your cur-
rent PC and enable Outlook 2003 to import them. Here are the basic steps:

1. Locate and copy the Outlook Express files to a portable media such as
a CD-ROM, floppy disk, or memory drive.
2. Copy the files to your current PC.

3. Use Outlook Express on your current PC to read the copied data and
then enable Outlook 2003 to import the data.

4. Import the files by using the method described in the section “Moving
from Outlook Express to Outlook 2003,” earlier in this chapter.
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AC power, Europe, 192
Accept button, 145, 152-153, 183, 297
Account Financial Information area,
Account form, 86
Account form
Account History frame, 231-232
as alternative to Outlook Contacts, 83
Categories button, 86
content, 83
Details tab, 86-87
duplicate information with Business
Contact form, 85
entering information, 85-87
New button, 85, 86
Opportunity form linkages, 82
Account History frame, Account form,
231-232
Account History Items, 235
Account History list, 86
Account list, 85, 231
accounts
neglected, 101
overdue, 100, 102, 107-109
Accounts by Category report, 101
Accounts by Rating report, 100-101
Accounts by Status report, 100, 107-109
Accounts History report, 102
Accounts List with Business Contacts
report, 102
Accounts Neglected report, 101
ACT!, 117
Actions drop-down menu, Contacts
AutoDialer, 303, 304
Display Map of Address, 303, 304
Follow Up, 303, 304
Forward As vCard, 305
Link command, 305
New Contact From Same Company, 305

New Distribution List, 305
New Journal Entry, 305
New Letter To Contact, 305
New Message to Contact, 303
Active Appointments command, 27
Active Sync, Microsoft, 83
Activities page, Contacts, 35, 212, 230, 302,
310-313
Add A Fax command, 36
Add Address Or Domain dialog box, 137
Add Contact Picture dialog box, 301
Add Holidays button, 202
Add Item dialog box, 233
Add List dialog box, 157
Add New Item, 148
Add Or Edit dialog box, Product And
Service Items List, 93
Add The Items in This File To The Existing
List option, 94
Add To List button, 248
Add Users dialog box, 262, 290-291
Address Block option, 242, 246
Address Book button, 37
Address Cards view, Contacts, 58
Advanced E-Mail Options button, 263
Advanced E-Mail Options dialog box,
263-264
Advanced filter option, 248, 249, 271
agenda, 187
Agenda Wizard, 187
agreement
management, 144, 151-154
player rules, 152-154
alarm, reminder, 9, 11
aligning columns, 77
All Attendees list, 180
All Contact fields option, 56-57
All Day Event check box, 287
All Folders, 276
All Items option, 230
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All Mail Folders list, 15, 260
All Tasks Fields option, 58
antiphishing.org (Web site), 141
anti-spam filters, 122
Apply Color button, 217
appointment

categories, 177

Free/Busy scheduling, 172, 288-289

linking to prospect account, 231

meeting invitations, 289-290

recurring, 21, 287-288

setting up, 285-287

in shared calendars, 172

viewing active, 27
Appointment command, Account History

list, 86

Appointment form

All Day Event check box, 287

Categories button, 177, 287

Contacts button, 199, 287

creating an appointment entry, 285-287

end time, 285-286

Label list box, 286-287

Location text box, 286

Reminder, 287

Scheduling tab, 172, 288-290

start time, 285-286

Subject text box, 286
Appointment Recurrence dialog box, 288
Archive Folder, 139
archiving

e-mail, 30, 136, 138-140

Outlook data file, 39
Are There Any Exceptions? dialog box, 129
Arrange By Categories option, 220
Arrange Meeting (flag option), 208
Assign Task button, 28, 154, 228, 297
Attach Original Message option, 131
audience

knowing, 237-238

selecting, 239-240
Author (permission level), 157
AutoArchive button, 138, 139
AutoArchive dialog box, 30, 139-140
AutoDialer option, Contacts, 303, 304
Automatic Formatting command, 218

Automatic Formatting dialog box, 218
Automatically Accept Meeting Request And
Process Cancellations check box, 185
Automatically Decline Conflicting Meeting
Requests check box, 186
Automatically Decline Recurring Meeting
Requests check box, 186
Automatically Record These Items list box,
211, 312
Automatically Starts Windows Media With
Reminder check box, 189
automation
archiving, 39
backing up, 40-42
call, 33-35
data management, 39-42
fax, 36-37
integrating communication, 37-38
synchronizing, 39
AutoMergeField, 249
AutoPick Next button, 180, 183, 289
Available Fields list, 65, 112, 208
Avanquest (Phone Tools), 276, 277

ol e

Backup Options dialog box, 41
Backup The File Selected Above To This
Location option, 196
Backup These Personal Folders Files
option, 41
Backup tool
Backup The File Selected Above To This
Location option, 196
creating file with, 40-42
downloading, 40
installing, 40
uploading information with, 196
B2B (Business To Business) customer,
99-100
B2C (Business To Consumer) customer,
99-100
bcc e-mail, 281
BCM. See Business Contact Manager
BlackBerry, 83, 195
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Blocked Senders list, 30, 136
broadcasting e-mails, 250, 273-274, 281
Business button, 300, 301
business cards, scanning, 48
Business Contact form
as alternative to Outlook Contacts, 83
Business Contact History area, 88
Contact Preferences area, 88
description, 84
Details tab, 88-89
duplicate information with Account
form, 85
entering information, 88-89
Opportunity form linkages, 82
Business Contact History area, Business
Contact form, 88
Business Contact Manager (BCM)
account information, 83, 85-87
business contacts, 84, 88-89
Business Services, 250
description, 81-83
direct-mail marketing and, 240, 241
disappearing commands, 84
downloading update, 82
E-Mail Marketing, 250
following up on proposal, 234-235
importing into, 93-95
installing, 82
integration, 117
limitations, 96-98
mapping client location, 225-226
opportunities, 84, 90-92, 96
for Pocket PC, 83
Product And Service Items list, 84,
92-96, 97
updating, 82
using to prospect a new customer,
231-235
value of, 114
view options, 110-113
Business Contact Manager (BCM) reports
Accounts by Category, 101
Accounts by Rating, 100-101
Accounts by Status, 100, 107-109
Accounts History, 102

Accounts List with Business Contacts,
102
Accounts Neglected, 101
Business Contacts by Category, 102
Business Contacts by Rating, 102
Business Contacts by Status, 102
Business Contacts History, 102-103
Business Contacts Neglected, 102
Business Contacts phone list, 102
Business Tasks, 105
in Excel, 114-117
filtering, 109-110
Modify Report dialog box, 107-108
Opportunity by Product and Service, 105,
109-110
Opportunity Forecast, 105, 106
Opportunity Funnel, 105, 106, 110-111
Past Due Opportunities, 105
Quick Accounts List, 102
refining, 107-109
saving formats, 108, 114
Source of Leads, 104
value of, 114
views, using, 110-113
Business Contacts by Category report, 102
Business Contacts by Rating report, 102
Business Contacts by Status report, 102
Business Contacts History report, 102-103
Business Contacts Neglected report, 102
Business Contacts phone list report, 102
Business Data Import And Export Wizard,
117
Business Note, 86, 231
business opportunities, tracking, 90-92
Business Services, Business Contact
Manager (BCM), 250
Business Tasks report, 105
Business To Business (B2B) customer,
99-100
Business To Consumer (B2C) customer,
99-100
Business Tools button, 88, 94, 100, 102, 104
buttons, for form design, 70-72
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Calendar
Appointments view, 19, 20
for collaborating on time commitments,
288-291
creating an appointment entry, 285-287
creating an recurring appointment,
287-288
Events list, 19, 20
invitations, 145-146, 154
Month view, 21
One Day view, 18
organizing with, 17-21
permissions, 290-291
publishing on family home computer,
200-201
publishing online, 201
reminders, 18, 19
sharing, 157-160, 171-172, 201, 290-291
time zone coordination, 197-198
view options, 18-21, 291
viewing Tasks list with, 27-28
Calendar By Categories, 176
Calendar Options dialog box
Add Holidays button, 202
Free/Busy Options, 182
Meeting Room Calendar Options, 185
Planner Options button, 181
Time Zone button, 197
Calendar Properties dialog box, 157, 158
Calendar Title area, 201
call automation, 33-35
Call Contact option, 34
Call Date field, 208
Call (flag option), 208
Call Status line, 35
Captions font, 75
card scanner, 48
categories
Accounts by Category report, 101
Business Contacts by Category report,
102
creating, 67-68
customer, 67-68, 206
meeting, 176-178

Categories button
Account form, 86
Appointment form, 177, 287
Contacts, General page, 67, 301
Tasks list, 229, 287
Categories dialog box, 67, 163, 177
Categories list
appointment classification, 287
default list, 54
selecting categories, 56, 219
cc e-mail, 123, 124, 281
cell phone
password protection, 276
protecting contacts, 277
receiving Outlook messages on, 221
receiving reminders on, 275-276
turning off during meeting, 187
use abroad, 193
Change Password option, 276
Change The Document Layout option, 246
Chart Wizard, 115
charts, designing BCM with Excel, 114-116
Check Address dialog box, 301
Check Full Name dialog box, 299
Check Messages When They Arrive
option, 219
Check Phone Number dialog box, 300
CheckBox button, 70
checklist
building from customer perspective, 272
Day After, 252
Mailing Form, 240-241
meeting, developing, 179
travel, developing, 191-192
Choose A File dialog box, 210
Choose A Folder dialog box, 129
Choose Folders button, 17
Choose profile dialog box, 242
clients. See also customers
keeping, 205-212
mapping location, 225-226
Close Date field, Opportunity form, 90, 233
collaborative tools
agreement management, 144, 151-154
delegation, 145, 156-157
SharePoint server, 147-151, 159, 199
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sharing, 145, 157-160
supervising, 154-155
value of, 11
coloring messages, 216-218
columns, aligning, 77
ComboBox button, 70
comma delimited files, 50
comma separated values (.CSV), 94
CommandButton, 70
commitment
Accept or Decline buttons, 145
letter of understanding, 269
meeting, 290
time, 13, 259-265
to-do, 14
communication, integrating, 37-38
company information database, 64
company profile
description, 62
developing your own, 64
researching, 63-64
for sales, 65-66
Competitors field, Opportunity form, 91
completion time, estimating, 24-25
Condition button, 218
Condition list box, 248
Confidential (message option), 31
confirmation list, 184
confirmation requests, 165
contact
automatic links to, 211
frequency, scheduling, 206-207
linking an item to, 210
plan, 206
Contact form
building customer sales profile, 72-77
cleaning up standard, 73
default, 78
fields, 72-73
frames, 74-77
opening, 70
publishing, 77
toolbox buttons, 70-71
Contact Picture dialog box, 301
Contact Preferences area, Business
Contact form, 88

Contact Properties dialog box, 78
Contacts
Actions drop-down menu, 303-305
Activities page, 212, 302, 310-313
adding picture to, 301
Address Cards view, 58
All Fields tab, 264
categories, 54-56, 67-68
company profile, 62-66
compatible files, 48-49
creating new, 53-56
custom fields, 59-60
customer profile, 62, 64-65
customers, categorizing, 67-68
details, 56-58, 302, 303
Display Map of Address option, 303, 304
e-mail, sending, 304
fields sequence, 61
flagging for follow-up, 303-304
follow-up flag, 207
Follow Up option, 208, 303, 304
importing from existing files, 48-52
linking appointment to, 287
linking related, 54
list as customers and suppliers
database, 162
little black book compared, 52
New Distribution List option, 305
New Letter to Contact option, 305
New Message to Contact option, 303
noncompatible files, 50-52
personal information, adding, 48
Phone list view, 58-59, 61, 66
photos, 54
printing, 307
Private button, 55
profiles, 62-66
protecting cell phone, 277
views, 58-59
ways of using, 47-48
Contacts button
Appointment form, 199, 287
Contacts, General page, 301
Navigation page, 49, 52-53, 299
Navigation pane, 34
Tasks, 229, 295
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Contacts Folder, 242, 246
Contacts, General page

Address Book icon, 301

Business button, 300

Categories button, 301

Company field, 300

Contacts button, 301

e-mail field, 301

File As list box, 300

Full Name button, 299

IM Address field, 301

Job Title field, 299

Phone Numbers area, 300

Web Page Address field, 301
Contacts list

By Category, 244, 253

customizing by category, 213-214

merging for direct-mail marketing,

241-248

Miscellaneous Fields, 264-265

New button, 264

Phone List view, 253

synchronizing phone contacts with, 277

Telemarketing forms, 254
Control panel, Windows, 36, 37
Copy View dialog box, 26, 254
copying file message, 42
Create New Folder dialog box, 127
Create New Journal Entry When Starting

New Call option, 34

Create Signature dialog box, 306
Create Your Own command, 233
.CSV (comma separated values), 94
cultures, identifying meeting, 176
Current View dialog box, 18
Custom View Organizer, 21, 26, 254
customer profile

building with forms, 69-79

description, 62

developing your own, 64-65

loading new, 223-225
customer support, organizing, 168-169
customers

BCM account information, 85-87

BCM business contact information, 88-89

Business To Business (B2B), 99-100
Business To Consumer (B2C), 99-100
categorizing, 9, 67-68, 206
classifying messages from, 216-220
contact frequency, scheduling, 206-207
contact plan, 206
events, planning, 250-253
financial information, 86
flagging a contact, 208-209
forgotten, 68, 101, 102
hidden, 68
history, recording and reading, 230
information, 223-225, 231
keeping, 205-212
keeping tabs on, 268-269
knowing your audience, 237-238
linking appointment to account, 231-232
mapping location, 225-226
proposal, following up on, 229-230
proposal, sending, 228-229
quotes, analysis of, 215-216
receiving messages on cell phone, 221
relationships with, developing, 9, 10
requests, working on, 226-230, 232-233
sales targets, creating, 213-215
tracking history, 209-212
uniform customers and suppliers list,
creating, 161-163
using BCM to prospect new, 231-235
vision of, understanding, 268
Customize Current View By Category
dialog box, 177
Customize Current View By Company
dialog box, 248
Customize Current View option, 27, 61, 112,
213, 248
Customize Fields dialog box, 213
Customize Outlook Today screen, 16-17
Customize View dialog box
Fields button, 208
Filter button, 271
Customize View Phone List, 59, 61, 65
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data protection, 276
database
company information, 64
Microsoft Accounting 2006, 117
sharing, 98
uniform customers and suppliers list,
161-163
Day After checklist, 252
Decision Maker field, Show Fields dialog
box, 61
Decline button, 145, 152-153, 183, 297
Default Reminder option, 183-184
Delegate Permissions, 156-157
delegation, 145, 156-157, 262
deleted item, recovering, 278-279
Deleted Items folder, 139
Design Form dialog box, 70, 73
designating a task, 28-29
Detailed Tasks list, 153
Details page, Contacts, 56, 302, 303
Details tab
Account form, 86-87
Business Contact form, 88-89
Task form, 25
dialup connection, travel and, 192
Direct Inward Dial (DID), 38
direct-mail marketing
audience, selecting, 239-240
balancing with e-mail campaigns, 273-274
content, planning, 239
feedback, selecting, 240-241
history of, 238
labeling the mailing, 245-247
merging all contacts with letter, 242-243
merging selected contacts with letter,
243-245
planning, 238-241
printing, 241-245
Disabled Items button, 84
Display Map of Address option, Contacts,
303, 304
Do Not Forward option, 279, 280

Do Not Import Duplicate Items option,
49, 50
Document library, 149
Double-Clicking A Journal Entry area, 211
Download Wizard, 40
downloading
Business Contact Manager updates, 82
Outlook add-in tool, 40
Rights Management add-in, 280
your memory, 13-14
Due By list box, 208, 229
Dun & Bradstreet (company information
database), 64
Duration field, Show Fields dialog box,
177-178

oF o

Edit Signature dialog box, 306
Editor (permission level), 157, 262
e-mail. See also messages
archiving, 30, 136, 138-140
art of sending, 133-134
attaching previous messages, 131-132
behaviors of senders, 123-124
Blocked Senders list, 30, 136
broadcasting e-mails, 250, 273-274, 281
cc messages, 123, 124, 281
classifying messages, 125
confirmation request, 165
emptying Deleted Items folder, 139
flagging, 163-165
folder, creating, 127-128
Inbox management, 132-133
inserting a follow-up reminder in, 229
junk, 122, 136-137
Mailbox Cleanup, 138
marketing, 249-250
options, 30
organizing, 30-31, 126
phishing, 140-141
proposal, 228-229
protecting addressee’s mail address, 281
read receipt, 134
rule, creating, 128-131
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e-mail (continued)
Safe Recipients list, 136
Safe Senders list, 136-137
sending from Contacts page, 304
Sent Items folder, 136
task request, 297
tips, 145-146
tracking, 167
Unified Messages system, 37-38
unwanted, 122-125
using rules to eliminate, 127-131
vCard, 162, 305-306
voting, 165-167
E-Mail Marketing, Business Contact
Manager (BCM), 250
E-Mail Options button, 131, 263
E-Mail Options dialog box, 132
End date dialog box, 200
Enterprise Resource Planning (ERP)
systems, 7-8, 50
Entry Type list box, 224
e-office cleaner, 138-140
evaluation form, 173-174
event
content, 250-251
convincing customers to come, 251
Day After checklist, 252
following up on, 252-253
Guest Material and Printing Worksheet,
251
mingling during, 252
name badges, 251, 252
planning, 250-253
sales and marketing tips, 272-273
Event Address field, 189
Event Planner Worksheet, 251
Excel
comma separated values, 94
designing BCM charts with, 114-116
importing files, 50, 51
saving BCM reports in Excel format,
108, 114
telemarketing report, 256
workbook for passwords, 278
Exchange server, 159, 194-195

Exclude This Recipient button, 246

Expected Revenue field, Opportunities
list, 90

expiration dates, remembering, 196-197

ofF e

family, keeping in contact with, 199-201
fax, 36-37, 38
Fax icon, 36
Fax Wizard, 36, 37
feedback, direct-mail marketing, 240-241
Field Chooser, 72, 169
fields
creating custom, 59-60
creating in Task form, 169
for customer sales profile form, 72-73
inserting into frames, 75-77
sequence, 61
splitting into categories, 74-75
Fields button
Customize Current View By Category
dialog box, 177
Customize View dialog box, 112, 208, 214
Customize View Phone List dialog box,
59, 61, 65
Filter dialog box, 248
Fields to Merge option, 245
File command, Account History list, 86
files
importing to Outlook Contacts, 48-52
inserting, 230
opening shared, 159
filter
customer base for marketing purposes,
271
junk e-mail, 30, 137
messages, 218
reports, 107-110
selecting customers for direct-mail
marketing, 248-249
Filter button, 59, 248, 271
Filter dialog box, 218, 248, 271
Find button, 138
Finish Rule Setup dialog box, 130
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Flag button, 163, 228
Flag To list box, 208, 229
Flag wizard, 163-164
flagging
a contact, 208-209
contacts for follow-up, 303-304
as a reminder, 235
request, 163-165
folder
creating, 127-128
opening shared, 263
sharing, 263
Folder Size dialog box, 196
Follow Up (flag option), 208, 235, 254
Follow Up option, Contacts, 208, 303, 304
Font button, 75
For These Contacts list box, 211
Form library, 168
forms. See also specific forms
building customer sales profile, 72-77
cleaning up standard, 73
default, 78
fields, 72-73
frames, 74-77
opening, 70
publishing, 77
toolbox buttons, 70-71
Forward As vCard option, Contacts, 305
Frame button, 70, 74
Frame Properties dialog box, 74-75
frames
creating in Contact form, 74-75
creating in Task form, 169
inserting fields into, 75-77
Free/Busy scheduling, 172, 182-183,
288-289
Full Name button/field, 61, 299

oG o

Get Data button, 247
Get Directions button, 225
goals

business, 11

planning, 14

recording as tasks with reminders, 260
sales, 213

Gold (customer category), 206

Google (search engine), 224

Greeting Line Wizard, 243

Group Schedule dialog box, 172

Guest Material and Printing Worksheet, 251

oH o

Help, 38, 63, 84

history
Accounts History report, 102
Business Contact History report, 102-103
tracking customer, 209-212

holidays, adding foreign to Outlook, 202

o]e

icons, used in text, 4
Image button, 71
Import A File Wizard, 49, 50
Import And Export Wizard, 48-50, 117, 316
Import button, 94
Import Product And Service Items
Wizard, 94
importing
compatible files, 48-49
contacts from existing files, 48-52
Excel files, 50, 51
Internet Mail account settings, 316
mail folders, 316-317
noncompatible files, 50-52
product and service items list, 93-95
Inbox
cleaning, 30
fax in, 38
management, 132-133
Inbox Properties dialog box, 194-195
Include Appointment Details check box,
200
innovation, 10-11
Insert Address Block dialog box, 242, 246
Insert button, 228
inserting files, 230
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Instant Messaging, 189
integrating communication, 37-38
internal support, requesting, 227-228
Internet Explorer, 63, 268, 280
Internet Options dialog box, 317-318
invitation
agenda forms, 187
Calendar, 145-146, 154
confirmation list, 184
finalizing time, 183-184
for online training or conferences, 189
opening, 189
scheduling meeting, 181, 289-290
tracking, 184
Invitation form
Accept button, 183
Date, Time, and Place, 179
Decline button, 183
Equipment required, 179
Guest confirmation, 179
Guest Invitation, 179
Meeting Workspace button, 149
opening, 181
Propose New Time button, 183
Requirements, 179
Send button, 181
Subject, 179
Tentative button, 183
Invite Attendee button, 154, 189, 289
iPod, 196
item
deleted, recovering, 278-279
disabled, 84
linking automatically, 211, 311-312
linking to contact manually, 210, 310-311

° ] °

John Wayne rule, 277

Journal
contact history, creating, 310-311
description, 309-310
entry form, 34, 224
linking items automatically, 311-312
linking items to contact manually,

310-311

linking Microsoft Office files to, 313
note, 224-225, 269
retrieving, 313-314
viewing by contact, 313
views, 313-314
Journal button, navigation pane, 314
Journal Entry form
Entry Type list box, 224
Phone Call, 34
Subject, 224
Journal Options dialog box, 211, 312, 313
junk e-mail, 122, 136-137
Junk E-Mail filter, 30
Junk E-Mail Options dialog box, 137

oo

Keep An Updated Copy Of This Task On My
Tasks List option, 28, 228

o/ o

Label button, 70
Label list box, Appointment form, 286-287
Label Options dialog box, 246, 247
labeling
direct-mail marketing, 245-247
Time Zone, 197-198
LAN connection, travel and, 192
leadership, 144
letter of understanding, 269
Letters And Mailing option, 242, 245, 247,
249
life balance, 42-43
Link Button, 150
Link command, 305
Link File dialog box, 96, 234
Link Items To Contact dialog box, 210, 311
Link To An Existing Workspace option, 150
Link To field, Opportunity form, 90
linking
appointment to prospect account, 231
items automatically, 211, 310-311
items to contact manually, 210, 310-311
Microsoft Office files to Journal, 313
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opening a linked document, 212
proposal to a Task, 229-230
proposals, 95-96
retrieving linked information, 311
to track customer history, 210
ListBox button, 70
Listbuilder service, Microsoft, 117

o/l o

Mail button, Navigation Pane, 260
Mail command, 15
Mail Format list box, 250
Mail Format page, 306
Mail Merge Helper, 247
Mail Merge option, 242, 244, 245, 247, 249
Mail Merge Recipients dialog box, 242,
244, 246
Mail Merge Task pane, 247
Mail Merge toolbar, 249
Mail Message command, 235
mailbox
cleaning Inbox, 30, 138, 196
organizing, 30-31
Mailbox Cleanup, 30, 138, 196
Mailing Form Checklist, 240-241
Manage Attendees, 148
Map Custom Fields dialog box, 50-52
mapping client location, 225-226
marketing
content, 239
description, 10
direct-mail, 238-249
e-mail, 249-250
knowing your audience, 237-238
messages, 123
planning events, 250-253
telemarketing, 253
Master Category List button, 55, 67-68, 177
Master Category Wizard, 55
medicine, reminder for, 43
meeting
agenda, 187
categories, 176-178
checklist, developing, 179

commitment, 290

confirmation list, 184

finalizing time for, 183-184

identifying meeting cultures, 176

invitation, 289-290

mapping client location, 225-226

preparing for, 178-179

reserving resources, 185-186

scheduling, 179-185

time zone, 176

tracking form, 188

video and Web conferences, 189
Meeting Room Calendar Options dialog

box, 185

Meeting Workspace button, 149
Merge To E-Mail dialog box, 249
Merge To list box, 245, 247
Merge To Printer dialog box, 243, 246
merging

all contacts with letter, 242-243

selected contacts with letter, 243-245
Message Options dialog box

Request A Read Receipt Of This Message

check box, 165

Use Voting Buttons check box, 166
messages

anti-spam filters, 122

archiving, 30

art of sending, 133-134

attaching previous, 131-132

behaviors of senders, 123-124

broadcasting, 250, 273-274, 281

classifying, 125, 216-220

coloring, 216-218

deleted item, recovering, 278-279

e-mail cleanup, 135-140

filtering, 218

folder, creating, 127-128

Inbox management, 132-133

mailbox, organizing, 30-31

marketing, 123

options, 30

organizing, 126

prioritizing, 278

protecting addressee’s mail address, 281

read receipt, 134
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messages (continued)
with restricted reading permission,
279-280
rule, creating, 128-131
selecting arriving messages by subject,
218-220
sending, 31
sensitivity, 31
SMS, 221
in Tasks list, 133
Unified Messages system, 37-38
unsolicited, 122
wanted, classifying, 125
why people send, 121-125
Microsoft Accounting 2006 database, 117
Microsoft Active Sync, 83
Microsoft Fax console, 36, 37
Microsoft IRM service, 279
Microsoft Listbuilder service, 117
Microsoft MarketPlace (Web site), 159, 194
Microsoft Office Online, 187
Microsoft Small Business Accounting, 92
Microsoft Small Business Web site, 117
mi8.com (Web site), 159, 194, 195
Mobile Phone Tools (Avanquest), 276, 277
Modify Report button, 107, 109
Modify Report dialog box, 107-108
Move Message From Someone To A Folder
option, 129
Move To The Specified Folder option, 129
MP3 devices, 196
MS Office Online (Web site), 173, 194, 239
MSN Map site, 304
MSN Maps & Directions site, 225, 226
MSN .NET Passport, 279, 280
MSN.com (Web site), 159
MultiPage button, 71
My Calendars window, 157
My Tasks window, 229

o\ o

name badges, 251, 252
Name button, 155
Name Of New View text box, 26, 254

neglected customers, 101, 102

negotiation, 144

.NET Passport, 279, 280

New Account form, 231, 232

New button, Calendar, 189

New Call dialog box, 34

New Category text box, 55, 67, 177

New Contact From Same Company option,
Contacts, 305

New Distribution List option, Contacts, 305

New Field button, 59, 65, 208, 214

New Field dialog box, 59-60, 214

New Folders tab, Ways To Organize Inbox
dialog box, 126

New Journal Entry For Contacts option,
224, 269

New Journal Entry option, Contacts, 305

New Letter To Contact option, Contacts,
305

New Message to Contact option,
Contacts, 303

New Rule button, 128, 219, 221

New vCard From Contact button, 306

Note, Outlook, 195-196

note taking, meeting, 186

Notes button, Navigation pane, 196

Notify Me When New Messages Arrive
option, 263

Number list box, 34

o () o

objective, business, 11

OCR (Optical Character Recognition)
software, 48

offline folders, 39, 194

OMA (Outlook Mobile Access), 195-196

One Day Calendar view, 17-18

Online meeting setup, 189-190

Open A Shared Calendar dialog box, 291

Open Other User’s dialog box, 263

Open Other User’s Folder dialog box,
155, 159

Open Outlook Data File list box, 42



Opens The Item Referred To By The
Journal Entry option, 211
Opportunities list
Expected Revenue field, 90
using to control prospects, 215
Opportunity by Product and Service
report, 105, 109-110
Opportunity command, Account History
list, 86
Opportunity Forecast report, 105, 106
Opportunity form
as alternative to Tasks, 83
Close Date field, 90, 233
Competitors field, 91, 233
completing, 90-91
description, 84
Initiated By field, 91
Link To field, 90
linkage to Account form, 82
linkage to Business Contact, 82
Opportunity Title text box, 90, 232
Probability field, 90, 233
Product And Service Items, 91
Sales Stage field, 90
Source of Lead field, 91
Status area, 90
for tracking business opportunities,
90-92
updating, 234
Opportunity Funnel report, 105, 106,
110-111
Opportunity History, 233
Opportunity History Items list, 91, 233, 234
Opportunity Title text box, 90, 232
Optical Character Recognition (OCR)
software, 48
OptionButton, 70
Options button, e-mail, 31
Options dialog box
AutoArchive button, 139
Calendar Options button, 202
Default Reminder, 184
Delegates tab, 156
E-Mail Options button, 131, 263
e-Office Cleaner options, 139

Journal Options, 211
Mail Format tab, 305-306
Other tab, 139
Security tab, 278
Oracle, 8
organization
Calendar, 17-21
messaging, 29-31
Outlook Today, 15-17
Tasks list, 21-29
Organize Pane, 30, 216-218
Other User’s Folder option, 263
Outlook Data File, 39-40, 42, 194, 196, 276
Outlook Express
changing default mail system, 317-318
copying data from another PC, 318
importing Internet Mail account settings,
316
importing mail folders, 316-317
moving to Outlook 2003, 315-318
Outlook Mobile Access (OMA), 195-196
Outlook Research, 63
Outlook Today
commitments listed in, 260
customizing, 16-17
opening, 15
Outlook Web Access (OWA), 194-195
overdue accounts
Accounts by Status report, 100, 107-109
Business Contacts by Status report, 102

opPe

Palm OS devices, 195

Palm Pilot, 83

password, 276, 278

Password To Open text box, 278

Past Due Opportunities report, 105

Peachtree, 8

performance, measuring, 269-270

Permission in Calendar Properties dialog
box, 290-291

Permission Level, 157, 262, 291

Permission List, 262
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permissions
Calendar, 290-291
delegating, 156-157
levels, 157-159, 262, 291
Personal Fields list, 58
Personal Folder Backup dialog box, 40-42,
196
Personal Folders command, 15, 260, 276
Personal Folders Properties dialog box,
276
personal information, adding to Contact
profiles, 48
personal information management (PIM),
194
pfbackup.exe software, 40
phishing, 140-141
Phone Call Journal, 34, 35
phone calls
autodialing phone calls, 303, 304
follow-up, 252
receiving Outlook messages on cell
phones, 221
telemarketing, 253-256
turning cell phones off during meeting,
187
Phone list, Navigation page, 61
Phone list view, Contacts, 58-59, 61, 66
Phone Log command, Account History
list, 86
Phone Tools (Avanquest), 276, 277
photo, contact, 54
picture, adding to Contacts, 54, 301
PIM (personal information management),
194
Place Chart option, 116
Planner Options dialog box, 181
planner, printing, 307
planning
direct-mail marketing, 238-241
events, 250-253
productive meetings, 178-179
Platinum (customer category), 206
Pocket PC, 83, 195, 276
preparation, for meetings, 178-179
presentations, tips for, 272-273

Primary Business Contact area, Account
form, 85-86
Primary Contact field, 86
Print dialog box, 36
Printer and faxes folder, 36, 37
Printers And Fax devices list, 36
printing
Contacts, 307
direct-mail marketing, 241-245
name badges, 251, 252
reminder list, 13
priorities, organizing, 21-23, 261
prioritizing messages, 278
Priority button, 22-23
Private button, 55
Probability field, Opportunity form, 90
procurement, 12
Product And Service Items List
accessing, 92
Add Or Edit dialog box, 93
adding to, 91, 93
description, 84
importing an existing list, 93-95
limitations, 97-98
linking proposal, 95-96
Opportunity value in, 233
uses of, 82
profile
building with forms, 69-79
creating for sales, 65-66
description, 62
developing your own, 64-65
researching, 63-64
projects, managing, 169-171
Properties dialog box, 74
proposal
following up on, 229-230, 234-235
linking, 95-96
sending, 228-229
Proposal category, 214, 219
Propose New Time button, 183
prospects, 231-235
Publish at my location check box, 182
Publish button, 77, 169
Publish Form dialog box, 77
publishing a profile form, 77
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Quick Accounts List report, 102

QuickBooks, 117

quick-learning program, 146

quotes, analyzing to help close orders,
215-216

o R e

rating
Accounts by Rating report, 100-101
Business Contacts by Rating report, 102
read receipt, 134
Reader (permission level), 262
Reading Pane option, 255
reading permission, restricted, 279-280
Recently Modified view, 111
Recover Deleted Items option, 279
recovering deleted item, 278-279
Recurrence button, 288, 295
recurring appointment
list, 21
setting up, 287-288
recurring Tasks, 207
Remember icon, 4
Remind Me To Backup Every X Days

option, 41
reminder
alarm, 9, 11

for appointments, 287

for customer contact, 207, 208-209

for customer follow-up, 48

default option, 183-184

of expiration dates, 197

for financial and organizational
control, 12

flagging as, 235

Follow Up option, Contacts, 303, 304

importance/value of, 9, 11

inserting a follow-up reminder in e-mail,
229

medicine, 43

new task as Task reminder, 235

printing list, 13
receiving on cell phone, 275-276
recurring, 12
for sales and fulfillment activities, 12
setting up, 184
as SMS messages, 221
sound selection, 287, 295
subfolders and, 173
synchronizing, 13, 276
for taking a break, 261
for tasks, 18, 19, 295
time, 23, 208, 209
Reminder Selection Box, 235
Reminder Sound selection box, 287
Replace Existing List With Items In This
File option, 94
report
Accounts by Category, 101
Accounts by Rating, 100-101
Accounts by Status, 100, 107-109
Accounts History, 102
Accounts List with Business Contacts,
102
Accounts Neglected, 101
Business Contacts by Category, 102
Business Contacts by Rating, 102
Business Contacts by Status, 102
Business Contacts History, 102-103
Business Contacts Neglected, 102
Business Contacts phone list, 102
Business Tasks, 105
filtering, 109-110
Modify Report dialog box, 107-108
Opportunity by Product and Service, 105,
109-110
Opportunity Forecast, 105, 106
Opportunity Funnel, 105, 106, 110-111
Past Due Opportunities, 105
Quick Accounts List, 102
refining, 107-109
Source of Leads, 104
telemarketing, 256
request
e-mail confirmation, 165
flagging, 163-165
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request (continued)

for internal support, 227-228

Task, 261, 296-297

using BCM, 232-233

working on customer’s, 226-230, 232-233
Request A Read Receipt Of This Message

check box, 165

reserving resources, 185-186
Reset Current View command, 27
Resource Scheduling dialog box, 185
resources, reserving, 185-186
restricted reading permission, 279-280
retirement plan, 43
Reviewer (permission level), 157
Rights Management add-in, 279, 280
RS Outlook, 209, 276
rsoutlook.com (Web site), 221, 276
rules

agreement, 152-154

creating e-mail, 128
Rules And Alerts dialog box, 128, 131, 220
Rules For This View list box, 218
Rules Wizard, 30, 126, 128-130, 219, 221
Run This Rule Now On Messages Already

In “Inbox” check box, 130

oS e

Safe Recipients list, 136
Safe Senders list, 136-137
sales
keeping a client, 205-212
Outlook help with, 10
prospects, 231-235
quotes, analyzing, 215-216
targets, creating, 213-215
tracking customer history, 209-212
Sales Stage field, Opportunity form, 90
sales tips
balancing mail and e-mail campaigns,
273-274
checklist, building from customer
perspective, 272
customer’s vision, understanding, 268

events and presentations, maximizing,
272-273
keeping tabs on customers, 268-269
letter of understanding, 269
marketing productivity, increasing, 270
performance, measuring, 269-270
questions for brainstorming, 267
target markets, working with, 270-271
tracking opportunities with tasks, 268
SAP, 8
Save as Web Page dialog box, 200
Save Backup button, 196
scanning business cards, 48
scheduling
customer contact frequency, 206-207
meetings, 179-185
reserving resources, 185-186
Scheduling tab, Appointment form,
180-181, 288-290
script, telemarketing, 255-256
ScrolBar button, 71
search engines, 224
Search For A Download text box, 40
Search Text dialog box, 219
Searching For The Words text box, 218
security
cell phone contacts, protecting, 277
data protection, 276
password, 276, 278
protecting addressee’s mail address, 281
restricted reading permission, 279-280
training as protection tool, 277
Select Action(s) List, 219
Select Available Fields From list box, 26,
112, 208
Select Contact Folder list, 242, 246
Select contacts dialog box, 199
Select Enterprise Form dialog box, 112
Select From Outlook Contacts option, 242
Select Objects button, 70
Select When Messages Should Be Checked
options, 219
Select Where To Place The Folder list, 128
Selected Destination Folder list, 49, 50
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Send An Alert To My Mobile Device When I
Get Messages From Someone option,
221
Send E-mail (flag option), 208
Send Fax Wizard, 37
Send Letter (flag option), 208
Send Me A Status Report When The Task Is
Complete option, 28
Send Me A Status Report When This Is
Complete option, 228
Sensitivity list box, 31
Sent Items folder, 136, 229
Service Sign Up wizard, 279-280
Set Permissions button, 186
Setup button, 247
Share My Calendar option, 157
SharePoint server, 147-151, 159, 199
sharepointtrial.com (Web site), 147
sharing
Calendar, 157-160, 171-172, 201, 290-291
database, 98
folders, 263
Outlook properties, 145
permissions, 262
Tasks, 157, 262, 298
tool service suppliers, 159
Sharing Wizard, 98
Short Messages Service (SMS), 221,
275-276
Show An Additional Time Zone check box,
197
Show Fields dialog box
Business Contacts Entry Form fields, 112
Decision Maker field, 61
Duration field, 177-178
New Field button, 59, 214
Select Available Fields From list box,
26,112
Show List list box, 230
Show Mail Merge Toolbar, 249
Show Names From The list box, 262
Show These Fields box, 26
Show These Fields In This Order list, 65,
208, 214
Signatures button, 306

Silver (customer category), 206
Sites And Workspaces hyperlink, 148
Smartphone, 83, 195
SMS (Short Messages Service), 221,
275-276
Sort button, 59
sounds, reminder, 287, 295
Source of Lead field
BCM Recently Modified view, 112-113
Opportunity form, 91
Source of Leads report, 104
Specify A Name For This Rule text box, 220
Specify Words Or Phrases To Search For
text box, 219
Sperry software (Web site), 276
SpinButton, 71
Standard (customer category), 206
Start Call button, 35
Start Creating A Rule From A Template
option, 129
Start date dialog box, 200
Start From A Blank Rule option, 219
Start Searching button, 63
Start Time date box, 224
State field, 248
supervising, 154-155, 261, 298
suppliers list, creating, 161-163
surveys, conducting, 165-167
Synchronization tab, 194-195
synchronizing
cell phone with tasks and calendar, 276
description, 39
offline folders and, 39
reminders, 276

oJ o

Tab Separated Values (DOS) option, 50
table, adding to Task, 170-171

TabStrip button, 71

target markets, working with, 270-271
targets, creating sales, 213-215

Task button, 229, 293

Task command, Account History list, 86
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Task form
Categories button, 229, 295
Contacts button, 229, 295
customizing, 168-169
Due date field, 23, 227, 230, 294
Owner field, 295
Priority list, 23, 227, 294
Private check box, 295
Start date field, 23, 294
Status field, 227, 294
Subject line, 227, 294

Task Items list, 210

Task Pane Wizard, 249

Task Request, 261

Taskpad, 27

Tasks
accepting or declining, 152-153, 297
adding table to, 170-171
for assigning internal support, 227-228
business goals and objectives, 11
creating recurring, 207
for customer support, 168-169
customizing form, 168-169
evaluation form, 173-174
new, 197
in Opportunity History Items list, 233
for procurement activities, 12
for remembering expiration dates, 197
requesting, 296-297
sharing, 298
supervising, 298
tracking opportunities with, 268
updates, receiving, 297
vacation requests, 174

Tasks folder, 262

Tasks list
accepting a task, 29
accessing, 16
agreement management with, 152-154
completion time, estimating, 24-25
creating new, 293-295
declining a task, 29
designating tasks, 28-29
Details page, 25
displaying, 293
messages in, 133

organizing with, 21-29
prioritizing, 21-23
reminders, 23

rules, 152-154

saving a view, 26-27
scheduling a task, 23
selecting open proposals, 214
sharing, 157, 262

sorting, 152

Start Date, 23

supervising with, 29, 154-155
Total Work field, 25

viewing, 27

viewing Calendar with, 27-28
viewing fields, 25-26

views, 261, 295-296

Tasks List By Person Responsible, 154, 155

Tasks View By Categories, 229
teamwork
agreement management, 144, 151-154
Calendar, promoting use of, 145-147
Calendar, sharing, 171-172
collaborative tools, 144-145, 151-160
commitment, 145
customer support, organizing, 168-169
customers and suppliers list, creating
uniform, 161-163
delegation, 145, 156-157
e-mail tips, 145-146
evaluation form, 173-174
leadership, 144
maintaining team commitment, 143-145
negotiation, 144
projects, managing, 169-171
quick-learning program, 146
requests, following up on, 163-165
SharePoint server, 147-151
sharing, 145, 157-160
supervising, 154-155
surveys, conducting, 165-167
vacation requests, 174
Technical Stuff icon, 4
technical support, 264-265
telemarketing
forms, 254
report, 256
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script, 255-256
success, ensuring, 253-256
view title, creating, 254
telephone. See phone calls
Tentative button, 183
TextBox button, 70
This Folder, Visible To Everyone option,
254
This Is An Online Meeting Using box, 189
This Is The Mailing Address box, 301
Thomson Gale (company information
database), 64
time commitments
boss-imposed, 261-263
description, 13
self-imposed, 259-261
system-imposed, 263-265
time perceptions, 176
time zone, 176, 197-198
Tip icon, 4
To Here command, 225
to-do commitments, 14
ToggleButton, 70
Total Work field, 25
tracking
business opportunities, 90-92, 268
customer history, 209-212
Tracking tab
e-mail, 167
invitation, 184
Traffic Sign button, 225
training
importance of, 144
online, 189
as protection tool, 277
travel
AC power, 192
Calendar appointments, 199
cell phone use abroad, 193
checklist, developing, 191-192
connecting through Outlook Mobile
Access (OMA), 195-196
connecting through Outlook Web Access
(OWA), 194-195
dialup connection, 192
expiration dates, remembering, 196-197

family contact and, 199-201
foreign holidays, adding to Outlook, 202
LAN connection, 192
opening files from memory card or
CD-ROM, 193-194
publishing agenda on family home
computer, 200-201
publishing agenda online, 201
time zone coordination, 197-198
wireless connection, 192
Traveldrive device, 196
Treo Smartphone, 195
Turn On This Rule check box, 130

olf o

Unified Messages system, 37-38
Untitled Contact dialog box, 53-54
updating an opportunity, 234

usability, 272

Use The Current Document option, 242
Use Voting Buttons check box, 166
Using Colors option, 217

oo

vacation requests, 174

vCard, 162, 305-306

Verify Password option, 276

video conferences, 189

View button, Calendar, 17

View Deleted Items Size button, 138

View Group Schedules command, 172

View Mailbox Size button, 138, 196

views, refining Business Contact Manager,
111-113

voice mail, 37-38

voting, e-mail, 165-167

o[/ o

Waiting On Someone Else option, 227

Warning! icon, 4

Ways To Organize Inbox dialog box,
126, 128
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Web conferences, 189
Web site
antiphishing.org, 141
Avanquest, 276, 277
Microsoft MarketPlace, 159, 194
Microsoft Small Business, 117
mi8.com, 159, 194
MS Office, 173, 194, 239
MSN Maps & Directions, 225, 226
MSN.com, 159
rsoutlook.com, 221, 276
sharepointtrial.com, 147
Sperry software, 276
When Posting To This Folder, Use list, 78
When Replying To A Message drop-down
list, 131

Where My Name Is Not In The To Box
option, 129
Windows Media Services, 189
Windows Rights Management (RM) Client,
279, 280
wireless connection, travel and, 192
Word
direct-mail marketing use, 242-243
telemarketing script, 255-256
Word Mail Merge Task pane, 245
Workspace Wizard, 149

oyo

Yahoo! (search engine), 224
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